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Device Description
The Pinnacle3® Radiation Therapy Planning (RTP) software is composed of several modules including the core Pinnacle3 
functionality, Syntegra™, P3IMRT®, and AcQSim3™. The Pinnacle3 RTP software runs on a Solaris UNIX (or UNIX compliant) 
computer, which allows qualified medical personnel to enter patient data into the system, use that data to construct a plan 
for radiation therapy, and evaluate the plan. Optionally, the qualified medical personnel may output the plan in an 
electronic or printed form for use by other systems in the delivery of treatment to a patient.
Pinnacle3 includes networking capabilities to provide connectivity to other Pinnacle3, Syntegra, AcQSim3, or P3IMRT 
workstations, input devices and output devices, as well as access to the Pinnacle3 database from any Pinnacle3 workstation 
available on the network. The system can be run from a single workstation but has network capability to other Pinnacle3 
workstations and to both input and output devices via local area network (LAN) or wide area network (WAN). The Pinnacle3 
RTP System also has an enterprise configuration for larger sites requiring a centralized data center environment. This system 
consists of one or multiple rack mountable servers on which Pinnacle3 sessions run which enables display on any network 
accessible computer. The expected service lifetime of the software is five (5) years.
To enable use of the software, a license key must be issued by the installer after software installation has been completed. 
If you have any software issues, please contact your service representative: Customer Support (1-800-722-9377 for US and 
Canada), your local Philips Customer Service provider, or your local Distributor. Beginning with Pinnacle3 16.4, you will need 
to provide your service representative with the equipment ID assigned to your software kit. Your equipment ID can be 
found in the About window and is used to direct your call to the appropriate service personnel.

Intended Use
Pinnacle3 Radiation Therapy Planning System is a software package intended to provide planning support for the treatment 
of disease processes, utilizing photon, proton, electron and brachytherapy techniques.

Indications for Use
Pinnacle3 Radiation Therapy Planning System is a software package intended to provide planning support for the treatment 
of disease processes. Pinnacle3 Radiation Therapy Planning System incorporates a number of fully integrated subsystems, 
including Pinnacle3 Proton, which supports proton therapy planning. The full Pinnacle3 Radiation Therapy Planning System 
software package provides planning support for the treatment of disease processes, utilizing photon, proton, electron and 
brachytherapy techniques.
Pinnacle3 Radiation Therapy Planning System assists the clinician in formulating a treatment plan that maximizes the dose 
to the treatment volume while minimizing the dose to the surrounding normal tissues. The system is capable of operating 
in both the forward planning and inverse planning modes. Plans generated using this system are used in the determination 
of the course of a patient’s radiation treatment. They are to be evaluated, modified and implemented by qualified medical 
personnel.

Contraindications
There are no known contraindications regarding the use of the Pinnacle3 RTP system.

Intended Audience
This manual is written for qualified medical personnel trained as users of Pinnacle3 RTP systems. You should make sure that 
you have thoroughly read and completely understand the manuals and release notes that are delivered with the software. 
Keep this manual and all other manuals delivered with the software near your Pinnacle3 system and review them 
periodically. The initial installation procedure will be performed by a Field Service Engineer. If you suspect that your system 
has an error, discontinue its use and contact Customer Support or your local distributor.

Philips Medical Systems (Cleveland), Inc.
5520 Nobel Drive
Fitchburg, WI 53711
USA
Tel: +1 800 722 9377
Web: www.philips.com/healthcare
InCenter: incenter.medical.philips.com

Medical Device Directive
Pinnacle3 Radiation Therapy Planning 
System is CE Marked to the Medical 
Device Directive 93/42/EEC.

European Representative
Philips Healthcare, Nederland B.V.
PHC Quality & Regulatory Affairs
Europe
Veenpluis 4-6
5684 PC Best
The Netherlands

Australia/New Zealand Sponsor
Philips Healthcare
65 Epping Road
North Ryde, NSW 2113 
Locked Bag 30, North Ryde NSW 1670
4598 006 81251 A  Pinnacle3 16.4 Planning Instructions for Use



2

Minimum Requirements
This section provides the minimum requirements concerning hardware and software related to running the current product 
release as intended. 

Notes
Equipment specifications are subject to alteration without notice. All changes will be in compliance with regulations 
governing manufacture of medical equipment.
Pinnacle3 and P3IMRT are registered trademarks, and AcQSim3 and Syntegra are trademarks of Philips. Other brand or 
product names are trademarks or registered trademarks of their respective holders.
No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system or translated into any 
human or computer language in any form by any means without the consent of the copyright holder. Unauthorized copying 
of this publication may not only infringe copyright but also reduce the ability of Philips to provide accurate and up-to-date 
information to users and operators alike.

Use of Symbols in Labeling
Philips Healthcare complies with International Standards and FDA requirements for the use of symbols in labeling. An 
online glossary of symbols used by Philips Healthcare is available at http://www.symbols.philips.com.

Professional
• Solaris 11 version 11.3 or later with Oracle X6-2

(Note for existing sites: 11.2 or later with Oracle X5-2)

• 64GB RAM (based on number of concurrent users)

– Additional RAM requires upgrade
– Upgradeable to 384GB RAM

• Rack Management: 1U each server

Smart Enterprise (Cluster Server Nodes)
• Solaris 11 version 11.3 or later with Oracle X6-2

(Note for existing sites: 11.2 or later with Oracle X5-2)

• Solaris Cluster required on cluster nodes
• 64GB RAM (based on number of concurrent users)

– Additional RAM requires upgrade
– Upgradeable to 384GB RAM

• Rack Management: 1U each cluster server
Network
• 10,000/1,000/100 Mbps Base-T Ethernet
• 1,000/100 Mbps Base-T Ethernet for remote 

management (ILOM)
• 4/8/16GBs HBA ports supported for 

communication between Smart Enterprise 
Cluster servers and the SAN

Third-Party Software
• OVDC(VCC) is used to access Pinnacle3

• Third-party software installations are not 
supported on any Pinnacle3 system server 
without proper validation.

Smart Enterprise (Application Servers)
• Solaris 11 version 11.3 or later with Oracle X6-2

(Note for existing sites: 11.2 or later with Oracle X5-2)

• 64GB RAM (based on number of concurrent users)

– Additional RAM requires upgrade
– Upgradeable to 384GB RAM

• Rack Management: 1U each application server
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�General Device Warnings
Do not load non-system software onto the computer used by this system without the direct authorization of Philips 
Medical Systems. Feature performance and safety may be compromised.

To assure proper treatment, it is critical that a qualified medical person review and verify all system treatment plan 
parameters using an independent verification method prior to treating patients using the plan.

Report the occurrence of a serious incident in relation to this device to Philips Customer Support and the competent 
authority of the Member State in which the user and/or patient is established.

We recommend that you review TG40, TG53, and other pertinent radiation therapy treatment standards and incorporate 
those methods into your clinical practice to ensure that your use of the system results in the most accurate treatment 
plans. TG40, TG53, and other reports are available publicly at the American Association of Physicists in Medicine (AAPM) 
website.
• Comprehensive QA for radiation oncology: Report of AAPM Radiation Therapy Committee Task Group 40. Medical 

Physics 21(4), 1994.
• American Association of Physicists in Medicine Radiation Therapy Committee Task Group 53: Quality assurance for 

clinical radiotherapy treatment planning. Medical Physics 25(10), 1998.

The following clinical practices are recommended to verify the accuracy of each treatment plan:
• An independent calculation of the monitor units for each beam of a plan and treatment time for each brachytherapy 

plan.
• Acquisition and review of portal images or review of multi-leaf collimator (MLC) leaf positions after import to the 

treatment system.
• A chart check prior to the plan being delivered or during the first week of treatment.
• Independent review of the treatment plan prior to the delivery.
• Cross-functional review of the plan in a weekly chart round.
• Manual verification of record and verify settings after transfer to the treatment machine.
• Verification of the SSD and field shape during patient setup.

These reviews should be performed for a new plan or when a change is made to any component of a plan.

U.S.A. law: CAUTION: Federal law restricts this device to sale by or on the order of a physician.

This software product is a Medical Device.

Only qualified medical personnel should operate the system. New personnel should receive training prior to 
unsupervised operation of the system. For more information, contact Customer Support or your local distributor.

Serious injury to patients can result due to the misapplication of this product. Make sure that you thoroughly understand 
all the user instructions prior to using this device.

Pinnacle3 treatment plans may include the statement NOT FOR CLINICAL USE. Based on the machine or isotope data and 
the treatment plan, the software determined that the plan cannot be delivered clinically. Do not treat patients with 
plans that are not for clinical use.

Pinnacle3 includes sample data. This information is for reference purposes only. Do not treat patients with plans based 
on sample machines or other sample data.
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10 Introduction
1 Getting Started

Introduction
The Pinnacle3 treatment planning system provides a comprehensive set of tools for setting up and 
evaluating treatment plans. The software includes options for simulation, and photon, electron, 
stereotactic radiosurgery, proton, and brachytherapy treatment planning.

�CAUTION
If you purchase Pinnacle3 without the dose calculation features and you try to open a plan that 
already has dose computed, you will get an error message that dose will be invalidated. You can 
still view the plan. If you do not save the plan, the dose will still be intact. If you save the plan, 
you will have to go back into Pinnacle3 (with dose) to recompute dose. We recommend that you 
make a copy of the plan and work on the copy so the dose in the original plan does not get 
invalidated.

NOTE
The Pinnacle3 system should not be used within the space where surfaces may come 
into contact with the patient or with an attendant who can touch the patient. This space 
is defined as 1.83 meters (6 feet) outside the perimeter of the intended location of the 
treatment table and 2.29 meters (7.5 feet) above the floor.

Classic Pinnacle3

Classic Pinnacle3 refers to the multi-window interface included with the Pinnacle3 treatment 
planning system. 

Planning

Planning refers to the basic, single-window interface included with the Pinnacle3 treatment 
planning system. 

AcQSim3

AcQSim3 is a simulation tool that allows you to do the following tasks:

• perform absolute localization at the time of scan acquisition because AcQSim3 can determine 
table coordinates corresponding to where the patient should be marked (available for approved 
Philips scanners only)

• use advanced DCR (digitally composited radiograph) display and manipulation tools
• set up volumes of interest to eliminate image data that would impede visualization
• add a user-defined default set of orthogonal beams and a customized set of viewing windows 

upon starting your simulation plan
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• set independent window/level values, set up laser lookup tables, display 2D reference lines, 
and set other visualization parameters

• create separate preferences for simulation and planning

• use AcQSim3 as a stand-alone CT simulation system or add dose and IMRT for a complete 
simulation and planning system networked to a single database

�CAUTION
Some of the AcQSim3 features are available only for DICOM image sets. You must have DICOM 
Image 4.2 or later installed to use those features. The features that require DICOM Image 4.2 
state that you must be using a DICOM image.

Syntegra and Image Fusion

Syntegra and Image Fusion allow you to correlate, or register, multiple patient image sets using the 
image fusion features. You can view correlated images in 2D and 3D.

NOTE
The Syntegra features are available only if you are licensed for Syntegra.

DICOM conformance

DICOM (Digital Imaging and Communications in Medicine) is a standard for the electronic transfer 
of digital images and associated information, developed by the American College of Radiology and 
the National Electrical Manufacturers Association. The Pinnacle3 software operates within DICOM 
standards and within the standards of the manufacturer’s Conformance Statement for DICOM. The 
DICOM conformance statement is available on the Philips Healthcare website 
(www.healthcare.philips.com).

Log in to the workstation
Your workstation is ready to use when the power is turned on and the log-in prompt appears on the 
screen. The log-in prompt appears whenever you turn on the power, reset the system, or log out.

1 At the log-in prompt, enter your user name, then press the Return key. The password window 
appears.

2 Type your password, then press the Return key. To keep passwords secret, the password is not 
shown as you type it.

When you are logged in, the Pinnacle3 screen background appears on the desktop.

User accounts

The standard account is p3rtp. Individual user accounts can be set up by your system administrator.

When a new user account is created it uses the default factory settings. Your account includes your 
own home directory. You can view and copy the files in another user’s directory, but you cannot 
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12 Start the software
save to the other user’s directory. Once you log in to your user account and make any change, that 
change is specific only to your account. Scripts you create are specific to your account, too.

So, you could create a script and save it in your home directory, then have other users copy it to 
their own directories. (You can still save scripts to the common script directory under Pinnacle3 
where everyone can use them.)

Patient and plan files are not located in individual user home directories so all users can work on all 
patients and plans.

Start the software
After you are logged in to your workstation, you can start the software.

1 Click the Pinnacle3 icon in the front panel at the bottom of the screen.

The Launch Pad window appears. For more information, see Launch Pad window.

NOTE
The Pinnacle3 icon that appears in the front panel will be one of the two icons shown 
here. The icon varies depending on the version of the Solaris operating system that your 
system is running.

2 To select an institution, click the Institutions button in the Launch Pad window. The Select 
Institution window appears.

3 Highlight the name of the institution you want and then click Close. The Launch Pad window 
appears.

If you do not make a selection, the software uses the default institution shown at the bottom of 
the Select Institution window.

NOTE
To add institutions and learn how to add patients and plans, see the Launch Pad 
Instructions for Use.

4 Click the Planning button to add patients, acquire and import patient images, and add plans. 
The Patient Select window appears.

If you want to review an existing plan, select the patient and plan.

5 At the bottom of the Patient Select window click the appropriate button:

• AcQSim—Start AcQSim3.
• Fusion—Start Syntegra or Image Fusion. See the Image Fusion chapter.
• Planning—Start the planning software. Depending on your preference settings, you will go 

into Classic Pinnacle3 (multi-window interface) or the Planning window (single-window 
interface).

The default viewing windows display a transverse, sagittal and coronal view.
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Launch Pad window
The first screen you see when you start Pinnacle3 is the Launch Pad window. This window provides 
access to patient database operations for the current institution. 

The following options are available from the Launch Pad window.

• Institutions—Add, select, or delete institutions. See the Launch Pad Instructions for Use for 
details.

• Planning—Proceed to the patient planning software. See the Launch Pad Instructions for Use 
for details.

• Physics—Access the physics tool. The physics tool is described in the Pinnacle3 Physics 
Instructions for Use.

• Configure—Access system administration functions. See the Launch Pad Instructions for Use for 
information about system administration.

• Backup—Archive patient and physics data to tape or across the network. See the Launch Pad 
Instructions for Use for details.

• Restore—Restore archived patient and physics data. See the Launch Pad Instructions for Use for 
details.

• Exit—Exit the Launch Pad window. See the Exit the software section for details.

Locked data in Launch Pad

If data in Launch Pad is locked, no other users can modify the data until the lock is released or the 
user exits Launch Pad. Locking is employed in several areas:

• While any institution data is being modified, that institution and all patients in that institution 
are locked. If one institution is locked, you can still make changes to or work in another 
institution.

• While any patient information is being modified, including plan or image set information, the 
patient is locked.

• While physics information is being modified, the physics module is locked.
• While a plan is being modified in the software, the patient is locked. The plan and patient are 

not available to other users on the network until the person editing the plan exits the planning 
session.

• Once the software has been run on a plan, the primary CT image set and plan type are locked.

Exit the software
When you are finished with your treatment planning session, you should exit the planning 
software.

1 Select File - Exit.

The Save Confirmation window appears.
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14 Exit the software
2 Select the appropriate option:
• Exit without saving—Exit the software without saving the plan. 
• Save and exit—Save the plan before exiting.
• Delete auto-saved computed files—Delete any computed files that were created during the 

planning session. Plan elements that will be deleted include (but are not limited to) the 
following items: dose grid, control point dose, brachytherapy dose, DRRs, and compensators.

• Delete stored control point dose for dynamic arc beams—Remove dose from all control 
points in the plan. This option appears only if your plan contains a dynamic arc beam.

• Cancel—Close the Save Confirmation window and return to the software. 
3 When prompted: End planning session. Are you sure?, select Yes to quit planning. The Patient 

Select window appears.
4 Click the Close button in the Patient Select window.
5 Click the Exit button to exit Launch Pad. A confirmation window appears.
6 Click the Yes button to exit the software, or click the No button to return to Launch Pad.

If you chose to exit Launch Pad and you do not plan to use the system again soon, you should 
end your session and log out of the system.

Log out of the system

The procedure for logging out of the system varies depending on the version of the Solaris 
operating system that your system is running.

Solaris 10
1 Click the EXIT button on the front panel.

A Logout Confirmation window asks you to confirm or cancel the exit procedure.

2 Click the OK button to verify your selection.

When you click the OK button, the current screen workspace layouts are saved. The log-in 
prompt appears.

NOTE
You can also log out by right-clicking the desktop and selecting Log out from the menu.

Solaris 11
1 From the System menu on the Solaris desktop, click Log Out. A confirmation window appears.
2 Click the Log Out button to log out of the system. The log-in prompt appears after you have 

successfully logged off of the system.
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Shutdown procedures

�CAUTION
You must shut down system components in the proper order. All users must be logged out of all 
workstations before you shut down the system power for any component.

We recommend that you shut down your systems on a weekly, biweekly, or monthly basis. UNIX 
systems are robust, but there are file maintenance and “housekeeping” procedures that occur only 
during system shutdown and startup.

You should shut down your system for the following reasons:

• To deal with system issues that you cannot address otherwise.
• To guard against system damage in case of severe electrical storms, hurricanes, and other 

weather issues such as extremely high humidity and temperatures.
• To occasionally “flush” clogged system resources, including memory leaks, printer daemons, 

and the mail daemon.

If your site has just one or two workstations, you might want to shut down your system each Friday 
evening and then bring it back up on Monday morning. If a weekly shutdown is impractical, do it 
once a month. If your site has a large network with multiple workstations, you should shut down 
your system once a month.

For information on the shutdown procedures for your system, please consult the instructions for 
use for your system’s server. If you need assistance, please contact Customer Support or your local 
distributor.
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2 Setup

Overview
The procedures and information in this chapter assume that you have set up a patient, imported 
one or more image sets, and created a plan in Launch Pad. For information on how to perform 
those tasks, see the Launch Pad Instructions for Use.

�CAUTION
If you are starting a plan that you restored from Pinnacle3 4.0b or earlier (only SunOS versions), 
the software displays an error that the .ImageInfo file has been modified outside of the software. 
Since those software versions did not include information about patient position, this is expected 
behavior. You can ignore this error. The software assumes the patient is head-first, supine.

The initial setup of the patient is the same for stereotactic radiosurgery, photon, electron, or proton 
beam treatment planning. For stereotactic radiosurgery treatment plans, you can also set the 
frame coordinates.
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New plan setup for image-based planning
In accordance with International Atomic Energy Agency (IAEA) recommendations and International 
Electrotechnical Committee (IEC) 62083 standards, you must confirm all patient and plan setup 
information prior to delivering treatment.

When you open an image-based plan for the first time, the Confirm Plan Setup window appears. 
You cannot begin planning until you verify that the information in this window is correct for the 
primary image set. If you have secondary image sets in the plan, you must use the viewing windows 
in Pinnacle3 to confirm that the patient orientation is correct for each image set.

�CAUTION
If no CT scanner, CT to density table, or CT to stopping power table is available, notify the 
physicist who commissioned the software. The manufacturer name, model name, or kVp for the 
scanner may have been entered incorrectly during commissioning.
1 Verify that the patient setup information is correct. Use the viewing window in the Confirm 

Plan Setup window to view the image set.

Patient orientation is detected from the original image data file. If the patient orientation is 
unavailable, the software assumes that the CT scan was obtained with the patient positioned 
on their back, head first into the scanner with the table moving into the scanner.

If the patient setup information is not correct, click the Cancel and Exit button to return to 
Launch Pad. Use the Data Set Editor window to change the patient orientation information. For 
more information, see the Launch Pad Instructions for Use.

2 Verify that the scanner and CT to density table are correct, or select a CT to density table if one 
is not already selected.

The software uses the data file for the image set to determine which scanner was used to 
acquire the images. The CT to density table that the physicist selected for that scanner during 
commissioning appears in the CT-Density Table for Dose Calculation field. If the software is 
unable to determine which scanner was used to acquire the images, then you must select the 
appropriate CT to density table from the CT-Density Table for Dose Calculation option list.

The selected CT to density table is shown in the Confirm Plan Setup window. You cannot 
modify the table, but you can select a different table from the CT-Density Table for Dose 
Computation option list.

If the image set is a maximum intensity projection (MIP) or minimum intensity projection 
(MinIP) image set, then the software does not associate a scanner with the plan.

3 If you are licensed for proton treatment planning, verify that the CT to stopping power table is 
correct, or select a CT to stopping power table if one is not already selected.

The CT to stopping power table that the physicist selected for the scanner during 
commissioning appears in the CT-Stopping Power Table for Dose Calculation field. If the 
software is unable to determine which scanner was used to acquire the images, then you must 
select the appropriate CT to stopping power table from the CT-Stopping Power Table for Dose 
Calculation option list.
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The selected CT to stopping power table is shown in the Confirm Plan Setup window. You 
cannot modify the table, but you can select a different table from the CT-Stopping Power Table 
for Dose Calculation option list if necessary.

4 If the CT scanner information and the patient setup information are correct, click the Accept 
button. If not, click the Cancel and Exit button to delete the plan and return to Launch Pad.

5 Click the Setup button at the top of the window to display the Patient Setup panel. Continue to 
the sections that follow in this chapter for additional setup information.

Change the CT to density table

You can select a different CT to density table at any time during planning. By default, the software 
uses the CT to density table that you accepted in the Confirm Plan Setup window.

Click the View button to view the CT to density table. You cannot edit the table, but you may need 
to see it in order to choose the correct one for your plan.

If you select a different CT to density table, you are prompted to accept the new table when you 
compute dose for a beam. If dose has already been computed and you select a different CT to 
density table, dose is invalidated.

Change the CT to stopping power table

NOTE
The information in this section is only applicable if you are licensed for proton treatment 
planning.

You can select a different CT to stopping power table at any time during planning. By default, the 
software uses the CT to stopping power table that you accepted in the Confirm Plan Setup window.

Click the View button to view the CT to stopping power table. You cannot edit the table, but you 
may need to see it in order to choose the correct table for your plan.

If you select a different CT to stopping power table after you have computed dose for a beam, dose 
is invalidated.

Set window/level 

Use the window/level feature to identify values that provide good contrast for viewing images. For 
more information about setting the window and level, see the View Patient Data chapter.

Set the body board

NOTE
If you are licensed for proton treatment planning, you will not be able to compute dose 
for a proton beam if you use a body board.
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You can specify most of the patient position options in the Data Set Editor window, as described in 
the Launch Pad Instructions for Use. However, there is one more patient positioning parameter you 
can set: the use of a body board.

1 Are you using a body board?
• If yes, in the Use body board field, select Yes. A field appears for you to set the angle of the 

board.
• If no, in the Use body board field, select No. This procedure is complete.

2 In the Angle field, set the angle (-10 to 90 degrees) of the body board as you will use it during 
treatment.

NOTE
If you alter the body board settings, computed dose for beams set to laser localization 
will be invalidated and the beam display will be updated.

Remove the couch

�CAUTION
If you are licensed for proton treatment planning, we recommend that you do not remove the 
couch from the patient data. The presence of the couch in the beam changes the effective range 
of the beam, and the resulting delivery may be different than what you intend. Use one of the 
following options to plan with the couch in the patient data.
• Make sure that the couch that will be used during treatment is the couch that is used when 

the patient data is collected.
• Set up the beam geometries to avoid the couch.
• Model the couch using regions of interest and density overrides to account for the couch 

attenuation. For information about this method, contact Customer Support and request 
Application Note 2009-01, or download the document from InCenter.

�WARNING
During photon planning, the couch interferes with SSD measurements and dose computation 
unless it is removed from the patient data. If the couch was not removed as part of the new plan 
setup, you should remove it before adding beams and computing dose.

�WARNING
When removing the couch, observe the couch removal plane in the transverse and sagittal 
windows. Verify that the couch does not bisect any part of the patient. If the couch removal 
plane erroneously bisects the patient, dose calculations may be incorrect, bolus may appear 
incorrectly, and lungs and other cavities may be replaced with air, among other problems.

Because the patient CT scans include the couch on which the patient is scanned, the couch appears 
to the software to be an extension of the patient data. You can remove the couch from the patient 
data so it does not affect SSD and dose computation. The location of the couch removal plane is 
indicated by a line in 2D images and by a plane in 3D images.

The couch removal plane removes the CT couch from the scan, which is sufficient for most plans. 
You should always check the location of the couch removal plane to verify that it is in the correct 
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location for computation. If a plan requires that you treat through the couch at oblique angles and 
you want to create a more accurate representation of the couch on the linear accelerator, contact 
Customer Support and request Application Note 2009-01 or download the document from 
InCenter.

1 Click the Couch Removal tab.
2 Select Yes at Remove couch from scan.
3 To remove the couch, do one of the following options:

• Enter the Y coordinate for the top of the couch (the distance from the “bottom” of the data 
set to the couch top).

• Click the Move couch removal plane tool and in the 2D viewing windows remove the couch 
by dragging the couch removal line until it is placed at the point where the patient ends and 
the couch top begins.

4 You can lock and unlock the position of the couch removal plane. Click the buttons shown at left 
to lock or unlock the couch.

5 If you want to change the color of the couch removal line, use the Display color option list to 
select a different color.

Set the outside air threshold

�WARNING
Specifying an incorrect outside-patient air threshold can result in incorrect SSD calculation and 
inaccurate dose calculation. Verify that the outside-patient air threshold is set correctly before 
computing dose. Values should be 0.6 to 0.85 g/cm3.

Pinnacle3 does not require you to define external patient contours for image-based plans. Instead, 
it uses the density information in the image scans to differentiate between the patient and the air 
surrounding the patient.

Use the outside-patient air threshold to specify the density threshold to differentiate between the 
patient and the air. Voxels outside the patient below this threshold are considered to be air; dose is 
zero in these voxels. If this threshold is not specified correctly, dose may appear in low-density 
objects, such as blankets or positioning devices, that are present in the CT scan.

Couch removal 
plane indicator
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1 In the Outside-patient air threshold field, enter the density that should be considered air (not 
part of the patient data set). 

2 Click the button next to the threshold to select the unit of measure.

NOTE
You can set a default value for the Outside-patient air threshold field. For more 
information, see Preferences in the Utilities chapter. 

�CAUTION
Remove the couch prior to generating an external ROI. If you do not remove the couch, it may be 
included as part of the patient.
3 If you want to generate a region of interest (ROI) for the patient-air threshold (a skin contour), 

click the Display as ROI button. The software generates patient-air contours on each slice. The 
ROI appears in the list on the Regions of Interest panel with a default name of External ROI #, 
where # is a number.

If you change the outside-patient air threshold, click the button again to generate a new ROI 
using the new value.

NOTE
A new ROI is generated each time you click the Display as ROI button. To remove 
external ROIs that you do not want, go the Regions of Interest panel and delete them.
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Use lasers to align the patient
Laser alignment localization lets you use the CT data to simulate laser alignment of the patient. 
Laser alignment allows you to position the laser center in the patient data set as it will be 
positioned during treatment. You can then determine the offset between the planning isocenter 
and the laser center and reposition the patient accordingly.

NOTE
If you export plan information, relative couch shifts between the patient setup and the 
treatment positions are exported if the lasers have been set for a plan and the plan 
contains only one isocenter. If the plan contains multiple isocenters, then the shifts are 
not exported (see the Export chapter).

You set the laser alignment system in the CT Scanner Configuration window in the physics tool. The 
system may have either one or three moveable lasers. The one moveable laser is in the X (sagittal) 
direction. The three moveable lasers consist of one in the X direction and two in the Y (coronal) 
direction (one on each side of the table). For more information, see the Pinnacle3 Physics 
Instructions for Use.

Set the laser center

�CAUTION
If lasers are not positioned correctly, inaccurate patient setup information may be reported. Be 
careful when positioning the lasers.
1 Click the Setup button to display the Patient Setup panel, then click the Localization tab.
2 There are several ways you can specify the position of the laser center. 

• Interactively position the laser center in viewing windows. Use the 2D or 3D laser positioning 
tools to drag the laser center to the desired position in either 2D or 3D windows.

• Enter the coordinates of the laser center in the CT Lateral, Ant-Post, and Sup-Inf fields.
• If you have defined a point of interest that corresponds with the laser center position, you 

can select the POI and click the Copy from POI button.
3 Do you want the lasers always shown in the viewing windows?
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• If yes, in the Display after localization complete field select Yes. From the Display color 
option list, select the laser color.

• If no, in the Display after localization complete field select No.

View coordinate details

After you localize the patient, you can use the Beam Isocenter window to view details about the 
laser localization coordinates. The lower portion of the window displays how the table and patient 
will be set up with respect to the point of interest. For more information about the Beam Isocenter 
window, see Obtain coordinates for the isocenters in the Beams chapter.

1 Display the Beams panel.
2 Select the POI that is at the laser center.
3 Click the Details button. The Beam Isocenter window appears.
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Stereotactic frame localization

NOTE
All length dimensions in Pinnacle3, including stereotactic coordinates, are shown in 
centimeters in all software displays and printouts. This is required to comply with 
International Atomic Energy Agency (IAEA) 1540 standards.

Stereotactic frame localization allows you to specify the frame position and transform CT 
coordinates to stereotactic frame coordinates. Once you have performed the localization, the 
isocenter coordinates can be displayed using the stereotactic frame coordinate system.

NOTE
This section uses a BRW frame as an example for the frame localization process. The 
system also supports Compass, Fischer, and Leksell frame localization.

NOTE
Pinnacle3 properly accounts for tilt in its stereotactic frame transformations.

The rods from the stereotactic frame appear as cross sections on each transverse CT image. The 
locations of these cross sections determine the transformation from the CT to the frame coordinate 
system.

�CAUTION
Each isocenter specified in CT coordinates is converted to the frame coordinates using the 
transformation for the closest CT slice. 
The transformation is also used to properly orient beams, which are specified with respect to the 
frame and must be reoriented with respect to the CT coordinate system to account for any 
rotation between the coordinate systems.

Automatic stereotactic frame localization

In most instances, the software can automatically locate the frame rods and then compute a 
separate transformation for each slice.
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�CAUTION
The automatic frame localization can fail when the CT scan includes a head ring or when a rod is 
touching the patient or another high-density object. If the automatic rod localization fails, you 
have to manually position the rods in the patient data.
1 On the Localization tab of the Patient Setup panel, click the Stereo Localization button.

The Stereotactic Frame Localization window appears.

2 Select the stereotactic frame type.

NOTE
You can use the Preferences utility to set up a default frame for stereotactic frame 
localization. For more information on setting up a default frame, see Preferences in the 
Utilities chapter.

3 Click the Find Rods and Compute Transformations button. When the rods are found, the rod 
positions appear on each slice. When the transformation is complete, the software displays the 
number of slices having valid transformations.

NOTE
For information on the status of the transformation on each slice, click the Examine 
Detail button. See Individual slice localization for an explanation of this function.

�CAUTION
For accurate dose computation the frame rods must be digitally removed from the patient data 
set. Verify that the software has found each rod on each slice.
4 Click the Remove Frame button. The status displays under the button.
5 Click the Close button to close the Frame Localization window.

Individual slice localization

In the Individual Slice Data window you can view the transformation information for individual 
slices. You can also localize the frame rods and compute the transformations on individual slices 
using the options in this window.

�CAUTION
The automatic frame localization can fail when the CT scan includes a head ring or when a rod is 
touching the patient or another high-density object. If the automatic rod localization fails, you 
have to manually position the rods in the patient data.

For Fischer frame localization, you may need to adjust the Rod Search Threshold so that the metal 
frame rods can be distinguished from the high-density plastic of the frame. You can use the Show 
image value 2D tool or the Profile tool to determine the correct CT number for this threshold.

1 Click the Examine Detail button in the Stereotactic Frame Localization window. The 
Stereotactic Localization Individual Slice Data window appears.
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�CAUTION
When using individual slices for frame localization and transformation, you should use the slice 
closest to the isocenter and a minimum of one slice above and one slice below the slice closest to 
the isocenter.
2 In the Slice List, select the desired slice.
3 Click the Find Rods For Slice button.
4 Click the Compute Transformation button to compute the transformation on the selected slice.

Manually position rods

You must attempt to compute transformations prior to starting this procedure. If you do not, you 
cannot enter some of the windows.

1 Click the Examine Detail button in the Stereotactic Frame Localization window. The 
Stereotactic Localization Individual Slice Data window appears. 

2 Click the Edit/View Rod Positions button. The Stereo Slice Rod Positions window appears.
3 In a transverse viewing window, display the slice on which you want to manually position the 

frame rods.
4 Select the Manually position rod tool from the Stereo Slice Rod Positions window.
5 In the viewing window, click and drag the rod indicator to position it on the correct rod. 

NOTE
If you want to see the numbers of the rods in the viewing window, set the Frame 2D 
Display option to Label in the Stereotactic Frame Localization window.

�CAUTION
For accurate dose computation, the frame rods must be digitally removed from the patient data 
set. Verify that the software has found the rod correctly.
6 If the rod is not in contact with another high-density object, click the Find rod center from 

current position button. The software automatically locates the rod center from the manually 
defined position.

7 Repeat steps 5 and 6 for each rod you need to position on that slice.
8 When the rods have been positioned, return to the Stereotactic Localization Individual Slice 

Data window and click the Compute Transformation button to compute the coordinate system 
transformation for that slice. 

�CAUTION
Do not click the Find Rods for Slice button; it will reposition all the rods on the slice.
9 Repeat steps 2-8 for all other slices that need manual rod positioning.
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Angiographic frame localization

Angiographic frame localization allows you to reconstruct the intracranial target position and 
magnification from orthogonal angiographic films. The coordinates can be entered manually into 
the software.

Two films are required for entering the localization frame coordinates: Anterior-Posterior and 
Lateral.

�CAUTION
Before using the angiographic frame localization options, you must obtain valid CT frame 
transformations.

Find the rods
1 On the Localization tab of the Patient Setup panel, click the Stereo Localization button.

The Stereotactic Frame Localization window appears.

2 Select the type of headframe used.
3 Click the Angiographic Localization button. The Angiographic Frame Localization window 

appears.
4 Select the correct film orientation.

�CAUTION
The coordinates determine the position of the patient in the frame. Verify your coordinates after 
you enter them into Pinnacle3. Entering invalid coordinates may affect beam placement and, 
therefore, dose calculation.
5 Enter the coordinates.

Complete the frame reconstruction

Once the angiographic frame coordinates have been entered, frame reconstructions can be 
computed, magnification factors reviewed, and you can copy target coordinates to beam 
isocenters.

1 In the Stereotactic Frame Localization window, click the Angiographic Localization button. The 
Angiographic Frame Localization window appears.

2 Click the Reconstruct button. The Lateral, AP, and Vertical reconstructions compute and appear 
in the window. The error factor is also computed and listed on the window.

�CAUTION
The automatic frame localization can fail when the CT scan includes a head ring or when a rod is 
touching the patient or another high density object. If the automatic rod localization fails, you 
have to manually position the rods in the patient data.
3 Click the Magnification button. The Angio Film Magnification window appears. Magnifications 

and Source to Film Distance are provided for both orientations of the film.
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�CAUTION
Before copying the target angiographic frame coordinates to the beam isocenter, you must 
obtain valid CT frame transformations. 
4 Click the Beam Isocenter button. The Beam Isocenter window appears. The isocenter 

coordinates are translated into physical coordinates in relationship to the headframe.
5 Click the Copy Angio button to copy the target coordinates to the beam isocenter.
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3 View Patient Data

Overview
The software allows you to display two-dimensional (2D) and three-dimensional (3D) images of 
both patient data and treatment planning data.

In this chapter you will learn to use the visualization tools to display 2D and 3D images of patient 
anatomy and the regions of interest, points of interest, and beams.

The software contains a number of useful visualization tools. You can use these tools in any order:

• 2D and 3D viewing windows
• Tools window, which appears when you right-click a viewing window
• Side Tools window, which can appear along the right side of the screen (if you are licensed for 

AcQSim3)
• Cutplane tools, which allow you to define a plane that cuts through the 3D data set to reveal a 

feature of the patient anatomy
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Viewing windows
All 2D and 3D images are displayed in viewing windows. The viewing windows remain displayed 
regardless of which panel you select from the buttons at the top of the window.

When the planning tool starts, a set of viewing windows appears by default: transverse, sagittal, 
and coronal image orientations.

View menu

Use the View menu to change the configuration of the viewing windows.

Item Description

Display one large 2D transverse viewing window. You can choose a different orientation from the 
option list at the bottom of the window.

Display a large, 2D transverse viewing window; a small, 2D sagittal window; and a small, 2D coronal 
window. This is the default layout. 

Display nine 2D viewing windows. The top windows are transverse, the middle are sagittal, and the 
bottom are coronal. The windows in each row are synchronized, meaning that the images zoom, scroll, 
and pan together. By default, windows in each row display consecutive slices, but you can specify a 
custom slice separation for each row in the Slice increment fields at the bottom of the window if 
desired.

Display nine 2D transverse viewing windows. The windows are synchronized, meaning that the images 
zoom, scroll, and pan together. You can choose a different orientation from the option list at the 
bottom of the window.

Display one 2D transverse, one 3D, and two DRR viewing windows.

Display one 2D transverse, 2D sagittal, 2D coronal, one 3D, one beam’s eye view, and one large DRR 
viewing window.

Display one large beam’s eye view window.

Display one 2D transverse, 2D sagittal, 2D coronal, and one 3D viewing window.

Display one large beam’s eye view window with a small room’s eye view window in the corner.

Display two large 2D windows in the same orientation for comparing the primary and secondary 
studies side by side. The layout also has controls to let you view the primary image, the secondary 
image, or both at once (fusion). These two windows are always synchronized, so there is only one slice 
selection slider.

Display two rows of 2D windows: a 2D transverse, 2D sagittal, and 2D coronal window. The top row 
displays the primary image set and the bottom row displays the current secondary image set. You can 
change the image set shown in each row.

Display 12 beam’s eye view windows.
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Viewing options

Use the Primary, Secondary, and Fusion radio buttons to choose what image sets display in the 
windows. If you choose Secondary or Fusion, the current secondary image set is used for display. 
The Fusion option displays both the primary and secondary image set. 

If you change to an oblique view in a viewing window, use the Reset T/S/C button to change back to 
an orthogonal view.

Maximize the viewing area

To expand the viewing area on screen, you can hide the panel on the left side of the screen so that 
the viewing windows expand into that space.

To expand the viewing area, click the Hide button. The panel is hidden, and the viewing windows 
expand to the left.

To restore the panel, click the Show button. The viewing windows return to their original size and 
the panel reappears.

Maximize a viewing window

You can expand a viewing window so that it fills the entire viewing layout.

1 Click the viewing window that you want to expand.
2 Press the m key. The viewing window expands to fill the viewing area.
3 To return the viewing window to its original size, click the m key again.

Switch between 2D and 3D modes

You can switch the display mode between 2D and 3D in most windows. To switch a viewing window 
between 2D and 3D, right-click in the viewing window to open the Tools window, and then select 
2D > Enter 3D Mode or 3D > Enter 2D Mode. Some windows do not allow you to switch the display 
mode between 2D and 3D. In these windows, an error message appears if you try to do so.
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2D viewing windows

NOTE
A change in the aspect ratio of your screen will distort the 2D images. However, this 
does not affect printed images.

Change the slices that appear

You can choose the slices displayed in 2D windows by either specifying particular slices or using 2D 
tools and menu options to browse through the images.

Display a specific image in a viewing window
1 Right-click in a 2D viewing window. The Tools window appears. 
2 Select 2D - Choose Slice. The Image Selection window appears.
3 In the Image to Display field, enter the slice number and then click Close. That slice appears in 

the viewing window.

1

2

3

4

1 The trial name or record name displays in white text.

2 The slice number, slice position, image set name, and image-related information display in yellow text.
For transverse images, slices are numbered from 1 starting at the end of the image set. The Z position 
corresponds with the scanner Z position for each slice. For sagittal and coronal images, the index 
number in the image set is used as the slice number.

3 Ruler, which measures five centimeters and is scaled when the image is zoomed in and out

4 The orientation cube uses letters and arrows to indicate patient orientation.
The letter in the box indicates the side of the image that is displayed:
• A = Anterior
• P = Posterior
• S = Superior
• I = Inferior
• L = Left
• R = Right
Color-coded arrows on the box indicate patient orientation: 
• Green arrow is anterior-facing
• Yellow arrow is left-facing
• Orange arrow is superior-facing
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Scroll through images
• If you do not know the number for the slice you want to display, use the Scroll through slices 

tool to find it. See the Tools chapter for more information about this tool.
• To move through an image set one slice at a time, use the Next Slice and Previous Slice options 

in the 2D menu of any viewing window or the Next Slice and Previous Slice options in the 2D 
menu of the Tools window. Keyboard shortcuts are also available. When the cursor is in a 
viewing window, press n or the up arrow key to display the next slice in the series of slices. Press 
p or the down arrow key to display the previous slice in the series of slices. You can toggle the 
direction that the arrow keys scroll through the image set in the Preferences window.

Display the slice position in other windows

You can display the position of any currently displayed slice as a line in other 2D windows. For 
example, if you have three 2D windows and the image orientation is different for each, you can 
indicate the position of the currently displayed transverse slice by a line in the sagittal and coronal 
images.

To turn the display line on or off for a single viewing window, in the Tools window select 2D - 2D 
Slice Position On/Off.

To turn the display line on or off for all viewing windows, in the Tools window select 2D - Global 2D 
Slice Position On/Off.

Use the Correlated pointer tool shown at the left to select the orthogonal slices that are displayed 
in a viewing window set. See the Tools chapter for more information about this tool.

2D menu options

To display the Tools window, right-click in a viewing window. See the Tools chapter for information 
about the 2D tools.

Menu option Description

Enter 3D Mode Change the 2D viewing window to a 3D display.

Next Data Set View the next image set in the viewing window. You can also type a v in a viewing window 
to see the next image set. To scroll through image sets while skipping the dose image set, 
use the left and right arrow keys.

Orientation View a transverse, sagittal, or coronal image in the 2D viewing window. You can also type 
an a to view a transverse (axial) view, an s for a sagittal view, or a c for a coronal view.

Interpolation Select Nearest Neighbor Interpolation or Bi-linear Interpolation. Bi-linear interpolation 
takes longer to display, but provides better display quality.

Zoom Use the following selections to magnify an image. 
• Zoom—This label shows the current zoom factor.
• Fill Window—Set the zoom factor so the entire image fits in the window.
• Double Zoom—Double the current zoom factor.
• Half Zoom—Cut the current zoom factor in half.
• Life Size—Produce a life size image, meaning that the patient anatomy could be 

measured by measuring the image on the screen.
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Specify the interpolation method

As you zoom in on an image, individual pixels become visible. The interpolation method determines 
the smoothness of the transition between adjoining pixels. The software offers two types of 
interpolation:

• Nearest Neighbor Interpolation—the greyscale value displayed is that of the closest pixel in the 
original image. Images may appear somewhat blocky.

2D Slice Position Turn the display of slice positioning on or off in the selected 2D window. A check mark 
appears next to this option when it is turned on. To display slice positions, you can also 
use the Correlated pointer tool.

Global 2D Slice Position Turn the display of slice positioning on or off in all viewing windows. A check mark 
appears next to this option when it is turned on. To display slice positions, you can also 
use the Correlated pointer tool.

Set Slice To Current POI This displays the slice that contains the currently selected POI. Select a POI in the Points 
of Interest panel.

Reference Ind. 2D This changes the behavior of the Correlated pointer tool. A check mark appears next to 
this option when it is turned on. See the Tools chapter for an explanation of the tool.

3D Slice Position Turn the display of slice positioning on or off in 3D windows. A check mark appears next 
to this option when it is turned on. To display slice positions, you can also use the 
Correlated pointer tool.

Clear Annotation Remove all annotations from the image.

2D Measurement Grid Turn the display of the measurement grid on or off in the selected 2D window. A check 
mark appears next to this option when it is turned on. Set the grid size in the Preferences 
window. See Preferences in the Utilities chapter.

Global 2D Measurement 
Grid

Turn the display of the measurement grid on or off in all 2D windows. A check mark 
appears next to this option when it is turned on. Set the grid size in the Preferences 
window. See Preferences in the Utilities chapter.

Choose Slice Display a specific slice in a 2D viewing window. In the window that appears, enter the 
number of the slice you want to display.

Next Slice View the next slice in the image set.

Previous Slice View the previous slice in the image set.

Next Trial (or Next Record) If using multiple trials or records, view the next trial or record. You can also type a t in a 
viewing window to see the next trial or record.

Menu option Description
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• Bi-linear Interpolation—the displayed value is interpolated linearly from the four original 
image pixels surrounding the display position. Images appear smoother, but take longer to 
display.

Specify the interpolation method
1 Right-click in a 2D viewing window. The Tools window appears. 
2 Select 2D - Interpolation. Then select the interpolation method.

Set the default interpolation method
1 Open the Preferences window. See Preferences in the Utilities chapter.
2 Next to Default interpolation for 2D display, select Bi-linear or Nearest neighbor interpolation 

as the default method.

Set the window and level

You can set the window and level parameters to adjust the amount of contrast in each image set. A 
color scale, typically ranging from black through gray to white, is used to display the images. (You 
can change the display from greyscale to color in the Data Set Specifications window.) The 

Nearest Neighbor Interpolation Bi-linear Interpolation
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“window” specifies the range of values to be mapped into the color ramp. The “level” specifies the 
image value at which the range begins. 

Image values below the level are set to the dimmest color (black). Image values above the level plus 
the window are set to the brightest color (white). Image values between these endpoints are set 
based on a linear ramp. 

Exponential and logarithmic ramps assign more colors to the higher and lower values, respectively. 
Since hot spots in some types of images are so hot, linear ramps sometimes show only the hotspot. 
For exponential and logarithmic ramps, the straight line in the diagram above is replaced with an 
exponential or logarithmic curve.

The histogram equalization ramp is an optimal assignment of the color shades to the data. It 
accentuates all details, including some details you may not want accentuated, like noise.

If you have the Default middle mouse window/level preference set to Yes, you can use the middle 
mouse button in the viewing window to set the window and level.

1 Open the Window/Level window in any of the following ways:
• Right-click in a 2D viewing window and click the Window/Level button.
• Click the Setup button at the top of the window and then click the Window/Level button in 

the Patient Setup panel.
2 Do you want the window and level settings to be the same for all images with the same 

modality?
• Yes—Set Link window/level by modality to Yes. The next time you modify the window and 

level settings for one image set, those settings are applied to all other image sets with the 
same modality. Continue to step 3.

• No—Set Link window/level by modality to No. Continue to step 3.
3 In the Data set list, select the image set for which you want to set the window and level.
4 Drag the sliders to change the values of the Window, Level, or Level + Window. You can also 

reset the window and level by typing the desired image values in the fields beside the sliders.

To use one of the standard window and level values, click your choice in the Presets list.

Bright

Dim

Screen brightness

Window

Level

Low High
Patient data value
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NOTE
When you manually change the window or level values, the selection in the Presets list 
changes to “--” because you are no longer using window and level values that are 
defined by a preset.

5 In the Color ramp function list, select the type of color ramp to be used with the image set or 
viewing window. This distributes color map entries through the full range of values in the image 
set.

If you select Histogram Equalization, you can better view two or more areas in which image set 
values are concentrated, but the areas are far apart. The equalized table uses more colors in 
areas with higher concentrations of values, but very few where the histogram falls to zero, thus 
allowing more contrast in both areas.

6 In the Distribution of data set values section of the window, use the histogram to view the 
distribution of image set values to see where the greatest concentrations of CT values lie.
• To interactively change the window and level in the histogram to emphasize concentrations 

of CT values, drag the red and green markers, respectively. 
• To change the display range of the histogram, enter new values in the Min and Max fields. 

For example, you can decrease the range to magnify an area of the histogram.
7 When you finish setting the window and level, click Close.

Edit the presets

In the Window/Level window, click the Edit Presets button.

You have the following options:

• To develop a new preset, click the Add Preset button, type a name for the new preset in the 
Name field, and enter settings for it in the Window and Level fields.

• To edit an existing preset, select the preset in the list and then enter new settings in the 
Window and Level fields.

• To delete presets that you created yourself, select the preset in the list and then click the Delete 
preset button. You cannot delete a preset that came with the software.

• To save your edited presets for use in future sessions, click the Save presets button. If you do 
not, your edited presets will be lost as soon as you end your current session.

• To cancel your edited presets and return to the original settings, click the Load factory presets 
button. Presets that you created yourself are unaffected.

When you finish editing the presets, click Close. 

Window and level tools

In addition to the Window/Level commands described in the previous section, you can use tools on 
the Tools panel to interactively change the window and level. See the Tools chapter for information 
about the window and level tools.
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NOTE
When you finish setting the window and level, you should select a different 2D tool to 
avoid accidentally changing the window and level settings.
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3D viewing windows

1 To switch to 3D viewing mode, right-click in a viewing window. The Tools window appears. 
Select 2D - Enter 3D Mode.

2 To render a 3D image, right-click in the viewing window and select 3D - Render.

You can also position the cursor in the viewing window and press r to render the image. Clicking 
the cursor in the 3D window during rendering cancels the rendering operation.

3 To change the rendering method, right-click in the viewing window and select 3D - Image Type. 

Selections include skin, bone, and digitally reconstructed radiographs (DRRs) of varying image 
qualities. High-quality methods take longer to render.

4 Use the 3D tools and menu options to control the appearance of the 3D image. The tools are 
described in the Tools chapter.

For example, you can change the viewpoint of an image using selections from the 
3D - Viewpoint menu option. To specify when new 3D images are rendered, use the 
3D - Render New Image options.

1

2

3

1 The trial name or record name displays in white text.

2 Data set limits display as a blue cube.

3 The orientation cube uses letters and arrows to indicate patient orientation.
The letter in the box indicates the side of the image that is displayed:
• A = Anterior
• P = Posterior
• S = Superior
• I = Inferior
• L = Left
• R = Right
Color-coded arrows on the box indicate patient orientation: 
• Green arrow is anterior-facing
• Yellow arrow is left-facing
• Orange arrow is superior-facing
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3D image display options

The software provides powerful 3D imaging features for viewing patient data. You can specify some 
3D parameters in the Data Set Specifications window. To open this window, select Utilities - Data 
Sets.

The top portion of the window displays the data sets that are available for your plan. To select a 
data set, click the radio button next to the data set that you want to select.

NOTE
The window displays Variable in the Sup-Inf Voxel Size field for variably-spaced data 
sets.

The bottom left portion of the window displays the details for the selected data set. You cannot 
modify these values. The bottom right portion of the window displays the fields for the selected 
data set. These fields are described in the following tables.

The following fields allow you to choose how the data set is rendered.

The following fields allow you to set the rendering threshold and step size.

Select a 3D image type for all images

The View 3D menu in the Data Set Specifications window lets you access 3D rendering parameters. 
From this menu, you can select the type of image that is rendered and control its appearance. 

1 Select Utilities - Data Sets.

The Data Set Specifications window appears.

2 Select View 3D - Standard Images. 

Option Description

2D Color The color to be used in 2D viewing windows to display the image set.

3D Color The color to be used in 3D viewing windows to display the image set.

Render Specify whether the current volume should be rendered in 3D images. You should set the 
Render option to No when you do not want to render the patient data set in 3D windows. 

Data set limits Specify which line segments making up the outer volume limits should be displayed.

Option Description

Lower Limit
Upper Limit

Set limits of the range of CT numbers that are used when rendering images. By changing 
these limits, you can determine which structures are displayed when images are 
rendered. Structures within the threshold limits are visible. 

Step Size Refers to the steps taken along each ray during volume rendering. A lower value produces 
a more accurate image but takes longer to generate. The values for these parameters can 
be set by typing a value into the box or by clicking the left mouse button on the slider and 
dragging it to a new value.
The default step size is 0.1 cm. If you change this value to be rather large (for example, 
1.0), you may “lose” parts of the image since the software will render a very coarse image 
in a 3D window.
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3 Choose the image type from the menu that appears. This image type is used to render all 3D 
images until a different image type is selected.

Standard image types include skin, bone, and digitally reconstructed radiographs (DRRs) of 
varying image quality. Lower-quality images take less time to generate because a simpler 
interpolation method is used for the image generation. However, as the name suggests, the 
image quality is not as good.

4 Right-click on the viewing window in which you want to view the image and select 2D - Enter 
3D Mode.

5 Right-click on the viewing window and select 3D - Render, or position the cursor in the 3D 
viewing window and press r to render the image.

Clicking the cursor within the 3D window while the image is being rendered cancels the 
rendering operation.

NOTE
Increasing the size of the window to be rendered increases the amount of time it takes 
to complete the rendering.

Select a 3D image type for a viewing window

The procedure above sets the rendering for all 3D images. To render images using different 
rendering methods in each viewing window (for example, a Skin rendering in one viewing window 
and a Bone rendering in the next), use the following steps.

1 Right-click in a 3D viewing window. A Tools window appears.
2 Select 3D - Image Type, and then select the rendering method for that window. 

Repeat these steps for the other viewing windows.

3D menu options

You can select when a 3D volume renders, the image type, and how regions of interest appear 
inside the volume using the 3D tools and the options in the 3D menu of the Tools window. See the 
Tools chapter for information about the 3D tools.

For details on creating BEV displays and room’s eye view (REV) displays in viewing windows, see 
Beam’s eye views and Room’s eye view.

Menu option Description

Enter 2D Mode Change the 3D viewing window to a 2D display.

Render Render the image in 3D.
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Render New Image The following options determine when an image is rendered:
• When requested—The 3D image is rendered only when you select the Render 

command.
• After motion complete—The 3D image is rendered after you complete any change 

in the orientation of the data set.
• After any view change—The 3D image is rendered continuously, even as you make 

changes to the orientation of the volume. If you want to view a rendered image 
even while you are rotating the volume and don’t care how fast or slow the 
software performs, you may want to choose this option.

• After any view change (Low-Res)—This option only affects data sets rendered in a 
surface image type, such as Bone-Default, Skin-Default, Bone-High or Skin-High. 
The data set is rendered as a low-resolution voxel projection while it is moved. 
When motion is complete, the data set is rendered using its normal image type. If 
the data set is already using a low-resolution or voxel project image type, or is 
being rendered as a DRR, this option works like the After any view change option.

The Render 3D images automatically preference overrides the initial setting upon 
plan start-up. If you select a different Render New Image option, it becomes the 
current rendering method.

Image Type Select a type of rendering. Selections include skin, bone, and digitally reconstructed 
radiographs of varying image qualities. High-quality methods take longer to render. 

Viewpoint Change the viewpoint for a 3D image. If you reposition the data set so that it is no 
longer visible in the viewing window, you can choose Move focus to volume center to 
reposition the center of the volume in the middle of the viewing window.

Clear Annotation Remove all annotations from the image. 

Transparent Dataset On

When the patient volume is rendered using skin or bone rendering, regions of interest 
(ROIs) are often obscured from view because of the patient data. When you want to 
see the ROIs and patient data together in a 3D image, you can make the patient 
surface transparent. A check mark appears next to this option when it is turned on.

Next Trial (or Next Record) If using multiple trials or records, view the next trial or record. You can also type a t in 
a viewing window to see the next trial or record.

Menu option Description
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Access 2D and 3D tools
You have different ways to display the 2D and 3D tools: 

• You can right-click in a viewing window to display the Tools window.
• The Side Tools window can appear along the right side of the screen (if you are licensed for 

AcQSim3). This window provides quick access to tools appropriate to the currently selected 
viewing window (2D, 3D, BEV, BRV, or REV).

This section describes the various tool windows. For information about specific tools, see the Tools 
chapter.

ToolsTools window

By clicking your right mouse button in a 2D or 3D viewing window, you open a window that features 
tools specific to a 2D or 3D window.

The Tools window closes after you select a tool. If you want the Tools window to remain open after 
you make a selection, click the Pin window button shown at left.

More tools may appear in the window depending on the planning task you are performing (for 
example, ROIs).

For details about each tool, see the Tools chapter.

Side Tools window

You can choose to display a Side Tools window along the right side of the main window (if you are 
licensed for AcQSim3). This window provides quick access to tools appropriate to the currently 
selected viewing window (2D, 3D, BEV, BRV, or REV).

To display the Side Tools window, click the Side Tools button in the Tools window. To display the 
Side Tools window as a default, set the Display Side Tools window preference in the Preferences 
window to Yes. See Preferences in the Utilities chapter for more information.

For details about each tool, see the Tools chapter.

Program the middle mouse button

To program the middle mouse button to a particular tool, click the tool with the middle mouse 
button. Subsequently, each click of the middle mouse button in a viewing window activates the 
selected tool. To cancel the middle-mouse button programming, either select a different tool with 
the middle mouse button or use the 2D cursor select tool or 3D cursor select tool. For details about 
each tool, see the Tools chapter.
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Cine viewing options
If you imported a 4D image set, you can use the Cine tool to create a movie of all the phases that 
are associated with the patient. You can create a movie in 2D or 3D viewing windows. 

To use the Cine tool in a 2D viewing window, set the viewing mode to Transverse, Sagittal, or 
Coronal. To use the Cine tool in a 3D viewing window, render the image as a DRR.

1 Right-click in a viewing window. The Tools window appears.
2 In the Cine portion of the window, click the Play button. The viewing window cycles through all 

the phases associated with the patient. If you are creating a movie in a 3D viewing window, it 
may take a few minutes for all the phases to render.

After the movie has started, you can use the scroll bar next to the Stop button to adjust the 
speed of the movie.

3 Click the Stop button to stop the movie. If you change the viewing window, the movie 
automatically stops.
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Beam’s eye views
Beam’s eye view (BEV) displays allow you to view the patient anatomy that lies in the path of a 
beam. You can view volumetric images of the patient anatomy such as skin and bone rendered 
images and digitally reconstructed radiographs (DRRs). 

You can display BEVs for each beam or you can develop multiple BEVs for the same beam.

1 Create or go to a 3D viewing window and then right-click it. The Tools window appears.
2 Select BEV and then select the beam you want to view. If you select Current, for example, the 

view is locked to the current beam. The BEV appears in the viewing window.
3 Click the BEV Options button. The Beam’s Eye View Options window appears.
4 In the Window option list, make sure the window you are setting up as a beam’s eye view is 

selected.

To change the background color of the window, click the Background color button and select a 
color in the window that appears.

5 In the Type option list, select the type of image you want to view. The resulting options vary 
depending on your selection.
• If you select DRR, continue with the remaining steps of this procedure. Appropriate settings 

are selected by default, but you can change them if necessary. The DRR settings apply to the 
selected beam, not to the selected viewing window.

• If you select 2D Orthogonal Plane, set the offset of the isocenter from the center of the 
viewing window, and set the interpolation. These settings apply to the selected viewing 
window only. This procedure is complete. 

• If you select 3D Image, a regular skin-rendered 3D image is shown in the BEV. The 
perspective in a 3D BEV is different from that of a regular 3D window, and is defined so that 
the projected field size is correct with respect to the image’s anatomical features. If you 
select 3D Image, you have the option of turning the display of other beams on or off in the 
BEV. This procedure is complete.

6 Set the Display grid? option to turn on or off the measurement grid. As a default, the 
measurement grid is turned off.

BEV DRR BEV DCR
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To customize the measurement grid, enter a resolution in the Grid resolution field, and select a 
style and color from the Grid style and Grid color option lists. 

7 On the Window/Level tab, set the window and level to gain the best DRR contrast and 
brightness for your plan.

These window and level settings are based on the maximum DRR value. For more information, 
see Set the window and level.

8 In the Color ramp function option list, select the type of color ramp.
9 Set the Automatic brightness option to turn on or off the automatic brightness processing. As a 

default, Automatic brightness is turned on for DRRs. 
10 On the Settings tab, adjust the settings described in the table below as needed. 

Setting Description

Step size 
Resolution

Set the step size and resolution for computation.
Step size refers to the steps taken along each ray during volume rendering. A lower 
value produces a more accurate image but takes longer to generate.
The Fast settings are used during interactive rendering (e.g., during gantry rotation) 
when a faster DRR is desirable. Otherwise, the Normal settings are used.

Energy (MeV) Select the beam energy used for computation.
An energy of 0.025 to 0.03 MeV has been shown to generate the best DRRs. The default 
value is 0.03 MeV. Use a higher energy for thicker image sets, or when you want to 
simulate a port film.

Brightness Select the brightness factor used when rendering.
Try a brightness value from 0.7 to 0.8 for the best DRR image quality. Values between 
1.0 and 2.0 make the image brighter. Values between 0.1 and 1.0 make the image 
darker.

Interpolation Select the method for generating the DRR.
• Coarse uses nearest neighbor interpolation. It is less smooth than the other options, 

but faster.
• Smooth uses linear interpolation in the Z dimension only. This is the default 

selection; it is smoother than Coarse and faster than Smoothest.
• Smoothest uses linear interpolation in all three dimensions, but is slower than the 

Smooth option.
If you want to set the default method of DRR interpolation to always be Coarse or 
Smoothest, use the Preferences window.

CT to density table Select the table to be used when computing the DRR. This table is only used for the 
DRR; it is not used in the calculations performed in your plan.
For each image type (CT, MR, PET), make sure you have a CT to Density Table that can 
properly render that type. See the Pinnacle3 Physics Instructions for Use for information 
on setting up a table.

Automatically generate 
DRRs

Select:
• Yes if you want the software to automatically generate the DRR any time you modify 

the display settings.
• No if you only want to render the DRR yourself.
This setting applies to all the DRRs in your plan. You can also set this option in the 
Preferences window.

Speed up collimator 
movements

Select Yes to speed up collimator movement when adjusting a collimator on a BEV with 
the mouse.
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11 When you finish setting the BEV parameters, click the Close button.
12 To render the BEV, press the “r” key in the viewing window.

NOTE
If the image does not appear, go to the Data Set Specifications window and make sure 
the Render option for the patient data is set to Yes. 

NOTE
To quickly turn on or off a DRR for the current beam, right-click the BEV and click the 
BEV On/BEV Off button in the Tools window.

12-Panel Beam’s Eye View

Sometimes, you may want to see multiple BEVs, such as when viewing BEV for control points.

In the Planning window, from the View menu, select the 12-panel BEV icon to configure the 
viewing windows to display a 12-panel BEV. 

Whenever the 12-panel BEV is displayed, the following options are available along the bottom of 
the viewing window:

Speed up BEV translation Select Yes to speed up BEV translation by only rendering the current BEV during 
translation. When this option is set to Yes, only the current BEV renders as you translate 
the BEV using the mouse, while any other BEV windows display only the axis lines that 
represent the isocenter location. Once you release the mouse, the other BEVs render 
completely.

Setting Description

Title Description

Beam Select the beam for which you want to view MLC control points and leaf positions in the 
viewing window.

Clip leaves Select this check box to clip the display of the MLC leaves to the jaws. If this check box is 
not selected, the entire MLC is shown in the BEV viewing window.

Fill in leaves Select this check box to fill in the MLC leaves with color so they are easier to see. If this 
check box is not selected, the MLC leaves are displayed as outlines.

Max Leaf Motion Select this check box to display on the BEV tab the maximum extent of the leaf openings 
across control points for step-and-shoot beams.

Navigation controls (left to right):
• Previous 12 control points.
• Previous control point.
• Next control point.
• Next 12 control points.

MLC Options Opens the Beam MLC Leaf Position Editor window.
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Room’s eye view
In a room’s eye view (REV), you can see the location of the patient in relationship to the machine. 
This can be helpful in determining if the patient orientation is correct. However, small data sets may 
be difficult to interpret given the small amount of the patient that you see in proportion to the 
room.

You can display REVs for each beam in the plan or you can develop multiple REVs for the same 
beam. Only one beam is shown per window.

The gantry, accelerator, table, and room floor appear, too. If you want to change the display of 
these components, see the Pinnacle3 Planning Reference Guide.

The geometry of these objects is associated with the beam’s machine. When the beam geometry is 
modified, the REV updates appropriately. The gantry rotates, the couch rotates, and the patient 
shifts when the isocenter or the laser center is modified.

1 Display a 3D window or beam’s eye view window.
2 Right click in the 3D or beam’s eye view window. The Tools window appears.
3 Select REV.
4 Select the beam to be viewed. The window changes to a room’s eye view. If you select Current, 

for example, the view is locked to the current beam. The REV appears in the viewing window.
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Beam relative views
Beam relative views (BRVs) are 2D views that are based on a beam’s position and orientation. BRVs 
are generally oblique with respect to transverse, coronal, and sagittal patient geometry. Use BRVs 
to examine the spatial relationships between a beam, patient anatomy, POIs, and ROIs. BRV 
orientations are parallel to the central axis of the beam (back/front), parallel to the beam’s x-axis, 
or parallel to the beam’s y-axis.

BRVs are available for any beam, and are useful in several situations. For example:

• You can use BRVs for simulations involving cancers of the head and neck when a non-coplanar 
beam arrangement is needed. For proper field matching, you can quickly locate a projection 
that is sagittal or coronal to the central axis of the supra clavicular or head fields, then 
manipulate the gantry collimator or couch of an alternate beam to correctly match the 
divergence to a fixed beam.

• When simulating half-beam breast tangents in which the treatment couch must be angled, you 
can graphically match the diverging beams throughout the patient. Select the beam axial slice 
of the medial tangent field, then turn on the display for the lateral beam on the 2D BRV axial 
slice of the medial beam. Use gantry and collimator adjustments to align the lateral beam with 
the medial tangent beam.

1 Create a 2D viewing window and right-click it. The Tools window appears.
2 From the BRV menu, select the beam you want to view. The default BRV orientation is 

Front/Back. The BRV appears in the viewing window. The lines across the image represent the 
beam.

3 To select a different BRV orientation, right-click the viewing window and select 2D - BRV 
Orientation.

4 To change the slice plane of the BRV, right-click the viewing window and select 2D - BRV 
Options.

The Beam-Relative View (BRV) Options window appears.

5 Make sure the correct beam and window are selected.

The Window option list contains all BRVs, BEVs, and room’s eye views (REVs) for the current 
beam. If you select a BEV or REV in this window, all BRV-specific options will be unavailable. 

6 Set the orientation of the BRV.

When setting orientation, you can select either Front/Back, the names assigned to the 
machine’s top and bottom jaws (for example, Y1/Y2), or the names assigned to the machine’s 
right and left jaws (for example, X1/X2). Changing the orientation results in the BRV offset being 
reset to 0.

7 Use the Offset, Index, and Step Size fields to specify the plane displayed in the BRV.

The offset, a slice increment that corresponds to the distance from the isocenter plane, is the 
Step Size multiplied by the Index. You can enter a negative or positive offset value or use the 
slider to pan smoothly through the BRV. The Step Size must be between 0 and 2 cm.
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In BRVs with Front/Back orientation, a negative offset corresponds to a plane on the source 
side of the isocenter; a positive offset corresponds to the other side. Thus, the BRV offset works 
like the 2D BEV offset.

8 Set the display rotation of the BRV.

This rotation is only available for Front/Back BRVs. You can set this rotation to any angle.

9 When you finish setting the BRV parameters, click the Close button.
10 To display dose distribution in the BRV as a colorwash, click the Plan evaluation button at the 

top of the Planning window. Then, in the Dose Display & Analysis section, next to 2D 
Colorwash Display select On.

To turn the BRV back into a standard 2D window, right-click the BRV and select None from the 
BRV menu.

BRV tools

Other than the exceptions listed below, 2D tools work in BRVs as they do in any other 2D window. 
For more details about using 2D tools, see the Tools chapter.

• You cannot use the POI tools to move the isocenter of the BRV’s beam. The BRV image plane is 
determined by this isocenter.

• When a beam is being viewed in a BRV, you cannot use the 2D Beam Angle tool to position the 
beam on 2D images.

• You must close the BRV before changing the trial.
 Pinnacle3 16.4  Planning Instructions for Use 4598 006 81251 A



Digitally reconstructed radiograph options 51 

4598 006 81251 A  Pinnacle3 16.4  Planning Instructions for Use

Digitally reconstructed radiograph options
If you display images as DRRs, you can set your own parameters for generating them instead of 
using the standard DRR images.

NOTE
These DRR settings do not apply in beam’s eye views. If you want to make DRR settings 
in BEVs, right-click a BEV window and click the BEV Options button. For more details, 
see Beam’s eye views.

NOTE
The software can only create composite 3D renderings of surface images, not of DRR 
images or of DRR/surface combinations. The DRR blocks out the surface rendering at 
spots where the two would appear instead of merging.

1 Select Utilities - Data Sets.

The Data Set Specifications window appears.

2 Select View 3D - Image Type - Digitally Reconstructed Radiograph. The DRR Options window 
appears.

3 Enter the DRR parameters:
• DRR Energy—The beam energy used for computation. An energy of 0.025 to 0.03 MeV has 

been shown to generate the best DRRs.
• CT to Density Table—The CT to Density table to be used when computing the DRR. The CT to 

Density table maps the CT numbers to density, and the mass attenuation coefficients for 
these densities are used to generate the DRRs. 

• Brightness Factor—Brightness values from 0.7 to 0.8 produce the best DRR image quality. 
Values between 1.0 and 2.0 make the image brighter. Values between 0.1 and 1.0 make the 
image darker. 

• Use Rendering Threshold—Use the upper and lower rendering thresholds in the Data Set 
Specifications window to set the range of CT numbers for generating the DRR. The values 
between the lower and upper limits are used to generate the DRR. For example, to see less 
soft tissue in the DRR, raise the lower limit.

NOTE
DRRs look best when generated from slices with a thickness less than 5 mm. If you 
generate DRRs with thicker slices, their appearance might seem “stepped”.

4 If you want to specify faster DRR rendering, in the Data Set Specifications window select View 
3D - Interpolation - Nearest XY, Linear Z.

This interpolation does not adversely affect image quality, because X-Y resolution is typically 
much finer than the Z resolution.

5 To close the Data Set Specifications window, select Close.
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Add cutplanes to 3D images
Cutplanes allow you to define a plane that cuts through the three-dimensional image set to reveal a 
feature of the patient anatomy. For the best cutplane effect, select a case on which you have drawn 
a number of ROIs.

NOTE
The After Motion Complete rendering option, which renders the 3D image after you 
complete any change in the orientation of the image set, does not apply to the 
movement of cutplanes.

The following procedure is an example of how to use cutplanes.

1 Choose a Poly Surf or similar rendering option for the ROIs you want to display in 3D.
2 If necessary, right-click in a viewing window and select Enter 3D Mode from the 2D menu of the 

Tools window that appears.
3 Right-click in the viewing window again, select 3D - Image Type, and then select a Skin 

rendering option.
4 Select Utilities - Cutplanes.

The Cutplanes window appears.

5 Select Options - Add X Cutplane (transverse, sagittal, or coronal) to add a cutplane through the 
center of the image set in the desired orientation. 

If you want to add a cutplane to all image sets, select All Data Sets from the Data Set Name 
option list.

6 Turn on or off the cutplane display using the toggle button next to the Mark column. If you turn 
off a cutplane it is automatically unmarked so you cannot move it accidentally. If you mark a 
cutplane it automatically displays.
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7 At the bottom of the window, select the display mode for the cutplanes. Cut out displays the 
whole image set with a plane cut out of it. Box displays only the portion of the image set that is 
left after the plane cuts through it.

8 Change the orientation or position of the cutplane using the cutplane tools.

These tools operate on “marked” cutplanes. To mark the cutplane, click the box in the Mark 
column of the spreadsheet. The marked cutplane displays in yellow in 2D viewing windows and 
in red in the 3D viewing windows.

Then, for example, you can click the Move cutplane 3D tool shown at left, put the cursor on the 
red line, and then click and drag the red box left or right to set the intersection position. You can 
try intersecting through the center of some ROIs.

You can use the other cutplane tools to rotate the cutplanes about the X, Y, and Z axes, or to 
move the cutplane along one axis in 2D. To create a complex cutplane display, you must select 
and render each segment without overwriting other segments.

9 To specify non-normalized cutplane vectors, click the Edit Normal button.

The software automatically normalizes vectors according to the values in the Cutplane Normal 
fields. When you click Edit Normal, you can assign your own normal values without having the 
software re-normalize them. Enter the non-normalized vectors in the New Normal fields, click 
the Accept button to save the new vectors, and then click the Done button.

10 With the cursor in the 3D window, press the r key to render the plane. You will see a skin 
rendering in the marked volume and some protruding ROIs on the unmarked side.

11 Right-click in the viewing window, select 3D - Image Type, and then select a Bone rendering 
option.

12 In the Cutplanes window, select Options - Reversed Marked Cutplanes. The cutplane reverses 
its position.

13 Render the cutplane again, as described in step 10. You will see a bone rendering in the marked 
volume, this time on the other side of the patient.

Cut out display Box display
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Sample cutplane display

To create a complex cutplane display, use the following settings and then apply the cutplanes.

Field Setting

Image Set Both

Display Mode Cut-Out

Transverse Cut On

Sagittal Cut On

Coronal Cut On

3D Colorwash (in Syntegra) Show Secondary on Primary (This projects the secondary image set on the 
surface of the primary image set.)
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General display options

Set the display of all beams

The All Beam Display option in the Utilities menu allows you to override the display settings for 
individual beams. You can display or hide all the beams in the 2D viewing windows. And, you can 
display or hide all the beams in the 3D viewing windows.

Set the display of all ROIs and POIs

The All ROI Display and All POI Display options in the Utilities menu allow you to override the 
display settings for individual ROIs and POIs. You can display or hide all the ROIs and POIs in the 2D 
viewing windows. And, you can display or hide all the ROIs and POIs in the 3D viewing windows.
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4 Image Fusion

Overview

NOTE
The Registration panel is available only if you are licensed for Syntegra, and the 
Deformation panel is available only if you are licensed for Syntegra and Dynamic 
Planning. Contact Customer Support for licensing information.

Pinnacle3 and Syntegra allow you to correlate, or register, multiple patient image sets using the 
image fusion features. You can view correlated images in 2D and 3D, and you can correlate multiple 
patient image sets even if they use different modalities. 

After you register a secondary image set to the primary set, you can also create a deformed image 
set that represents the mapping of the secondary image set to the primary image set based on the 
computed deformation vector field (DVF).

The Image Fusion window uses two reconstructed studies of the same organ or system; you 
reorient an active image to align with a stationary reference image in any direction. Syntegra uses 
multiple reconstructed studies of the same organ or system. You can select more than one 
secondary image set for image fusion, but you can only view fusion of one secondary image set at a 
time with the primary image set.

You can save the reoriented, aligned image data as part of your plan.

NOTE
The Image Fusion and Syntegra windows display images in absolute coordinates (in 
centimeters). Thus, if one study is acquired in the standard CT matrix of 512x512 with a 
pixel size of 1 mm and another is acquired in a 128x128 matrix with a pixel size of 4 mm, 
both studies have the same size in the display. 

Image fusion limitations
• If the position of the patient on the table is not the same in the image sets that you want to 

register, you may not be able to accurately align the image sets.
• If you are registering multiple secondary image sets that are not pre-registered or that use 

different fields of view, you must register each image set separately.

The fusion window
On the Utilities menu, click Image Fusion to open the Image Fusion or Syntegra window.

The Image Fusion and Syntegra windows are each one large window that allows you to register 
multiple image sets. The main icons along the top show the different panels for Setup, 
Registration, Deformation, and Contours. When you open a fusion window, by default a 2D 
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transverse, coronal, and sagittal viewing window set and 3D viewing window appear in the right 
panel (you can change the default in your preferences).

Main icons 

Setup panel

Options menu

Fields

Icon Panel Description

Setup Displays the Setup panel. Use it to set up the display of your image sets, 
determine which image sets are moveable, and perform manual registration.

Registration Displays the Registration panel. This is only available if you are licensed for 
Syntegra. Use it to automatically register the secondary image sets to the 
primary image set.

Deformation Displays the Deformation panel. This is only available if you are licensed for 
Dynamic Planning. Use it to create a deformed image set and assess the quality 
of the deformed image set.

Contours Displays the Regions of Interest panel. Use it to draw contours of tumors and 
anatomical structures.

Menu Item Function

Global Thick Slice Display Turn on or off the display of thick slices in 2D viewing windows. 

2D Tool Parameters Set the increments to use with the shift and rotation tools.

Registration Parameters View the translation and rotation offsets between the primary and selected 
secondary image set.

Field Description

Primary Image Set The image set to which all other image sets are registered.

Secondary Image Set An image set that will be registered to the primary image set.

2D Color The color to be used in 2D viewing windows to display the image set.

Available Fusion Image Sets The list of available secondary image sets that can be registered to the primary 
image set. All moveable fusion image sets are moved when you use the 
interactive registration tools.

Copy this transformation to Copy the transformation parameters of the current secondary image set to 
another secondary image set. You can only copy the parameters to moveable 
image sets.

Image thickness The requested thickness for the thick slice display. This setting applies to all 
image sets.

Fusion display method If you select Alpha Blending (only available in Syntegra), the Alpha field 
appears. If you select Checkerboard, the Tile size field appears.
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NOTE
ALL secondary images that are moveable are moved together when you use the 
registration tools or the automated registration.

Registration panel

The Registration panel is available only if you are licensed for Syntegra.

Options menu

Fields

Alpha Use the Alpha slider to set the transparency of the primary image set. This 
feature is only available in Syntegra.

Tile size The size of the squares to use when displaying the “checkerboard” view of the 
image sets. This setting applies to the current viewing window.

Field Description

Menu Item Function

Global Thick Slice Display Turn on or off the display of thick slices in 2D viewing windows.

2D Tool Parameters Set the increments to use with the shift and rotation tools.

Registration Parameters View the translation and rotation offsets between the primary and selected 
secondary image set.

Tab Field Description

Images Use defaults for Set the default automated image registration type. The combination you 
select configures Syntegra to use a recommended algorithm. The order of 
the modalities in the list is not relevant: CT-MRI would be the same as MRI-
CT.

Images Algorithm Algorithms to determine the best registration for all the image sets. You can 
set the default algorithm as a user preference.
• Cross correlation makes direct comparisons between image set values. It 

is effective for registering image sets of the same modality.
• Local correlation makes comparisons of many areas of the image sets. It 

works best for image sets with differing modalities in which equivalent 
features can easily be seen (for example, CT-MR).

• Normalized mutual information uses probability concepts to optimize 
the data between image sets. It does not assume a functional 
relationship between the values, so it is effective for multi-modality 
image sets.

Images Show intermediate 
transformations

As each transformation step is complete, display that transformation in the 
viewing windows.

Images Elapsed time Displays how long the fusion has been running.

Images Time limit The maximum time Syntegra should work on fusing the image sets.

Images Similarity score This number shows the progress of the transformation (like a “percent 
complete” number). It does not define the accuracy of the transformation, 
merely its state. It appears during the registration process.
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Deformation panel

The Deformation panel is available only if you are licensed for Dynamic Planning. See Deformable 
image registration in this chapter.

Regions of Interest panel

See the Regions of Interest chapter for information about contouring.

Images Use common bounding 
box

Select whether to limit both data sets at once or limit them separately.
• Yes—Use a common bounding box for both image sets.
• No—Use separate bounding boxes for the primary and secondary image 

sets.

Images Limit both data sets If Use common bounding box is set to Yes, select the method for limiting 
both data sets:
• No—Use a combination of both image sets.
• Existing ROI—Set the Margin around the combined ROIs.
• Bounding Box—Limit the image sets to a rectangle you define.

Images Limit Primary data Limit fusion of the primary image set to the defined subvolume or one of its 
regions of interest.
• No—Use the whole image set.
• Existing ROI—Limit the image set to an ROI. 
• Bounding Box—Limit the image set to a rectangle that you define.

Images Limit Secondary data Limit fusion of the secondary image set to the defined subvolume or one of 
its regions of interest. 
• No—Use the whole image set.
• Existing ROI—Limit the image set to an ROI. 
• Bounding Box—Limit the image set to a rectangle that you define.

Points Fiducial Points Displays the fiducial point sets (one point each on the primary image set 
and a secondary image set). Also displays the distance between the two 
points.

Points 2D Display for All Fiducial 
Pairs

Turn on or off the display of the points in 2D viewing windows.

Points 3D Display for All Fiducial 
Pairs

Turn on or off the display of the points in 3D viewing windows.

Points Mean distance between 
points

The average distance between all primary/secondary fiducial point sets.

Tab Field Description
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Viewing windows
2D and 3D viewing windows are used to view the patient anatomy, fusion of the image sets, fiducial 
markers, and regions of interest.

Default viewing window

Next to the default viewing window set, the following fields allow you to control the display.

NOTE
You cannot combine surface and MIP image types in one viewing window.

Other viewing windows

Use the View menu to change the configuration of the viewing windows.

Field Description

Render Specify whether the current volume should be rendered in 3D images. You should set 
the Render option to No when you do not want to render the patient data set in 3D 
windows.

3D Color Set the color to be used when displaying the image set in 3D.

Image Type Specify the image type. The image types are surface and maximum intensity projection 
(MIP).

Render Threshold Use the upper and lower rendering thresholds to determine the range of values used 
when generating the image. Threshold values do not apply to the MIP image type.

3D Colorwash Select how the software shows the primary and secondary image sets in 3D displays.

Menu Item Function

Display one large 2D window for viewing the primary image, the secondary image, or both at 
once (fusion). The layout also features a smaller 2D window, which always displays the primary 
image as a reference. The larger and smaller windows stay synchronized as you change their 
orientation.

Display two large 2D windows in the same orientation for comparing the primary and secondary 
studies side by side. The layout also has controls to let you view the primary image, the 
secondary image, or both at once (fusion). These two windows are always synchronized, so 
there is only one slice selection slider.
This layout is good for reviewing registration and drawing contours after the image sets are 
registered.

The default view contains transverse, sagittal, and coronal 2D views in the top row, and a 3D 
view. This layout includes 3D viewing window options.
This layout is good for manual- or image-based registration. It allows the best view of image 
alignment.

Display three 2D windows: transverse, sagittal, and one large coronal window. There are no slice 
selection bars in this window so you will have to use the n and p keys or the scroll tool to change 
slices.
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Viewing options

Use the Primary, Secondary, and Fusion radio buttons to choose what image sets display in the 
windows. If you chose Secondary or Fusion, the current secondary image set is used for display. 
Use the Reset to T/S/C button to set the display back to one transverse, sagittal, and coronal 2D 
view.

The Fusion option displays both the primary and secondary image set. While using the Fusion 
mode for the viewing windows, you can use the Show secondary image cutout tool to create a 
“cutout” in the primary image set that shows the secondary image set. This view can help you 
determine if your images are aligned.

Display two rows of 2D windows: a 2D transverse, 2D sagittal, and 2D coronal window. The top 
row displays the primary image set and the bottom row displays the current secondary image 
set. You can change the image set shown in each row.
This layout is good for placing points for point-based registration.

Display three sets of 2D viewing windows. Each set is a sequence of slices. The first row is the 
primary image set. The second row is the secondary image set. The third row is the fusion view 
(both image sets).
This layout is good for reviewing the image sets after registering them.

Display three 2D windows (transverse, sagittal, and coronal) and one 3D window.

Display three rows of 2D windows of each orientation: transverse, sagittal, and coronal. The 
rows are synchronized. You can change the slice separation in each row.

Menu Item Function
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Set up the image sets

�CAUTION
View your image sets as single slices before transforming and registering the image sets. Doing so 
should allow you to see if there are any anomalies in the image sets you intend to use.

The following is the basic procedure for setting up your image sets. For detailed information and 
procedures, see the sections that follow.

1 Click the Setup icon at the top of the window to display the Registration Setup panel.
2 For the primary image set, change the 2D color, if necessary.

3 If the window and level are not optimal, click the Window/Level button. The Window/Level 
window appears. Change the settings so the image set appears correctly for your needs. See 
Modify the window and level.

4 For the secondary image sets, select the image set for which you want to set the color, window, 
and level.

5 Change the 2D color if necessary.

6 If the window and level are not optimal, click the Window/Level button. The Window/Level 
window appears. Change the settings so the image set appears correctly for your needs. See 
Modify the window and level.

7 Repeat steps 3-5 for each secondary image set.

8 Under Available Fusion Image Sets, click on the Moveable/Not Moveable toggle button next 
to each image set until the proper image sets are moveable or unmoveable.

NOTE
The Undo previous transformation button can be used while an image set is moveable. 
Once you change the image set to not moveable, the registration changes you have 
made cannot be undone. The Redo button can be used to re-do an action you just chose 
to undo and will work only for those changes that are still in memory.

9 In Syntegra only: Use the Move Secondary Center to Primary Center and Reset Secondary 
to Initial Position buttons to move the secondary image sets if necessary. The Move 
Secondary Center to Primary Center button moves the geometric center of the secondary 
image set to the geometric center of the primary image set.

10 To change the 2D checkerboard view, use the Tile Size field to set the size of the squares.
11 In Syntegra only: Under 2D View Parameters, if you want to use the alpha blending view, select 

Alpha Blending then use the Alpha slider or field to set the transparency of the primary image 
set.

Now you can manually adjust the registration, or if you are licensed for Syntegra you can use 
the automatic registration tools in the Registration panel.

Set the color map

At the top of the Registration Setup panel you can select the color map for each image set.
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The default color map for the primary image set is greyscale. The default color map for all 
secondary image sets is thermal. If you have different default color maps selected as preferences, 
those will be used as the defaults.

For the primary image set, from the 2D Color option list, select the color map.

For secondary image sets, from the Image Set option list, select the desired image set. Then from 
the 2D Color option list, select the color map.

Modify the window and level

The “window” specifies the range of values to be mapped into the color ramp. The “level” specifies 
the image value at which the range begins. Image set values are mapped to colors based on a ramp 
function that can be selected in the Window/Level window. The default is a linear function, but 
you can set a new default in the Preferences window.

You can set the window and level for each image set. In the Preferences window you can set default 
window and levels for the primary image set and all secondary image sets.

In the Syntegra or Image Fusion window, select the image set for which you want to set the 
window and level. Use the table that follows to set the window and level that you prefer. 

NOTE
When you manually change the Window or Level values, the selection in the Presets list 
changes to “--” because you are no longer using window and level values that are 
defined by a preset.

Field Description

Sliders Use the long sliders to interactively set the window and level for the primary image set and all 
secondary image sets.
The red line sets the window. The green line sets the level and window. Click between the 
lines and drag to adjust the level. Use the radio buttons below each slider to make changes to 
the desired image.

Window Use the slider or enter the window number you want for the image set.

Level Use the slider or enter the level number you want for the image set.

Units Specify the window and level units: percentage of max (maximum value in the image set), 
actual image set values, or standard uptake values (SUVs). SUV units are available when there 
is SUV information in Philips PET image sets. For the actual image set, the range of values is 
zero to the maximum volume value.
When you select SUV, the range of values becomes 0-10. The software converts each image 
set value to an SUV before mapping it to a color. The two SUV color maps (SUV2 and SUV3) 
each have 10 discrete colors. If you set the level to zero and the window to 10, then all SUVs in 
the range 0-0.5 map to the first color, 0.5-1 to the second color, 1-2 to the third, 2-3 to the 
fourth, etc. You can use the full range or decrease the window. You can use other color maps 
with SUV, but the other maps do not have discrete colors.

Ramp The function to use to distribute color map entries through the full range of values in the 
image set. The functions are: linear, logarithmic, exponential, and histogram equalization.

Presets Use standard or custom window and level settings. To create or edit a preset, see Window and 
level presets.
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Click the More button to change the way the window is displayed. The window includes a 
histogram as an additional tool for setting the window and level.

Use the histogram to view the distribution of data set values and identify where the greatest 
concentrations of values lie.

• To interactively change the window and level in the histogram to emphasize concentrations of 
values, drag the red and green markers, respectively. (If you do not see them, the window 
marker is at the very left edge and the level marker is at the very right edge.)

• To change the display range of the histogram, enter new values in the Min and Max fields. For 
example, you can decrease the range to magnify an area of the histogram.

Window and level presets

To use one of the standard window and level values, select from the Presets option list.

If you want to edit the window and level of the preset values, click the Edit (or Edit Presets) 
button. The Edit Window/Level Presets window appears.

• To develop a new preset, click the Add Preset button, type a name for the new preset in the 
Name field, and enter settings for it in the Window and Level fields.

• To edit an existing preset, select it in the list and then enter new settings in the Window and 
Level fields.

• To delete presets that you created yourself, select the preset in the list and then click the 
Delete Preset button. You cannot delete a preset that came with the software.

• To save your edited presets for use in future sessions, click the Save Presets button. If you do 
not save, your edited presets will be lost as soon as you end your current session.

• To cancel your edited presets and return to the original settings, click the Load Factory Presets 
button. Presets that you created yourself are unaffected.

When you finish editing the presets, click the Close button.

Make image sets moveable

In the middle of the Registration Setup panel you can choose which image sets are moveable or 
stationary. Any image set that is moveable is changed by the registration and transformations you 
perform. All changes to secondary image sets are relative to the coordinate system of the primary 
image set.

Click the button next to the image set name to toggle between moveable and unmoveable.

NOTE
ALL secondary images that are moveable are moved together when you use the 
registration tools or the automated registration.
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Set 2D fusion display

Checkerboard

To achieve the illusion of fusing images in the 2D views, alternating tiles of the active and reference 
images appear in the fusion window. The “tile size” allows you to vary the amount of mixing 
between the pixels of the active and reference studies when they are fused and can be useful when 
evaluating the registration between image sets. The default setting is alternating one pixel from 
each image set. To display a different overlay in the selected view, enter a new number in the Tile 
size field and press Enter, or click and drag the slider.

Alpha blending

This feature is only available if you are licensed for Syntegra. If you are licensed, this is the default 
display mode.

Alpha blending is used in computer graphics to create the effect of transparency. In computer 
graphics, each pixel has three channels of color—red, green, and blue—and a fourth channel called 
the alpha channel. The alpha channel controls graphics display methods such as levels of 
transparency or opacity. You can use alpha blending to simulate the transparency of the primary 
image set so you can “see through it” to the secondary image set.

The alpha value is used to blend the red, green, and blue values from each image set. A value of 
zero (0) makes the primary image set completely transparent. A value of one (1) makes the primary 
image set completely opaque.

Use the Alpha slider to set the alpha value of the primary image set. The default value is 0.5 (50%).

Copy a transformation

This feature is only available if you are licensed for Syntegra. If you have multiple secondary image 
sets that were acquired on the same machine, with the same patient position, and with the same 
field of view, you can copy the fusion transformation from the first image set to the second image 
set.

To copy a completed fusion transformation to another image set, make the image sets moveable. 
Under Copy this transformation to, select the image set, then click the Go button.
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Use thick slices
The “thick” slice feature is only available if you are licensed for Syntegra.

Use the Image Thickness field under 2D View Parameters to set how “thick” each slice should be in 
the image set. This feature allows you to decrease the “noise” in the image set.

Syntegra averages all of the image data over the range of slices that makes up that thickness. When 
displayed in the viewing window the range of slices is displayed (Z = 10.0 to 12.20) since it is not a 
specific slice.

The value that you enter may not always be the actual slice thickness. The actual thickness can be 
seen by looking at the range of slices displayed in the viewing window. Syntegra determines the 
thickness by taking the original slice you displayed in the viewing window and adding an equal 
number of slices to either side so that the total thickness is less than or equal to your entered 
value.The voxel size plays a large part. For image sets with

• standard slices: for example if your voxel size is 0.3 cm, Syntegra can only add slices in 
increments of 0.3 cm to either side of the current slice. If you enter 1.0 cm, you will get a thick 
slice of 0.9 cm, not 1.0 cm (the original slice and a slice on either side = 0.3 + 0.3 + 0.3 = 0.9). To 
get a thick slice that is the same as the value you enter, make the value a multiple of the voxel 
size.

• inconsistent slices (only affects transverse views since inconsistent spacing is only allowed in 
the Z direction): the thickness is your entered value. Syntegra uses a weighted average to 
combine the slices, where the weight is the percentage of the slice that fits inside the thick 
slice.

• oblique slices: the original oblique slice is averaged with parallel oblique slices at increments of 
0.4 cm from the original slice so the distance from the first to last slice is less than or equal to 
your entered value.

When using thick slices please note that:

• you can change a thick slice back to the individual slices at any time.
• ROIs cannot be created on thick slices and existing ROIs are not displayed.
• the maximum thickness allowed is 16 mm.
• points for point-based registration cannot be placed on thick slices.
• you can use the zoom, pan, and scroll tools in viewing windows displaying thick slices.
• you can use the cutout window tool in viewing windows displaying thick slices.



Automatic registration 67 
Automatic registration
The features in this section are available only if you are licensed for Syntegra.

�CAUTION
View your image sets as single slices before transforming and registering the image sets. Doing so 
should allow you to see if there are any anomalies in the image sets.

Image-based registration

For image-based registration you do not have to define any points (fiducial markers). Syntegra 
registers the image sets based on the image data.

1 Select the secondary image set that you want to register.
2 From the Use defaults for list, select the combination to be used.

The combination that you select configures Syntegra to use a recommended algorithm but you 
can select a specific algorithm (or set one as a user preference).

3 If necessary, from the Algorithm list, select the algorithm that Syntegra should use to align the 
image sets.

4 In the Show intermediate transformations field select Yes or No to view the transformations as 
they occur.

5 In the Time limit field set the maximum length of time you want the software to run 
transformations.

6 You can limit the volume of the primary or secondary image set that should be used for 
registration. Select the appropriate option in the Use common bounding box field:
• Yes—Use one common bounding box for both the primary and secondary image sets.
• No—Use separate bounding boxes for the primary and secondary image sets.

7 Define how the image sets should be limited.
• No—Do not limit the image set.
• Existing ROI—Limit the image set to an ROI. Select the ROI from the list that appears.
• Bounding Box—Limit the image set to a rectangle that you define. Limit the volume by using 

the Adjust bounding box tool to draw a rectangle on the image set. See Define the sub-
volumes.

8 Click Register Images. The Stop and Accept button appears in place of the Register Images 
button. The Similarity Score field appears and updates after each iteration so that you can see 
how close the registration is to completion.

If you want to stop the registration before the software considers the registration complete, 
click Stop and Accept. If you stop the registration before the software is finished, the current 
iteration of the registration is used and shown.

�CAUTION
Verify the accuracy of your registration before proceeding. If it is not accurate enough, use the 
manual tools or image- or point-based registration to refine it further.
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Define the sub-volumes

Using the Adjust bounding box tool, you can define one sub-volume (box or region of interest) on 
each image set that the software uses for registration. Sub-volumes let you eliminate some of the 
“extra” parts of the image set that are not vital for registration because the software ignores all of 
the data points outside of the sub-volume. For example, when fusing head scans in which one 
image set contains a portion of the neck and torso, create a sub-volume that excludes the neck and 
torso.

You can draw sub-volumes while using the fusion view on transverse, sagittal, or coronal views, or 
you can select an ROI to use as the sub-volume.

NOTE
You can draw the sub-volume as large as you want, but the software will not let you 
cover the image set and slice information in the bottom of the viewing window.

Point-based registration

You can use fiducial markers to help align the images. To register image sets, you must set up 
fiducial marker pairs: one marker on the primary image set (displays in red) and one on a secondary 
image set.

These markers can be moved at any time. If you move the image set, the markers move with the 
image set. In 2D views a marker appears as a crosshair inside a circle. In 3D views a marker appears 
as a sphere.

Syntegra displays the distance between each pair so that you can identify misplaced or un-
registered markers.

1 Select the secondary image set that you want to register.
2 On the Points tab, click Add New Fiducial Pair. The software adds a set of fiducial markers to 

the list.
3 In a viewing window, use the Place fiducial markers tool to place each marker at the 

appropriate spot on the image set.
4 Repeat steps 2 and 3 for each pair you want to add.

You must place a minimum of 3 pairs of markers. You can place a maximum of 10 pairs of 
markers.

5 Click Register Images. After the registration is complete, the mean distance of all the points 
appears at the bottom of the panel.

�CAUTION
Verify the accuracy of your registration before proceeding. If it is not accurate enough, use the 
manual tools or image- or point-based registration to refine it further.
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Registration parameters

To view the translation and rotation offsets of each secondary image set, on the Options menu, 
click Registration Parameters. The window displays the information for the current secondary 
image set. To change the image set, select it from the Secondary Image Set list.

You can change the translation vector by modifying the X, Y, or Z offsets. If you set the Rotation 
field to Angles, you can change the rotation.
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Manual registration
Use the 3D tools first to begin correlating the images, then use the 2D tools to fine-tune the 
registration process.

Adjustments in 3D

The 3D tools are available only in Image Fusion.

1 In the Setup panel, set up the transverse, sagittal, and coronal viewing windows so you can see 
the image sets in all three orientations.

2 If the secondary image set does not appear, it might be completely outside the CT image. Click 
on the Moveable/Not Moveable toggle button next to the secondary image set to make it 
moveable, then use the 3D registration controls to shift and rotate the 3D images. 
• Use the Move secondary tool to shift the 3D image. 
• Use the Rotate secondary tool to rotate the 3D image.

3 Repeatedly shift and rotate the active image with respect to the reference image until the 
studies appear to be correlated.

3D rendering

After you register the images, you can render reference and active studies in 3D using the 3D 
window controls. These controls only appear in the default layout of the Image Fusion window.

The 3D view displays a blue and a green wireframe, representing the field of view (FOV) of the 
reference and active studies, respectively. If the FOVs of the active and reference studies are the 
same, wireframes have the same size and overlap.

As you move the active image, watch the effect on the wireframes in the 3D view. The green 
wireframe reflects the transformations. The reference wireframe, in blue, does not change because 
the reference study is static spatially.

To change the orientation of the 3D view, right-click it and use the 3D rotate, 3D pan, and 3D zoom 
tools. See the Tools chapter for details about these tools.

1 Change the display colors of the image sets using the Primary 3D Color and Secondary 3D Color 
option lists.

You can set the display colors to see a clear distinction between the CT images and the MRIs. 
We recommend the Thermal selection for secondary PET images and secondary MRIs.

2 If you want to render the secondary image set with the primary image set, select Yes in the 
Secondary Render field.

By default, the secondary image set is rendered with the primary image set.

3 Set the rendering thresholds for both image sets.

The thresholds determine the limits of the pixel values that are included in the 3D 
reconstruction. Pixel values outside the limits are not rendered.
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4 Use the 3D Colorwash option menu to select how the software shows the primary and 
secondary image sets in 3D displays.

5 To render the image sets, click the Render button.

To view the image from another angle, change its rotation and render it again.

Adjustments in 2D

Use the following tools to make manual adjustments or manually fuse image sets.

• To shift the image set in small increments, click the 2D fine-tune shift tool shown at left, then 
click in the top, bottom, left, or right part of the image, depending on the shift you want. For 
example, click the left side of the image set to shift it to the left.

• To rotate the image set, click the 2D fine-tune rotation tool shown at left, then click the right 
half of the image for clockwise rotation and the left half for counterclockwise rotation.

The rotation controls are based on the center of the image. Watch the effect on the active 
image in the target plane and other planes.

�CAUTION
Verify the accuracy of your registration before proceeding.
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Deformable image registration
After you register a secondary image set to the primary image set, you can choose to create a 
deformed image set. A deformed image set is a new image set that is mapped to the primary image 
set based on the computed displacement vector field (DVF) between the primary and secondary 
image sets.

Rigidly register the image sets

Before you create a deformed image set, rigidly register the secondary image set to the primary 
image set.

1 Click Deformation in the Syntegra window to open the Deformation panel.

NOTE
The Deformation panel is available only if you are licensed for Syntegra and Dynamic 
Planning.

2 In the Rigid Registration section of the Deformation panel, select the secondary image set that 
you want to register.

3 In the Limit Image Sets section of the Deformation panel, you can limit the volume of the 
primary or secondary image set that should be used for registration. In the Use common 
bounding box field select Yes or No to use one common bounding box for both the primary and 
secondary image sets, and then define how the image sets should be limited.
• No—Do not limit the image set.
• Existing ROI—Limit the image set to an ROI. Select the ROI from the list that appears.
• Bounding Box—Limit the image set to a rectangle that you define. Limit the volume by using 

the Adjust bounding box tool to draw a rectangle on the image set. See Define the sub-
volumes.

4 If necessary, select the algorithm that Syntegra should use to align the image sets from the 
Rigid Registration Algorithm list.

5 Click Register Images. The software registers the images.

Create a deformed CT image set
1 In the Rigid Registration section of the Deformation panel, select the secondary image set that 

you want to use for deformation.

NOTE
The secondary image set must be a CT or cone beam CT (CBCT) image set. Also, 
deformed image sets cannot be deformed again, so do not select a deformed image set 
as the secondary image set.

2 In the Limit Image Sets section of the Deformation panel, you can limit the volume of the 
primary or secondary image set that should be used for deformation. In the Use common 
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bounding box field select Yes or No to use one common bounding box for both the primary and 
secondary image sets, and then define how the image sets should be limited.
• No—Do not limit the image set.
• Existing ROI—Limit the image set to an ROI. Select the ROI from the list that appears.
• Bounding Box—Limit the image set to a rectangle that you define. Limit the volume by using 

the Adjust bounding box tool to draw a rectangle on the image set. See Define the sub-
volumes.

3 In the Deformable Registration section of the Deformation panel, select the modality of the 
primary image set from the Primary Image Modality options.

4 In the Filter images field, select Yes or No to exclude extraneous data from the images.

If you select Yes, the software attempts to exclude everything outside of the patient from the 
images, including the table, blankets and other patient coverings, and head frames, masks, and 
other positioning devices. This is particularly important when one image set includes a head 
frame, for example, and the other image set does not. Excluding artifacts outside of the patient 
can improve the resulting deformation.

5 If necessary, change the amount of smoothing that is applied during deformation by typing a 
value in the Smoothing field. For the initial deformation we recommend that you use the 
default value, which will be sufficient for the majority of deformations. If you notice that your 
deformation is too constrained or is not smooth enough, you can change the Smoothing value 
and deform the images again. For example, if there has been a dramatic change in the patient 
between the acquisition of the primary and secondary image sets, you may need to adjust this 
value to obtain a more satisfactory image deformation.

Smoothing controls the amount of Gaussian smoothing that is used to reduce deformation 
irregularities, but it also limits the resolution of the deformation. A small Smoothing value 
results in more variation in deformation than a large value. If you set the value too low, the 
software could produce unnatural deformations. If you set the value too high, you could 
smooth the deformation too much and reduce the accuracy of local deformations.

6 Click Create Deformed Image. The software creates a new deformed image set that represents 
the mapping of the secondary image set to the primary image set based on the computed DVF.
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Registration QA tools
Click Deformation in the Syntegra window to open the Deformation panel. The Deformable 
Registration and Registration Validation sections of the panel provide several tools that you can 
use to assess the quality of the deformation.

NOTE
The Deformation panel is available only if you are licensed for Syntegra and Dynamic 
Planning.

View the deformation

You can view the displacement vector field (DVF) that is computed between the primary image set 
and the selected secondary image set. The DVF displays as either arrows or a grid on the following 
image sets:

• Primary image set
• Secondary image set that was used to generate the DVF
• Deformed image set
• Fusion views of the primary image set and either the secondary image set or the deformed 

image set
1 In the Rigid Registration section of the Deformation panel, verify that the secondary image set 

for which you want to display the DVF is selected in the Secondary Image field.
2 In the Deformable Registration section of the Deformation panel, set Deformation Display to 

either Arrows or Grid.
3 If necessary, adjust the Deformation Display Spacing value to set the spacing of the DVF 

display.
4 If you set the Deformation Display to Arrows, you can set two additional options:

• Limit arrows to patient?—Limit the deformation display to the patient volume as defined by 
the outside-patient air threshold.

• Minimum Arrow Length—Set the minimum length of arrow to display. This filters out the 
display of arrows that are shorter than the minimum length, which helps you to visualize the 
regions with the largest displacements between image sets.

Validate the registration

In the Registration Validation section of the Deformation panel, click Validate to open the 
Registration Validation window. The information shown in the window is the registration 
information for the secondary image set that is listed in the Secondary Image field. To show 
information for a different image set, select the image set from the Secondary Image list.

The Registration Information section of the window contains details about the registration, 
including the specific primary and secondary image sets used in the registration and the rigid 
translation and rigid rotation parameters that were applied to the secondary image set in relation 
to the primary image set.
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NOTE
If the secondary image set is a deformed image set, “--” appears in the Secondary Image 
Date field.

The Validation Information section of the window lists the Target Registration Error value, if you 
calculated this value, and information about the approval of the registration. (See Calculate the 
Target Registration Error.) Comments that you type in the Comment field are saved with the trial 
and are included in the plan report.

Calculate ROI Similarity

The ROI Similarity section of the window lets you assess the quality of the image deformation by 
measuring the mapping between deformed ROIs and non-deformed ROIs.

NOTE
You can use the Propagate ROI feature to propagate ROIs from a record to your primary 
image set and then use the propagated ROIs as reference ROIs when you use the ROI 
Similarity feature. See Propagate ROIs from a record.

1 Click Add to add a row to the ROI Similarity table.
2 Define a pair of ROIs to compare by selecting one of the ROIs in the Reference ROI column and 

the second ROI in the ROI to Validate column.

Repeat steps 1 and 2 until you have defined all of the pairs of ROIs that you want to compare.

3 Click Compute to calculate the Dice Score, Mean Distance to Agreement, and Max Distance to 
Agreement values for the ROI pairs.

The Dice Score (DSC) (Dice Similarity Coefficient) is a measure of how well the two ROI volumes 
overlap one another. The results are reported as a value between 0.00 and 1.00: A value of 0.00 
indicates no overlap of the ROI volumes, and a value of 1.00 indicates a perfect overlap of the 
two volumes.

The distance to agreement value is calculated by first determining the shortest distance 
between each point on one ROI and the closest point on the other ROI. Then the maximum of 
these distances is chosen for each slice. Mean Distance to Agreement is the mean of these 
values across all slices. Max Distance to Agreement is the maximum of these values across all 
slices.

NOTE
The Max Distance to Agreement and Mean Distance to Agreement values may 
be slightly larger than expected because they are computed slice-by-slice. This 
may be most noticeable when the superior or inferior end of one ROI spans 
more slices than its corresponding ROI, or similar situations.

4 To delete an ROI pair, click the Delete check box for the pair and click Delete Selected. To delete 
all of the ROI pairs, click Select All and then Delete Selected.

Click Clear All to remove all of the check marks from the Delete check boxes.
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Calculate the Target Registration Error

You can assess the quality of the image deformation by calculating the Target Registration Error 
(TRE). TRE is the average of the distances between pairs of points: one point located on the primary 
image set and one point located on the deformed secondary image set.

1 In the Registration Validation section of the Deformation panel, click Place TRE Points. The 
Registration panel opens.

2 From the Image Set list in the Secondary section of the panel, select the deformed image set.
3 On the Points tab in the Automated Registration section of the panel, click Add New Fiducial 

Pair. The software adds a set of markers to the list.

To display the fiducial markers in the viewing windows, set the 2D and 3D display options as 
appropriate.

4 In a viewing window, use the Place fiducial markers tool to place each marker at the 
appropriate spot on the image set.

Select Primary below the viewing windows to move the point on the primary image set, and 
select Secondary to move the point on the secondary image set.

5 Repeat steps 3 and 4 for each pair of markers that you want to add.
6 To delete a pair of markers, select the pair in the table and click Delete Current Fiducial Pair.
7 Click Deformation at the top of the Syntegra window to open the Deformation panel.
8 In the Registration Validation section of the panel, click Validate. The Registration Validation 

window opens. The Target Registration Error value is shown in the Validation Information 
section of the window.

NOTE
The TRE value is also shown in the Mean distance between points field on the Points 
tab in the Registration panel.

Modify the registration

If you are not satisfied with the results of the registration, you can make modifications and register 
the image sets again.

• Rigid registration—return to the Deformation panel, make adjustments to the rigid registration 
settings as necessary, and register the image sets again. Additionally, if you used a bounding 
box to limit the volume, you can change the dimensions and location of the bounding box 
before you register the image sets again.
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• Deformable registration—return to the Deformation panel, verify that the deformed secondary 
image set that you want to modify is selected in the Secondary Image field, and click Reset 
Deformation. The following actions occur:

See Deformable image registration for information about registering and deforming image sets.

Approve the rigid registration

When you are satisfied with the results of the rigid registration, you can approve the registration.

1 In the Registration Validation section of the Deformation panel, type your name or initials in 
the Approved By field.

2 Click Approve Registration. The following actions occur:
• The secondary image set is labeled “Approved” in the Setup panel, and it cannot be moved.
• You can include the record dose for this secondary image set in prior dose.
• When you generate your plan report, information about the approved rigid registration is 

included in the plan report.

Reject the rigid registration

Once you have approved a rigid registration, if you need to remove the approval from the 
registration or set the secondary image set to Moveable, you must reject the rigid registration.

NOTE
When you reject a rigid registration, no changes are made to the rigid registration itself. 
The primary and secondary image sets remain registered as they were prior to your 
approval.

1 In the Rigid Registration section of the Deformation panel, verify that the secondary image set 
for which you want to reject the registration is selected in the Secondary Image field.

Image Deformation Being Reset Actions

CT image set • The deformed CT image set and the displacement 
vector field (DVF) that were generated during the 
deformation are deleted.

• The CT image set that was the source for the deformed 
CT image set becomes Moveable unless the image set 
has an approved rigid registration, in which case it 
remains Approved.

CT image set that includes prior dose The actions listed for the CT image set occur. In addition, 
the following also occur to remove prior dose:
• In the Prescriptions window, the Dose Display Mode is 

set to Current Dose Only for all trials.
• In the Manage Prior Dose window, the Scale Mode is 

set to Scale Factor for all trials.
• In the Manage Prior Dose window for all records in all 

trials, the setting in the Include column is set to None, 
the Scale Factor value is set to 1, and the Delivered 
Fractions value is set to the total fractions of the 
record.
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2 In the Registration Validation section of the Deformation panel, click Reject Registration. The 
following actions occur:

Approve the deformation

When you are satisfied with the results of the deformation, you must approve the deformation in 
order to deform dose using this deformation.

1 In the Registration Validation section of the Deformation panel, type your name or initials in 
the Approved By field.

2 Click Approve Registration. The following actions occur:
• The deformed image set is labeled “Approved” in the Setup panel, and it cannot be moved.
• You can include the record dose for this secondary image set in prior dose.
• When you generate your plan report, information about the approved deformed secondary 

image set is included in the plan report.

Reject the deformation

If you need to remove the approval from a deformation, you must reject the deformation.

1 In the Rigid Registration section of the Deformation panel, verify that the deformed secondary 
image set for which you want to reject the deformation is selected in the Secondary Image 
field.

Image Registration Being Rejected Actions

CT image set • The approval is removed from the rigid registration.
• The selected secondary CT image set becomes 

Moveable unless the image set has an approved 
deformed registration, in which case it remains Not 
Moveable.

CT image set that includes prior dose The actions listed for the CT image set occur. In addition, 
the following also occur to remove prior dose:
• In the Prescriptions window, the Dose Display Mode is 

set to Current Dose Only for all trials.
• In the Manage Prior Dose window, the Scale Mode is 

set to Scale Factor for all trials.
• In the Manage Prior Dose window for all records in all 

trials, the setting in the Include column is set to None, 
the Scale Factor value is set to 1, and the Delivered 
Fractions value is set to the total fractions of the 
record.

PET image set • The approval is removed from the rigid registration.
• The selected secondary PET image set becomes 

Moveable.
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2 In the Registration Validation section of the Deformation panel, click Reject Deformation. The 
following actions occur:

Image Deformation Being Rejected Actions

CT image set • The approval is removed from the deformed CT image 
set.

• The CT image set becomes Not Moveable.

CT image set that includes prior dose The actions listed for the CT image set occur. In addition, 
the following also occur to remove prior dose:
• In the Prescriptions window, the Dose Display Mode is 

set to Current Dose Only for all trials.
• In the Manage Prior Dose window, the Scale Mode is 

set to Scale Factor for all trials.
• In the Manage Prior Dose window for all records in all 

trials, the setting in the Include column is set to None, 
the Scale Factor value is set to 1, and the Delivered 
Fractions value is set to the total fractions of the 
record.
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5 Auto-Segmentation

Overview
Auto-Segmentation is a tool that automatically produces contours for normal tissues in CT image 
sets. Unlike model-based segmentation, Auto-Segmentation does not require you to position the 
anatomical structures on the CT image set. It uses probability-based atlases and a segmentation 
algorithm to find the regions of interest.

Auto-Segmentation comes pre-loaded with factory atlases, which include the abdomen, head and 
neck, male pelvis, and thorax atlases. After you select an atlas, Auto-Segmentation automatically 
segments the CT image set. 

NOTE
The Auto-Segmentation features are available only if you are licensed for Auto-
Segmentation. Contact Customer Support for licensing information.

Terminology
• Atlas is a group of organs or structures that are used by Auto-Segmentation to define the 

regions of interest. 
• Structures are the anatomical regions of interest. They are a sub-unit of an atlas.
• Factory atlas is a default atlas that is installed with the Auto-Segmentation tool. 
• Custom atlas is a copy of a factory atlas that you have modified to fit the needs of your clinic.
• Loading an atlas refers to adding the segmented ROIs to a plan so that you can view the 

segmented CT image sets.

Supported images

�CAUTION
Your segmentation results may be inaccurate if your image set contains any of the following 
characteristics:
• Contrast media
• Metal artifacts
• A derived image set (MIP, AvgIP, or MinIP)

You can use Auto-Segmentation on these image sets, but it is your responsibility to verify the 
results. 
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Auto-Segmentation supports the following types of image sets:

• CT image sets
• Maximum Intensity Projection (MIP), Average Intensity Projection (AvgIP), and Minimum 

Intensity Projection (MinIP) CT image sets
• Concatenated image sets

Image sets must meet the following requirements. For more information, see the Patients and 
Plans chapter of the Launch Pad Instructions for Use.

• Patient orientation must be head-first supine, except for the Male Pelvis atlas. For the Male 
Pelvis atlas, the patient orientation can be head-first supine or head-first prone.

• The label for the patient scan orientation (for example, head-first supine, or feet-first supine) 
should match the patient orientation at acquisition. Using a patient orientation that is not 
supported can cause Auto-Segmentation to fail.
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Set up Auto-Segmentation Preferences
In the Preferences window you can select a factory atlas or customize an atlas based on the needs 
of your clinic. You can perform the following tasks:

• Determine if you want to use a specific atlas in your clinic by setting it to active or inactive. An 
inactive atlas does not appear in the list of atlases when you use the Auto-Segmentation tool.

• Create a custom atlas. You can copy an atlas and activate the structures that you want to 
segment. You can change the structure names and colors. In addition, you can delete structures 
from a custom atlas.

• Reorder the appearance of the atlases in the list. You may want to move the most frequently 
used atlases to the top of the list.

NOTE
Because preferences are specific to a software version, the default settings are used 
unless you change the Planning and AcQSim3 Preferences for this software version. The 
Auto-Seg panel in the Preferences window is password-protected to prevent accidental 
changes. For more information, see the System Administration chapter of the Launch 
Pad Instructions for Use.

Open the Auto-Seg panel in the Preferences window
1 Click the Configure button in the Launch Pad window or click the Utilities menu in the 

Planning, AcQSim, or Image Fusion windows. 
2 Select Preferences from the list.
3 Select Auto-Segmentation from the Category list on the left side of the Preferences window.
4 Enter the password. The default password is Atlas. You can change the password after entering 

the correct password by clicking the Change Auto-Seg Password button and following the 
prompts. If you have any difficulties with your password, please contact Customer Support or 
your local distributor.

If you have a separate login name, you will create your own preferences. If all users log in using 
the same name, one set of preferences is used for all system users.

Set the atlas to active or inactive

Auto-Segmentation requires that you specify at least one active atlas and structure. To activate an 
atlas in the Preferences window, select the check box after an atlas’s name. To make a structure 
active or inactive, see Customize the atlas.

Customize the atlas

You can modify the list of structures that are displayed and segmented by activating or deactivating 
them. Factory atlases can be active or inactive, but you cannot make specific factory structures 
active or inactive. Since you cannot change a factory atlas, you will make a copy and then change 
the structures of the copied atlas. Then you can activate your custom atlas.
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1 To copy or view the names and colors for an atlas’s structures, select the radio button in front of 
an atlas’s name.

2 Click the Copy button. The copied atlas appears at the end of the atlas list. The structures that 
are included in the copied atlas are listed in the right side column.

3 Select the check boxes in the Active column for the structures that you want to segment.
4 To rename an atlas or structure, click on the Name field and type a new name. If you do not 

change the name, the copied atlas name and the original structure names will be displayed. You 
cannot change the name of an original factory atlas or structure.

5 To change the color of a structure, click on the Color field for a structure and select a different 
color.

6 To delete an atlas from Preferences, select the radio button next to the atlas name in the Select 
column and click the Delete button. You cannot delete an original atlas and its structures.

7 Click the Save Planning Preferences button or the Save AcQSim Preferences button to save the 
modifications, or click the Close button to exit without saving.

Reorder the list of atlases

You can set the order of the atlases that display.

1 Select the radio button in front of the atlas that you would like to move. You can only reorder 
atlases, not structures.

2 Click the up and down buttons next to the Copy button to position this atlas in the list.
3 Click the Save Planning Preferences button or the Save AcQSim Preferences button.
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Use Auto-Segmentation
Before using Auto-Segmentation for the first time, you can set up your preferences to determine 
which atlases and structures will be available for your clinic’s use. If you do not set up your 
preferences, you can still use the default factory atlases. See Set up Auto-Segmentation 
Preferences.

You can use Auto-Segmentation after creating a plan or from Launch Pad. After creating a plan and 
starting either Planning or AcQSim3, perform the following steps:

• If you want to segment a new atlas, click the Auto-Seg button and continue to Start Auto-
Segmentation for a plan.

• If segmented atlases are available, and you want to use one of the completed atlases, click the 
Auto-Seg button and continue to Load completed Auto-Segmentation atlases into a plan.

• If Auto-Segmentation is already started, the Auto-Segmentation Status window is displayed 
and you must wait until it is finished.  You can safely exit Pinnacle3 during segmentation. The 
segmentation continues to run even though you have ended your Pinnacle3 session. See Check 
Auto-Segmentation Status.

Atlases can be backed up and restored along with other Pinnacle3 data. For more information, see 
the Backup and Restore chapter in the Launch Pad Instructions for Use. 

To delete an atlas from a plan, see Delete ROIs and ROI contours.

Start Auto-Segmentation for a plan
1 In the Auto-Segmentation window, select an atlas.
2 Click the Start button. The Auto-Segmentation Status window opens.
3 After the segmentation is finished, click the Close button to close the Auto-Segmentation 

Status window. The Load Atlas ROI window opens. 
4 In the Load Atlas ROI window, select one or more atlases that segmented successfully. 

A status message notifies you whether the segmentation was successful. If the segmentation 
was not successful, see Analyze a failed segmentation.

If there are multiple structures in the atlases, click the Details button to verify the 
segmentation status of each structure.

5 Click the Load button. The software prompts you to verify the position and accuracy of the 
generated list of ROIs, as well as the ROI names and colors.

�CAUTION
Before loading an atlas into a plan, check the status of the structures. Failed structures will not be 
loaded into the plan.

Load completed Auto-Segmentation atlases into a plan
1 In the Auto-Segmentation window, click the Load Completed Atlases button.
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2 Select an atlas that segmented successfully. If the automatic segmentation was unsuccessful 
because of memory constraints, you can try to segment the atlas again when your system has 
fewer processes running.

3 Click the Load button. The software prompts you to verify the position and accuracy of the 
generated list of ROIs, as well as the ROI names and colors.

4 Make any necessary adjustments to the ROIs. 

�CAUTION
After the atlases are loaded, verify all structures for position and accuracy before continuing the 
planning process in Pinnacle3. 

Use Auto-Segmentation with Launch Pad

You can launch Auto-Segmentation before creating a plan.

1 In the Patient Select window in Launch Pad, add or select a patient. 
2 Click the Images button to select the image set. A previously Auto-Segmented image set has 

the value Yes in the Auto-Seg column. The column’s value is either Yes or empty. For more 
information about selecting images, see the Patients and Plans chapter in the Launch Pad 
Instructions for Use.

3 Click the Auto-Seg button. The Auto-Segmentation window opens.
4 Select an atlas.
5 Click the Start button. The Auto-Segmentation Status window opens. You can click the Close 

button to close the window.
6 Once the segmentation is finished, the Auto-Segmentation Status window reopens. 
7 Check the segmentation status.

NOTE 
You can return to the Auto-Segmentation Status window at any time by clicking an 
Auto-Seg button on a window. For more information, see Check Auto-Segmentation 
Status.

Troubleshooting

If you want to use Auto-Segmentation, you must have at least one active atlas. See Set up Auto-
Segmentation Preferences. If all of the factory and custom atlases are set to inactive, then the Auto-
Seg button in the Image Select window will be grayed out.

If the automatic segmentation was unsuccessful because of memory constraints, you can try to 
segment the atlas again when your system has fewer processes running.

Sometimes the atlas cannot be successfully segmented because of factors in the image (for 
example, dental artifacts) or unusual patient anatomy (for example, a missing lung). In these cases, 
it is unlikely that trying to segment the atlas again will yield different results. For more information, 
see Supported images.
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Check Auto-Segmentation Status
The Auto-Segmentation Status window allows you to check on the progress or cancel the 
segmentation.

If the segmentation is running and you want to perform other tasks, you can click the Close button 
to hide the Auto-Segmentation Status window. This will not affect the segmentation. You can 
return to the Auto-Segmentation Status screen at any time by clicking an Auto-Seg button on a 
window.

You can use Auto-Segmentation on different image sets at the same time. The number of image 
sets on which you use Auto-Segmentation at the same time is limited by the number of processors 
on the platform. For example, if you have four processors, you can start two instances of Auto-
Segmentation from Launch Pad on two image sets at the same time.

Analyze a failed segmentation

If the segmentation fails, the reason for the failure displays in the Auto-Segmentation Status 
window. Otherwise you can view the status for all of the atlases by clicking the Details button in the 
Load Atlas ROI window. The Auto-Segmentation Details window lists all the atlases and indicates 
whether their structures were successfully or unsuccessfully segmented.
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6 Model-Based Segmentation

Overview

NOTE
The organ model library is available in the Planning, AcQSim, and Syntegra windows 
only if you are licensed for Model-Based Segmentation (MBS).

The organ model library provides pre-defined ROIs for common structures. You can load single 
organ models into a plan, or you can load a group of organ models at the same time. Standard 
organ models in the organ model library are designed to adapt to CT data.

While traditional ROIs are built on contours, organ models are ROIs built on 3D polygonal surface 
meshes, or meshes. A mesh is defined by a collection of vertices. You can edit the vertices in a mesh 
manually and then automatically adapt the mesh to the patient image set. After adaptation, you 
can convert the mesh to the contours used in traditional ROIs.

NOTE
Standard ROI tools are unavailable until you convert a mesh to contours.

You can propagate meshes to secondary image sets. This allows you to adapt a mesh using data 
from another image set.

You can add new organ models to the library or add new samples to existing organ models. You can 
also create new organ model groups to match your clinical practices.

Use the organ model library

Load an organ model or group

To load an organ model or group, first display the Regions of Interest panel to the left of the 
viewing windows by clicking the Contours button at the top of the window.

Set up the display

While you can load organ models or groups in any view, we recommend the following four-window 
view.

1 From the View menu, select the view shown at the left. 

2 Click the Zoom correlated pointer 2D tool. 

3 Click and drag on a 2D window to define the area into which to load an organ model or group. 
When you release the mouse, the Correlated pointer tool is automatically selected.

4 Click in a 2D window to define the center of the first organ model or group you want to load.
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Load the organ model or group

The software loads the organ models at the intersection of the transverse, coronal, and sagittal 
views, which you can define using the Correlated pointer tool as described above. If there is no 
intersection, the software loads the organ models at the center of the selected window (2D 
windows) or at the center of the image set (3D windows).

When you load a group, the spatial relationships among the organ models in the group are not 
maintained; rather, the organ models are all loaded at the same center point. Manually position the 
organ models after you load the group.

1 Click the Load Organ button. The Load Organ Model window opens.
2 Select an organ model or group.

The software adds a new mesh for each organ model. The meshes are listed in the Regions Of 
Interest list and appear in the viewing windows in the same orientation as the image set. All 
organ models are centered where you defined in Set up the display.

The Load Organ Model window closes after you select an organ model or group. If you want 
the Load Organ Model window to remain open after you make a selection, click the Pin 
window button.

Manually position a mesh

A mesh must be positioned near the organ so that the software can adapt it to fit the organ. You 
can edit a mesh in order to position it closely to the organ. Select the mesh you want to manually 
position, then select the appropriate 2D editing tool.

NOTE
Editing a mesh does not change the organ model in the library; editing only affects the 
ROI in the current plan. To modify an organ model, see Customize the organ model 
library.

Please remember these points when manually positioning a mesh:

• You can toggle among the editing tools using the middle mouse button. You must set the 
Middle mouse window/level preference to No in order to use this feature. See Preferences in 
the Utilities chapter.

• You can undo the most recent edit by clicking the Undo mesh edit button.
• The mesh editing tools affect only the currently selected mesh. You have the option of clicking a 

mesh to select it for editing. To do so, set the Allow mesh tools to set current mesh preference 
to Yes. See Preferences in the Utilities chapter.

If you must make extreme changes to the mesh, we recommend you set the Replace mean mesh 
before adaptation setting to Yes in the Organ Model Settings window. See Create an organ model.

Tool Name Function

Move mesh Move the selected mesh to a new location. Select the mesh that you want to 
move, then drag it to the new location.
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Adapt a mesh

After you have edited the mesh so that it is positioned near the organ, you can automatically adapt 
it to match the image set to which the ROI is assigned.

NOTE
You can adapt a mesh to one image set while viewing another image set. See Propagate 
a mesh to secondary image sets for information on using organ models in plans with 
multiple image sets.

1 Click the Edit Options tab, and select the mesh you want to adapt.
2 Do you want to set custom adaptation settings or use default settings?

• Custom adaptation settings—go to step 3.
• Default settings—go to step 4.

3 Click the Organ Model Settings button. Adjust the adaptation settings in the Organ Model 
Settings window as needed. See Create an organ model.

4 If you want the adapted mesh to attempt to avoid a certain ROI, select the ROI in the Avoid ROI 
option list.

5 Do you want contours to be automatically updated as the mesh changes?
• Yes—set the Auto-update contours option to Yes.
• No—set the Auto-update contours option to No.

Scale mesh Scale the selected mesh. Select the mesh that you want to scale, then drag left 
and right to scale it horizontally or drag up and down to scale it vertically.

Rotate mesh Rotate the selected mesh. Select the mesh that you want to rotate, then drag 
clockwise or counterclockwise to rotate the mesh around its center.

Undo mesh edit Undo the last action that you performed on the mesh. Click the Undo mesh edit 
button again to redo the action.

Pull mesh Pull the surface of the mesh. Set the radius of the tool, then drag the cursor to 
pull the mesh. As you drag the cursor, vertices farther away from the original 
cursor location move in the direction you drag, but with a distance weighted by a 
Gaussian function and the radius of the tool. A dashed-line circle indicates the 
range of vertices affected as you drag the cursor.
The Mesh Modeling Options section on the Edit Options tab of the Regions of 
Interest panel contains a Lock edited vertices option. To prevent edited vertices 
from moving during adaptation, set the Lock edited vertices option to Yes before 
using this tool. Setting the Lock edited vertices option to Yes can be useful if the 
mesh is shifting toward neighboring organs during adaptation. Please note that 
the lock is not absolute; the edited vertices may still move slightly during 
adaptation.
Locked edited vertices display in a different color from other vertices. Click the 
Reset button to unlock all vertices in the mesh.

Tool Name Function
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NOTE
If you set this option to No, you can still update the contours manually by clicking the 
Update button next to this option.
If you convert a mesh to contours, edit the contours, change back to mesh display, and 
then edit the mesh, the edits you made to the contours are lost if the Auto-update 
contours option is set to Yes.

6 Click the Adapt Mesh button. The progress meter displays the percentage of the adaptation 
completed. Click the Stop button to stop the adaptation at any time.

After adaptation is complete, you can edit the mesh if needed and adapt it again.

NOTE
You can undo the adaptation by clicking the Undo mesh edit button.

Convert a mesh to contours

NOTE
You must convert a mesh to contours before performing many common ROI-related 
tasks, such as computing ROI statistics, generating dose volume histograms (DVHs), or 
setting IMRT objectives and constraints.

You have several options for converting a mesh to contours:

• Automatically convert a mesh to contours after each edit—set the Auto-update contours 
option to Yes.

• Convert a mesh to contours—click the Update button (next to the Auto-update contours 
option).

• Convert all meshes to contours—click the Convert All Mesh to Contours button.

After conversion, review the contours and edit them as needed. See Edit ROI contours in the 
Regions of Interest chapter.

NOTE
The most superior and/or inferior contours commonly require editing. 
You can correct small contouring anomalies by selecting Options - Clean ROI. See Clean 
ROIs in the Regions of Interest chapter.

Propagate a mesh to secondary image sets

When a plan has multiple image sets, you can propagate a mesh from the primary image set to the 
secondary image sets, as long as the source and target image sets are not the same. Once the mesh 
has been propagated, you can manually position and adapt the meshes on the secondary image 
sets.

NOTE
Before you propagate ROIs to secondary image sets, the image sets must be registered. 
If the image sets are not automatically registered (such as phased respiratory image 
sets), use Syntegra or Image Fusion to register the image sets. See the Image Fusion 
chapter.
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1 In the Regions of Interest panel, load, manually position, and adapt organ models in the 
primary image set. See Load an organ model or group, Manually position a mesh, and Adapt a 
mesh.

NOTE
While you can load organ models or groups in any view, we recommend the four-
window view shown at left.

2 Select Options > Propagate ROIs. The Propagate ROIs window opens.
3 Select the Propagate Mesh ROIs tab.
4 Select the check boxes for the meshes you want to propagate.
5 To automatically adapt the meshes after propagation, select the Adapt after Propagation check 

boxes for the meshes to be propagated.
6 Select the secondary image sets to which you want to propagate the meshes in the Select 

target data sets list.
7 Click the Propagate button.

Use the options below the viewing windows to display the different image sets, then change 
the colors of the ROIs so that they are easier to distinguish from one another.

To review, manually position, and adapt propagated meshes, first select the image set to which 
you propagated the organ. At the bottom of the window, select the Secondary option, then 
select the image set to which you propagated the organ from the Secondary option list.

After you manually position and adapt the meshes on the secondary image sets, you can use 
ROI expansion/contraction tools to combine the different ROIs for a particular structure into 
one composite ROI in the primary image set. You can use two different methods:

• Use ROI expansion/contraction tools to combine the ROIs from the different image sets into 
a single ROI in the primary image set. This method is slower, and results in only one 
additional ROI (the new composite ROI) in the primary image set. See Expand and contract 
ROIs in the Regions of Interest chapter.

• Propagate the ROIs from secondary image sets back to the primary image set, then use ROI 
expansion/contraction tools to combine the ROIs into a single ROI. This method is faster, and 
results in multiple additional ROIs (the new composite ROI and the propagated ROIs) in the 
primary image set.
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Customize the organ model library
You can create custom organ models, add samples to existing organ models, and add or delete 
organ models and groups.

The organ model library is password-protected to prevent accidental overwriting of mesh data. The 
default password is p3mbs.

NOTE
After you enter the default password, you can set a custom password by clicking the 
Change Password button in the Organ Model Library window.

Create an organ model

You can create custom organ models to use as organs or as dose-shaping ROIs.

NOTE
Organ models are saved in head-first supine orientation. When you load an organ, the 
software orients it correctly to match the patient image set, allowing you to use a single 
organ model for multiple treatment orientations.

1 How do you want to create the new organ model?
• From a new ROI—create an ROI and draw contours as needed. Go to step 2.
• From an existing ROI—modify the ROI contours as needed and go to step 2.
• From an existing organ model—load the organ model and go to step 5.

2 Select Options - Convert Contours to Mesh. The Mesh Generation window appears.

The window displays the current ROI volume and suggested number of vertices for the mesh.

NOTE
You can continue to edit the ROI with the Mesh Generation window open. When you 
are finished editing, click the Recompute button to update the ROI volume and 
suggested number of vertices.

3 Enter the number of vertices for the mesh in the Requested # of vertices field, or accept the 
value that the software suggests. The minimum number of vertices is 200.

NOTE
Setting an extremely large number of vertices increases the adaptation time for an 
organ model and may not produce better results. The practical limit for the largest organ 
models is around 3,000 vertices.

4 Click the Generate New Mesh button. A status window appears while the software generates 
the mesh.

5 Name the ROI with the name you want to appear in the organ model library.
6 Set the following default settings for the new mesh:

• Color
• 2D and 3D display modes (must be mesh display modes)
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• Line width
• 3D editing tool radius

7 Adjust the mesh (if necessary) using the mesh editing tools. See Manually position a mesh.
8 Click the Organ Model Settings button on the Edit Options tab. The Organ Model Settings 

window appears. Adjust the settings as needed.

Setting Description

Replace mean mesh 
before adaptation?

Replaces the mean mesh with the displayed mesh before adaptation. Set this option to Yes 
only when the edited mesh differs significantly from the original mesh.

Clean ROI after 
adaptation?

Removes small contour anomalies after adaptation. Set the Minimum contour area to a 
value appropriate for the size of the mesh. You must set the Auto-update contours option 
to Yes for ROI cleaning to occur.

Smooth mesh after 
adaptation?

Smooths the mesh by moving vertices based on the averages of surrounding vertices. You 
can also manually smooth the mesh by clicking the Smooth Mesh button on the Edit 
Options tab of the Regions of Interest panel.

Organ Flexibility Sets the amount of shape variation allowed during adaptation. Use higher values for organs 
with significant variation (for example, the rectum) and lower values for organs with less 
variation (for example, the femur).

Proximity Weight As the software searches for the features that define the organ, this field sets the 
importance of features detected at greater distances from the mesh. Enter a higher setting 
to prevent the mesh from attracting to features that are farther away from the mesh.

Min CT Value Sets the minimum CT value the software uses when searching for features during 
adaptation.

Max CT Value Sets the maximum CT value the software uses when searching for features during 
adaptation.

Gradient Direction Sets how the software determines which gradients are strong or weak when it searches for 
features during adaptation. Strong features are those that define the organ. Select one of 
the following:
• Positive—Software treats a positive gradient as a strong feature and a negative gradient 

as a weak feature. Choose this option for a structure that has a lower CT value than the 
surrounding tissue, such as the brain.

• Negative—Software treats a negative gradient as a strong feature and a positive 
gradient as a weak feature. Choose this option for a structure that has a higher CT value 
than the surrounding tissue, such as the bladder.

• Unsigned—Software treats gradients with larger magnitudes as strong features and 
gradients with smaller magnitudes as weak features.

Gradient Clipping Sets whether the software uses hard or soft clipping in relation to the Max Gradient 
CT#/mm and Gradient Direction when searching for features during adaptation. Hard 
clipping finds fewer features; soft clipping finds more features.

Max Gradient CT#/mm Sets the maximum gradient value the software uses when searching for features during 
adaptation.

Avoid CT Values Sets a threshold value and instructs the software to avoid CT values either greater than or 
less than that value when searching for features during adaptation.
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9 Select Options - Organ Model Library. When the software prompts you, enter the password. 
The default password is p3mbs. The Organ Model Library window appears.

NOTE
After you enter the default password, you can set a custom password by clicking the 
Change Password button in the Organ Model Library window.

10 Select the group to which you want to add the new organ model.

NOTE
You can create a custom group at a later time and move the mesh to this group. See 
Create a group.

11 Click the Save ROI <Organ_Name> as New Model button. 
12 When the software prompts you, enter your name and click the Done button. 

The new mesh is labeled with your name and the current date and time, and is saved in the 
group you selected. The Samples field is set to one sample. The Samples field will update as 
you add more samples to the mesh.

Add a sample to an organ model

You can generate a sample to add to an existing organ model from two sources: from image data or 
from existing contours.

The software adds samples to an organ model in a weighted fashion; as you add more samples, 
each sample has progressively less influence on the organ model. We have found that after the first 
five to ten samples, adding samples does not improve substantially the effectiveness of the organ 
model.

NOTE
The mesh must have the same number of vertices as the organ model to which you wish 
to add the sample. Begin by loading the organ model to which you want to add a sample 
in order to ensure the sample you create has the same number of vertices.

Limit Feature Search Limits the search for features along a triangle normal. When the software finds no features 
after a specific number of consecutive steps (based on the feature searching settings Min 
CT Value, Max CT Value, and Gradient Direction), the software ignores potential features 
farther out along the triangle normal.
Select None if you do not want to limit the search for features along a triangle (from 10 mm 
inside the mesh to 10 mm outside, with steps every 1 mm). Select Half to stop the search 
for features when 11 consecutive steps find no features, or Full to stop the search when 3 
consecutive steps find no features. The standard setting is None; select Half or Full when 
the mesh is attracting to features that may be false features because they are located in 
areas where the CT value is outside the range defined by the Min CT Value and Max CT 
Value.

Settings acceptable for 
adaptations?

Sets whether the organ model can be adapted. Select No when creating a mesh to be used 
as a dose-shaping ROI. This prevents you from unintentionally adapting this mesh to the 
patient data. For example, you might use this setting for a nodal neck volume.

Setting Description
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Add a sample generated from image data

Generate a sample by loading an organ model, editing it, and adapting it to the patient image set.

1 Load into a plan the organ model to which you want to add a sample. See Load an organ model 
or group.

2 Manually position and adapt the mesh. See Manually position a mesh and Adapt a mesh.
3 Select Options - Organ Model Library. When the software prompts you, enter the password. 

The Organ Model Library window appears.
4 Select the organ model to which you will add a sample.
5 Click the Add ROI <Organ_Name> as New Sample button. The software averages the current 

mesh into the mean mesh for the organ model in the organ model library.

NOTE
You can display the mean mesh at any time by setting the Show Mean option in the 
Organ Model Settings window to Yes.

Add a sample generated from contours

Generate a sample from contours you have already created by loading an organ model and 
automatically modifying the mesh to match the contours.

1 Load into a plan the organ model to which you want to add a sample. See Load an organ model 
or group.

2 Set the 2D Display mode to Contour.
3 Delete, create, and edit contours as necessary to create the desired shape.
4 If necessary, check the relative positions of the contours and the mesh. A mesh must be 

positioned near the contours so that the software can adapt it to fit the contours.
a Set the 2D Display mode to Mesh.
b Click the Organ Model Settings button on the Edit Options tab. In the Organ Model Settings 

window, set the Show Colorwash option to Yes.
c Compare the relative positions of the contours and the mesh and adjust the position of the 

mesh if necessary.
5 Select Options - Fit Mesh to Contours.

The software modifies the existing mesh to fit the new contours while keeping the number of 
vertices constant. The display switches to a mesh display when the process is complete.

You can compare the mesh to the contours by setting the Show Contours and/or Show 
Colorwash options in the Organ Model Settings window to Yes. If the new contours differ 
significantly in size and shape from the original mesh, you may need to select Options - Fit 
Mesh to Contours several times to achieve the desired result.

6 Select Options - Organ Model Library. When the software prompts you, enter the password. 
The Organ Model Library window appears.

7 Select the organ model to which you will add a sample.
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8 Click the Add ROI <Organ_Name> as New Sample button. The software averages the current 
mesh into the mean organ model in the organ model library.

Manage the organ model library

Select Options - Organ Model Library. When the software prompts you, enter the password. The 
Organ Model Library window appears.

Once the organ model library is open, you can perform several different tasks as described below.

Change the password

The default password is p3mbs. Click the Change Password button, and when the software 
prompts, enter the old password, then enter the new password, then re-enter the new password to 
confirm it.

Import an organ model

You can load an organ model into a plan from a file. Once the organ model is loaded, you can also 
save it to the library.

1 On the Organ Models tab, click the Import Organ button. The Select ROI File window appears.
2 Navigate to and select the appropriate .template.roi file for the organ model, then click the OK 

button.

Delete an organ model

On the Organ Models tab, select the organ to be deleted and click the Delete Model 
<Organ_Name> from Library button.

Create a group
1 On the Groups tab, click the Create New Group button. A new group appears in the list.
2 Select the new group and enter a name in the Edit Group Name field.

Rename a group

On the Groups tab, select the group and enter a new name in the Edit Group Name field.

Delete a group
1 On the Groups tab, select the group and click the Delete Group button.
2 When the software prompts you to confirm the deletion, click Yes.

Move an organ model to a different group
1 On the Groups tab, select the organ model to be moved from the Model to Move option list.
2 Select the group to which you want to move the organ model from the Destination Group 

option list.
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Back up and restore organ models

You can back up and restore the organ model library in Launch Pad. See the Launch Pad Instructions 
for Use.

Restore original organ models and groups

In addition to restoring organ models that you have backed up, you can also restore the original, 
unmodified organ models and groups. As you restore the original organ models and groups, you 
can choose whether to overwrite modified organ models and groups with the original versions.

NOTE
If you choose to overwrite modified organs and groups with the original versions, all 
changes you have made to the organs and groups are lost.

Click the Restore Factory Settings button, and when the software prompts, choose whether to 
overwrite specific organ models and groups.
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7 Regions of Interest

Overview
A region of interest (ROI) is a contour or set of contours that defines the limits of an area which is 
important in treatment planning, such as the target volume or a radiation-sensitive structure. 
When using CT images for planning, only the structures for which you want to generate volumetric 
or statistical information need to be defined as ROIs. In contour-based planning, all structures to be 
defined by contours should be entered as ROIs and assigned densities.

Any number of contours can be used to define an ROI, and any number can be drawn on a single 
image slice. You can draw contours on transverse, sagittal, or coronal 2D images, but all contours 
for a single ROI should be drawn on slices with the same orientation.

The volume units (voxels) inside the ROI contours may or may not be included in the ROI volume, 
depending on how you define the contours. If a contour is entered within another contour, the area 
bounded by the two contours is included in the ROI. The gray areas in the illustration below indicate 
portions of the ROI that are included in the ROI volume.

NOTE
You can quickly define ROIs by loading organ models, adapting them to the image set, 
and then converting them to contours. The organ model library is available in the 
Planning, AcQSim, and Syntegra windows only if you are licensed for Model-Based 
Segmentation (MBS). See Model-Based Segmentation.
You can also quickly define ROIs by using the Auto-Segmentation tool, which 
automatically produces contours for normal tissues in CT image sets. The Auto-
Segmentation tool is available in the Image Select, Planning, and AcQSim windows only 
if you are licensed for Auto-Segmentation. See Auto-Segmentation.

�CAUTION
Be careful when creating ROIs that approach the surface of the patient. Incorrect positioning of 
ROIs, particularly when assigning densities or using bolus, can affect the accuracy of the plan. For 
example, if a lung contour touches the surface of a patient and the air/tissue threshold is higher 
than the lung density, the lung will be filled with air. Review the placement of all ROIs, whether 
manually or automatically generated.

ToolsClick the Contours button at the top of the window to display the Regions of Interest panel. 

These ROI contours... translate to these ROI volumes. 
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Sort ROIs

You can manually order the list of ROIs.

1 Select Options > Sort.

The Sort window appears.

2 Click the ROI tab.
3 Select an item and use the arrows to move it:

Display ROIs on all image sets

To toggle the Display ROIs on all data sets option, select Options > Display ROIs on all data sets. 
You can also toggle the default setting for this option in the Preferences window.

When the Display ROIs on all data sets option is turned on, ROIs that you draw appear on every 
image set in the plan. When the Display ROIs on all data sets option is turned off, ROIs that you 
draw appear only on the image set in which the ROI was drawn.

NOTE
If the 2D display mode for the ROI is Contour and the Display ROIs on all data sets 
option is turned on, the ROI only appears on other image sets if the slices in the image 
sets align exactly with the slices in the image set on which the ROI was drawn.

Control Description

Move item to the top

Move item up

Move item down

Move item to the bottom
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Draw contours
Follow the steps below to begin drawing contours. Then you can manually contour structures using 
the Create contour paintbrush tool, Create contour freehand tool, and Create contour point by 
point tool.

Begin to draw contours
1 Click Add ROI. A new ROI is added to the ROI list with a default name.

Select the ROI to which you want to add contours.

2 In a 2D viewing window, display the image you want to use for contouring. You may want to 
zoom in on the structure to facilitate drawing.

3 If you want to rename the ROI, delete the automatically generated name (e.g., ROI_1) and type 
a new one in the ROI Name field.

4 If you have multiple image sets, select the image set to associate with the ROI.
5 In the ROI Type option list, select the type to associate with the ROI.
6 Draw the contours as needed. The following sections explain how to use the drawing tools. The 

number of contours you define appears as you complete the contours.

You can use the n and p keys (next and previous slice) to scroll through the slices of the image 
set. You can also press the up arrow key to move to the next image or the down arrow key to 
move to the previous image. You can toggle the direction that the arrow keys scroll through the 
image set in the Preferences window.

7 To update the volume display and the volume for the selected ROI, click Recompute.

�CAUTION
Review all contours to verify that they are correct for your plan.
The gray area around the perimeter of the viewing window represents the edge of the density 
grid; do not draw ROIs outside this grid. The software does not compute areas of ROIs that are 
outside the density grid.

You can edit ROIs using the procedures described in the Edit ROI contours section.

Use the Create contour paintbrush tool

Use the Create contour paintbrush tool to “paint” an ROI on a slice. The tool provides contour 
drawing, editing, and deleting functions, depending on where you use it.

1 Follow the steps in Begin to draw contours.
2 Enter the diameter (mm) of the brush that you use to “paint” the ROI in the field below the 

Create contour paintbrush tool.
3 On the Edit Options tab of the Regions of Interest panel, set the Auto-close painted contours 

option. If you want painted contours to be closed and filled automatically, leave this option set 
to Yes. In some situations, such as the contouring of organ walls, you may want to set this 
option to No.
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4 Select the Create contour paintbrush tool, then position the cursor at the point on the slice 
where you want to start, edit, or delete the contour.

The tool works differently depending on where you click.

• If you click on an image where there is no contour, a new, circular contour appears. Drag to 
create a thick line; wherever you move the cursor, the circle is filled in for the ROI.

• By clicking inside the edge of an existing contour, you can push out the edges of the contour.
• If you click outside, but near, an existing contour, the tool functions as an eraser, and the 

contour is erased wherever you move the tool. You can use this method to push in the edges 
of a contour.

5 Go to the next slice, draw a contour for the ROI, and repeat the previous steps.

Draw continuous line contours

Use the Create contour freehand tool to define contours by drawing a continuous line like the one 
shown below.

1 Follow the steps in Begin to draw contours.
2 Select the Create contour freehand tool, then drag around the limits of the region until you 

have closed the contour.
3 Go to the next slice and repeat the previous steps to draw a contour for the ROI.

Draw point-by-point contours

Use the Create contour point by point tool to define contours by “dropping” a series of points, as 
shown below.

1 Follow the steps in Begin to draw contours.
2 Select the Create contour point by point tool and click where you want to start the contour. A 

small box appears and indicates the point you defined.
3 Click where you want to add the next point to the contour. You can also drag the point to the 

position you want. A line is drawn between the two points. Define the remaining points in the 
same manner.
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4 To close the contour, click on the first point you defined. The square point markers disappear.
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Change the ROI display
The options on the Display Options tab of the Regions of Interest panel let you select different 
display options for the selected ROI, including color, 2D display method, 3D display method, box 
size, and line width.

For information on ROI precision, see the Pinnacle3 Planning Reference Guide.

Color

The ROI display color is automatically selected when the ROI is added. The ROI is displayed in the 
same color in both 2D and 3D images. To change the display color, select the ROI and make a 
selection from the Color list.

2D display

To select a different 2D display method for an ROI, select the ROI and make a selection from the 2D 
Display list. You have the following options:

• Contour—The ROI is shown as a line contour. This is the default 2D display setting. The contours 
are only visible in the orientation used to draw contours.

• Colorwash—The ROI is shown only as a colorwash. Although the ROI is visible in all three 
orientations, you cannot manually draw contours in this display mode.

• Both—The ROI is shown as both a polygonal wire surface and colorwash, and it is visible in all 
three orientations. The polygonal wire surface will appear in oblique views.

• Poly—A polygonal wire surface is generated for the ROI, and a contour is drawn on the 2D slices 
where the polygonal wire surface intersects the slice. Use this display to see a contour for the 
ROI on other orthogonal slices, or to view an ROI on oblique slices and in multiple data sets. 
When displaying large ROIs, you may notice a significant decrease in system speed.

• Mesh—The ROI is shown as a mesh.

NOTE
Mesh display is available only if you are licensed for Model-Based Segmentation (MBS). 
See the Model-Based Segmentation chapter.

• Off—The ROI is not displayed in 2D images. You can contour with the display off, but each 
contour will “disappear” until you turn on the 2D display for that ROI.

When manually drawing ROI contours, you need to select a drawing mode (Contour, Both, or Poly). 
To view ROIs on 2D images in all three orientations (transverse, sagittal and coronal), select 
Colorwash, Both, or Poly as the display mode.

3D display

ROIs can be displayed in 3D mode with or without the patient data. The 3D display mode 
determines how the ROI appears in all 3D windows. For all display modes, a wireframe is used 
when rotating the volume and when the 3D image is not rendered.
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To select a different 3D display method for an ROI, select the ROI and make a selection from the 3D 
Display list.

If you select any 3D display mode besides Wireframe, you must render the image before the ROI 
surface will be visible. To do this, right-click the viewing window in which you want to render the 
ROI and select 3D - Render. 

You have the following 3D display options:

• Wireframe—Each contour in the ROI is drawn as a wireframe.

• Surface—The ROI appears as a solid surface after rendering. Use this option to generate surface 
displays of large ROIs.

• Trans Surf (Transparent Surface)—The ROI is rendered as a transparent surface. Any ROIs or 
other objects within or behind the transparent ROI are visible.

NOTE
The default step size for rendering ROIs is 0.1 cm. If you increase this value in the Data 
Set Specifications window (for example, to 1.0), you may “lose” parts of the image, 
since the software will render a very coarse image in a 3D window. This affects Surface 
and Trans Surf displays only.

• Poly Wire (Polygonal Wire)—The ROI is rendered with a polygonal wireframe.

NOTE
In order to add annotations to wireframe ROIs, you must click directly on one of the 
wires.

• Poly Surf (Polygonal Surface)—The ROI is rendered using a solid polygonal surface. This option 
can slow display speed when rendering large ROIs.

• Trans Poly (Transparent Polygonal Surface)—The ROI is rendered using a transparent polygonal 
surface. Any ROI within or behind the transparent ROI is visible.

• Mesh Wire—The ROI is rendered with a polygonal wireframe mesh.
• Mesh Surf—The ROI is rendered using a solid polygonal surface mesh.
• Trans Mesh—The ROI is rendered using a transparent polygonal surface mesh.

Wireframe Surface
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NOTE
Mesh display is available only if you are licensed for Model-Based Segmentation (MBS). 
See the Model-Based Segmentation chapter.

NOTE
Because mesh displays render quickly, you may want to choose an automatic rendering 
option when viewing meshes. For information on rendering options, see 3D menu 
options in the View Patient Data chapter. For information on meshes, see the Model-
Based Segmentation chapter.

• Off—The ROI is not displayed in 3D images.

Display ROI without patient data
1 Select Utilities - Data Sets. 

The Data Set Specifications window appears.

2 Select No for the Render parameter setting.
3 Right-click the viewing window in which you want to render the ROI and select 3D - Render.

NOTE
If the patient data already appears in the viewing window, you must make a change to 
the display (for example, use the Rotate tool to rotate the display) in order for the 
patient data to disappear.

Display ROI with transparent patient data

When patient volumes are rendered using skin or bone rendering, ROIs are often obscured from 
view because of the patient data. To see ROIs and patient data together in a 3D image, as shown, 
you can make the patient surface transparent. 

1 Create a 3D viewing window or enter 3D mode in an existing viewing window.
2 Select the 3D display mode for the ROIs to be displayed with the patient data.
3 Right-click the viewing window where you want to display the patient data and select 

3D - Transparent Dataset On.
4 Right-click the viewing window again and select 3D - Render. 
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Box size and line width

Click the Box Size list to change the size of the points on a selected contour. Use the Small box size, 
for example, on continuously drawn curves to edit individual points in the curve more easily.

Click the Line Width list to change the line width for a selected ROI.

Display the contour outline in BEVs

To display ROIs in beam’s eye view DRRs, in the Display outline in BEV DRR field select Yes. In each 
BEV window, the outlines of the contours appear.
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Propagate ROIs from a record
If a plan has a record as a result of copying another plan, you can propagate ROIs from the record to 
the primary image set with or without deformation. 

NOTE
You can only propagate from a record if you have the Dynamic Planning option.

1 Open the Propagate ROIs window using one of the following methods:
• From the Regions of Interest panel or the Record Viewer window, select Options > 

Propagate ROIs.
• From the Registration Validation section of the Deformation panel in Syntegra, click 

Propagate ROIs.

The Propagate ROIs window opens.

2 Select the Propagate Dynamic Planning ROIs tab.
3 Select the ROI Source to use.
4 Select the check boxes for the ROIs that you want to propagate.
5 Specify whether to apply deformation when the ROI is propagated from the record.
6 Specify whether to replace existing ROIs in the plan with ROIs that are propagated from the 

record.
• Yes—one of the following will occur:

– If the name of an ROI that you selected to propagate matches the name of an ROI on the 
primary image set in the plan, then the ROI in the plan will be replaced with the 
propagated ROI.

– If none of the ROI names match, then the propagated ROI will be added as a new ROI in 
the plan.

– If the name of an ROI that you selected to propagate matches the name of an ROI in the 
plan, but that ROI is not on the primary image set, then the propagated ROI will be added 
as a new ROI on the primary image set in the plan.

• No—the propagated ROI will be added as a new ROI on the primary image set in the plan.
7 Click the Propagate button.

If you selected Yes to replace existing ROIs with propagated ROIs, dose may become invalidated 
or your dose distribution may change if replacing the existing ROI changes the shape of a block 
that is based on the ROI or if you use prescriptions that prescribe to an ROI, for example. 
Review dose, prescriptions, DVHs, scorecard goals, and other elements of the plan that rely on 
ROIs after you propagate the ROIs.

After you propagate, you can use ROI expansion/contraction tools to combine the different ROIs for 
a particular structure into one composite ROI in the primary image set.
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Delete ROIs and ROI contours
You can remove entire ROIs or particular ROI contours with the following tools and menu options.

Delete ROIs
1 Click the Delete ROI button. 

The ROI Delete window opens.

2 Select the ROIs that you want to delete:
• Select an ROI by selecting the check box to the left of the ROI name.
• Click the Select Auto-Seg button to select all ROIs that were created by the Auto-

Segmentation tool.For information about Auto-Segmentation, see the Auto-Segmentation 
chapter. 

• Click the Select Personalized Planning button to select all ROIs that were used to create the 
personalized plan. For information about Personalized Planning, see the P3IMRT Instructions 
for Use.

If the ROI cannot be deleted due to a dependency, the name of the ROI appears in the panel on 
the right side. To view a list of the objects that are associated with the ROI, click the Examine 
objects button.

NOTE
You cannot delete an ROI that has a prescription, beam, dose volume histogram (DVH), 
or IMRT objective/constraint associated with it. 

3 Click the Delete Selected ROIs button.

Delete a contour from an ROI
1 To delete one or more contours from a slice associated with the current ROI, click the Delete 

contour tool. Drag to draw a box over any contours that you want to delete that are associated 
with the current ROI.

2 To remove all contours for an ROI without removing the ROI from the list, select 
Options - Delete All Contours.

The software prompts you for confirmation before removing the contours.

3 To remove the last contour or set of contours you added to an image, click the Undo last 
contouring button on the Edit Options tab of the Regions of Interest panel.
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Copy ROI contours
You can copy existing contours from the current slice to adjacent slices or to a range of slices. You 
can transfer ROI contours from one data set to another. In addition, you can create a copy of an 
entire ROI. The following sections describe your options.

Copy contours from last slice

You can copy all the contours from a slice you just edited to another slice.

1 Click the Edit Options tab in the Regions of Interest panel.
2 To copy all the contours to the

• previous slice, click the Previous button.
• next slice, click the Next button.
• current slice, click the Current button. 

Contours are not copied if the slice to which you want to copy contours already contains contours 
for the ROI.

If you have a transverse 2D viewing window active, the software displays the slice onto which you 
just copied the contours.

Copy a contour to a range of slices
1 Select the Select contour tool and click on the contour to be copied.
2 Select Options - Copy Contour to Slices.

The Copy Contour window appears.

3 Enter the minimum and maximum coordinates for the slices to which you want to copy the 
selected contour.

4 Click the OK button to copy the contour to the specified slices. Click the Cancel button if you do 
not want to copy the contour.

�CAUTION
Review the copied contour(s) to verify that it is correct for your plan. Make any necessary 
changes.

Transfer contours to another data set

You can transfer ROI contours from one data set to another. If you select a different data set for an 
ROI in the Data Set option list of the Regions of Interest panel, a window appears. Select whether 
to replace the ROIs existing contours or create an ROI that contains the transferred contours.

Note that contours cannot be transferred exactly because data sets can have different orientations 
and resolutions. Instead, new contours are generated by autocontouring the 3D shape enclosed by 
the original contours. The new contours are always transverse.
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Create a copy of an ROI
1 At the top of the Regions of Interest panel, select the ROI to copy.
2 Select Options - Copy Current ROI. The new ROI appears in the list with “_COPY” appended to 

its name.

If the ROI had a mesh associated with it, the mesh is copied too. See the Model-Based 
Segmentation chapter.
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Edit ROI contours
The following sections explain your options for editing ROI contours.

Delete a section of a contour

You can use the Split contour tool to divide a single contour into two contours on the current ROI 
and then delete the unwanted portion of the contour. This tool is most useful for editing contours 
generated using the autocontouring tools.

In the following example, some soft tissue was included in an automatically generated lung contour. 
To separate the lung from the soft tissue, select the Split contour tool and position the cursor on 
point 1 of the current ROI. Click and drag the cursor to point 2 to create two separate contours. If a 
line does not appear between the two contours, try again. The starting and ending points for 
defining the separation line must be outside (not on) the contour you are attempting to separate. 

After separating the contours, you can delete the unwanted contour using the Delete contour tool.

Edit ROI contours using the editing tools
1 Click on the contour to select it. When the contour is selected, all of the points in the contour 

are displayed with square point markers.

NOTE
When editing a contour, zoom in on it to see the points to be edited.

2 Select an editing tool to edit the contour.
• When adding or removing points, click at the position of the point to be added or removed.
• When using the Edit contour or Move contour tools, click on the point or contour to be 

moved and drag the point to the new position.

1

2
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You can use the following editing tools.

Tool Description

The Select contour tool allows you to select a contour for editing by clicking it.

After selecting a contour with the Select contour tool, use the Add contour point tool to add a point 
after the last point that was added.

Use the Edit contour tool to move points in the selected contour using a “rubber band” effect. Click 
on the point you want to reposition and then drag the point to the new location.

After selecting a contour with the Select contour tool, use the Insert contour point tool to place a 
point between two previously defined contour points. To insert a point, position the cursor between 
the two points and press the left mouse button. You can then position the point as desired.

After selecting a contour with the Select contour tool, use the Remove contour point tool to remove 
points from the contour. Position the cursor on the point you want to remove and press the left 
mouse button to remove it.

Use the Move contour tool to move the contour to a new location on the same slice. (If you do not 
select the contour first but just click on this tool, the points do not appear, which allows you to place 
the contour accurately.) Click the contour you want to move and drag it to a new location.

Use the Scale contour tool to scale the selected contour. (If you do not select the contour first but 
just click on this tool, the points do not appear, which allows you to scale the contour accurately.) 
Select the contour you want to scale, click on a point, then drag it left and right to scale it horizontally 
or drag up and down to scale it vertically.
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Interpolate contours
If you do not want to draw contours for a structure on every slice of a data set, you can use the 
program’s interpolation features to generate contours between contours you drew on non-
consecutive transverse slices. The individual interpolated contours that are displayed indicate 
where the edge of the interpolated volume intersects the transverse slices.

Interpolating between contours
1 Draw contours on at least the first and last slices that contain the ROI. The more contours you 

draw within the ROI, the more accurate the interpolation will be.
2 On the Edit Options tab, click the Interpolate Between Contours button.
3 Once the interpolated contours have been generated, you can use the ROI editing tools to move 

and reshape the contour.
4 If you are not satisfied with the results, you can edit the contours or click the Delete All 

Interpolated Contours button to delete them.

Advanced interpolation
1 Use one of the ROI drawing tools to draw two or more contours for the structure that you want 

to interpolate. Using more contours will produce better results from the interpolation.
2 Select Options - Advanced Interpolation.

The Contour Interpolation window appears.

3 Select the ROI to be interpolated.
4 Select the type of interpolation to generate the contours:

• Based on overlap, without curve centering—This option generates interpolated contours 
only if the defined contour pairs overlap.

• Based on overlap, with curve centering—With this option, contours are interpolated 
regardless of whether they overlap. Contour pairs are first centered, the interpolated volume 
is generated, and the drawn contours are shifted to their correct positions, as illustrated 
below. 

When contours overlap, there is little difference between these two methods.

The original contours are centered The interpolated contours are generated 
and then shifted based on the positions of 
the original contours
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5 Select whether to load the contours into a new ROI. If you set this option to Yes, all of the 
interpolated contours, along with copies of the original contours, are moved to a new 
“destination” ROI. The name for the new ROI is generated by appending “_INTERP” to the 
original ROI name. 

6 Click the Interpolate between all contours of ROI button to generate the interpolated 
contours.

�CAUTION
Review the contours to verify that they are correct for your plan. The interpolation might 
produce unexpected results if the ROIs do not have the same approximate shape.
7 Once the interpolated contours have been generated, you can use the ROI editing tools to move 

and reshape the contour. If you are not satisfied with the results, you can click the Delete 
Interpolated Contours button to delete the interpolated contours, or you can edit the 
appropriate contours.
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Expand and contract ROIs
You can use the expansion and contraction feature to generate the following:

• New contours based on existing ROIs, plus or minus a margin. In the example below, the 
software creates a new ROI by expanding the source ROI by a uniform margin of 0.5 cm.

• New contours that are combinations of existing ROIs. The existing ROIs are unaffected by this 
operation.

When you expand or contract an ROI group, the action is performed on the exterior border of all 
the ROIs combined.

1 Click the ROI Expansion/Contraction button on the Edit Options tab.

The ROI Expansion/Contraction window appears. 

2 Click the appropriate tab to use individual ROIs or ROI Groups.
3 Select the Source check box for the ROI to be used as the source. To combine two or more ROIs, 

select the Source check boxes for multiple ROIs.
4 If you want to prevent the new ROI from overlapping an existing one, you can define a limiting 

ROI by selecting one of these options:
• Avoid Interior—the new ROI will avoid the region inside this ROI.
• Avoid Exterior—the new ROI will avoid the region outside this ROI. For example, you can 

contour the skin surface, then select the Avoid Exterior check box for the patient surface ROI 
in order to keep the new ROI within the patient volume.

5 Set the destination ROI:
• Select ROI to modify—From the option list, select the ROI for which the new contours will be 

drawn. All contours in this ROI will be replaced by new contours. 
• Create new ROI—Enter the name for the new ROI.

Source ROI

Destination ROI (Source ROI + 0.5 cm)
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6 Define the margin of expansion or contraction of the source ROI(s):
• Uniform margin—Enter the margin for expansion or contraction in all directions.
• Variable margin—Enter the right and left margins, anterior and posterior margins, and 

superior and inferior margins.
7 Click one of the following buttons to complete the expansion or contraction:

• Expand—Expand the source ROI(s) by the margin.
• Contract—Contract the source ROI(s) by the margin.
• Create Ring ROI—Create a new “ring” ROI around the source ROI. The margin you defined 

sets the thickness of the ring. A ring ROI can be useful for surface structures such as the 
rectum wall.

NOTE
When creating a ring ROI with a uniform margin, set the margin at least 1.5 times the 
minimum voxel size of the image set. 

The software performs the expansion or contraction. This may take a few minutes for large 
volumes.

�CAUTION
Review the contours to verify that they are correct for your plan.

Source ROI Source ROI 
surrounded by ring ROI
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Autocontour ROIs
Use the autocontouring tools to generate contours automatically based on the CT values in the 
patient images.

Autocontouring tips

The autocontouring function uses the point in the image where you click as a starting point (or 
“seed” point). It then searches to the right of the seed point for pixels having CT values above or 
below the limits you define with the upper and lower thresholds.

• If the CT value of the seed point is within the range of the thresholds, the contour is drawn on 
the pixels just before the values cross out of the threshold range.

• If the seed point CT value is outside the range of the thresholds, the contour is drawn on the 
first pixels whose values cross into the threshold range.

Because the software searches to the right, you should generally choose a seed point directly on 
the structure or to the left of it.

For example, the contour shown in the following figure was generated with a seed point indicated 
by the asterisk, using thresholds of 800 and 4096. Notice that the contour is drawn on the first pixel 
that crosses the lower threshold. For images from most CT scanners, the CT values shown in the 
table below the figure should work well for commonly autocontoured structures. These are 
recommended values; you may need to change them for your plan.

�CAUTION
When autocontouring, you can inadvertently create contours that may lead to incorrect 
definition of the ROI volume. The correct definition of this volume is critical to the calculations of 
dose volume histograms and statistics for the ROI.
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450 296 337 336

554 337 304 340
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*

Structure Lower Limit Upper Limit

Lung 100 800

Bone 1300 4096

Skin 500 4096
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�CAUTION
Review the contours to verify that they are correct for your plan. 

For information on 2D tools you can use to assist in autocontouring, see the Pinnacle3 Planning 
Reference Guide.

NOTE
You can also autocontour a structure on all slices using the single contour 
autocontouring tool and pressing the n or p keys on the keyboard to move from one 
slice to the next. Using this method, you can control the seed point on each slice and 
thus control the position of the generated contours.

Set an autocontour bounding box

You can create a bounding box to specify a smaller area for the software to use when automatically 
creating contours. This can prevent the software from contouring the couch or artifacts in the 
image set.

You can also apply an isodensity colorwash to the image. The colorwash appears in the image set 
where the values are within the autocontouring thresholds.

1 Click the Autocontour Options button on the Edit Options tab. The ROI Bounding Box window 
appears.

2 Next to Apply Bounding Box select Yes. The default bounding box size is the image set volume.
3 Use the origin fields to set the starting point of the bounding box. Then set the width, length, 

and height.

OR

Use the bounding box tools to create and adjust a bounding box.

4 Set the bounding box color.
5 Next to Display Isodensity select Yes if you want to display an autocontouring colorwash.

Autocontour ROIs
1 Display the image you want to use for autocontouring in a 2D viewing window.
2 Click the Contours button.
3 Select an existing ROI or create a new one.
4 If the image set is a PET image set, click the Autocontour Options button on the Edit Options 

tab. The ROI Bounding Box window appears.

In the Threshold Unit option list, select either Raw Values or SUV.

NOTE
The software can only import SUV values from Philips PET scanners. If you did not 
import the image set from a Philips PET scanner, you cannot change the threshold units.

5 Enter the upper and lower autocontour threshold.
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6 Select one of the following autocontour tools:
• To generate a single contour on a single slice automatically, select the Autocontour structure 

on current slice tool. Next, click the left mouse button at an appropriate seed point in the 
image. The software searches in the direction of the arrow until it finds the first structure 
with CT values within the specified density range, then automatically draws a contour around 
the structure.

• To generate contours automatically for all structures on a single slice that have densities 
within the specified range, select the Autocontour all on current slice tool. Next, click the 
left mouse button within the image. All structures on the slice within the threshold are 
contoured. If the 2D image is zoomed, the autocontouring may include contours that are not 
visible in the window.

• To autocontour a single contour on all slices that include the structure, select the 
Autocontour structure on all slices tool. Next, click the left mouse button at an appropriate 
seed point in the image. The tool uses the specified autocontouring thresholds to generate a 
contour on the current slice, then does the same on adjoining slices for any connected 
structure that has a density within the threshold range.

• To generate contours automatically for all structures on all slices, select the Autocontour all 
on all slices tool. Next, click the left mouse button at an appropriate seed point in the image. 
The tool uses the specified autocontouring thresholds to generate contours on the current 
slice, then does the same on adjoining slices for any connected structure that has a density 
within the threshold range.
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Override ROI density

NOTE
If you are not licensed for proton treatment planning, you can disregard the references 
to stopping power in this procedure.

NOTE
For electrons, the maximum density override for ROIs is 11.3 gm/cm3. If you enter a 
value greater than 11.3 gm/cm3, the software still uses 11.3 gm/cm3 for dose 
computation. For shielding structures directly on the surface of the patient, make sure 
the ROI is thick enough to stop all primary electrons. When shielding structures are 
used, high overrides that correspond to the density of lead may compromise the 
integrity of the algorithm used in the dose computation.

�WARNING
Changing the density or stopping power changes the dose calculation. Verify that the override 
values you enter are correct. If you change the override values, recompute dose.

The density or stopping power information that you enter is used in the dose calculation, and it 
overrides the density and stopping power information in the CT image set; however, the CT data is 
not permanently altered. You can always return to the CT data by setting the Override Density 
option to No.

The software uses the density and stopping power override data instead of the CT data when 
autocontouring and when computing ROI statistics for the density data set. See Compute statistics 
on ROIs and Autocontour ROIs.

1 In the Regions of Interest panel, select Options - Density Override.
2 If you want to specify an override value for one or more ROIs, set Override Density to Yes for 

those ROIs. The order in which you turn on the Density Override option for the ROIs determines 
the default Override Sequence.

3 If necessary, change the Override Sequence as appropriate for your plan. The Override 
Sequence is the order in which the software overrides the density and stopping power for the 
ROIs. For example, if multiple ROIs overlap each other, the software uses the density of the ROI 
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with the largest Override Sequence value for the overlapping volume of the ROI (see example 
below).

4 If you want to set the density and stopping power of the voxels outside of the ROI instead of 
inside of it, click the Inside ROI button in the Load Voxels column. This option can remove 
objects from outside a given ROI. For example, if you want to remove all densities around the 
patient, you can autocontour the skin and load the voxels outside the ROI with a density of 
zero.

5 Are you licensed for proton treatment planning?
• No—go to step 6 to continue.
• Yes—go to step 8 to continue.

6 In the Density field, type the density value.

Density values must be within the range specified by the CT to Density table for this patient.

7 Select the density units, either g/cm3 or CT numbers.

This procedure is complete.

8 Type the override value in the Density, Stopping Power, or CT Number field. The values in the 
other two fields are adjusted accordingly.
• If you override the density, the CT number corresponding to the density that you specified 

will be used to set the stopping power for the ROI based on the CT to stopping power table.
• If you override the stopping power, the CT number corresponding to the stopping power that 

you specified will be used to set the density for the ROI based on the CT to density table.
• If you override the CT number, the density and stopping power for the ROI will be set based 

on the table values corresponding to the CT number that you specified.

This procedure is complete.

ROI Override Sequence value

A 1

B 2

C 3
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NOTE
Range and modulation are recomputed when you change the density, stopping power, 
or CT number values. In addition, dose is invalidated when these values are changed.

View ROI density overrides

You can view ROI overrides in a separate window.

In the Density tab of the Regions of Interest window, click the View Density Overrides button. The 
Density Override Display window appears.

The grayscale CT image within the ROI is replaced with a solid color corresponding to the density 
value of the override. Use the Show image value 2D tool to display the image value of a density 
override.

NOTE
An error message appears if the density override display is invalid. Click the Recompute 
button to recompute the density override display.

The Density Override Display 
window displays an ROI with its 
density overridden
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Correct contouring problems

Clean ROIs

Use the Clean ROI option to correct the following contouring problems.

• When copying ROI contours, you can accidentally copy a contour on top of itself. When this 
happens, nothing is “inside” the two contours. The resulting volume contains only the voxels 
through which the contour passes, as shown below.

• When autocontouring, you can generate many small, unnecessary contours in addition to the 
contour for the structure, or you can inadvertently generate duplicate contours for the same 
structure.

�CAUTION
When autocontouring or copying ROIs, you can inadvertently create contours that lead to an 
incorrectly defined ROI volume. This volume is critical in calculating dose volume histograms and 
ROI statistics. Check the autocontoured ROIs to verify that they are correct.
1 Select the ROI you want to correct.
2 Select Options - Clean ROI.

The software scans the selected ROI to detect problems, and the ROI Curve Cleanup Results 
window appears.

All contours with an area smaller than the Minimum Contour Area are listed in the window, as 
are contours that have more overlap than the Overlap Threshold.

3 If necessary, change the Minimum Contour Area and Overlap Threshold and click the Rescan 
button to check again for problems using the new parameters.

4 To delete problem contours, click the Delete Curves button. To move contours to a different 
ROI, click the Move Curves to New ROI button.

5 When you finish, click the Close button.

Smooth ROIs

Autocontouring can produce small filaments where the curve loops back upon itself. While these 
filaments are the correct behavior for autocontouring and cause no problems for treatment 
planning, they present problems for RTOG output. To eliminate these filaments, use an ROI 
smoothing method called erosion/dilation.
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NOTE
You cannot use this method on ROIs that have sagittal or coronal contours.

1 Select Options - Smooth Contours.

The ROI Erode/Dilate window appears.

2 Select the ROI you want to smooth.
3 Specify the margin as a fraction of voxel size.

The default margin, 0.5, is sufficient to eliminate filaments. The range of allowable margins is 
0.1 to 10.0. The larger the fraction, the smoother the result.

4 Click the Erode/Dilate ROI button.

The ROI is first contracted by a small margin to eliminate the filaments and other small features, 
then expanded by the same margin to restore the original structure (now smoothed).

5 Click the Close button when you finish the smoothing operation.

Reduce ROI points

Contours generated using continuous line contouring and autocontouring can contain a large 
number of points, which can slow the display speed. The software provides three methods for 
eliminating unnecessary points in contours, especially in regions of little curvature, to improve the 
display speed.

Reduce points by distance
1 Select the ROI to be reduced.
2 Select Options - ROI Point Reduction - Reduce Current ROI by Distance.
3 The software prompts you to enter the maximum distance to reduce the points. The default 

value should work well in most cases. Enter a value, then click the OK button.

In the following illustration, if the distances between point B and the dotted line, point C and 
the dotted line, and point D and the dotted line are less than the maximum distance you assign, 
and the distance between point E and the dotted line is greater than the maximum distance, 
then points B, C, and D will be removed.

A

E
F

.
. .

. . .
B

C
D

Maximum Distance Method
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Reduce points by area
1 Select the ROI to be reduced.
2 Select Options - ROI Point Reduction - Reduce Current ROI by Area.
3 The software prompts you to enter the maximum area to reduce the points. The default value 

should work well in most cases. Enter a value, then click the OK button.

The maximum area method is similar to the maximum distance method. In the following 
illustration, if the area of the shaded region is greater than the maximum area you assign, then 
points B, C, and D will be removed. Both methods reduce the number of points significantly. 
However, the maximum area method is better in most situations, as it retains the shape of the 
ROI more accurately.

Reduce points for all ROIs

If you intend to use DICOM RT to export ROIs to a system that limits the number of points in a 
contour, you can use this feature to reduce the number of points in all the ROIs.

1 Select Options - ROI Point Reduction - Reduce Points for All ROIs.
2 The software prompts you to enter the maximum number of points per contour. Enter a value, 

then click the Reduce Points button.

This method applies both the maximum distance and maximum area methods to reduce the 
number of points in all ROIs. The software uses default maximum distance and area values and 
iteratively increases the values until all contours in all ROIs contain no more than the number of 
points that you specified.

F

A . .B
C

D.
.

.E

Maximum Area Method

.
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Create a beam-specific ROI

NOTE
This feature is only available if you are licensed for proton treatment planning.

The beam-specific ROI feature lets you create a new ROI by expanding the target ROI in the beam’s 
coordinate system using margins that are specific to the beam. (In contrast, ROIs that are expanded 
using the ROI Expansion/Contraction tool are expanded and contracted using the Pinnacle3 patient 
coordinate system.) You can specify beam-specific proximal, distal, and lateral margins that help to 
mitigate range uncertainty and target motion while the beam is being delivered. You can use the 
new ROI for optimization objectives and for plan evaluation in the presence of uncertainties.

The following must be true before you can create a beam-specific ROI.

• You must have defined a target ROI for the beam.
• The target ROI must be displayed in a mode other than mesh mode.
1 In the Beams panel, click the Modifiers tab and click the Beam Specific ROI button.

The Beam Specific ROI window opens.

2 In the Beam option list, select the beam for which you want to create the ROI.
3 Type the lateral margins in the Left, Right, Top, and Bottom fields. The X and Y directions are 

shown in the following graphic for the beam coordinate system.

4 Type the proximal and distal margins.
5 Click the Create Beam Specific ROI button. A new ROI is created and is added to the ROI list. 

The new ROI is named beam name_target ROI name. For example, if the name of the target ROI 
is “PTV” and the name of the beam is “AP”, then the name of the new beam-specific ROI is 
“AP_PTV”.

6 To view information about the beam-specific ROI, click the Contours button to open the 
Regions Of Interest panel.

X2

Y1

X1

Y2

Table

Beam’s Eye View
(from above)

Gantry
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Manage ROI groups
ROI groups are managed automatically when you use Dynamic Planning. However, an ROI Group 
Manager is provided to allow you to make changes when a manual ROI group is preferred over an 
automatic one, for example, or when ROI groups are not working as you wish. This feature allows 
you to add and delete ROIs and ROI groups and adjust their colors.

NOTE
If you make changes using the ROI Group Manager, ROI Trending and ROI Group DVH 
could be affected as well leading to undesirable behavior. For this reason, you should 
only use the ROI Manager as a last resort.

NOTE
This feature is available only if you are licensed for Dynamic Planning.

The ROI Group Manager is available in the Regions of Interest panel by selecting Options > ROI 
Group Manager, and in the ROI Expansion/Contraction window by clicking the ROI Group 
manager button on the ROI Group tab.

When the ROI Group Manager window opens, you can perform the following actions.

Add an ROI group
1 Click Add ROI Group.
2 Type a Name for the group.

When you propagate ROIs or use Dynamic Planning, the Color is automatically assigned based 
on the “source” ROI. This ensures that planning ROI colors match ROI Group colors. This is 
clinically desirable. However, if you need to change the color, you can do so.

3 Select a Color for the group.

Add an ROI to a group
1 Select a group to which you want to add an ROI from the ROI Groups list.
2 In the list of Available ROIs below the ROI Groups, select the source for the ROIs from the ROI 

List. The source is either the current plan (Planning) or a record.
3 Select the ROIs to add to the group and click Add To ROI Group.

Remove an ROI from a group

Other than deleting a record, this is the only way to delete an ROI from a group.

1 Select a group from the ROI Groups list.
2 In the list of Grouped ROIs, select the ROIs to remove.
3 Click Remove From ROI Group.
4598 006 81251 A  Pinnacle3 16.4  Planning Instructions for Use



128 Manage ROI groups
Delete an ROI group
1 Select a group to delete from the ROI Groups list.
2 Click Delete ROI Group.

Set the color of an ROI group
1 Select a group from the ROI Groups list.
2 Select a Color from the list.
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Compute statistics on ROIs
1 In the Regions of Interest panel, select Options > Statistics.

�CAUTION
Any part of the ROI that is outside the dose grid will not have dose calculated. To obtain accurate 
statistics for ROI dose, the entire ROI must be included in the dose grid. To ensure accurate 
density statistics, the entire ROI must be included in the patient density volume.
2 Select the data set for which you want to compute statistics from the Data Set To Compute 

Stats On option list. If you select Density, statistics are computed by looking up values from the 
primary data set and passing them through the selected CT to density table.

3 Select Recompute Statistics from the Statistics menu.

NOTE
Initially, the software is set up to calculate statistics only when you select the 
Recompute Statistics option. To have statistics update whenever any change is made to 
an ROI, select Statistics - Update Stats When - Any ROI Altered.

The statistics computed for the ROI are volume, minimum and maximum value, mean value, 
sum value, SUV value, standard deviation, and percent outside grid. The last value is the 
percentage of the ROI that is outside the grid for which statistics were calculated.

The sum value is the sum of the image set voxel values for those that are within the ROI.

The % Outside Grid value displays the percentage of the grid that is outside the data set for 
which statistics were calculated. If you are computing dose statistics, the % Outside Grid refers 
to the dose grid. If you are computing density statistics, the value refers to the density grid. If 
the grid fully encompasses the ROI, this value is zero.

The % Outside Grid is only correct if the entire ROI is within the data set to which it is assigned. 
In most cases, this distinction is not important, but keep the point in mind if you use image 
fusion with multiple patient volumes. Image fusion is described in the View Patient Data 
chapter.
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8 Points of Interest

Overview
You can use points of interest (POIs) as isocenters, as reference points for 2D and 3D viewing, and to 
generate profiles between two known coordinates. Once dose has been computed, you can use 
POIs to obtain point dose information, including the total dose at the point and the dose 
contribution from each beam to the point.

An isocenter is a POI at which a beam is aimed. You can add any number of POIs or isocenters to a 
plan. For isocentric setups, you will usually have only one POI for a given set of beams. For SSD 
beams, you need to add an isocenter for each beam, plus a calculation POI.

Precise positioning of isocenters is required, especially for stereotactic radiosurgery. Be careful in 
your placement of isocenters: if there is too much overlap, you could apply a larger than intended 
dose to one area (a “hot spot”).

You can place POIs in 2D, 3D, and BEV viewing windows. A number of tools help you interactively 
and automatically place isocenters after they have been added.

Display the Points of Interest panel to the left of the viewing windows by clicking the Points button 
at the top of the window.

Place a point of interest

NOTE
If you want to use a POI for beam placement or dose evaluation, you must place the POI 
on the primary image set.

1 Click the Add Point button. A new POI is added to the list with a default name.

2 Make sure the new POI is highlighted in the list.
3 In the POI Name field, change the name of the POI to something appropriate for your plan and 

according to your clinical practices.
4 If you have multiple image sets, select the image set to associate with the POI.
5 In the POI Type option list, select a type to associate with the POI.
6 Position the POI using any of the following options:

• If you know the CT coordinates of the POI, enter its position in the Lateral, Ant-Post, and 
Sup-Inf fields. 

• Use the point of interest tools to interactively position the POI.
• Use the Autoplace POI tool, as described in the next section.
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NOTE
The DICOM coordinates appear in the Points of Interest panel below the CT 
coordinates. The DICOM coordinates do not appear if any of the following statements 
are true.
• The image set is not a DICOM image set.
• You modified the image set using the Data Set Editor window.
• The plan uses a water phantom or synthetic data.

7 Set the diameter of the POI, in centimeters.

The diameter is for visualization only, except for stereotactic plans, where diameter reflects the 
default cone size. For more information on this setting, see Specify POI diameters.

8 Set the 2D display mode, 3D display mode, and color that is assigned to the POI. For more 
information on these settings, see Change the POI display.

Position isocenters automatically
You can automatically place an isocenter so that it covers regions of interest (ROIs). The placement 
algorithm uses the smallest possible box or centroid to cover the ROIs. The POI is then placed at the 
center of this construct. 

Place a POI in one ROI
1 Click the Add Point button. Then click the Autoplace POI button. The POI Automatic 

Positioning window appears.
2 Select the ROI that you want to cover from the Region of Interest list.
3 Select Box or Centroid as the POI placement method.
4 Click the Automatically Place Point button.

�CAUTION
Verify that the automatically placed POI is in the correct location. Change its position or diameter 
if necessary.

Place a POI in multiple ROIs
1 Click the Add Point button. Then click the Set Inside Multiple Regions button. The Select 

Multiple ROIs window appears.
2 Select the check box for the desired ROI. Repeat for each ROI that you want to cover. 
3 Select Box or Centroid as the POI placement method.
4 Click the Autoplace POI button.

�CAUTION
Verify that the automatically placed POI is in the correct location. Change its position or diameter 
if necessary.
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Make a POI a reference point

If you are licensed for AcQSim3 and relative coordinates are enabled, the Set Reference Point 
button is enabled on the Points of Interest panel. If you use a beam isocenter as the reference 
point, you can see the location of other beams relative to the beam assigned to the reference point.

If you click this button, the selected POI coordinates are set to 0,0,0 and all other plan element 
coordinates (beam isocenters, 3D bounding box, cubic VOIs, dose grid, other POIs, and the laser 
coordinate origin) are relative to the POI.

�CAUTION
If you set relative coordinates after computing dose, the dose is made invalid.

Delete a POI
1 Click the Delete Point button.

The POI Delete window appears.

2 Select the POI that you want to delete.
3 Click the Delete Selected POI button to delete the POI.

If the POI is an isocenter for any treatment beams or setup beams, you cannot remove the POI. 
To delete such a point, you must delete the beams or specify a different isocenter for the 
beams. If necessary, click the Examine objects button to view the objects that rely on the 
selected POI.

�CAUTION
Deleted beams cannot be undone and will change your treatment plan. Verify that you are 
deleting the correct beam or selecting the correct isocenter.

Copy a POI
You can copy the selected POI from the POI list. This option enables you to copy the same POI 
parameters values from the selected POI but under a different POI name. To do this, select the POI 
that you want to copy.

1 Click the Copy Point button.
2 A new copied POI is added to the list with a Default_COPY name.

Lock a POI
You can lock a POI to prevent it from being modified. 

To lock a POI, select it from the list and click the Lock POI button. The button image changes from 
unlocked to locked.
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To unlock a POI, select it from the list and click the Unlock POI button. The button image changes 
from locked to unlocked.

NOTE
After locking the POI, you cannot modify the POI Name and coordinates. 
However, you can change other attributes like POI type, Diameter, and Display 
Options.

Point of interest utilities

Sort POIs

You can manually order the list of POIs.

1 Select Options - Sort.

The Sort window appears.

2 Click the POI tab.
3 Select an item and use the arrows to move it:

Point of interest coordinate precision

You can select the precision used to display the coordinates of all POIs.

1 Select Options - POI Spreadsheet.

The Points Of Interest window appears.

2 Select Options - Coord Display Precision. Select the precision you want from the list that 
appears.

Change the POI display

You can display POIs in both 2D and 3D images. The color of the POI in 2D and 3D images 
corresponds to your selection in the Color list of the Points of Interest panel.

Control Description

Move item to the top

Move item up

Move item down

Move item to the bottom
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In 2D images, the intersection of the POI and the slice is displayed as a circle. The crosshairs on the 
POI and the size of the circle indicate closeness to the center of the sphere. If the POI is positioned 
directly on an image slice, a complete crosshair is drawn. If the POI does not lie directly on the slice, 
partial crosshairs are drawn. Record POIs are indicated by dashed circles.

The following figure shows a set of transverse images. A small isocenter is positioned directly on 
slice 25. The larger isocenter is positioned between the images. The crosshair on slice 25 is more 
complete, indicating that the large isocenter is closer to slice 25 than to the slice 26.

In 3D images, POIs are displayed as surface, transparent or wireframe spheres the size of the 
specified diameter.

1 Make sure the POI you want to change is highlighted in the list.
2 To change the color of the POI, select an option from the Color option list.
3 From the 2D Display option list, select On, Off, or Label to set the 2D display mode for the POI. 
4 From the 3D Display option list, select Surface, Transparent, Wireframe, or Off to set the 3D 

display mode for the POI.

Specify POI diameters

You can change the diameter of a POI. For stereotactic radiosurgery, the isocenter display can be 
useful in selecting the appropriate collimator size. By changing the isocenter diameter size, you can 
see how well the circular collimator covers the target volume. 

Using the Autoplace POI function you can have the software select the nearest diameter size that 
covers the specified ROI. You can also use the POI Diameter list to determine the available 
diameters, as described in the following steps. The diameter values in this list can be set to any 
diameter size or limited to the available collimators on a given machine. 

1 Select Options - POI Diameter List. The POI Diameter List window appears.
2 To set up an arbitrary list of diameters, you can add and delete diameters on the list using the 

Add Diameter and Remove Current Diameter buttons. You can change the diameter values by 
typing in the boxes. 

Slice 25 Slice 26
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3 If you want to set up the diameter list to correspond with available collimators on a machine, 
click the Copy from Machine button.

In the Machine field of the next window, select the machine from which you want to copy the 
circular collimator values. The available circular collimators for the machine are listed. Click the 
Set the POI diameter list to machine collimator diameters button to change the diameter list, 
and then click the Close button.

4 If you want to sort the list so that diameters are listed from smallest to largest, click the Sort By 
Diameter button in the POI Diameter List window. 

5 If you want this diameter list to be the default selection for automatic isocenter placement, 
click the Save As Default button.

6 When you finish, click the Close button.

Calculate the distance between points of interest
1 Select Options - POI Spreadsheet.

The Points Of Interest window appears.

2 Select Options - POI Distance Window. The Distance window appears. 
3 Select the two points from the First POI and Second POI option lists. The distance between the 

points is shown at the bottom of the window. 

Position points of interest interactively

You can use the following tools to interactively position POIs in 2D or 3D images.

Position isocenters on 2D slices

Select the Move POI tool to place a POI directly on a transverse, sagittal, or coronal slice.

On the 2D slice where you want to place the isocenter, position the cursor and click the left mouse 
button to place the POI on the slice. You can also position the POI by holding down the left mouse 
button and dragging the POI to the new position.

Position isocenters between slices

If you want to place an isocenter between CT slices, select the Nudge POI toward you tool or the 
Nudge POI away from you tool. 

Click in the viewing window that shows the images you want to use for positioning. Continue to 
click in the window until the isocenter is positioned properly.

For example, to move the isocenter between two transverse slices, click in the viewing window that 
shows transverse images. Clicking the Nudge POI toward you tool moves the isocenter 1/10 of the 
voxel height toward you in the volume. Clicking the Nudge POI away from you tool moves the 
isocenter 1/10 of the voxel height away from you in the volume. 
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If a POI is positioned between CT slices and you want to reposition it without changing the slice, 
you can use the Translate POI tool to move the POI within the current plane without moving it to 
the slice where you click.

Position isocenters in 3D images

Select the Move POI 3D tool to position POIs on the surface of a rendered image. This tool is useful 
for setting up SSD treatments. 

NOTE
3D POI positioning does not work unless a surface image (skin or bone) is rendered in a 
3D viewing window.

Open a 3D viewing window and then render the 3D image. Then position the cursor and click the 
left mouse button to place the POI in the volume. You can also position the POI by holding down 
the left mouse button and dragging it to the new position.
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9 Beams

Overview
This chapter explains how to set up plans for all external beam treatment modalities. Plan setup 
includes patient localization and beam setup.

For stereotactic radiosurgery and photon or electron beam treatment planning, you perform the 
initial setup of the beams and the beam geometry in the same manner.

The basic process for the initial beam setup is as follows:

1 Add a beam.
2 Set the beam display.
3 Set the beam isocenter.
4 Set the angles (this includes setting the couch, gantry, and collimator angles).
5 Set up the jaws.
6 Match beam edges.

After you finish setting up the beams, you can add the beam modifiers to your plan. See the Beam 
Modifiers chapter for more information.

For proton beam treatment planning, the basic process for the initial beam setup is as follows:

1 Add a beam.
2 Set the beam display.
3 Set the beam isocenter.
4 Set the couch and gantry angles.
5 Set the snout.
6 Match beam edges.

The software adds a default aperture and compensator to proton beams that use the double 
scattering or uniform scanning modalities. See the Beam Modifiers chapter for more information.

Click Beams at the top of the window to display the Beams panel.

Sort beams
You can manually order the list of beams.

1 Click Beams at the top of the window. The Beams panel opens.
2 Select Options - Sort.

The Sort window opens.

3 Click the Beam tab.
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4 Select an item and use the arrows to move it:

Control Description

Move item to the top.

Move item up.

Move item down.

Move item to the bottom.
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Preparing to add, copy, and delete beams

About the machines

Only commissioned machines are available in planning and simulation. The software uses the most 
recent machine version unless you specifically change the version. See the Pinnacle3 Planning 
Reference Guide for more details.

�CAUTION
The default machine is selected automatically when you add a beam. Because beam geometry is 
machine-dependent, verify that the correct machine is being used for each beam before you set 
the beam parameters.

�CAUTION
The current POI is selected automatically as the isocenter when you add a beam. Verify that the 
correct POI is being used as the isocenter for each beam.

View machine information

You can view the physics information for the machine that is used by the current beam. In the 
Beams panel, select Options > Machine/Energy or right-click the machine name in the Setup tab. 
(Due to the behavior of the Pinnacle3 windowing environment, the Num Lock and Caps Lock 
functions must be turned off in order for the right-click behavior to work properly.)

You cannot change the information in the Machine Information window, but you can use it to 
confirm that you have selected the correct machine. For detailed information about the machine 
parameters, see the Pinnacle3 Physics Instructions for Use.

Add a beam
1 In the Beams panel, click Add Beam. The software adds a new beam to the list.

NOTE
If a POI does not exist when you add a beam, the software places one in the center of 
the CT image set and automatically selects it as the isocenter.

2 Make sure the new beam is highlighted in the list.

NOTE
To more efficiently set up the plan, you can enter the parameters for the first beam and 
then use one of the copy commands to add the remaining beams.

3 In the Name field, change the name to something appropriate for your plan according to your 
clinical practices.

4 If you will export plan information to a Record and Verify system, enter a unique ID for each 
beam in the Field ID field.
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5 In the Machine field, select the machine to be used for treatment. The version of the machine 
appears after you select it.

6 In the Modality field, select the mode to be used for treatment.
7 In the Energy field, select the energy to be used for treatment.
8 In the Beam Type field, select type of beam that you want to use:

• For fixed beams, choose Static.
• For arced beams, choose Arc.
• To perform forward planning and set up control points, choose Step & Shoot MLC.
• To create a conformal arc plan, choose Conformal Arc. See the Beam Modifiers chapter for 

more information.
• For beams with motorized wedges, choose Motorized Wedge. See the Beam Modifiers 

chapter for more information.

• To create a VMAT plan, choose Dynamic Arc. See the P3IMRT Instructions for Use for more 
information on how to create a VMAT plan.

9 In the Dose Rate field, select the dose rate to be used for the beam.

NOTE
If the High-Dose Technique is enabled for the machine, and the MU of the beam is 
greater than the MU threshold that was specified for this beam type in Physics when 
your machine was commissioned, then the value is exported as “SRS” in the High-Dose 
Technique tag (300A,00C7) of the DICOM export.

10 In the Delivery Time Multiplier field, enter the value (1 to 5) to be used to calculate the 
maximum treatment delivery time for the plan.

11 If you are using the Stereotactic Radiosurgery (SRS) technique for the treatment and your 
machine is enabled for the High-Dose Technique, select Yes for the SRS Technique option. This 
setting exports a value of “SRS” in the High-Dose Technique tag in the DICOM export.

Add a proton beam
1 In the Beams panel, click Add Beam. The software adds a new beam to the list.

NOTE
If a POI does not exist when you add a beam, the software places one in the center of 
the CT image set and automatically selects it as the isocenter.

2 Make sure the new beam is highlighted in the list.

NOTE
To more efficiently set up the plan, you can enter the parameters for the first beam and 
then use one of the copy commands to add the remaining beams.

3 In the Name field, change the name to something appropriate for your plan according to your 
clinical practices.
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4 If you will export plan information to a Record and Verify system, enter a unique ID for each 
beam in the Field ID field.

5 In the Machine field, select the machine to be used for treatment. The version of the machine 
appears after you select it.

6 In the Modality field, select the mode to be used for treatment.
7 In the Target ROI field, select the target ROI for this beam.
8 To adjust the range or modulation, set proximal or distal margins, and view general beam 

parameters, click Details. The Proton Beam Parameters window opens.

The Proton Beam Parameters window displays the set range and set modulation values and the 
target range and target modulation values:

– The Range and Modulation fields show the set range and set modulation values, which are 
the values that the beam would exhibit if it was delivered to water. For double scattering and 
uniform scanning beams, these values are sent to the machine for delivery. 

– The Target Range and Target Modulation fields show range and modulation values that are 
determined by ray tracing through the target. Target range is the deepest depth of the target 
in terms of water equivalent distance. Target modulation is the greatest longitudinal 
thickness of the target in terms of water equivalent distance.

9 Choose one of the following:
• To use the Target Range and Target Modulation values, do not make any changes to the 

beam parameters. Go to step 12.
• To use the Range (set range) and Modulation (set modulation) values, go to step 10.

10 To add margins to the proximal or distal edge of the target ROI in order to adjust the 
longitudinal dose to the target, set the Enter Margins field to Yes and go to step 12. Otherwise, 
set the Enter Margins field to No and go to step 11.

11 If necessary, change the range and modulation values by typing new values in the Range field 
and the Modulation field. Then go to step .

12 Specify either Automatic or Manual margins by clicking the appropriate button.
• If you specify Automatic margins, the software computes the optimal margins and displays 

the values in the Proximal and Distal fields. For information, see “Methodologies and tools 
for proton beam design for lung tumors”, by M.F. Moyers, et al, International Journal of 
Radiation Oncology * Biology * Physics 49:1429–1438 (2001).

• If you specify Manual margins, specify the appropriate margins by typing values in the 
Proximal and Distal fields.

Set beam parameters for double scattering and uniform scanning
1 If the selected machine supports full plateau delivery and you want to enable that option for 

this beam, select Yes in the Full Plateau field. The software sets the modulation to be equal to 
the range, and the software will calculate dose to the surface of the patient.

NOTE
The full plateau option is only available if it was enabled for this machine during the 
commissioning process. Full plateau delivery means that the 100% dose level extends to 
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the patient surface, while full modulation means that the proximal level of the SOBP 
extends to the patient surface. For full modulation, if the proximal level is 95%, then 
95% of plateau dose extends to the patient surface.

2 The Model Parameters section of the window includes information about the range band that 
the software selected for the beam. Click SOBP to view the Cumulative Weight and the 
components for this range band.

3 To lock the beam, continue to Lock a beam.

Lock a beam

To lock a proton beam when you are finished setting the beam parameters and defining the 
aperture and compensator, select Yes in the Lock Beam field in the Proton Beam Parameters 
window. (To define an aperture for double scattering beams and uniform scanning beams, see 
Apertures. To define a compensator, see Compensators.)

When the beam is locked, the only parameters that you can change are the couch and gantry 
angles, isocenter, and SSD.  The other beam parameters are locked and cannot be changed unless 
the beam is unlocked:

• You cannot change the range, modulation, snout, proximal margin, distal margin, the CT to 
density table or the CT to stopping power table.

• You cannot choose a different machine, modality, or target ROI for the beam.
• You cannot copy and oppose beam.
• You cannot edit the aperture or compensator.
• The aperture, range, and modulation are not updated if the target ROI is modified.

NOTE
When you unlock a beam, the range and modulation values are automatically updated, 
and the computed dose is invalidated. Also, the aperture and compensator are not 
automatically unlocked. You must manually unlock those modifiers if you want to edit 
them.

Copy a beam

�CAUTION
Including two identical beams in your plan can cause dose to be higher than intended. Make sure 
you modify the copied beam appropriately.

1 In the list of beams, select the beam you want to copy.

2 From the Options menu, select Copy Beam. A beam with the same settings as the selected 
beam is added to the plan.
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Copy and oppose a beam

NOTE
You cannot copy and oppose a dynamic arc or conformal arc beam. You also cannot 
copy and oppose proton beams when the beam is locked, when the beam contains ROIs 
that are used for distal blocking, or for a machine that uses discrete gantry angles.

1 In the list of beams, select the beam you want to copy.
2 From the Options menu, select one of the following:

• Copy & Oppose Beam—A new beam whose gantry angle is opposed to the selected beam is 
added to the plan.

• Copy & Oppose Beam w/ Table—A new beam whose gantry and couch angles are opposed 
to the selected beam is added to the plan.

NOTE
Copy & Oppose Beam w/ Table is not available for proton machines that use discrete 
gantry angles.

Delete a beam

�WARNING
You cannot restore beams after you have deleted them. Be careful when deleting a beam 
necessary to your plan. Make sure that you are deleting the beam from the correct trial.
1 Click Delete Beam. The Select Beam to Delete window opens.
2 Delete the beams.

• To delete one beam, select the beam and click Delete Selected Beam.
• To delete all beams, click Delete All Beams in List and confirm the deletion in the window 

that opens.

Use stored beam files

NOTE
The following information does not apply to proton beams.

You can access stored beam configurations using the Standard Plans command in the Options 
menu of the Beams panel. 

Several beam configuration files have been provided with the software:

• FourField.Beam.Script is set up as a standard four-field box. 
• FourFieldProstate.Beam.Script is set up as a standard four-field box with the region of interest 

named “prostate” automatically blocked with a 1 cm margin. 
• StereoFiveArc.Beam.Script is a stereotactic radiosurgery plan with five arcs.
• StereoSevenArc.Beam.Script is a stereotactic radiosurgery plan with seven arcs.
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You can create your own stored beam files using the scripting functions. See the scripting 
information in the Utilities chapter for more information.

1 Select Options > Standard Plans. The Standard Beam Plans window opens.
2 By default, the window lists the beam configurations that are provided with the software. If you 

want to use a beam configuration that you created using the scripting functions, click User Std 
Plans.

To switch back to the list of configurations that are provided with the software, click System Std 
Plans.

NOTE
New scripts do not appear in the Standard Beam Plans window until you exit the 
current plan and re-enter it.

3 Select the plan from the list and click Proceed. The Confirm Standard Plan window opens.
4 Select the isocenter and the treatment machine to be used for the beams, then click Add New 

Beams.

The software creates the beam setup for the selected plan.

�CAUTION
The beams added to your plan may not be exactly correct for your plan. Verify each beam’s 
placement and settings after adding stored beams.
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Beam visualization
Initially, the software displays all beams in both 2D and 3D viewing windows. As you add beams to 
the plan, each beam appears in a different color. To help you associate information in the Beams 
panel with the beam display in the viewing windows, the beam name is framed in the beam’s 
display color.

2D images display the intersection of the beam with the slice. The limits of the beam field are 
indicated by a solid line. The central axis for the beam is indicated by a dashed line. When the beam 
is orthogonal to the image plane, the central axis position is indicated by intersecting cross hairs.

Stereotactic arcs are indicated by their starting and ending beams in the arc and a curved rotation 
indicator, which shows the direction of rotation between the starting and ending beams.

In 3D images, you can display the beam as a solid surface or wireframe. You can also see the 
intersection of the beam with anatomical surfaces.

Set the beam display
1 Make sure the beam you want to change is highlighted in the list.
2 In the Display Options area, click the Color option list to select a different color.
3 Next to 2D Display, select Yes if the beam should appear in 2D viewing windows, or No if it 

should be hidden.
4 Next to 3D Display, select Yes if the beam should appear in 3D viewing windows, or No if it 

should be hidden.

You can also choose to display all the beams in 2D or 3D viewing windows. The All Beam 
Display option in the Utilities menu allows you to override the display settings for the 
individual beams. You can display or hide all beams in 2D or 3D viewing windows.

For more details on beam display parameters, see Set the beam display parameters in the 
Pinnacle3 Planning Reference Guide.
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Specify beam orientation and collimation
Although beam geometry setup is similar for all treatment modalities, you should consult the 
section below that applies to your modality. Beam geometry is limited by the physical machine 
parameters entered in the physics tools. Collimator jaw positions are set in the physics tool.

Beam orientation and collimation for stereotactic arcs

To determine the best placement of stereotactic arcs, you can create a set of 3D viewing windows 
and display 3D skin surface images of the patient from different viewpoints so the entire head is 
visible. As you add arcs to the plan, the surface path of the beam displays on the skin surface. 

See the View Patient Data chapter for more 2D and 3D display information. See Beam visualization 
for details on setting beam display options. 

Set the couch and gantry angles
1 In the Beams panel, click the Geometry tab.
2 Are you using a C-Arm machine?

• Yes—Go to step 3.
• No—Go to step 4.

NOTE
If you are licensed for C-Arm, it is available for photon and stereotactic beams and can 
be used with static, step-and-shoot, arc, and conformal arc beam types.
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NOTE
The couch angle is set to 0 degrees for machines that are commissioned with a C-Arm, 
and it cannot be changed.

NOTE
Mitsubishi DME 2.2e or later is required to export plans that contain C-Arm beams.

3 To set the angle for the C-Arm, do one of the following:
• Enter the degree of the angle. Go to step 6.
• Click and drag the head of the accelerator in the C-Arm graphic to change the C-Arm angle. 

Go to step 6.
4 To set the angles for the couch, do one of the following:

• Enter the degree of the angle.
•  Use the up and down arrows to set the angle. The couch in the graphic moves to that angle.
• Click and drag the outer portion of the couch in the graphic to the desired angle.

NOTE
If you are licensed for proton treatment planning and are defining the geometry for a 
proton beam, the collimator angle graphic is not shown.

5 Click Set Couch Positions to view the couch position information for the selected beam. The 
Couch Positions window opens. The default values that were commissioned in Physics are 
shown in the window. Verify that these values are correct for the beam, and change them as 
necessary for the plan.

If you change the values and want to propagate them to all beams that use the same isocenter 
as the selected beam, click Apply to related beams.

NOTE
The couch position values are in the IEC Table Top coordinate system and represent the 
exact values that are sent in the DICOM export. You do not enter the values seen inside 
the treatment room, but must first convert to IEC coordinates. Please refer to your 
treatment table's documentation for specific information.

6 Are you using an arc?
• If yes, go to the next step.
• If no, go to step 9.

NOTE
Electron arcs are not available in Pinnacle3.

Use these graphics to 
interactively change 
the couch and gantry 
angles.
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7 Click the Gantry Rotation Direction icon to toggle the rotation to the proper direction 
(clockwise or counterclockwise). The icon changes to show the direction.

NOTE
The Gantry Rotation Direction icon is not available for proton beams.

8 Set the starting and stopping gantry angles in one of the following ways:
• Enter the starting and stopping angles. The gantry in the graphic moves to show those 

angles.
• Use the up and down arrows to set the angles. The gantry in the graphic moves to those 

angles.
• Click and drag the green gantry in the graphic to the desired starting angle. Click and drag the 

red gantry to set the stopping angle.

Do not continue; this procedure is complete.

9 Set the gantry angle in one of the following ways (the starting and stopping angles are the 
same):
• Enter the starting angle. The gantry in the graphic moves to that angle.
• Use the up and down arrows to set the angle. The gantry in the graphic moves to that angle.
• Click and drag the green gantry in the graphic to the desired angle.

For proton beams that use a machine with discrete gantry angles, use one of the following 
methods:

• Select the desired angle from the Angle list.
• Click and drag the green gantry in the graphic to the desired angle.

�CAUTION
For a static beam, make sure the start and stop angles match. This is the default configuration.

Set the isocenter
1 In the Beams panel, click the Setup tab.

�CAUTION
Because most electron beam isocenters will be on the skin, we recommend that you add a point 
of interest at a specified depth for use as a reference point in the prescription and dose 
calculations.
2 Specify the isocenter by selecting it from the Isocenter list. Only the POIs that are assigned to 

the primary image set appear in the list.

�CAUTION
Changing the SSD moves the isocenter of the beam and all attached beams. If necessary, you can 
use multiple isocenters to avoid this situation.
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3 Set the SSD. The isocenter for that beam moves to the SSD you specify. You can use the 
isocenter placement tools to graphically move the isocenter.

For stereotactic and photon arcs, the SSD listed is the starting SSD for the arc. For electron and 
protonbeams, the SSD listed is the nominal SSD. The nominal SSD is the distance from the skin 
surface to a fixed reference location upstream in the beam line.

4 If the displayed localization system is not correct, select the localization method from the 
Localization System list.

If you localize the patient in the software and then change the localization method, you must 
localize the patient again.

Set the collimator angle and jaws

NOTE
If you are working with a proton beam, you do not need to follow the procedure in this 
section. Collimator angles and jaws do not apply to proton beams.

1 In the Beams panel, click the Geometry tab.

NOTE
If you want to add control points and perform forward planning in Pinnacle3, see the 
Forward-Planning IMRT chapter.

2 Set the collimator angle (looking down from the machine at the patient) in one of the following 
ways:
• Enter the degree of the angle. The collimator in the graphic moves to the angle you set.
• Use the up and down arrows to set the angle. The collimator in the graphic moves to the 

angle you set.
• Click and drag the collimator in the graphic to the desired angle.

NOTE
If you change the machine, the software may change the collimator angle to keep the 
tray opening in the same orientation. If the angle is not allowed for the machine, the 
software uses the closest allowable angle. Check your collimator settings after changing 
machines.

3 Is this a photon, stereo, or electron beam?
• If stereo or electron, go to step 7.
• If photon, go to step 4.

4 Enter the jaw positions. Are the jaws symmetric (dependent/jaw position is the same on both 
sides) in the horizontal or vertical directions?
• If yes, click the button beneath Symmetric so a Yes appears next to the direction that is 

symmetric. Set the width and height of the jaws.
• If no, click the button beneath Symmetric so No appears next to the direction that is 

asymmetric. Enter the position of the jaw from the central axis.
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NOTE
For fixed jaw machines, you cannot edit the jaw information.

5 If you want the jaw positions applied to all photon beams, click Apply to All Beams.

NOTE
If a machine does not allow asymmetric (independent) jaws, the asymmetric jaw 
options are not available.

NOTE
When you export a beam with independent jaws to a Record and Verify system, the 
beam exports as asymmetric even when the jaws are positioned symmetrically.

6 For fixed jaw machines, use the X1, X2, Y1, and Y2 fields to specify the width and height of the 
rectangle that the MLC leaves define (if necessary).

7 Is this a stereo or electron beam?
• Stereo—from the Circular Field list select the appropriate size. (The collimator is initially set 

to match the isocenter diameter.)
• Electron—from the Electron Cone list select the appropriate size.

Set the snout

NOTE
The snout options are only available if you are licensed for proton treatment planning.

1 In the Beams panel, click the Geometry tab.
2 In the Snout section of the panel, select the snout that you want to use from the Name list. For 

double scattering beams and uniform scanning beams, the software selects the smallest snout 
that will cover the field size by default. 

NOTE
You can only change the snout setting if you set the Spot Pattern Generation option to 
Automatic in the Proton Beam Parameters window.

3 If necessary, adjust the Air gap along central axis value. The initial value in this field is the 
maximum allowable air gap.

This value is the distance between the distal end of the snout and the surface of the patient 
that is measured along the central axis of the field. If this value is too small and the software 
detects a collision between the snout and the patient or the snout and the table, a collision 
indicator appears in the Snout section of the panel. In addition, the point at which the collision 
will occur is shown on the patient image.

If you change the Air gap along central axis value, the software recalculates the Minimum air 
gap within field value, which is the minimum air gap between the patient surface and the snout 
across the entire field.
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Match beam edges

You can match the beam edge for two opposed beams using the Match Edge command. The beams 
should be opposed prior to using the Match Edge command. The edge of the beams that is closest 
to the center of the patient is the edge that is matched.

1 In the Beams panel, select Options > Match Edge.

The Beam Edge Matching window opens.

2 Select the opposed beams for which you want to center or match the edge.
3 Click Center Opposed Beams to set the SSD for both beams so that the isocenter is centered 

between them.
4 Click Match Edge of Opposed Beams.

Center beam in field

You can move the isocenter of a beam (usually an asymmetric field) to the center of the field to 
make it symmetric. If you have already set up asymmetric jaws for the beam, centering the beam 
makes the jaws symmetric but does not change the field size. 

1 Select the beam that has the isocenter you want to center in the field.
2 Select Options > Center Beam in Field. The isocenter is moved to the center of the field.

Obtain coordinates for the isocenters

After setting up the isocenter for each beam, you can view the isocenter position in the CT 
coordinate system and the frame coordinate system or the corresponding motion needed to align 
the patient. The coordinates for all isocenters are included on the printed plan reports. 

Two opposed beams Beams after matching the beam edges
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Stereotactic frame coordinates
1 On the Setup tab of the Beams panel, click Details next to the Isocenter field.

The Beam Isocenter window opens.

2 If other beams use a different isocenter, select the beams from the Beam list to view the frame 
coordinates for the additional isocenters.

NOTE
If the stereotactic frame coordinates are known, you can enter the frame coordinates in 
the three fields at the center of the window. 

Laser alignment coordinates
1 On the Setup tab of the Beams panel, click Details next to the Isocenter field.

The Beam Isocenter window opens.

2 If other beams use a different isocenter, select the beams from the Beam list to view the laser 
or table motion for the additional isocenters.

3 If the laser alignment system is not correct, select the correct laser alignment system.

�WARNING
If you are upgrading from a previous version of Pinnacle3 software, make sure that the method 
for displaying the isocenter shift is consistent with your expectations. If necessary, you can 
change the default setting in the CT to density table in the physics tool. See CT Scanner 
Configuration in the Pinnacle3 Physics Instructions for Use.
4 Select how to display the isocenter shift:

• Table—Displays isocenter shifts relative to the table.
• Laser—Displays table motion in the X and Y direction as laser motion for simulation. Laser 

motion is the inverse of table motion and is specified per beam.
If you select a laser alignment system with a “1” in the name, you will have one moveable 
laser for simulation. If you select a laser alignment system with a “3” in the name, you will 
have three moveable lasers.
The one moveable laser is in the X direction (left/right). The three-laser system has one laser 
in the X direction and two in the Y (up/down) direction, one on each side of the table.
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Change the machine for a beam

�CAUTION
After you select a new machine for a beam, verify that all beam modifiers, beam geometry, and 
dose rate settings are correct.

When you change the machine for a beam, the software attempts to preserve all beam modifiers, 
beam geometry, and dose rate settings:

• If the new machine does not support a beam modifier that is associated with the beam, the 
software removes that beam modifier from the beam.

• If the new machine does not support the geometry of the beam, the software attempts to 
accommodate for the capabilities of the new machine, which may result in beam geometry that 
is different from the original beam geometry.

• If the new machine can use the same dose rate, then the dose rate is retained. If the same dose 
rate is not available on the new machine, then the default dose rate for the new machine is 
used.

If you optimized the beam in IMRT, you may need to optimize the trial again after you change the 
machine for a beam. If you optimized the beam with the IMRT or VMAT optimization type, you may 
want to run the optimization again for at least 5 iterations so that the MLC positions can adjust for 
the new machine.

1 Click the Beams button. The Beams panel opens. Select the Setup tab.
2 Select the beam for which you want to change the machine.
3 In the Machine list, select the machine that you want to associate with the beam.
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10 Beam Modifiers

Overview
This chapter covers the beam modifiers you can add to a treatment plan.

Display the beams panel to the left of the viewing windows by clicking on the Beams button at the 
top of the window. You will use the Modifiers tab to add modifiers to your beams.

NOTE
The ODM field in the Modifiers tab displays whether an opening density matrix (ODM) 
in the field is valid (Yes when ODM is valid, No when ODM is invalid). Dose computed 
with an ODM in the field results in approximate MUs, and the plan cannot be used 
clinically or exported. Approximate monitor units are identified with a tilde (~) after 
dose is computed. You can invalidate the ODM by clicking the Reset button or 
converting the beam using P3IMRT. After you invalidate the ODM, the plan can be used 
clinically or exported. See the P3IMRT Instructions for Use for information on converting 
a beam with an ODM to a deliverable beam.

Stereotactic radiosurgery modifiers

For stereotactic radiosurgery there are typically no modifiers added to the plan. For some newer 
treatment systems mini multi-leaf collimators (MLCs) are used. If you have mini-MLC capabilities 
that can be set up for your machine in the physics tool and set up in planning, see Multi-leaf 
collimators.

Electron beam modifiers

For electron beam planning you can add blocks and bolus. To add these to your plan, see the 
following sections:

• Blocks
• Bolus

Photon beam modifiers

For photon beam planning you can add blocks, MLCs, wedges, compensators, and bolus. To add 
these to your plan, see the following sections:

• Blocks (including the AutoSurround feature available for photon beams)
• Multi-leaf collimators
• Wedges
• Compensators
• Bolus
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Proton beam modifiers

Proton treatment planning uses apertures and compensators to modify beams. See the following 
sections for information:

• Apertures
• Compensators

NOTE
The aperture and proton-specific compensator options are only available if you are 
licensed for proton treatment planning.
4598 006 81251 A  Pinnacle3 16.4  Planning Instructions for Use



156 Blocks
Blocks
This feature can only be used with electron and photon beams. When adding beam blocks, you can 
draw the block in a beam’s eye view window or generate blocks automatically based on a region of 
interest.

Beam blocks are added from the Modifiers tab of the Beams panel.

Add a block
1 Click the Modifiers tab of the Beams panel. 
2 Select the beam from the Beam list.
3 Click Add Block. You can click on it a number of times to add the total number of blocks you 

want to set up.
4 In the blocks list, select the one on which you want to work.

�CAUTION
For a photon arc, automatic blocks are generated at the starting angle for the arc. The block is not 
modified as the gantry rotates. 
5 Do you want the software to automatically generate the block based on a region of interest or 

do you want to manually define the block?
• Automatic—From the Structure option list select the region of interest to associate with the 

block.
• Manual—From the Structure option list select Manual.

�CAUTION
Verify that the automatically placed blocks are correct for the beam. Modify them as appropriate 
for your plan. You can edit automatically generated blocks by changing the block type to Manual 
and then using the editing tools to adjust the block shape.
If you switch from Automatic to Manual, the block’s contours are copied to the new manual block 
and the block’s margin is set to 0.0. Any existing manual contours are lost.

�CAUTION
If the beam geometry is changed during automatic blocking, the software automatically reshapes 
the block to conform to the ROI shape.
While the block shape is correctly maintained regardless of the beam angle, the collimator jaws 
are not adjusted to surround the specified ROI. Check your block and adjust the field size as 
necessary.
6 From the Action option list, select whether to expose or block the region of interest.
7 From the Rest of Field option list, select whether to expose or block the field outside of the 

region of interest, or to take no action (As Is).
8 Do you want the manually defined block to move with the collimator?

• If yes, in the Rotate with Collimator field select Yes.
• If no, in the Rotate with Collimator field select No so the block remains stationary.
 Pinnacle3 16.4  Planning Instructions for Use 4598 006 81251 A



Blocks 157 
Blocks will not rotate with the collimator during optimization of MLCs, regardless of your 
selection.

9 Do you need an extra margin around the block?
• If yes, in the Margin field enter the extra amount to be added to all four sides.
• If no, go to 10.

10 Are you using an MLC?
• If yes, in the Use MLC? field select Yes. Go to 12.
• If no, in the Use MLC? field select No. In the Tray # field, enter the block tray number/name 

(up to 16 characters). The name is “--” by default. 

NOTE
For fixed jaw machines, the Use MLC? field is set to Yes and cannot be changed.

NOTE
When you print or export a plan using DICOM RT, the Tray # value is included with each 
block.

�CAUTION
Default values are used initially for the tray transmission factor and block and tray transmission 
factors. Verify that these values are correct and change them as necessary for your plan.
11 Are you setting up a block in a photon beam?

• If yes, enter the transmission factors in the Tray and the Block and Tray fields. Then go to 12.
• If no, go to 12.

12 Are you going to manually define the block or do you need to edit the block?
• If yes, continue to Manually define the block.
• If no, this procedure is complete.

NOTE
When creating blocks and MLCs for an ROI, be aware that the ROI display mode affects 
its appearance, especially for small field sizes. The Colorwash and Poly modes more 
accurately represent the ROI than the Contour display. For details on ROI precision, see 
the Pinnacle3 Planning Reference Guide.

NOTE
If your machine has MLC leaves that track the jaws, you can click MLC Options to view 
and verify the MLC leaves as they will be positioned at the linac.

Manually define the block
1 Change the viewing window to a beam’s eye view (BEV).
2 In the viewing window, turn on the 3D display for all structures you want to see while defining 

the block. 
3 Select the block from the block list.
4 In the Structure option list select Manual if it is not already selected. 
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5 Select the Create block point by point or Create block paintbrush tool.
• For the Create block point by point tool, click on the BEV where you want to start drawing 

the block. A small box appears at the point you defined. Continue to define the remaining 
points in the same manner. To close the contour for the block, click on the first point that you 
defined. 

• For the Create block paintbrush tool, drag on the BEV to draw the block. As you draw, the 
contour of the block appears.

6 To specify a margin (cm) for the block, enter it in the Margin field.

Use the tools along the beam panel to edit the block. For more information, see the Tools 
chapter.

Now you can set blocking priorities, set up multi-leaf collimators (MLCs), and export block and 
MLC data.

Set the blocking priorities

The priority option allows you to set up a beam block that always blocks a specific structure while 
always exposing another. By using this option and selecting the appropriate combination of the 
Action and Rest of Field options, you can effectively create a hierarchy of structures and can spare 
sensitive structures while exposing the tumor.

For example, if you have a sensitive structure near your target volume and you want to always 
block the sensitive structure but expose the target volume, you can set the priority of the sensitive 
structure to 1 and the priority for the target volume to 2. This set of blocking priorities would 
generate the block shown below.

1 On the Modifiers tab in the list of blocks, select the block you want to set as the top priority 
(the exposure or blocking that is most important).

2 From the option list that appears next to the block, select 1.
3 For each additional block, select it and set the priority.
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Use the AutoSurround feature

NOTE
The AutoSurround feature is not available for fixed jaw machines.

This feature can only be used with photon beams. Use AutoSurround to make the collimator jaws 
automatically move to the boundaries of the blocks or to a margin around the block edge. The 
AutoSurround feature may be used with a block or with an MLC. 

If MLC leaves have been manually positioned, the software warns you that the positioning will be 
lost if you use AutoSurround. When using AutoSurround with an MLC, the jaws push to either the 
block or the MLC-defined field, whichever is more limiting. Leaves that are above or below the 
block area and never touch the block are not affected.

1 Set the AutoSurround blocks field to Yes. The AutoSurround margin field appears.
2 In the AutoSurround margin field, set the offset between the jaws and blocking mask.

Unlock the blocks in a beam

If you have copied a plan to a new image, all blocks whose beams have at least one control point 
are locked by default to prevent any changes from taking place during the copying process. To make 
changes to the blocks in the plan you must unlock them.

When blocks are locked for a beam and you change the beam’s geometry (by moving the isocenter, 
for example), the existing block shape is unaffected and rotates with the collimator. However, you 
can still edit individual MLC leaf positions.

When blocks are locked, you cannot perform the following tasks:

• change the beam machine, energy, modality, or type
• copy and oppose a beam
• change the electron cone
• turn the MLC on or off
• use leaf pushing and similar operations that affect the entire MLC
• change the jaw positions and jaw symmetry
• add, delete, or insert a control point
• add, delete, or change the angle and orientation of a wedge, compensator, or a block 

associated with the beam
• export blocks for the beam
• regenerate an arc beam
• reset the ODM
• use the AutoSurround feature

If a beam’s blocks are locked, you can unlock them by selecting the beam and setting the Lock 
Blocks field to No. This field affects all the blocks in a beam.

When optimizing an IMRT plan, blocks are unlocked automatically before optimization begins.
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Delete a block
1 In the blocks list, select the one you want to delete.
2 Click Delete Block. 

The block tray number changes to No block.
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Wedges
You can add wedges to photon beams. You can choose from the wedges (physical, dynamic, or 
motorized) that were defined in the physics tool for the selected machine. In beam’s eye view 
displays, a label appears indicating which jaw the thick end is facing. These labels and the available 
wedges vary depending on the names entered in the physics tool.

The wedge orientation icons are designed to look like the actual wedges as they appear when 
added to the wedge tray. The small tab shows the placement of the tab that is inserted into the 
machine.

1 On the Modifiers tab, select the wedge to be used for treatment from the Wedge list.

NOTE
To use a dynamic wedge, you must use a static beam type.

2 Is the wedge physical (static) or dynamic?
• Physical—the angle is fixed; you cannot set it.
• Dynamic—in the Angle field, specify the angle.

You can type any angle within the allowable range of 0 to 80 degrees if you specified continuous 
wedge angles when setting up the dynamic wedge in the physics tool. If you specified discrete 
angles in the physics tool, then you select one of the angles from a list.

3 In the Orientation field, select the wedge orientation.

The wedge icons and their corresponding wedge orientations are explained in the Pinnacle3 
Planning Reference Guide. 

�CAUTION
Verify that the wedge angle and orientation are correct for your plan prior to treating the patient.

To display additional information about the current wedge click the right mouse button on the 
Wedge field, Angle field, or Orientation field for the beam. For more information, see the 
Pinnacle3 Planning Reference Guide.

Set up a beam with a motorized wedge

�CAUTION
If you create a plan that contains a beam with a motorized wedge, you will only be able to export 
the plan using DICOM RT.
1 Add a beam to the plan.
2 Specify the machine, modality, and energy. (A motorized wedge must be defined for the 

machine you select.)
3 From the Beam Type list, select Motorized Wedge. Two control points are added to the beam: 

one wedged and one open. Each has a default relative weight of 50%.
4 Set up the beam display, beam isocenter, angles, and jaws.
5 Click the Modifiers tab.
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6 From the Wedge list, select the wedge that you want to use. Only wedges that can be used as 
motorized wedges appear in the Wedge list.

NOTE
If you had not selected Motorized Wedge as the beam type and you select a motorized 
wedge, the software prompts you to confirm that it is okay to change the beam type to 
Motorized Wedge. Click Yes to proceed. If you click No, no wedge is added.

7 In the Orientation field, select the wedge orientation, if necessary.

NOTE
Motorized wedges are not available in irregular field planning or planar dose 
calculation.

Change the angle of the motorized wedge

You can change the synthesized angle of the motorized wedge by adjusting the weights of the 
control points or by typing an angle value.

Adjust the control point weights
1 Compute dose for the beam that contains the motorized wedge you want to change.
2 Select Options > Control Points.

The Control Points window opens. The two control points for the beam are listed in the 
window. 

3 Adjust the weights of the control points as necessary.
4 If necessary, repeat this procedure for other beams that contain motorized wedges.

Set the angle
1 Select the beam that contains the motorized wedge that you want to change.
2 Click the Modifiers tab.
3 Type the necessary angle in the Angle field. The software adjusts the weights of the two control 

points so MUs are correctly distributed to achieve the angle you typed. See the synthesized 
wedge angle information in the Pinnacle3 Physics Instructions for Use for details about how the 
wedge angle is calculated.

NOTE
Pinnacle3 computes dose based on the weights of the control points, not the angle you 
type in the Angle field. The angle you specify determines the relative weights of the 
control points. Also, the maximum angle Pinnacle3 uses is the one entered in the Wedge 
Angle field of the Wedge Editor window in the photon physics tool. Refer to the 
Pinnacle3 Physics Instructions for Use for more information.
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Multi-leaf collimators
This feature can only be used with photon beams and only if the MLC physics data has been 
entered for the machine.

If your radiation therapy machine has a multi-leaf collimator (MLC), you can use the MLC controls in 
Pinnacle3 to help shape the radiation beam. The jaw transmission is set in the physics tool during 
modeling. For partial transmission jaws, the value used is the combination of the jaw and MLC 
transmissions.

When a beam contains a block and uses MLCs, you can define the MLC leaf positions automatically 
according to the definition of the beam block or manually by shaping the MLC leaf by leaf.

1 Click the Modifiers tab.
2 Define a block, if necessary.
3 In the Use MLC? field select Yes. MLC leaves are automatically pushed to the jaw positions or to 

the block if there is one.

NOTE
For fixed jaw machines, the Use MLC? field is set to Yes and you cannot change it.

4 Click MLC Options. The Beam MLC Leaf Position Editor window opens.
5 Make sure the correct beam is selected in the MLC for beam field.
6 If you modify the jaw positions for a beam that uses MLCs with control points and no block, on 

the Leaf Pushing tab click Push Leaves to Jaws to move the leaves to the current jaw position. If 
the beam contains multiple control points, you will have to do this for each control point.

7 Define the MLC leaves automatically or manually. Continue to one of the following:
• Automatically define the leaf positions.
• Manually define the leaf positions.
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NOTE
If the beam type is Step & Shoot MLC, a list of control points appears in the Beam MLC 
Leaf Position Editor window.To use the control points, see Forward-Planning IMRT. 

Automatically define the leaf positions
1 Make sure the correct beam is selected from the MLC for beam list in the Beam MLC Leaf 

Position Editor window.

�CAUTION
You must define blocks before setting the MLC leaf positions. Verify the placement of the 
automatically placed MLC leaves.

�CAUTION
For fixed jaw machines, the machine must treat with the closed leaves pushed behind the jaws. 
The software tries to force this to happen when you click Push Leaves to Block or when a change 
to the plan automatically causes the leaves to be pushed to the block. Verify that the closed 
leaves are behind the jaws before you compute dose.
2 On the Leaf Pushing tab, click Push Leaves to Block. The MLC leaves are automatically 

configured to match the beam block you defined, as shown in the beam’s eye view.
3 In the Push Leaves To Leaf list, select the appropriate option to cover exposed areas just 

outside the perimeter of the beam block. These options give you another measure of automatic 
control over the leaf positions, which may be necessary since the ROI is not rectangular and the 
MLC leaves are rectangular. 

Position Description

Center Make the MLC leaves stop at the first intersection point of the center 
of each leaf with the beam block.

Top Make the MLC leaves stop at the first intersection point of the top of 
each leaf with the beam block.

Bottom Make the MLC leaves stop at the first intersection point of the bottom 
of each leaf with the beam block.

Average Set the leaf to make underexposed and overexposed regions of the 
beam block equivalent. In the illustration at left, the overexposed and 
underexposed areas are equal.

Minimum Make the MLC leaves stop at the first intersection point with the 
beam block. This option ensures that the beam block is not 
overlapped, but more exposed area remains around the block.
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4 For machines that allow interdigitation and for which the MLC is not set to replace the jaws, 
you can move the closed leaf pairs behind the jaws to minimize leakage through the closed leaf 
pairs.

In the Close Leaves For list, select Current Trial to move the closed leaf pairs behind the jaws for 
all beams in the trial, or select Current Beam to move the closed leaf pairs only in the current 
beam. Then click Close Leaves Behind Jaws to push the closed leaf pairs behind the jaws.

NOTE
If the maximum tip position for the machine is less than or equal to the maximum jaw 
position and the beam is a static, arc, or motorized wedge beam, then the MLC leaves 
will not be pushed behind the jaws.

NOTE
For step and shoot or conformal arc beams, if the maximum tip position from the jaw 
for the machine is smaller than the field size along the direction of leaf travel, then 
clicking Close Leaves Behind Jaws will position the closed leaf pairs at different 
locations for different control points.

�CAUTION
Verify the automatically selected collimator angle.
5 Click Optimize Collimator Angle. The software selects the angle with the lowest error. 

NOTE
Optimize Collimator Angle is available if there is at least one block.

The geometrical data updates and the optimized results appear as a plot of error versus 
collimator angle. To close the histogram, click Close.

The Error field displays the MLC error, in cm2. The error is the sum of unblocked regions that 
should be blocked and of blocked regions that should be exposed. If you think the error is too 
high, you can refine the leaf positions by editing them manually.

6 If you want to add a skin flash adjustment, enter a value in the Shift leaves field and click either 
Shift A bank or Shift B bank. The software opens the leaves in the bank by the specified 
amount. If necessary, the software also shifts the jaw associated with the bank you are opening.

NOTE
The labels on the Shift A bank and Shift B bank buttons are the bank names that you 
entered in the MLC Editor window in the physics tool. For example, if the banks are 
named Left and Right, the buttons read Shift Left bank and Shift Right bank.

You can use the skin flash adjustment only for step-and-shoot MLC beams that do not use the 
AutoSurround feature. The adjustment affects only the selected control point, and moves only 

Maximum Make the MLC leaves stop at the first intersection point with the 
beam block after covering all exposed area around it. The MLC leaves 
will also cover some of the block.

Position Description
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those leaf pairs that are open by more than their minimum opposing leaf gap. For more 
information, see Forward-Planning IMRT. 

�WARNING
Verify the accuracy of your MLC settings before continuing. To check, visually verify the 
correctness of the MLC leaves. Incorrect MLC settings and leaf positions can result in incorrect 
dose.

Manually define the leaf positions

The leaves extend from the edges of the beam’s eye view if you have them defined to move parallel 
to the left/right jaws. The table in the Beam MLC Leaf Position Editor window shows the left and 
right position of each leaf pair. These positions update as you define the MLC settings.

NOTE
If the AutoSurround blocks option is on, manual editing of MLC leaves only affects the 
left and right jaws (assuming that the leaves move parallel to the left/right jaws), and 
only affects leaves that overlap the field. You can still move leaves above and below the 
field, but the top and bottom jaws will not widen to enclose those leaves.

NOTE
If you move a leaf so that it violates the maximum tip difference settings with which the 
machine is commissioned, other leaves may also move so that the maximum tip 
difference restrictions are satisfied.

1 Make sure the correct beam is selected from the MLC for beam list in the Beam MLC Leaf 
Position Editor window.

2 Enter the coordinates of the leaf positions or graphically place the leaves:
• To enter coordinates, click a position coordinate, and then enter the new position in the field 

above the table. This procedure is complete.
• To graphically move leaves—go to step 3.

3 Click the Move MLC manually tool.
4 Click an empty area between the leaves to extend the closest leaf to the clicked point, or 

reposition leaves by dragging their edges.

Leaves appear by default as white bars after you click in the beam’s eye view. Use the jaw labels 
to help orient yourself in the beam’s eye view.

NOTE
If a block automatically conforms to an ROI and you manually change the MLC leaf 
positions, and then you change the plan such that the block shape must be updated, the 
MLC leaf positions revert to the shape of the block. For example, if a block exposes a 
target ROI and you move the beam’s isocenter, the software updates the block shape 
and the MLC leaves conform to the new block shape. In this case, if you want to retain 
the MLC leaf positions that you defined manually, you must delete the block before you 
change the plan.
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5 To change the color of the leaves, click Options > Display Parameters to open the Beam Display 
window. Then select MLC Leaves from the Component list and choose the color from the 
Component 2D/3D Color list.

�WARNING
Verify the accuracy of your MLC settings before continuing. To check, visually verify the 
correctness of the MLC leaves. Incorrect MLC settings and leaf positions can result in incorrect 
dose.

MLC leaf display options

The Display Options tab in the Beam MLC Leaf Position Editor lets you set leaf display options for 
the current beam:

• Clip leaves—Select Yes to view only the section of the MLC that is within the rectangular field 
limits in the BEV window. When this setting is No, the entire MLC is displayed in the BEV 
window.

• Fill in leaves—Select Yes to fill in the MLC leaves with color. If you select No, the MLC leaves are 
displayed with outlines.

• Maximum leaf motion—Select Yes to display the maximum extent of the MLC leaf openings 
across all control points for step-and-shoot, and conformal arc beams. A dashed line showing 
the maximum extent of the leaf motion appears in the BEV DRR display.

NOTE
In the Utilities menu, you can set these same MLC leaf display options for all beams and 
override the settings of individual beams.
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Create conformal arc plans
A conformal arc plan calculates new sets of MLC positions at specified intervals through a 
treatment arc. When you build a conformal arc, you define the start and stop angles for the arc as 
well as the degrees between control points. The software creates a control point at the start angle 
and intermediate control points that are separated by the specified angle increment. A final control 
point is created at the stop angle. After the software creates the conformal arc, control points 
cannot be added or deleted.

At each control point, the MLC leaves are pushed to conform to the specified blocking mask. 
Control points for conformal arc beams are weighted so as to deliver a constant monitor unit (MU) 
per degree. However, the first and last (and sometimes the second to last) control points receive 
fewer MUs and have a smaller arc length.

You can export conformal arc plans by using the following methods:

• In DICOM RT export format
• In the Toshiba MLC export format
• To a Toshiba MLV Record & Verify system
• To the Varian Shaper system via the Shaper protocol/file format
• To Mitsubishi accelerators via DME

The following procedure explains how to create a conformal arc plan. The procedure assumes that 
you have already used the Photon Physics Tool to commission a machine that has an MLC and can 
deliver conformal arc beams. For details, see the Pinnacle3 Physics Instructions for Use.

1 Add a conformal arc beam to a plan. See Preparing to add, copy, and delete beams in the Beams 
chapter.

2 Click the Modifiers tab of the Beams panel.
3 Select the beam for which you want to set up a block from the Beam list.
4 Add blocks for the ROIs to be exposed or blocked. At least one ROI must be exposed, and 

manual blocks may not be used.
5 Click Conformal Arc.

The Conformal Arc window opens.

6 Set the rotation direction and gantry angles.
7 Enter a value in the Degrees Between Control Points field. If the arc length is 90 degrees or 

greater, use a value of 1-10 degrees. If the arc length is less than 90 degrees, use a value of 1-5 
degrees. (Arc length is the angular distance from the start angle to the stop angle in the 
direction of rotation.)

NOTE
The software will generate exact monitor units for each control point if you use the 
values described in step 7. For a quick calculation of the dose distribution, use a value of 
11-20 degrees if the arc length is 90 degrees or greater, or 6-10 degrees if the arc length 
is less than 90 degrees. When you use these values, the resulting monitor units are 
approximate and the plan cannot be used clinically or exported. Approximate monitor 
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units are identified with a tilde (~). When you are satisfied with the dose distribution, 
use the values described in step 7 to generate exact monitor units.

8 Do you want the collimator jaws to move automatically using the AutoSurround Blocks feature?
• Yes—go to step 9.
• No—go to step 10.

9 Set the AutoSurround Blocks option to Yes.

NOTE
The AutoSurround Blocks option does not appear for fixed jaw machines.

10 Click Create Conformal Arc. The software creates the conformal arc control points.

NOTE
You cannot manually add or delete individual control points or modify control point 
weights.

11 To view control points in the Conformal Arc Multiple BEV window, click Display consecutive 
MLC control point BEV in the Conformal Arc window.

12 To view detailed information for each control point, select Options - Control Points.

The Control Points window opens. The software displays the monitor units and weights of each 
control point in a conformal arc beam as a cumulative value from the starting point up to the 
control point.

13 Repeat steps 1-10 as needed to create additional conformal arc beams.

�CAUTION
After you export a conformal arc plan to a Record and Verify system or MLC treatment unit, verify 
that the exported plan information is consistent with the software’s plan.

MLV beam export

Toshiba MLV export requires that an MLC shape be exported for every 2 degrees of gantry motion 
throughout the arc. Unless you create the conformal arc with an increment of 2 degrees, the 
software does not create a control point for every gantry angle that must be exported. In order to 
address this, the export linearly interpolates the MLC positions for the required angles based on the 
actual control points of the conformal arc.

Varying jaw positions

Consider how you will export a conformal arc plan before varying jaw positions between MLC 
control points. Plans in which jaw positions vary between control points cannot be exported using 
Toshiba MLC export or Mitsubishi DME export. However, Toshiba plans with varying jaw positions 
can be exported using Toshiba MLV export.
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Apertures

NOTE
Aperture options are only available if you are licensed for proton treatment planning. 
Apertures are only available for use in double scattering beams and uniform scanning 
beams.
If a beam is locked, the aperture for that beam is also locked. If you cannot access the 
aperture options, unlock the beam and the aperture, if necessary. See Lock a beam.

The software adds a default aperture (the target aperture) to each double scattering beam and 
uniform scanning beam after you select a target ROI.

When calculating the milled aperture, the software applies the milling algorithm taking into 
account the physical milling tool diameter to ensure that the aperture created in planning should 
be achievable at the milling machine.

1 Change the viewing window to a beam’s eye view (BEV) so that you can visualize the aperture.
2 Click the Modifiers tab of the Beams panel.
3 Select the beam from the Beams list.
4 Select the structure that you want to expose from the Structure list.

If you select the Manual structure, go to Manually change the aperture to change the shape of 
the aperture opening.

5 Click Properties. The Aperture Properties window opens.
6 Specify an aperture ID in the Aperture ID field.

NOTE
The default ID for the aperture is generated based on the Medical Record Number of the 
patient, the Field ID, and the beam name.

7 Verify that the aperture material that is shown in the Material field is the correct material for 
this aperture. To change the material, select a different material from the Material list.

8 If necessary, specify a margin for the aperture opening in the Margin field. The software 
exposes the structure that you selected plus the margin that you specify when it creates the 
aperture opening. We recommend that you specify a margin of 0.30 cm or more.

NOTE
The data shown in the Stopping power relative to water field and the Slab thickness 
field are the data that were commissioned in the physics tool for this aperture material. 
You cannot change this data in planning.

9 Specify the number of slabs required for this aperture.

NOTE
The system verifies that the total thickness of the aperture slabs is sufficient to stop the 
radiation for the given range and modulation. The thickness safety margin of the 
aperture should be greater than or equal to 0.30 cm.
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10 Specify a conversion method by selecting the Over or Under option.
• Over—the aperture exposes the entire target ROI. In this conversion method, the opening of 

the milled aperture is always the same size or larger than the opening of the target aperture.
• Under—the aperture exposes as much of the target ROI as possible but might miss some 

sharp points or angles. In this conversion method, the opening of the milled aperture will be 
smaller than the opening of the target aperture.

11 Specify the milling tool diameter in the Milling tool diameter field.

NOTE
The initial value that is shown in the Milling tool diameter field is the default milling 
tool diameter value that was commissioned in the physics tool for this aperture 
material.
The field radius calculation that is displayed in the Snout section of the Geometry tab is 
based on the aperture milling diameter. If the aperture has an irregular shape, then the 
radii along the X and Y axes and the maximum radius are displayed.

12 Choose one of the following:
• To define the aperture for another beam, return to step 3.
• If you have defined the apertures for all of the double scattering beams and uniform 

scanning beams, continue to step 13.
13 Click Close to close the Aperture Properties window.
14 When you are finished defining the apertures, we recommend that you lock the apertures to 

prevent unwanted changes to the shape of the aperture. Go to Lock the aperture.

Manually change the aperture

When you select the Manual option from the Structure list, editing tools appear in the Beams 
panel that let you change the shape of the aperture opening.

1 Click Select block from the list of editing tools.
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2 Click the inside edge of the aperture. All of the points in the aperture are displayed with square 
point markers as shown in the following illustration.

3 Use the editing tools to modify the shape of the aperture opening. For information about using 
these tools, see the Tools chapter.

4 When you are finished modifying the shape of the aperture opening, we recommend that you 
lock the aperture to prevent unwanted changes to the shape of the aperture. Go to Lock the 
aperture.

Lock the aperture
1 In the Beams panel, click the Setup tab and then click the Details button. 

The Proton Beam Parameters window opens.

2 In the Beam list, select the beam that contains the aperture that you want to lock.
3 Select Yes in the Lock Aperture field.

When the aperture is locked, you cannot change the snout or the air gap. In addition, you 
cannot choose a different machine, modality, or target ROI. You can change the other beam 
parameters, however.
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Compensators
Compensators can be used with photon and proton beams:

• Photon beams—see Create compensators for photon beams.
• Proton beams—see Define compensators for proton beams.

NOTE
Proton compensator options are only available if you are licensed for proton treatment 
planning.

Create compensators for photon beams

The software can automatically design missing tissue and dose compensators or, if you have 
another means of designing compensators, you can enter the compensator thickness array 
manually. For information on designing compensators manually, see the Pinnacle3 Planning 
Reference Guide.

To open the Compensator Editor window, click Edit in the Compensator section of the Modifiers 
tab on the Beams panel.

If you use the automatic compensator design option, the software can compensate for missing 
tissue, primary dose, or full 3D dose (primary and scatter). The software determines the shape of 
the compensator as follows:

1 You define the density of the compensation material, the width, height, and resolution for the 
compensator, and the depth of the plane for the compensator shape optimization.

2 The software creates a series of points on the optimization plane with one point per cell in the 
compensator array.

3 The software computes dose using the following rules:
• Missing Tissue Compensator—The energy fluence is computed using SSDs, thus obtaining 

just a patient surface shape.
• Primary Dose Compensator—The energy fluence is computed using density-corrected 

primary fluence.
• Full 3D Dose Compensator—The density-corrected primary fluence is computed, and then a 

CC Convolution calculation is performed on the fluence. 
4 The software computes mean dose in the 2D array of points and the dose statistics for the 

optimization plane are displayed in the Compensator Editor window.

The fields under Plane Dose Statistics show how well you are achieving the same dose/energy 
fluence to all points. The software attempts to create a uniform dose/energy fluence to the 
points on the optimization plane. The values are relative because they depend on the monitor 
units, which are variable. Points beneath blocks or outside the patient are excluded. 

The Min, Max, and Mean fields display the minimum, maximum, and mean dose/energy 
fluence to all points in the plane. The Std Dev field displays the standard deviation from the 
mean of all the points.
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5 The thickness of compensation material in each cell of the compensator array is adjusted using 
one of the following equations, depending on the type of compensator you are using:
• Missing Tissue compensators:

• For Primary Dose and Full 3D Dose compensators, the system uses an iterative process to 
get a uniform TERMA or dose, respectively, to the user-specified plane:

MeanAttenuation is the mean μ/ρ for the beam energy spectrum and the compensator 
density.

6 The software repeats steps 3-5 for the specified number of iterations.

To fill the compensator pixels outside the optimized area of the compensator, the software uses 
the option you specify for the Thickness Outside Field in the Design Options window. This field 
and other compensator design options are described in the Pinnacle3 Planning Reference Guide.

Compensator attributes

The compensator attributes allow you to define the compensator.

• Density—Specifies the density of the compensator material (in g/cm3). 
• Source To Comp Dist—Specifies the distance from the source to the top of the compensator 

tray.
• Actual Width and Actual Height—Defines the actual dimensions of the compensator in the X 

and Y directions (in cm). If you select SAD for the scale width/height display in the next field, 
then the width and height are projections to SAD. If you enter the X Dimension, Y Dimension, 
and Resolution (as described below), the Actual Width and Actual Height are calculated using 
the following equations:

• Scale Width/Height Display To—Specify whether the width and height of the compensator 
should be set based on the source-to-axis distance (SAD) or source-to-compensator distance 
(SCD). If you select SAD, the Actual Width and Actual Height labels change to Width at SAD 
and Height at SAD.

• Resolution—Sets the compensator output resolution. The compensator is divided into a grid 
with this resolution, and thicknesses are determined for each section of the grid.

• X Dimension and Y Dimension—Sets the number of pixels in each direction. If you have 
entered the Actual Width, Actual Height, and Resolution, the X Dimension and Y Dimension 
are calculated automatically.

Thickness(i,j) = (SSD(i,j) - SSDmin )/Compensator density

Thickness i j,  Thickness i j, 
MeanDose Dose i j,  log
MeanAttenuation

-------------------------------------------------------------------–=

Actual Width X Dimension 1–  Resolution=

Actual Height Y Dimension 1–  Resolution=
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• Round Thickness Values—If you want to round the values in the compensator thickness array, 
select Yes and then specify a rounding value from 0.001 to 30 in the Round to Nearest field that 
appears. Rounding to the closest even multiple of the rounding value occurs after the last 
iteration of optimization or when you enter values manually in the compensator array. For 
example, if the rounding value that you specify is 0.200, a compensator thickness value of 0.250 
is rounded to 0.200 because 0.250 is closer to 0.200 than it is to 0.400, and a compensator 
thickness value of 0.320 is rounded to 0.400.

• OF Correction Factor—Enter a correction factor for the output factor if you measure dose with 
your compensator and you think that a correction is needed. A correction factor is not required; 
enter one only if you think it is necessary. Generally, the OF Correction Factor should be set to 
1.0. 

If an OF Correction Factor is used, it is multiplied by the collimator output factor (OFc) to give a 
total Collimator Output Factor for the compensated field:

See the Pinnacle3 Planning Reference Guide for more information about calculating the 
correction factor.

Define compensators for proton beams

NOTE
The following information only applies to double scattering beams or uniform scanning 
beams. 
If a beam is locked, the compensator for that beam is also locked. If you cannot access 
the compensator options, verify that the beam is not locked, and unlock the beam and 
the compensator if necessary. See Lock a beam.

The software adds a compensator to each double scattering beam and uniform scanning beam 
after you select a target ROI for the beam.

NOTE
The software will not add a compensator to the beam if it cannot find a valid range band 
for the beam. For more information, see Preparing to add, copy, and delete beams.

1 Click the Modifiers tab in the Beams panel, and select the beam from the Beams list.
2 Click Edit in the Compensator section of the Beams panel. The Compensator Editor window 

opens.
3 Verify that Yes is selected in the Use Compensator field.
4 Set the following attributes as appropriate.

NOTE
The resolution of a proton compensator is calculated using the diameter of the milling 
tool. You cannot change the resolution values in the X Resolution or Y Resolution fields.

• Scale Width/Height Display To—Specify whether the width and height of the compensator 
should be set based on the virtual source-to-axis distance (SAD) or virtual source-to-

OFc Collimator OF Compensator OF Correction Factor=
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compensator distance (SCD). If you select SAD, the software displays the Width at SAD and 
Height at SAD values. If you select SCD, the software displays the Actual Width and Actual 
Height values.

NOTE
The SAD is the distance from the isocenter to the virtual source. The SCD is the distance 
from the compensator to the virtual source.

• Round Thickness Values—If you want to round the values in the compensator thickness 
array, select Yes and then specify a rounding value from 0.001 to 30 in the Round To Nearest 
field that appears. Rounding to the closest even multiple of the rounding value occurs after 
the last iteration of optimization or when you enter values manually in the compensator 
array. For example, if the rounding value that you specify is 0.200, a compensator thickness 
value of 0.250 is rounded to 0.200 because 0.250 is closer to 0.200 than it is to 0.400, and a 
compensator thickness value of 0.320 is rounded to 0.400.

5 Click Properties. The Compensator Properties window opens.
6 Type an ID for the compensator in the Compensator ID field if you do not want to use the 

default ID assigned by the software.
7 Verify that the compensator material that is shown in the Material field is the correct material 

for this compensator. To change the material, select a material from the Material list.

NOTE
The data shown in the Stopping power relative to water field and the Minimum 
thickness field are the data that were commissioned in the physics tool for this 
compensator material. You cannot change this data in planning.

8 Specify whether edge processing should be applied to the compensator.
• Yes—An average thickness value is assigned to compensator pixels that are unblocked by the 

aperture and that do not intersect the target ROI. The value assigned is the average thickness 
of all of the pixels that fall within a radius that you specify from the pixel.

• No—The compensator pixels that fall outside of the target ROI are assigned the maximum 
compensator thickness value.

9 Specify whether smearing should be applied to the compensator.

When you apply smearing, each compensator pixel thickness value is reassigned to the lowest 
value among its nearest neighbors within the radius that you specify. Smearing mitigates 
patient motion and setup errors as well as dose “undershoot.”

• Yes—Specify a smearing margin between 0 cm and 5 cm.
• No—Smearing is not applied to the compensator.

NOTE
If you apply smearing or change the smearing settings after you have manually edited 
the compensator, the changes that you made to the compensator are lost when the 
software recomputes the compensator to apply the new smearing settings.
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10 Specify whether distal blocking should be applied to the compensator.

Distal blocking increases the thickness of certain pixels in the compensator to pull the dose 
back from organs that are distal to the target ROI.

• Yes—Click Edit. The Distal Blocking Editor window opens. Continue to step 11.
• No—Distal blocking is not applied to the compensator. Continue to step 15.

NOTE
If you add or remove distal blocking or change a margin after you have manually edited 
the compensator, the changes that you made to the compensator are lost when the 
software recalculates the compensator to apply the distal blocking changes.

11 In the Distal Blocking Editor window, select the check boxes for the ROIs that you want to use 
for distal blocking and click Add to distal blocking list. The ROIs appear in the Distally blocked 
ROIs list.

12 Type a margin from 0 cm to 5 cm that should be applied to the distally blocked ROIs.
13 To remove an ROI from the Distally blocked ROIs list, select the check box for the ROI you want 

to remove from the list and click Remove from distal blocking list.
14 When you are finished, click Close to close the Distal Blocking Editor window.
15 Specify whether the compensator should be truncated.

• Yes—The maximum thickness value of the unmilled compensator area is overwritten with 
the maximum thickness value of the milled compensator area that is generated by the 
system.

• No—The compensator is not truncated. The maximum thickness value of the unmilled 
compensator area that was specified during snout creation is retained.

16 Specify a milling method by selecting the Plunge or Continuous option.
• Plunge—The milling tool is a non-zero radius tool. Specify the milling tool diameter after you 

select this option.

NOTE
The initial value shown in the Milling tool diameter field is the value that was 
commissioned in the physics tool.

• Continuous—The milling tool is a zero-radius tool.
17 Click Close to close the Compensator Properties window.
18 To view the thickness array for the compensator, click Edit Thickness Array. The Compensator 

Array Editor displays the physical thickness values in the table, in centimeters. These values are 
calculated based on the snout that you specified for this beam, the shape of the aperture, and 
the compensator properties. The column and row headings are the coordinates of the X axis 
and the Y axis based on the graphic that follows. You cannot edit the values in the array from 
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this window. They are shown only for reference. To edit the thickness array, see Edit 
compensators for proton beams.

If you selected the Plunge milling method, every other row of the compensator thickness array 
is shifted in the positive X direction. The amount of the shift is half of the X step size 
(resolution). This shift ensures that all of the plunges fully overlap (there are no gaps of 
unmilled material). The shift is necessary because a circular cutting tool of finite diameter is 
used to mill the compensator. The graphic that follows illustrates a plunge milling method (a 
hexagonal milling pattern). This milling technique helps achieve the least overlap between 
milling bits while covering the compensator area completely. The numbers inside the circles 
represent the depth at a particular point in centimeters.

If you selected the Continuous milling method, no shift is applied.

X2

Y1

X1

Y2

Table

Beam’s Eye View
(from above)

Gantry
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Edit compensators for proton beams

The Compensator Editor lets you adjust the dose distribution by changing the thickness values of a 
compensator so that you can compare different dose scenarios and create an optimal compensator 
for the treatment.

NOTE
If the beam is unlocked but the compensator is locked, you can make changes to the 
compensator and view the results of the changes, but you cannot save your changes. To 
save changes, you must unlock the compensator before you make your changes. See 
Lock the compensator for proton beams.

1 Click the Modifiers tab in the Beams panel, and select the beam from the Beams list.
2 Click Edit in the Compensator section of the Beams panel. The Compensator Editor window 

opens.
3 Click Advanced Editing. The Advanced Compensator Editor window opens.

NOTE
The Advanced Editing button is only active if dose is computed for the beam.

The window contains two 2D viewing windows. The viewing window at the top shows the 
location and shape of the compensator. The viewing window at the bottom shows the dose 
distribution. You can display the isodose levels as a colorwash and as isodose lines.

The window also contains two tabs.

• Edit—Contains tools that let you edit the compensator. Continue to step 4.
• Display—Contains tools that let you change the display of the dose distribution. See Change 

the display.
4 Click the Edit tab if the Edit panel is not already shown.

The thickness array at the bottom of the Edit panel shows the thickness of each pixel in the 
compensator. When you click on a pixel in the thickness array, the location of that pixel is 
marked in the 2D viewing window. After you specify the isothickness settings and colors for the 
compensator on the Display tab, the pixels in the thickness array are color-coded according to 
their thickness.

5 From the Region list, select a method for editing the compensator.
• Pixel—Select Pixel to edit the compensator one pixel at a time. To edit a pixel, either select 

the Edit pixel tool shown at left and click on the pixel in the viewing window that you want to 
edit or select the pixel that you want to edit in the thickness array at the bottom of the Edit 
panel. Then enter the new thickness value in the Value at cursor field in the Settings area of 
the Edit tab.

• Area—Select Area to edit multiple pixels at one time. To select the pixels to edit, select one 
of the drawing tools shown at left and draw around the area that you want to edit.

NOTE
To change the diameter of the paintbrush for the Create contour paintbrush tool, type a 
value in the Diam. (mm) field.
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– Flat—Changes the thickness values for all of the selected pixels to the new thickness value 
that you enter in the Value field.

– Average—Calculates the average thickness of the selected pixels, and then changes the 
thickness values of the selected pixels to the average thickness value. For example, if you 
select two pixels with thickness values of 1.2 cm and 2.0 cm, the new thickness value for 
both of the pixels is 1.6 cm.

– Percentage—Changes the thickness values of the selected pixels by adding or subtracting 
the percentage that you enter in the Value (+/-) field from the original thickness values. 
Enter a positive value to add to the thickness, or enter a negative value to subtract from 
the thickness. For example, if you select two pixels with thickness values of 4 cm and 8 cm 
and then enter a value of “25” in the Value (+/-) field, the new thickness values for the 
pixels are 5 cm and 10 cm respectively.

– Add or subtract—Changes the thickness values of the selected pixels by adding or 
subtracting the value that you enter in the Value (+/-) field from the original thickness 
values. Enter a positive value to add to the thickness values, or enter a negative value to 
subtract from the thickness values.

6 Click Compute to calculate dose.
7 Continue to edit the compensator and compute dose until you are satisfied with the dose 

distribution.
8 If you selected the Area option in step 5 and drew contours and want to remove them from the 

image of the compensator, click the Delete contour tool and drag the cursor over any contours 
associated with the current ROI that you want to delete.

9 When you are finished editing the compensator, select File – Save and Close Window to save 
your changes and close the Advanced Compensator Editor window.

To close the window without saving your changes, select File – Reject and Close Window.

NOTE
The Save and Close Window option only saves the compensator for the current 
planning session. You must also save the trial when you exit the planning session to save 
the compensator to the trial.

10 When you are finished defining the compensator, we recommend that you lock the 
compensator to prevent unwanted changes to the shape of the compensator. Go to Lock the 
compensator for proton beams.

Change the display
1 Click the Display tab. The Display panel opens.
2 Drag the Anatomy - Compensator slider to change the opacity of the anatomy and the 

compensator in the viewing window.
3 Select On or Off in the Beam Display field to show or hide the beam in the viewing windows.
4 To view the thickness distribution of the compensator, click Add a new isothickness to add an 

isothickness line. A new row appears in the isothickness table.
5 Enter a thickness value in the Isothickness field.
6 To change the isothickness line display color, select a color from the Color list.
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7 To turn the display of the isothickness line on or off, click Display Color for the isothickness line.
8 To remove an isothickness line from the display, select the line that you want to remove and 

click Remove isothickness.
9 To view the dose distribution, select an option from the Isodose lines are list.

• Percent of Max Dose—The isodose lines are displayed as a percentage of maximum dose, 
and the maximum dose is listed.

• Percent of POI Dose—The isodose lines are displayed as a percentage of the dose at a 
selected point of interest (POI). When you select the POI, the dose at that normalization 
point is displayed.

10 Click Add a new isodose line to add one isodose line, or click Add/set lines at 98, 90, 80, …, 20, 
10% to add multiple isodose lines at the percent of the dose normalization point you selected in 
step 9.

Rows are added to the isodose table. The dose distribution is displayed in the viewing window 
as per the dose percentage.

11 To change the value for an isodose line, type a new value in the Value field for that line.
12 To change the isodose line display color, select the color from the Color list for that line.
13 To turn the 2D display of an isodose line on or off, click 2D Display for the line.
14 To display colorwash for the dose distribution, click Yes next to 2D Colorwash Display.
15 To remove an isodose line, select the line that you want to remove and click Remove isodose 

line.
16 To change the orientation of the image in the second viewing window, select an orientation 

from the list below the viewing window.
17 If the orientation of the image in the viewing window is Perpendicular BRV and you want to 

change the rotation of the image, type a value in the Display Rotation field.

Lock the compensator for proton beams

When you are finished editing the compensator, we recommend that you lock the compensator to 
prevent unintended changes to the compensator.

1 In the Beams panel, click the Setup tab and then click Details. 

The Proton Beam Parameters window opens.

2 In the Beam list, select the beam that contains the compensator that you want to lock.
3 Select Yes in the Lock Compensator field.

When the compensator is locked, you cannot make any changes to the compensator itself. In 
addition, you cannot change the snout, air gap, beam modality, or target ROI. You also cannot 
choose a different machine. You can change the other beam parameters, however.
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Print compensators for proton beams

The compensator printing feature lets you generate a printout of the compensator so you can verify 
that the compensator produced by the software and the physical compensator that was milled 
using the same specifications are comparable prior to treatment.

1 Click Print Compensator in the Compensator Editor window. The Compensator Printing 
window opens.

NOTE
The dots in the Compensator Printing window represent the center of the milling bit. 
The shape of the snout, either circular or rectangular, is also displayed.

2 Set up the isothickness lines as needed before printing. For more information, see Change the 
display.

3 Click Print. The Compensator Print window opens.
4 Click Select Printer to select a printer. The Color Printer Selection window opens.
5 Select the printer that you want to use and click Close.
6 Click Proceed to print the compensator. The paper size and the number of pages to be printed 

are determined by the size of the compensator.

The printout represents the milling pattern. If you used the plunge milling technique, then the 
compensator is represented by circular milling bits in the printout. If you used the continuous 
milling technique, then the compensator is represented by continuous lines on the printout.

Display measurement points

The Measurement Points section of the Compensator Printing window lets you view different 
thicknesses across the compensator and their distances from the X and Y axes.

1 To view the thickness at a particular point, click the Annotate compensator thickness tool and 
click the point that you want to measure on the compensator. The thickness of the 
compensator at that point and the distance of that point from the X and Y axes are displayed in 
the Measurement Points section of the window and in the upper right corner of the 
compensator viewing window.

2 To delete an annotated point, click the Delete annotation tool and click the thickness and 
distance information that you want to delete in the upper right corner of the compensator 
viewing window.

Remove compensators from proton beams

The software adds a compensator to each double scattering beam and uniform scanning beam 
after you select a target ROI for the beam. If you do not want to use a compensator with a beam, 
you must manually remove the compensator from the beam.

1 Click the Modifiers tab in the Beams panel, and select the beam from the Beams list.
2 Click Edit in the Compensator section of the Beams panel. The Compensator Editor window 

opens.
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3 Select No in the Use Compensator field. The software removes the compensator from the 
beam.
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Set proton beam modifier information for export
If you enabled the export of DICOM sequences for lateral spreading devices and range modulators 
when you commissioned the machine in physics, you can define the information to be exported on 
the Modifiers tab of the Beams panel. The information differs based on the type of beam that you 
are defining.

Define export settings for a uniform scanning beam

If the current beam is a uniform scanning beam, the Range Modulator Export Settings section 
appears on the Modifiers tab. Specify the start and stop gating angles of the range modulator in the 
appropriate fields.

Define export settings for a double scattering beam

If the current beam is a double scattering beam, the Range Modulator Export Settings and Lateral 
Spreading Device Export Settings sections appear on the Modifiers tab.

1 In the Range Modulator Export Settings section, specify the start and stop gating angles of the 
range modulator.

2 In the Lateral Spreading Device Export Settings section, specify the settings for the lateral 
spreading devices. Type a value for each lateral spreading device based on the settings of your 
machine. Some machines require you to type “IN” or “OUT” while others require you to type a 
sequence of 0’s or 1’s, where “0” indicates an “OUT” setting and “1” indicates an “IN” setting. 
For example, if a lateral spreading device has plates set as “100”, this indicates that the first 
plate is “IN” and the other two plates are “OUT”. Refer to the documentation that was provided 
by the machine vendor to determine the correct value.
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Bolus
The bolus feature can only be used with electron and photon beams.

�CAUTION
Make sure you verify that the bolus is correct for your plan prior to using the bolus when treating 
the patient.

You can add boluses to the plan at any time. Boluses appear on the image as soon as they are 
created, and they are created at the resolution of the patient image data, not the dose grid. Boluses 
are generated independent of jaw size, so a bolus can be wider than the beam size, if necessary.

Before you create a bolus, try to remove artifacts from the area where you want to create the 
bolus. You can remove artifacts such as patient markers, CT artifacts, and immobilization devices by 
creating a contour around the artifact and then setting the density override value to 0. You can also 
contour the external patient outline, override the density outside of the contour, and set the 
density to zero. The software will create the bolus without including the artifacts in its calculations.

Bolus limitations
• When you add bolus to an electron beam, and the source to bolus distance is less than the SSDs 

included in your output factor table, monitor units will not be available. If you want to add a 
bolus that is closer than the minimum SSD defined for the machine, we recommend that you 
add data measured with SSDs less than the current minimum to your output factor table.

• You cannot build a bolus if it extends outside of the image set or if the image set has 2 rows and 
columns, or less, of pixels in the air space outside of the patient.

• You cannot build a constant-thickness bolus if the patient does not appear in the center of the 
image set. However, you can still draw the bolus manually using the Create bolus point by 
point tool. For more information, see Variable thickness bolus.

• You cannot build a bolus on a single-slice image set. If your plan uses a single-slice image set, 
you must create an additional slice superior and inferior to the contoured slice. The center slice 
must be thicker than the bolus will extend.

• A bolus cannot extend to cover any part of the most superior and inferior slices.
• The software invalidates the bolus if you do any of the following:

– Move the couch removal plane so that it intersects with the bolus.
– Restore or remove a stereotactic frame.
– Change the outside-patient air threshold.
– Change the CT to Density table.
– Change the status of density override for one of the ROIs that the bolus intersects or 

touches.
– Change the status of whether to load voxels Inside ROI or Outside ROI for one of the density-

overridden ROIs.
– Change the density across the patient-air threshold for one of the density-overridden ROIs 

that the bolus intersects or touches.
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– Change the density unit so that the density changes across the patient-air threshold for one 
of the density-overridden ROIs the bolus intersects or touches.

– Change the shape of a density-overridden ROI that intersects or touches a bolus.

NOTE
If you open a plan that was created in Pinnacle3 7.6 or earlier, boluses in the plan are 
invalidated. You must recreate the boluses in order to include them in the plan.

Add a bolus
1 On the Modifiers tab on the Beams panel, click Edit in the Bolus column at the bottom of the 

panel, or select Options - Bolus. The Bolus panel opens.
2 Click Add Bolus. The bolus options appear in the panel.
3 Change the name of the bolus in the Name field, if necessary.

NOTE
Use only alphanumeric characters and underscores when you name the bolus. Do not 
use the following characters: ’ “ ‘ ~ & ) ( | < > + * / \ ; : @ ! [ ].

4 Create the bolus:
• To create a constant thickness bolus, go to Constant thickness bolus.
• To create a variable thickness bolus, go to Variable thickness bolus.

Constant thickness bolus
1 In the Edit Options section of the Bolus panel, select Yes in the Constant thickness field.
2 Do you want to create a bounding box to limit the data used to generate the bolus?

• Yes—select Yes in the Define skin boundaries field and go to step 3.
• No—select No in the Define skin boundaries field. The software will use data from the entire 

image set when it generates the bolus. Go to step 4.
3 Click the Skin boundary tool, then click and drag to draw a bounding box. The bounding box 

defines the patient surface area that will be covered by the bolus.

The software only uses data from inside the bounding box when it generates bolus, so you can 
use the bounding box to keep things such as CT artifacts and the couch from being used to 
generate the bolus.

NOTE
You can only draw the bounding box on a 2D transverse image. The software applies the 
bounding box when you define a bolus on a 3D BEV image, but the box itself does not 
appear in the 3D viewing window.

4 Do you want to define the bolus on a 2D transverse image or a 3D BEV?
• If 2D transverse image, go to Define bolus on 2D transverse image.
• If 3D BEV, go to Define bolus on 3D BEV.
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Define bolus on 2D transverse image

NOTE
To define a wrap-around bolus, go to Define wrap-around bolus.

1 From the Define bolus in list, select 2D Transverse.
2 Click the Add bolus edge tool.
3 On the transverse image, define the left and right edges of the bolus: Click and drag on the 

image to draw a line to define the left edge of the bolus, and then draw another line to define 
the right edge of the bolus. The edges of the bolus must be defined in a clockwise direction 
around the patient and must intersect the outside-patient air threshold.

The Bolus edges defined on slice field displays the slice on which the bolus is defined. Lines 
appear on the sagittal and coronal images to show the center, inferior, and superior borders of 
the bolus that will be built.

If you need to reposition a line, you must remove the line from the image and then redraw it. To 
remove a line, click the Delete bolus edge tool and then click and drag a rectangle around the 
line you want to remove. When you release the mouse button, the line disappears.

4 In the Density field, enter the density of the bolus.
5 In the Thickness field, enter the thickness of the bolus.
6 In the Distance fields, enter the distances that are needed between the current slice and the 

superior and inferior ends of the bolus.
7 Click Build Bolus. The bolus appears on the image. In addition, the 2D display option and 

additional buttons appear in the Bolus panel.

NOTE
If the software has difficulty finding the patient surface, adjust the outside-patient air 
threshold value and build the bolus again. See Set the outside air threshold in the Setup 
chapter.

NOTE
When the software begins to build the bolus, a Cancel button appears next to the Build 
Bolus button. Click Cancel to stop the build process, if necessary.
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8 Click the 2D display option to turn on and turn off the bounding box.

For information about the buttons that appear on the Bolus panel or to edit the bolus, go to 
Edit a bolus.

Define wrap-around bolus
1 From the Define bolus in list, select 2D Transverse.
2 In the Encompass data field, select Yes.
3 In the transverse viewing window, display the slice you want to use as the center slice for the 

bolus.
4 Click the Select the center slice tool, and click on the transverse image to select that slice as the 

center slice. The slice number displays in the Selected center slice field. The bolus will extend in 
the superior and inferior directions from this slice.

5 In the Density field, enter the density of the bolus.
6 In the Thickness field, enter the thickness of the bolus.
7 In the Superior Distance field, enter the distance that is needed between the center slice and 

the superior end of the bolus.
8 In the Inferior Distance field, enter the distance that is needed between the center slice and 

the inferior end of the bolus.
9 Click Build Bolus. The bolus appears on the image. In addition, the 2D display option and 

additional buttons appear in the Bolus panel.

NOTE
If the software has difficulty finding the patient surface, adjust the outside-patient air 
threshold value and build the bolus again. See Set the outside air threshold in the Setup 
chapter.

NOTE
When the software begins to build the bolus, a Cancel button appears in place of the 
Build Bolus button. Click Cancel to stop the build process, if necessary.

10 Click the 2D display option to turn on and turn off the bounding box.

For information about the buttons that appear on the Bolus panel or to edit the bolus, go to 
Edit a bolus.

Define bolus on 3D BEV
1 From the Define bolus in list, select 3D BEV. 
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2 Set up a BEV window for the current beam. You can use any of the BEV options (DRR, DCR, 2D 
Orthogonal Plane, or 3D Image).

NOTE
The DCR option is only available if you are licensed for AcQSim3.

3 Click the Create bolus point by point tool to define the contour of the bolus.
4 Click on the BEV where you want to start the contour. A small box appears and indicates the 

point you defined. Define the remaining points in the same manner. You can also click and drag 
a point to the position you want.

NOTE
Any points drawn outside the patient data will not be used to generate the bolus.

5 To close the contour, click the first point you defined. The small boxes disappear.

NOTE
The bolus contour is displayed based on the selected beam’s BEV coordinate system, so 
any changes you make to the selected beam’s geometry (couch angle, gantry angle, or 
collimator angle) after the contour is drawn will change the position of the bolus 
relative to the patient data, even if you do not change the shape or location of the 
contour. Once the bolus is built, the bolus is fixed to the patient data coordinate system, 
and changes to the selected beam’s geometry or selecting a different beam will not 
affect the bolus.

6 If you need to delete the contour, click Delete Curve.
7 In the Density field, enter the density of the bolus.
8 In the Thickness field, enter the thickness of the bolus.
9 Click Build Bolus. The bolus appears on the image. In addition, the 2D display option and 

additional buttons appear in the Bolus panel.

NOTE
If the software has difficulty finding the patient surface, adjust the outside-patient air 
threshold value and build the bolus again. See Set the outside air threshold in the Setup 
chapter.
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NOTE
When the software begins to build the bolus, a Cancel button appears in place of the 
Build Bolus button. Click Cancel to stop the build process, if necessary.

10 Click the 2D display option to turn on and turn off the bounding box.

For information about the buttons that appear on the Bolus panel or to edit the bolus, go to 
Edit a bolus.

Variable thickness bolus

NOTE
You can display a grid on a 2D image to help you draw the bolus. To display the grid, 
right-click in a 2D viewing window and select 2D - 2D Measurement Grid On. You can 
change the size of the grid in the Preferences window. For more information, see the 
View Patient Data chapter.

1 In the Edit Options section of the Bolus panel, select No in the Constant thickness field.
2 Click the Create bolus point by point tool to define the contour of the bolus.

NOTE
The contour of the bolus must intersect the outside-patient air threshold at two 
locations.

3 Click on the image where you want to start the contour. A small box appears and indicates the 
point you defined. Define the remaining points in the same manner. You can also click and drag 
a point to the position you want.

NOTE
Any points drawn outside the patient data will not be used to generate the bolus.

4 To close the contour, click the first point you defined. The small boxes disappear. The slice 
number on which the contour is defined displays in the Bolus edges defined on slice field.

5 If you need to delete the contour, click Delete Curve.
6 In the Density field, enter the density of the bolus.
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7 In the Superior Distance field, enter the distance you want between the current slice and the 
superior end of the bolus.

8 In the Inferior Distance field, enter the distance you want between the current slice and the 
inferior end of the bolus.

9 Click Build Bolus. The bolus appears on the image and additional buttons appear in the Bolus 
panel. For information about these buttons or to edit the bolus, go to Edit a bolus.

Edit a bolus

Once you have built a bolus, you can edit it to remove contours, smooth edges, or change the 
contour of the bolus. You can also convert a constant thickness bolus to a variable thickness bolus.

NOTE
Bolus contours must appear on contiguous slices. You cannot create a contour on a slice 
that would leave an empty slice in the bolus, and you cannot delete a slice from the 
middle of a bolus.

Invalidate a bolus

If you need to change the parameters of the bolus, click Invalidate Bolus. The edge markers or 
contours you defined remain on the image, as does the bounding box. Change the parameters as 
necessary, and then click Build Bolus.

NOTE
If you invalidate a bolus that has been applied to a beam, the bolus is no longer applied 
to any beam. Make sure you reapply the bolus to a beam after you build the bolus again.

Remove contours

Click Delete Superior End to remove the first contour on the superior end of the bolus.

Click Delete Inferior End to remove the first contour on the inferior end of the bolus.

You can click the buttons repeatedly to remove more than one contour.

Delete a bolus

To delete a bolus, click Delete Bolus. The bolus and the bounding box are removed from the image, 
and the name of the bolus is removed from the Bolus list.

Clean a bolus

The Clean Bolus feature lets you remove very small curves from your bolus.

1 Click Clean Bolus. The Bolus Curve Cleanup Results window opens.
2 In the Minimum Bolus Curve Area field, enter the necessary minimum bolus curve area.
3 Click Scan Bolus. The software searches the bolus for curves that are smaller than the minimum 

bolus curve area you specified and displays these curves in the Bolus Curve Cleanup Results 
window.

4 Click Delete Problem Curves to delete the curves that are listed in the window.
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NOTE
If you modify the bolus after cleaning it, you may need to clean it again.

Convert a bolus to a variable thickness bolus

Click Set to Variable to convert a constant thickness bolus to a variable thickness bolus. You can 
now edit the bolus with the tools available for editing a variable thickness bolus.

Edit a variable thickness bolus

Use the Create bolus paintbrush tool to edit the shape of a variable thickness bolus. This tool 
appears after you build a variable thickness bolus or convert a constant thickness bolus to a 
variable thickness bolus.

NOTE
You can display a grid on a 2D image to help you edit the bolus. To display the grid, right-
click in a 2D viewing window and select 2D - 2D Measurement Grid On. You can change 
the size of the grid in the Preferences window. For more information, see the View 
Patient Data chapter.

1 Click the Create bolus paintbrush tool.
2 Position the cursor at the point where you want to start, edit, or delete a contour.
3 Use one of the following methods to edit the contour.

• If you click on a section of the image where there is no bolus, a new, circular bolus appears. 
Click and drag to create a thick line; wherever you move the cursor, the circle is filled in for 
the bolus.

• If you click inside an existing bolus, you can push out the edges of the bolus.
• If you click outside, but near, an existing edge of the bolus, the tool functions as an eraser, 

and the bolus is erased wherever you move the cursor. You can use this method to push in 
the edges of the bolus.

NOTE
If the diameter of the paint brush is too large or too small, enter a new diameter value 
in the Diam (mm) field.

4 When you finish editing the contour, go to the next slice on which you want to edit the shape of 
the bolus and repeat the process.
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Add a scanned bolus

If the image set includes a bolus in the CT scan, you can add a scanned bolus to a beam so that the 
DICOM export will indicate that a bolus was present in the scan. A scanned bolus is a virtual bolus 
that is created as a ROI with a volume of zero. The density and thickness values of the scanned 
bolus are set to zero so that the bolus will not impact the dose computation. You cannot change the 
density or thickness values, or any of the other parameters, for a scanned bolus.

1 In the Modifiers tab on the Beams panel, click Edit in the Bolus column at the bottom of the 
panel, or select Options > Bolus. The Bolus panel opens.

2 Click Add Scanned Bolus. A new bolus is added to the Bolus list, and _Scanned is appended to 
the name of the bolus to indicate that it is a scanned bolus.

3 Change the name of the bolus in the Name field, if necessary.

NOTE
Use only alphanumeric characters and underscores when you name the scanned bolus. 
Do not use the following characters: ' " ' ~ & ) ( | < > + * / \ ; : @ ! [ ].

4 To delete a scanned bolus, go to Delete a bolus. To apply the scanned bolus to a beam, go to 
Apply a bolus to a beam.

Apply a bolus to a beam

You must apply a bolus to one or more beams in order to include the bolus in dose calculations.

NOTE
If you calculate dose for a trial that does not include a bolus, and then add a bolus to 
that trial, you may notice a change in dose values when you recalculate dose. This is to 
be expected, as the presence of the bolus impacts the resolution used internally by the 
software's dose calculation algorithm.

1 In the Bolus list, select the bolus that you want to apply to a beam.
2 In the Beam list, click in the Apply current bolus? column to toggle the Yes/No option for the 

beam to which you want to apply the bolus. If Yes appears next to a beam, then the bolus is 
applied to that beam.

You can apply the same bolus to multiple beams, and you can apply multiple boluses to one 
beam. However, if you create overlapping boluses, the overlapping boluses cannot be applied 
to the same beam.

Once you apply a bolus to a beam, the SSD With Bolus value displays on the Setup tab in the 
Beams panel.

NOTE
If you invalidate a bolus that has been applied to a beam, that bolus is no longer applied 
to any beam. Make sure to reapply the bolus to a beam after you build the bolus again 
(or reapply the scanned bolus directly to a beam). Also, dose for the beam is invalidated 
when a bolus is invalidated.
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NOTE
For IMRT plans, if all of the beams that will be optimized are not applied to the same 
bolus(es), or if some of the beams have bolus applied and some do not, the 
optimization will be significantly slower than if all of the beams have the same bolus(es) 
(or no bolus) applied to them.

3 To display a list of the boluses applied to a beam, go to the Beams panel and select the beam 
from the Beams list. Then, from the Modifiers tab, click List in the Bolus column at the bottom 
of the panel.

The Beam Reliant Boluses window opens.

Bolus display options

The bolus display options (Color, 2D Display, 3D Display, Box Size, and Line Size) function the same 
as the display options for ROIs. For information about the display options, see Change the ROI 
display in the Regions of Interest chapter.

NOTE
The mesh options and the Display outline in BEV DRR field described in the Change the 
ROI display section do not apply to bolus.

Bolus report

The plan printout contains a separate bolus information page that includes the thickness of each 
bolus (or “None” if the bolus is variable thickness), the density of each bolus, and the beams to 
which the boluses are applied. The SSD with bolus value appears in the Beam Geometry section of 
the plan printout.
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11 Calculate Dose

Overview
Once the beams are set up as desired, you can specify the dose grid and compute dose for the plan. 
If you want to change the dose computation options, such as homogeneous or heterogeneous 
dose, you can do so using the dose computation parameters. You can also set the prescription and 
optimize the beam weights to that prescription.

The basic process for computing dose is:

1 Set up the dose grid (this includes defining the grid and setting its resolution)
2 Extend the image set (if necessary)
3 Set the dose computation parameters
4 Compute dose
5 Set the prescriptions
6 Assign beams to prescriptions
7 Set the beam weighting

If your plan contains records, you can display the dose from those records to assess the impact of 
the prior dose on the current trial. See Assess the impact of prior dose.

NOTE
Dose can be displayed in either cGy or Gy. The dose display preference is set in the 
Preferences window. If you are licensed for proton treatment planning, all dose 
quantities are presented in units of cGy (RBE) or Gy (RBE). This chapter uses cGy when 
referring to dose.

�CAUTION
If you purchase Pinnacle3 without the dose calculation features and you try to open a plan that
already has dose computed, you will get an error message that dose will be invalidated. You can
still view the plan. If you do not save the plan, the dose will still be intact. If you save the plan,
you will have to go back into Pinnacle3 (with dose) to recompute dose. We recommend that you
make a copy of the plan and work on the copy so the dose in the original plan does not get
invalidated.

Click the Dose button at the top of the Planning window to see the dose computation options.

Dose

All dose in Pinnacle3 is presented in terms of cobalt-equivalent effective dose, and not physical
dose. The two doses are related through the Relative Biological Effect (RBE) factor. For photon and
electron beams, the two doses are numerically equivalent because the RBE factor is 1. That is not
the case for proton beams.
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When the system is not licensed for proton treatment planning, dose is presented as cGy or Gy 
because the RBE is 1. When the system is licensed for proton treatment planning, all dose 
quantities in Pinnacle3 are presented in units of cGy (RBE), according to the convention described in 
“The RBE issues in ion-beam therapy: conclusions of a joint IAEA/ICRU working group regarding 
quantities and units,” A. Wambersie, et. al, Radiation Protection Dosimetry, 122:463-470 (2006). 
Because the software uses this approach, you can create composite plans that include beams from 
protons, as well as other modalities, so that you correctly account for the biological effect of the 
entire course of treatment in the total dose.

Pinnacle3 does not directly calculate beam quantity calibration coefficients (dose per MU) for 
proton beams. You must enter a coefficient value that you calculate or measure outside the system 
in order to calculate absolute dose. It is important that the value that is entered is the effective 
dose per MU, taking the RBE into account. The value should not be obtained from a measured 
physical proton dose.

The prescription associates a dose value in cGy to a point at which the cGy/MU is known or to some 
other known cGy/MU value such as the maximum dose. The total monitor units required to 
produce the prescribed dose can be computed and divided between the beams based on the beam 
weights. You can create multiple prescriptions for a plan to determine the total dose from an initial 
treatment and a boost, or from a prior treatment and a current treatment.

Photon-specific dose information

While it can be difficult to manually compute the monitor units in a complex patient geometry, the 
software lets you analyze how the patient anatomy affects the final monitor unit calculation. You 
can trace through the changes in dose and monitor units as the patient surface curvature is 
considered, then as the primary scatter is modified by patient density, and finally as the secondary 
scatter is modified by heterogeneities. After performing a full 3D computation, you can turn off the 
heterogeneity corrections for the secondary scatter computation and recompute the monitor units. 
This gives the change in monitor units due to the effects of the patient density on secondary 
scatter. Similarly, the dose can be recomputed with heterogeneity corrections turned off for the 
primary TERMA computation, and the effect of the patient density on the primary dose can be 
assessed. Finally, the flat water phantom option allows the dose to be computed without any 
corrections for curvature of the patient surface. This final computation will match a simple manual 
computation for the water phantom.

The following dose engines are available:

• Fast Convolve computation performs a convolution superposition calculation with fewer ray
directions used for the scatter calculation than are used for Adaptive Convolve computation.
The Fast Convolve computation is less accurate near the surface and in the penumbra region,
with the maximum error typically being less than 5%. The software does not let you use this
dose engine to compute dose for use clinically.

• Adaptive Convolve computation performs adaptive sampling during convolution dose
calculation. Use this engine to reduce computation time by sampling every fourth point in the
dose grid and interpolating dose in flat areas. If the dose grid cannot be interpolated accurately
enough by sampling every fourth point, the software automatically switches to CC Convolution
and samples every point in the dose grid.
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• CC Convolution computation performs a full convolution superposition calculation. We
recommend that you use this option for all monitor unit calculations.
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Set up the dose grid

�CAUTION
Before computing dose, you must specify the size and location of the dose grid. The allowable
size of the dose grid is dependent on the amount of RAM in your system. If an error message
indicates that there is insufficient memory to create the dose grid, decrease the size or resolution
of the dose grid.

Use the 3D dose grid to specify where in the patient you want dose to be computed. The dose grid
also specifies the resolution to use for dose computation.

Placement of the dose grid is as important as the grid resolution. You can define the dose grid
manually or place the grid automatically to cover a range of slices.

�CAUTION
Position the dose grid to cover all critical structures. Otherwise, you may not have enough
information to properly assess the plan. Dose volume histograms might be calculated
erroneously if the entire region of interest is not included in the dose grid.

Manually place the dose grid
1 Click Dose at the top of the window to display the Dose panel.

2 Select the Draw dose grid tool.

If a dose grid already exists for the plan when you select this tool, the grid is displayed as a 
dashed green line on the 2D patient images. 

NOTE
If you do not see the dose grid on the display, it may be because the displayed image 
does not lie within the dose grid. Scroll through the 2D images until you see the dashed 
green line that indicates the dose grid.

If prior dose is included, the boundary of the dose distribution for each record that is included 
in prior dose is displayed with a thick orange line. If more than one record is included in prior 
dose, a separate thick orange line is displayed for each boundary. See Assess the impact of prior 
dose.

3 Define the lateral and anterior-posterior dimensions of the dose grid by drawing the dose grid 
in a transverse slice. Drag diagonally to draw the dose grid.

4 To define the superior-inferior dimensions of the dose grid, draw the dose grid in either a 
sagittal or coronal 2D slice.
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The following figure shows the dose grid displayed in all three orientations. You may find it 
easier to see the dose grid with the 2D beam display turned off.

5 If you need to adjust the placement of the dose grid, select the Move dose grid tool and drag 
the grid to the desired location.

Automatically place the dose grid

Cover a range of slices

Click Cover Range of Slices. The Automatic Grid Placement window opens. Enter the slices to cover 
in the fields, and then click OK.

Cover a specific region of interest
1 Click Cover Selected ROIs. The Automatic Grid Placement Using Target window opens.
2 In the Specify ROI to cover field, select the region of interest that should be contained within 

the dose grid.
3 In the Additional padding field, set the additional amount of space that should be contained 

within the dose grid outside of the area of the region of interest.
4 Click OK.

Set the dose grid resolution

The dose grid resolution specifies the size of the voxels for which the dose is computed. The dose 
grid dimensions and origins are set when you place the dose grid.

When you set up the dose grid resolution, there is always a trade-off between high resolution and 
computation time. To get better resolution, the voxel size must be decreased. This increases the 
number of voxels required to cover all of the regions of interest and increases the amount of time 
required to compute dose. 

Dose grid resolution also affects how quickly a plan opens. For example, if you compute dose for a 
plan with a dose grid resolution of 0.3 cm3, save and exit the plan, and then reopen the plan, the 
plan could take several minutes to load. We recommend that you use a dose grid resolution of 
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0.4 cm3 for preliminary dose computations, and then increase the dose grid resolution to 0.3 cm3 
for the final dose computation.

Using an unnecessarily large dose grid can also increase the calculation time without yielding any 
additional information for plan evaluation. For example, if the dose grid extends 5 cm beyond the 
patient in the lateral, anterior, and posterior directions, a significant percentage of the dose 
calculation time may be spent calculating dose in the air surrounding the patient.

�WARNING
Using a coarse dose grid resolution provides less accurate monitor unit calculations than the
default or higher-resolution dose grids. A dose grid resolution of 0.4 cm3 or smaller is
recommended. If the resolution is greater than 0.5 cm in any dimension, monitor units appear
with a tilde (~) to indicate that the values are approximate.

You can use the default dose grid resolution settings (0.4, 0.4, 0.4) for most dose computations. For
smaller field sizes, you may need a smaller voxel size (higher resolution). For plan evaluation, you
could use a low-resolution dose grid (0.5 to 1.0) to quickly obtain a general idea of the dose
distribution for a given plan. However, using a low resolution provides less accurate results.

NOTE
If the current trial contains proton beams, you will not be able to compute dose for the 
proton beams if you set a dose grid resolution that is coarser than 0.4 cm in any 
dimension.

�CAUTION
The dose grid resolution must be an even multiple of the density/fluence grid resolution, and
different dimensions can have different voxel sizes. If you enter an invalid resolution, Pinnacle3

will not allow you to compute the dose.
If the density/fluence grid resolution matches the dose grid resolution, changing the resolution
of either grid can adversely affect the accuracy at each point.

You can also specify the resolution of the density/fluence grid. For example, if a coarse dose grid is
adequate for your plan, but the dose at each point in the grid must be accurate, you need to set a
high-resolution density/fluence grid. To make the density/fluence grid match the dose grid, choose
the Match Dose Grid option in the Density/Fluence Grid Resolution field.
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Extend the image set
Ideally, a plan image set extends far enough above and below the beams so that dose calculations 
are correct with respect to primary and scatter effects. However, if the patient image set is not 
large enough, you can extend it on both ends by extrapolating the end CT slices for dose 
calculation.

Although there is no display of the additional slices, the software extends the density information 
in the top and bottom slices of the image set by the specified number of centimeters. This density 
information is included in the dose calculations.

Be aware that extending the image set increases computation time. If the image set does not need 
to be extended, set the top and bottom values to 0. If the image set needs to be extended in only 
one direction, set the value in the opposite direction to 0.

�WARNING
Make sure you will not affect the accuracy of the dose computations before selecting extension 
values for a plan. If you are treating using vertex fields, extending the image set in the superior 
direction could result in misleading SSD and dose calculations. If you think you may use non-
coplanar or vertex fields, you should acquire CT data that extends to the top of the head, and you 
should make sure the image set extension in the superior direction is set to 0. 

NOTE
You can also use this feature to extend image sets for contour-based planning. But if no 
density is defined for either of the end slices, extending the image set has no affect on 
the scatter dose and the extension results in larger MUs.

1 In the Extend top slice of CT field, enter the number of centimeters to extend the top slice 
beyond the end of the image set.

2 In the Extend bottom slice of CT field, enter the number of centimeters to extend the bottom 
slice beyond the end of the image set. 

The effects of dose grid geometry on dose calculation time

For details on these effects, see the Pinnacle3 Planning Reference Guide.
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Set the dose computation parameters
The dose computation parameters control how dose is computed. The dose computation options 
vary depending on the treatment modality.

For all beam types that are not proton beams, see the following sections for dose computation 
options.

For proton beams, the dose computation parameters cannot be modified. For double scattering 
beams and uniform scanning beams, the dose engine is always Pencil Beam. For all proton beams, 
the density correction is always heterogeneous.

Select the dose engine

You can select the dose engines for the beams without setting all of the specific dose computation 
parameters. In the Dose Computation section of the Dose panel, select a dose engine for each 
beam from the beam’s dose engine list. The engine is assigned to the beam with the default dose 
parameters.

See the Overview section for more information about each type.

Set all the parameters

�CAUTION
Unless you specify otherwise, all dose calculations for photon and electron beams assume a 
heterogeneous patient.
1 From the Dose panel, select Options > Dose Comp Parameters. The Dose Computation 

Parameters window opens.
2 From the Beam list, select the beam you want to set.
3 Select the correct dose engine.
4 For the type of beam, set the appropriate dose parameters.

�CAUTION
The Zenith and Azimuthal Bin Count parameters set the number of ray directions for the scatter 
calculation in polar coordinates. You cannot change these settings.

Photon beam Electron beam Stereotactic beam

In the Primary Homogenous and 
Scatter Homogeneous fields, specify 
the density correction for each 
calculation. See Photon density 
correction options for more 
information.

In the Density Correction field, 
specify whether the computation 
should be heterogeneous (density 
correction) or homogeneous (no 
density correction).

In the Arc Increment for Dose 
Computation field, set the distance 
(degrees) between sub-beams.

In the Arc Increment for Dose 
Computation field, set the distance 
(degrees) between sub-beams for 
photon arcs.
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NOTE
A greater number of degrees for arcs will speed up dose calculations because dose is 
calculated less frequently in each arc. However, as the number of degrees increases, the 
accuracy of the dose decreases.

Photon density correction options

�CAUTION
The Water Phantom at SSD option is not intended to be used for clinical dose calculations. If you 
use this option when the field edge lies outside the density grid, the software will not allow dose 
computation.

For photon beams, these are the density correction options:

• Primary Homogeneous—The primary fluence portion of the convolution superposition 
computation ignores all heterogeneities in the patient and instead uses a density of 1.0 gm/cm3 
throughout the patient.

• Scatter Homogeneous—The scatter portion of the convolution superposition computation 
ignores all heterogeneities in the patient and instead uses a density of 1.0 gm/cm3 throughout 
the patient. 

• Water Phantom at SSD—The dose is computed for the beam in a flat water phantom 
positioned at the beam’s SSD.
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Compute dose
Dose is computed for each beam individually. If you modify a beam after computing dose, only the 
modified beam must be recomputed.

�WARNING
You should use Adaptive Convolve or CC Convolution for photon beam monitor unit calculations. 
Fast Convolve dose calculation is designed for use during plan evaluation; using Fast Convolve or 
a dose grid resolution of more than 0.5 cm in any dimension adversely affects the accuracy of 
monitor units. In such cases, monitor units appear with a tilde (~) to indicate that the values are 
approximate.

�CAUTION
Before computing dose you must specify the dose grid size and location. Also, you cannot 
compute dose (profiles or output factors) for a machine that has output factors or measurement 
geometries with jaw setting violations.

�CAUTION
Currently, the software computes only relative dose for Cobalt 60 machines. At this time, 
absolute dose calculation for Cobalt 60 is not supported because the software reports machine 
controls in monitor units only, does not handle source decay for teletherapy sources, and does 
not handle corrections for timer error.
1 In the Dose Computation section of the Dose panel, make sure the appropriate dose engine is 

selected for each beam.
2 Do you want to compute dose for all of the beams?

• If yes, click Compute for the first beam, then click Redo Spreadsheet to trigger dose 
calculation for all of the other beams.

• If no, click Compute for the beam for which you want to compute dose.

�CAUTION
If any parameter which affects dose is modified during dose computation, the computation is 
cancelled for the beam.

You can continue to work in the software during dose computation. After dose calculation has 
started, the Compute button turns into a Cancel button which you can click at any time to 
cancel the dose computation. The word Done appears in place of the Cancel button when dose 
computation is complete.
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Set the prescriptions
You can prescribe dose before or after dose computation. If you change the prescription after dose 
computation, the dose values are retained and recalculation is not required.

You can create multiple prescriptions for a plan, allowing you to determine the total dose from an 
initial treatment and a boost, or the total dose from a prior treatment and a current treatment. You 
can also copy a beam to other beams and split the dose among them, or adjust the prescription.

The software computes dose as cGy/MU. The prescription associates a dose value in cGy to a point 
at which the cGy/MU is known or to some other known cGy/MU value such as the maximum dose. 
The total monitor units required to produce the prescribed dose can be computed and divided 
between the beams based on the beam weights.

NOTE
If you are licensed for proton treatment planning, dose is computed as cGy (RBE)/MU. 
For more information, see Dose.

When prior dose is included for the selected trial, the prior dose information is included in the 
Description column for the prescriptions in the Prescriptions window. In addition, the Prior Dose 
section of the Prescriptions window displays the prescriptions from records that are included in 
prior dose. See Assess the impact of prior dose.

�CAUTION
If you do not specify a prescription prior to dose calculation, a default prescription (200 cGy to 
the maximum dose for a single fraction) is used initially. You should change to the correct value 
before finishing the plan.

�CAUTION
Dose can be misleading if computed with a prescription that is beyond the machine’s limitations. 
In the physics tool, you must specify limits for monitor units and also specify whether to allow 
these limits to be exceeded for a machine. 
If the software is set up so that the limits cannot be exceeded and the prescribed dose requires a 
monitor unit setting which exceeds the limits, the monitor units are set to the limits and the 
actual dose may not match the prescription. When this occurs, the software displays a warning 
message to indicate that the values entered for the gantry rate, the MLC leaf speed, or MU per 
degree exceeds the limitations of the machine and are violated at some control points.

If a beam has invalid MUs, and multiple beams are assigned to more than one prescription, then 
the software will not calculate a total dose. If all of the beams have invalid MUs, the isodose lines 
and point dose readings are percentages. If all of the beams are assigned to the same prescription 
and a beam has invalid MUs, the software displays relative dose and dashes (--) for the beam 
weights.

Prescribe dose
1 Click Edit Prescriptions in the Dose panel, or press Ctrl + P. The Prescriptions window opens.
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When dose is computed, the Description indicates the actual dose computed by the system. 
The Monitor Units per Fraction and Total Fractions columns indicate the actual MUs per 
fraction and total number of fractions. Because MUs may be constrained values, the actual 
dose may differ slightly from the prescribed dose.

2 Select the appropriate trial from the list at the top of the window.
3 Add or edit a prescription:

• Add—Click Add. A new prescription is added to the list. In the Name field, type a new name 
for the prescription.

• Edit—Go to step 4.
4 Select a prescription and then click Edit. The Edit Prescription window opens.
5 In the Prescribe field, type the dose in cGy or Gy and specify whether it should be the overall 

(total) dose or dose per fraction.

�CAUTION
Maximum dose refers to the absolute maximum for the entire 3D volume of the patient, not for a 
given slice. Verify that your prescription is correct for the patient volume.
6 Use the table below to set up your prescription.

Prescribe to max dose Prescribe to an ROI Prescribe to a POI

In the Prescription percentage 
field, set the percentage of the 
maximum dose to receive the 
prescription.

In the Prescription percentage field, 
set the percentage of the ROI 
minimum, maximum, or mean dose 
to receive the prescription.

In the Prescription percentage field, set 
the percentage of the point dose to 
receive the prescription.

Select Max Dose from the 
Percentage of list.

Select ROI Min, ROI Max, ROI Mean, 
or ROI Volume from the Percentage 
of list.

Select Point Dose from the Percentage 
of list.

Select the region of interest from the 
for ROI list.
If you have selected ROI Volume in 
the Percentage of list, the Coverage 
Percentage field appears. Set the 
coverage percentage of the ROI 
volume to receive the prescription.
The MU for each beam assigned to 
the prescription is set to deliver the 
specified minimum, maximum, or 
mean dose to the selected region of 
interest.
When the ROI Volume option is 
selected, the MU for each beam 
delivers the specified percentage of 
dose to the percentage of the total 
volume that is set for the ROI. 
Relative beam weights are 
proportional to MUs when you 
prescribe to an ROI.

Select the point of interest to be used as 
the prescription point. Only POIs that 
are assigned to the primary image set 
appear in the list.

Select the proportional beam weighting 
option.
When the beam weights are 
proportional to MUs, the total monitor 
units delivered to the point is divided 
among the total number of beams based 
on the beam weights. When the beam 
weights are proportional to point dose, 
the contribution of each beam’s dose to 
the total point dose is proportional to 
each beam’s weight.
If you change the proportional beam 
weighting option after you assign beam 
weights, the software may adjust the 
relative beam weight values in order to 
maintain the same dose and monitor 
units. 
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7 In the Number of Fractions field, type the total number of fractions.
8 Click Close. The list of prescriptions for the trial is updated to reflect your changes.
9 By default, the first prescription listed in the Prescriptions window is designated as the current 

prescription. All new beams that you add to the trial will be assigned to that prescription. If you 
have multiple prescriptions and want to change the current prescription, click the radio button 
to the left of the prescription that you want to set as the current prescription.

Set total monitor units
1 In the Edit Prescription window, select the Set Monitor Units option. 
2 In the Total Monitor Units field, type the number of monitor units per fraction.
3 In the Number of Fractions field, type the total number of fractions.
4 Click Close.

NOTE
If the prescription changes, the software updates the value in the Total Monitor Units 
field to indicate the actual number of monitor units in the prescription.
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Assess the impact of prior dose

Note
The prior dose feature is available only if you are licensed for Dynamic Planning.

If your plan contains records, you can include the dose from those records to assess the impact of 
prior dose on the current trial. 

In order to include dose from a record, the record must meet the following requirements:

• Either the secondary image set that is associated with the record has been rigidly registered or 
deformably registered to the primary image set (and the registration has been approved), or 
the record was created by accumulating dose or importing dose to the primary image set. 

• The record does not have No in either the Selected for Treatment or Clinically Valid columns in 
the Manage Prior Dose window. 
– The Selected for Treatment column indicates whether the trial that was used to create the 

record was selected for treatment in the original plan. (If the original plan had only one trial, 
it is automatically selected for treatment.)

– The Clinically Valid column indicates whether the trial that was used to create the record was 
included the statement NOT FOR CLINICAL USE in the original plan.

See Deformable image registration and Use the Record Viewer and the Treatment Navigator.

�CAUTION
Verify that records where the Selected for Treatment value is Yes represent trials that were 
actually delivered clinically. The Selected for Treatment value is confirmation only of the trial 
being selected for treatment in the original plan, not of treatment delivery.
1 Click Edit Prescriptions in the Dose panel. Or, in Plan Evaluation, click Prescriptions in the 

Options menu. The Prescriptions window opens.
2 In the Dose Display Mode section at the bottom of the Prescriptions window, select the 

appropriate option: 
• Current Dose Only—Include only computed dose for the current trial. No prior dose is 

included.
• Prior Dose Only—Include only prior dose. No dose for the current trial is included.
• Current Dose and Prior Dose—Include both computed dose for the current trial and prior 

dose. 
3 If you chose Prior Dose Only or Current Dose and Prior Dose, click Manage Prior Dose to select 

the record dose to include. The Manage Prior Dose window opens.
4 If you want to scale the record dose before including it in prior dose, set the Scale Mode: 

• Scale Factor—Type a scale value. The record dose that will be included in the prior dose is 
the record dose multiplied by the scale value.

• Fractions Delivered—Type the number of fractions that were delivered. The record dose that 
will be included in the prior dose is the dose that was delivered in that number of fractions. 
This option is only available if a record contains a Total Fractions value and if each record has 
a single prescription.
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5 Select the record dose that you want to include in the prior dose by selecting an option from 
the Include column for each record:
• Rigid—Include the record dose without deformation. For secondary image sets, this option 

appears only if you have approved the rigid registration in the Syntegra window. See 
Registration QA tools.

• Deformed—Include the record dose with deformation. This option appears only if you have 
approved the deformation in the Syntegra window. See Registration QA tools.

• None—Include no dose from this record.

NOTE
To include dose from records that you created either by accumulating dose or importing 
dose to the primary image set, select Rigid in the Include column.

6 Click Close to close the Manage Prior Dose window. The Prior Dose section of the Prescriptions 
window indicates the records that are selected for prior dose, and the Description text for the 
prescription indicates that prior dose is included.

7 Click Close to close the Prescriptions window.

When prior dose is included, the following information is provided in the software:

• In 2D and 3D viewing windows, the Dose Display Mode (either Prior Dose Only or Current 
Dose and Prior Dose) displays in the upper-left corner of the window. 

• The boundary of the dose distribution for each record that is included in prior dose is 
displayed on 2D viewing windows. The boundary is displayed with a thick orange line, and 
the boundary is displayed only on the primary image set and only when the trial dose grid is 
displayed. If more than one record is included in prior dose, a separate thick orange line is 
displayed for each boundary. See Set up the dose grid.

• Indicators appear in the Scorecard and Dose Volume Histogram tabs of the Planning 
window, and the Planar Dose window. See Evaluate trials with a scorecard, Compute dose to 
a plane, and Evaluate plans with dose volume histograms.

When you generate your plan report, you can choose to print a summary of the prior dose 
information. See Print plan setup information.

You can return to the Prescriptions window and Manage Prior Dose window to change the 
prior dose settings as needed. To return to the Prescriptions window, press Ctrl+P.

NOTE
When you include record dose without deformation in a trial, and the dose grid of the 
trial differs from the dose grid of the included record, the prior dose display may differ 
from the dose display in the record. For example, if the secondary image set that is 
associated with a record is heavily rotated due to differences in patient positioning 
between scans, the dose grids will not be aligned well with each other. To reduce 
discrepancies like this, ensure that both the record dose grid and the trial dose grid have 
the same resolution and size, and that they overlay approximately the same part of the 
patient on each image set.
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Restrictions

When prior dose is included, you cannot perform the following tasks: 

• Optimize a trial.
• Use Personalized Planning.
• Use robustness analysis.

To perform these tasks, change the Dose Display Mode to Current Dose Only. 
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Assign beams to prescriptions
Pinnacle3 assigns all beams to the default prescription (200 cGy to the maximum dose for a single 
fraction). Once you have created your prescriptions, you can reassign the beams to specific 
prescriptions.

�CAUTION

For VMAT plans: If the MU per degree value exceeds the limitation of the machine, the violated 
values are highlighted in red to indicate that the beam is not deliverable. When this occurs, reset 
the monitor units in the prescription and specify the beam weights that are proportional to the 
monitor units. 

For more information about resetting the prescription, see the Compute Final Dose chapter in the 
P3IMRT Instructions for Use.

1 Click the Beam Weighting button in the Dose panel. The Beam Weighting and Prescription 
window opens.

2 In the Prescription field for the beam that you want to reassign, click the option list and select 
the prescription for this beam.

Add beams after creating multiple prescriptions

If you add a new beam to the trial after you have created your prescriptions, Pinnacle3 adds the 
new beam to the current prescription. If the current prescription is not appropriate for that beam, 
reassign the new beam to a different prescription.

Use prescriptions with proton beams

If you are licensed for proton treatment planning, Pinnacle3 assigns beams to prescriptions 
differently than if you are not licensed for proton treatment planning.

A prescription cannot have both proton and non-proton beams assigned to it. When you create a 
new beam or change the modality of an existing beam, the beam is automatically assigned to a 
prescription as follows:

• If no prescriptions exist, the software creates a new default prescription and assigns the new 
beam to that prescription.

• If two prescriptions exist (one with non-proton beams assigned and the other with proton 
beams assigned), the new beam is assigned to the appropriate prescription based on beam 
modality.

• If multiple prescriptions exist, but the beams assigned to those prescriptions do not match the 
modality of the new beam, the software creates a new prescription and assigns the new beam 
to that prescription.

• If multiple prescriptions exist for both non-proton and proton beams, and the beams assigned 
to the current prescription match the modality of the new beam, the software assigns the new 
beam to the current prescription.
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• If multiple prescriptions exist for both non-proton and proton beams, and the beams assigned 
to current prescription do not match the modality of the new beam, the software assigns the 
new beam to the first prescription in the prescription list that matches the modality of the new 
beam. The software notifies you with the name of the prescription to which the beam was 
assigned.

Verify that all of the beams are assigned to the correct prescriptions before you compute dose.
 Pinnacle3 16.4  Planning Instructions for Use 4598 006 81251 A



Set the beam weighting 213 
Set the beam weighting
The beam weights are set by specifying percentages of the total prescription for each beam. 
Because the beam weights are relative, changing the weight of one beam changes the weights for 
all other beams. As you modify a beam’s weight, other weights of other beams for the same 
prescription are adjusted so that the total percentage is always 100%. If you want to prevent a 
beam weight from being changed, you can lock the beam weight.

You can specify beam weighting before or after dose computation. If you change the beam weights 
after dose computation, the dose values are retained and recalculation is not required.

Monitor units are calculated for each beam and displayed as MU/Fraction for static beams and 
MU/Degree for arcs.

NOTE
For plans in which you prescribe dose to a POI, please be aware that when you select a 
different POI to which you will prescribe dose, the relative beam weighting changes 
rather than the monitor units. This occurs even when relative beam weights are locked.

Set specific beam weights
1 In the Dose Computation section of the Dose panel, click the Beam Weighting button.
2 Do you want to set relative weights or MU/Fraction for each beam?

• Relative weights—go to step 3.
• MU/Fraction—go to step 6.

3 Enter the relative weight for a beam. 
4 Do you want to lock the weight for this beam?

• If yes, click the Weight Lock button for that beam. Then go to step 5. The button is labeled 
Locked when the beam is locked. Unlock the beam by clicking the button again.

• If no, go to step 5.
5 Repeat steps 3 and 4 for all other beams with the same prescription. Remember that as you set 

the weight for each beam, the relative weights of all other beams using the same prescription 
change unless the weight is locked.

This procedure is complete.

�CAUTION
Beam weights are assigned using proportional monitor units rather than proportional dose 
unless point dose prescription with proportional dose is specified.
6 In the MU/Fraction or MU/Degree field, enter the monitor unit value for the beam.
7 Repeat step 6 for all other beams that have the same prescription.

Make beam weights equal

You can have the software make the beam weights equal for all unlocked beams assigned to a 
prescription.
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�CAUTION
When using the Set Equal Weights option, the beam weighting is based on Monitor Units instead 
of dose, unless the prescription was set up for point dose and the beam weighting option is set to 
be proportional to Point Dose.
1 In the Dose panel, select Options > Weighting Options. The Weighting Options window 

appears.

If you want to see the beam weights change, in the Dose Computation section click the Beam 
Weighting button and move the window that appears so you can see it and the Weighting 
Options window.

2 Select the prescription for which all beams should be weighted equally.
3 Click the Set Equal Weights for Unlocked Beams button.

Make beam weight proportional

This feature works for stereotactic radiosurgery arcs. The software makes the beam weights 
proportional to the arc lengths of the beams.

1 In the Dose panel, select Options > Weighting Options. The Weighting Options window 
appears.

If you want to see the beam weights change, in the Dose Computation section click the Beam 
Weighting button and move the window that appears so you can see it and the Weighting 
Options window.

2 Select the prescription that should have proportional beam weights.
3 Click the Set Weights Proportional to Arc Length button.

Optimize the beam weights

The software lets you add constraints to the selected prescription and optimize the beam weights. 
This feature is important, for example, in a stereotactic radiosurgery application with multiple 
isocenters within the brain.

1 In the Dose panel, select Options > Weighting Options. The Weighting Options window 
appears.

2 Click the Optimize Weights button. The Beam Weight Optimizer window appears. 
3 Click the Add button to add a new optimization point to the window. Each point you add lets 

you assign a different constraint to the beam weight optimization.

You can delete a point later by selecting it and clicking the Delete button.

4 Click one of the POI option lists and select a point of interest.
5 Use the next option list to specify whether the POI dose should be equal to, less than, or 

greater than the desired dose.
6 Specify the desired dose for the POI. (Actual dose is determined by the dose computation you 

performed earlier.)
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7 Use the Penalty field to determine which dose constraints are most important. 

For example, if you assign three constraints, you can enter 100 in the Penalty field for the most 
important constraint, 10 for the next important constraint, and 1 for the least important one. In 
this example, the first constraint is 10 times more important than the next one, and so on.

8 Do you want to group constraints by isocenter or prescription?
• No—in the Group By option list select No Grouping.
• Isocenter—in the Group By option list select Isocenter. The relative weights assigned to the 

isocenter beam group will not change. Only the overall group weighting changes.
• Prescription—in the Group By option list select Prescription. The relative weights assigned to 

the prescription beam group will not change. Only the overall group weighting changes.
9 Do you want the prescription modified as part of optimizing the beam weights?

• If yes, at Modify Prescription select Yes. The software modifies the prescription to meet the 
dose constraints.

• If no, at Modify Prescription select No. The software may be unable to meet the dose 
constraints you assign. This is because the software uses the prescription to calculate 
optimization.

10 If you want to specify more than one dose optimization point, repeat steps 3-9 for each point. 
But, you cannot apply multiple constraints to the same POI.

11 Click the Optimize button to optimize the beam weights.
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Display the dose distribution
The dose distribution can be displayed as isodose lines on any image. A colorwash display of the 
dose distribution can also be produced in 2D images, and isodose surface displays can be produced 
in 3D images.

�CAUTION
Dose must be computed for all weighted beams in order to display the dose distribution.

To access the dose display options, click the Isodose button. In the Inverse Planning workspace, 
you can select Options > Isodose Lines.

You can turn the 2D colorwash display on and off, turn all 2D and 3D isodose line displays on and 
off, and display the Isodose Line window to set isodose line display attributes. For more 
information about isodose displays and specifications, see the Plan Evaluation Tools chapter.
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Monitor unit calculation
After dose is computed, you can display the Monitor Unit window to obtain information which can 
be used to check the monitor unit calculation. This window reports monitor units using a quantity 
called normalized dose. The information displayed in the window changes based on the beam 
modality. 

In the Dose panel, select Options > Monitor Units. The Monitor Units window appears.

�WARNING
Using Fast Convolve dose computation or a dose grid resolution of more than 0.5 cm in any 
dimension adversely affects the accuracy of monitor unit calculations. In such cases, monitor 
units appear with a tilde (~) to indicate that the values are approximate.

For information on traditional, convolution algorithm, or hand monitor unit calculation, see the 
Pinnacle3 Planning Reference Guide.

Fields and buttons

Title Description

Cal Depth (Calibration Depth) The depth of the calibration point below the surface of the phantom.

Calibration Dose (D/MU) The calibration dose per MU.

Central Axis Depth The depth of the reference point, as projected along the central axis.

Collimator Output Factor (OFc) The computed correction factor determined during commissioning.

Dose at Ref Point/Fraction The dose per fraction at the given reference point.

Effective Depth The radiological depth scaled by density, pixel by pixel, along the line of 
sight.

Pinnacle3 does not use effective depth but provides it for secondary 
MU calculations.

Water Equivalent Depth This field appears only if you are licensed for proton treatment 
planning.
The radiological depth scaled by density, pixel by pixel, along the line of 
sight. Analogous to effective depth, but scaled by stopping power 
rather than density.

Equiv Square at SAD for Output Factor 
lookup (4A/P)

The equivalent square of the field used to look up the OFc.

Exposed Blocked Area at SAD The area of the beam that is exposed.

Exposed Unblocked Area at SAD The area of the beam without the block in the beam.

Off Axis Distance (OAD) The distance from the reference point to the central axis.

Pct of field blocked The percentage of the area of the field that is blocked by the beam 
block.

Percent of unblocked field intersecting 
patient.

The percentage of the area of the field exposed by the beam block and 
intersecting the patient.

Perimeter at SAD The perimeter of the beam exposed by the jaws as measured in the 
isocenter plane.
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Photon monitor unit calculation

If bolus was added to the beam, asterisks appear next to fields that do not include bolus in their 
computed values, such as SSD and depths.

NOTE
If a beam has invalid monitor units, change the reference point dose in the Monitor 
Units window.

NOTE
For fixed jaw machines, the Equiv Square at SAD for Output Factor lookup (4A/P) value 
is computed using the minimum circumscribing rectangle defined either by the jaws or 
by the edge of the MLC-defined field, whichever is more limiting. For Siemens machines 
in which the MLC replaces the jaw, it is computed using the rectangle defined by the 
most open leaves and the jaw positions. In all other cases, it is computed using the 
rectangle defined by the jaw positions.

Select the reference point for the beam

The reference point is a selectable, beam-specific point where details of the absolute dose 
computation for the beam are reported, or where absolute dose is specified. This point can be 
selected after dose is computed since it does not affect the dose distribution shape. 

NOTE
Only POIs that are assigned to the primary image set appear in the Reference Point 
option list.

�WARNING
Changing the position or dose of the reference point changes the dose throughout the dose grid. 
Be careful when positioning the reference point or changing the dose of the reference point.

The Reference Point options allow you to select a reference point for the dose calculation. You can 
choose a point of interest for the reference point, or you can specify the depth and position of the 
reference point. The system default is to use the isocenter for the beam as the reference point. 

Monitor Units Per Fraction (MU) The number of monitor units per fraction.

Normalized Dose at Ref Point (ND) The normalized dose at the given reference point. This value is equal to 
the dose divided by the calibration dose.

Total Transmission Factor (TTF) The total block and tray transmission factor.

Reference Point Depth The distance from the patient surface to the reference point along the 
line between the source and the reference point.

SCD The distance from the source to the calibration point.

Source to Point Distance (SPD) The distance from the source to the reference point.

SSD to Reference Point The source to surface distance along the line between the source and 
reference point.

Title Description
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To use a point of interest as the reference point, choose Use POI for Ref Point and then select the 
point from the list of points of interest. 

To define a reference point, choose Specify Depth, X, Y. In the fields that appear, enter the depth 
and any X and Y axis offset from the central axis. 

The X and Y offsets are defined using the coordinate system shown in the following illustration.

Define the dose normalization point for photon dose/MU

You can also define the normalization used for determining the dose per monitor unit. To use the 
output factor table to calculate the dose per monitor unit at the reference point, choose the Use OF 
Table option. If output factors are not available for a given beam geometry, or if you want to 
override the software MU computation using a measured absolute dose, you can use the Specify 
D/MU option. 

Software MU computation using the OF table

If you choose the Use OF Table option and appropriate output factors are available for the beam, 
the software computes absolute dose (Dose/MU) for the beam. In this case, reference point 
selection does not affect the dose distribution in any way. Details of the absolute dose computation 
are reported at the reference point. For detailed information on MU computation, see the 
Pinnacle3 Planning Reference Guide. 

The convolution dose engine is capable of computing absolute dose given the beam characteristics 
and the patient characteristics. Thus, normalized dose includes the effects of beam blocking, 
patient shape, inhomogeneities, etc.

�CAUTION
Reported OFc and OFp values may differ from measured values. The phantom output factor is 
computed using an ideal “measurement” of the scattered TERMA for the field. The software’s 
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220 Monitor unit calculation
internal normalization accounts for the absolute dose at the calibration point and forces OFp = 
OFc = 1 for the calibrated field.

Because all convolution calculations inherently handle the phantom scatter correctly (consistently, 
and in an ideal fashion), absolute dose normalization is achieved by scaling the incident energy 
fluence by the internal normalization constant, and the OFc that matches the field. During 
commissioning, the software tabulates the OFc values for all field sizes for which relative output 
factors were entered.

Overriding the software MU computation

If you use the Specify D/MU option, you can specify an absolute dose (cGy/MU) at the reference 
point. The internal monitor unit equation then simplifies to:

where (D/MU)meas is the measured absolute dose at the reference point.

NOTE
If you use the Specify D/MU option and dose becomes invalidated or uncomputed, the 
normalization reverts to the Use OF Table option.

Stereotactic radiosurgery monitor unit calculation

This Monitor Units window shows the average TAR (Avg. TAR field) and dI (Dair/MU at iso field) for 
the beam. To obtain the D/MU at isocenter, multiply these two values together:

The system also displays the D/MU at isocenter obtained directly from the beam’s dose 
distribution. The computed D/MU (diso) and the value in the dose grid should be approximately 
equal. 

NOTE
In most instances, the isocenter point will not fall directly in the center of one of the 
dose grid voxels, so the values may not be exactly equal. Using a smaller dose grid 
should improve this compliance.

NOTE
If you use RadCalc to read information from a Pinnacle3 stereotactic plan, the name of 
the prescription point in RadCalc may not match the name of the prescription point in 
Pinnacle3. In a stereotactic plan, the dose and monitor units are calculated using the 
prescription point you selected in the Prescriptions window. However, since the name 
of the prescription point is not used in the Monitor Units window, the software uses the 
name of the first prescription point that is listed in the Prescriptions window when data 
is transferred to RadCalc.

Dref point /Fraction MU D/MU meas=

TAR d1 D/MUiso=
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To display the TAR information for each sub-beam used to compute the current beam, click the 
Detail button. The Stereotactic TAR Information Per Gantry Angle window appears.

The fundamental stereotactic dose computation involves determining the dose per monitor unit 
D/MU (SSD, d, r, Wc) at a point from one of the stereotactic pencil beams that comprise an arc. For 
detailed information on stereotactic radiosurgery monitor unit calculation, see the Pinnacle3 
Planning Reference Guide.

Electron beam monitor unit calculation

Electron beam monitor units will be computed by the software for all field sizes and SSDs if you 
entered the output factor information correctly in the Electron Physics Tool. The SSD and field size 
for the beam cannot be outside the range of the setup geometries for measured output factors 
entered in the physics tool.

Proton beam monitor unit calculation

All dose in Pinnacle3 is presented in terms of effective dose, taking the Relative Biological Effect 
(RBE) into account. Pinnacle3 does not calculate dose per MU directly for protons, but requires you 
to enter a value that is calculated or measured outside the system in order to calculate absolute 
dose. It is important that you enter this value as effective dose, taking RBE into account. This is 
especially important for composite plans in which proton dose will be added to dose from photon 
or electron beams. (Note that Pinnacle3 assumes that RBE is 1 for photon and electron dose, so 
effective and physical dose for those modalities are identical.) For information about RBE, see the 
Calculate Dose chapter.

Select the reference point for the beam

The reference point is a selectable, beam-specific point either where details of the absolute dose 
computation for the beam are reported or where absolute dose is specified. You can select this 
point after you compute dose because it does not affect the dose distribution shape and it only 
changes the MU for that beam.

NOTE
Only POIs that are assigned to the primary image set appear in the Reference Point 
option list.

�WARNING
Changing the position or dose of the reference point changes the dose throughout the dose grid. 
Be careful when positioning the reference point or changing the dose of the reference point.

The Reference Point options allow you to select a reference point for the dose calculation. You can 
choose a point of interest for the reference point, or you can specify the depth and position of the 
reference point. The system default is to use the isocenter for the beam as the reference point. 

To use a point of interest as the reference point, choose Use POI for Ref Point and then select the 
POI from the list.
4598 006 81251 A  Pinnacle3 16.4  Planning Instructions for Use



222 Monitor unit calculation
To define a reference point, choose Specify Depth, X, Y. In the fields that appear, enter the depth 
and any X axis and Y axis offset from the central axis. 

The X and Y offsets are defined using the coordinate system in the following illustration.

Define the dose normalization parameter for proton dose/MU

You can also define the normalization used for determining the dose per monitor unit for double 
scattering and uniform scanning proton beams. Select the Use Relative Dose option for relative 
dose or the Specify D/MU option for absolute dose.

Overriding the software MU computation

For double scattering beams and uniform scanning beams, Use Relative Dose is the default option 
for defining the normalization that is used for determining the dose per monitor unit. The system 
computes the normalized dose when this option is selected.

The Specify D/MU option allows you to specify an absolute dose in (cGy (RBE)/MU) at the 
reference point. 

The internal monitor unit equation then simplifies to:

where (D/MU)meas is the measured absolute dose at the reference point.

NOTE
You must specify the dose at the reference point per fraction for proton beams in terms 
of effective dose per monitor unit, (cGy (RBE)/MU or Gy (RBE)/MU), taking RBE into 
account. This is particularly important in a composite plan that contains other 
modalities (photons or electrons) as well as protons, so that the composite dose 
correctly characterizes the biological effect of the entire course of treatment.

X2

Y1

X1

Y2

Table

Beam’s Eye View
(from above)

Gantry

Dref point /Fraction MU D/MU meas=
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12 Forward-Planning IMRT

Overview
Intensity-modulated radiation therapy (IMRT) is a treatment technique using beams with varying 
intensities to conform the high dose region to the target volume while sparing normal tissue 
structures, enabling dose escalation and improved local tumor control.

Forward-planning segmental IMRT is an extension of 3D conformal treatment planning. Beam 
intensities are modulated using physical, virtual, or dynamic wedges, tissue compensators, full or 
partial-transmission blocks, asymmetric jaws, and multi-leaf collimators (MLC). Designing the 
modulated fields is an iterative process that begins after a conventional 3D dose distribution has 
been computed and evaluated. Beam weights and beam directions may also be modified, in 
addition to beam intensity, to produce an optimal plan.

The forward-planning segmental IMRT procedures in this guide have are a natural extension of 3D 
treatment planning. The procedures you use depend on the clinical site being planned, your 
treatment objectives, and the delivery devices available to you.

The procedures meet the following criteria:

• Achievable using your treatment planning system (software versions 5.0 and higher).
• No significant increase in the complexity of the treatment planning or treatment delivery 

process.
• Treatment verification is possible using your standard clinical QA procedures.

Before using these procedures, you should become familiar with the basic treatment planning 
functions.

Techniques

�WARNING
Small field sizes are used in forward-planning IMRT. Validate your machines (beam models) at 
each field size prior to creating plans using the forward-planning techniques.

This chapter describes two different techniques for modulating beam intensities. One technique 
involves designing beam segments and then optimizing the weight of each segment to obtain the 
necessary dose distribution (see Design beam segments). The other technique involves adding 
control points to each beam and then optimizing the weights of the control points and beams to 
obtain the necessary dose distribution (see Forward planning using control points).

Control point vs. segment

IMRT uses control points to describe the dynamic aspects of a beam. The term “control point” was 
adopted from the DICOM RT specification. A control point is a general concept for specifying a point 
during treatment where the beam changes. Aspects of a control point that may change during 
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treatment include gantry, collimator, and couch angles, MLC leaf positions, jaw positions, wedge 
states, and MUs/weight. See the Forward planning using control points section for more 
information about control points.

A segment or multi-leaf collimator (MLC) control point, as the terms are commonly used, is 
essentially a control point that only allows changes in MLC leaf positions, jaw positions, and 
MUs/weight during delivery.

Skin flash adjustment

You can automatically adjust step-and-shoot MLC leaves to account for patient movement during 
treatment. When you set a skin flash adjustment in the Beam MLC Leaf Position Editor window, the 
software shifts the open MLC leaves on the selected bank by the specified amount. If necessary, the 
software also shifts the jaw associated with the bank you are opening. For more information, see 
Multi-leaf collimators in the Beam Modifiers chapter.

Design beam segments
Segmental IMRT uses multiple, fixed segments or subfields to create the intensity-modulated dose 
distribution. The beam segments are usually created using static multi-leaf collimators (MLCs). If 
practical, either full or partial-transmission blocks or asymmetric jaws may be used.

These procedures assume that you have already completed, displayed, and evaluated a 
conventional treatment plan.

You have several options for designing beam segments:

• Define segments using dose volumes as ROIs
• Draw segments on 3D DRR displays
• Draw segments on 2D BEV displays
• Define segments using asymmetric jaws
• Define segments using variable block margins

119%

115%
110%

105%

100%

Conventional 3D dose distribution
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A careful selection of the number of beams and beam angles generally reduces the number of 
segments required to produce a satisfactory plan.

Define segments using dose volumes as ROIs

If dose regions are outlined as ROIs, you can define beam segments automatically by using the 
software’s auto-blocking functions. 

You can automatically create an ROI from an isodose line by clicking the Create ROI button for the 
isodose line in the Isodose Line Window. See Create an ROI from an isodose line in the Plan 
Evaluation Tools chapter.

After you create ROIs for each appropriate dose range, follow the basic forward-planning 
procedures and automatically define segments by blocking or exposing the contoured dose ROIs.

Draw segments on 3D DRR displays
1 Copy one of the beams.
2 Change the weight for the new beam to zero.

NOTE
Setting the weight to zero ensures that the dose distribution for the original plan still 
displays on the screen.

3 Display a DRR for the new beam.
4 Display the 3D dose cloud corresponding to the first dose level to be blocked or boosted.
5 Add a block to the new beam.
6 Manually draw a block matching the 3D dose cloud displayed on the DRR. Turn on the MLC 

leaves.

Block drawn to cover 115% dose cloud
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226 Design beam segments
7 Repeat steps 1-6 for as many segments as necessary. If the beam just created is being opposed, 
you may use the Copy & Oppose option. Because you copied a beam with a zero weight, the 
weight for the copied beam is zero.

8 Recalculate the dose distribution.

110% segment 105% segment

Sample set of beam segments

Open segment 115% segment
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9 Adjust the beam weights to produce the optimal dose distribution. See Optimize beam weights.

Click the Dose button. On the Dose panel click the Beam Weighting button. The Beam 
Weighting and Prescription window appears.

Draw segments on 2D BEV displays
1 Copy one of the beams.
2 Change the weight for the new beam to zero.
3 Display a 2D BEV for the new beam.
4 Right-click in the viewing window. The popup Tools window appears.
5 Click the BEV Options button. The Beam’s Eye View Options window appears.
6 From the Type option list, select 2D Orthogonal Plane.
7 Change the offset (cm) if you want to define blocks on a plane other than the isocenter plane.
8 Click the Close button in the Beam’s Eye View Options window.
9 Turn on the 3D colorwash to display isodose levels on the 2D BEV.
10 Add a block to the new beam.

100%

105%

Intensity-modulated dose distribution

119%

115%
110%

105%

100%

Conventional 3D dose distribution
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11 Manually draw a block matching the dose level displayed on the BEV. Turn on the MLC leaves.

12 Repeat steps 1-11 for as many segments as necessary. If the beam just created is being 
opposed, you may use the Copy & Oppose option. Because you copied a beam with a zero 
weight, the weight for the copied beam is zero.

13 Recalculate the dose distribution.
14 Adjust the beam weights to produce the optimal dose distribution. See Optimize beam weights.

Define segments using asymmetric jaws
1 Copy one of the beams.
2 Change the weight for the new beam to zero. 
3 Display a DRR for the new beam.
4 Display a 2D dose distribution (transverse, sagittal, or coronal).
5 Move the appropriate asymmetric jaw on the DRR view until the desired dose levels are 

blocked. You can adjust the jaw by looking at both the DRR and the 2D dose displays.

Block drawn to cover 115% dose level
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NOTE
You cannot move an asymmetric jaw if AutoSurround Blocks is set to Yes.

6 Repeat steps 1-5 for as many segments as necessary. If the beam just created is being opposed, 
you may use the Copy & Oppose option. Because you copied a beam with a zero weight, the 
weight for the copied beam is zero.

113%

110%

105%

100%

Segment defined to block the first dose level
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7 Recalculate the dose distribution.
8 Adjust the beam weights to produce the optimal dose distribution. See Optimize beam weights.

105% segment

Open segment

110% segment

Intensity-modulated dose distribution

113%

110%

105%

100%

105%

100%

Initial dose distribution
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Define segments using variable block margins

The software’s blocking functions give you a number of options for designing intensity modulated 
treatments. For example, you can design an original field that treats the target volume with an 
appropriate margin. Then you design subfields to differentially block overlapping critical structures. 

You can also design segmented fields to deliver simultaneous integrated boost (SIB) treatments, 
where the volumes of regional, suspected, and gross disease are all treated simultaneously. In 
many cases, standard subfields can be created using the software’s HotScript feature.

1 Copy one of the beams.
2 Change the weight for the new beam to zero. 
3 Display a DRR for the new beam.

4 Define a new segment with margins that are different from the original beam using the 
autoblocking function, manual blocking, or a combination of the two techniques. Turn on the 
MLC leaves.

5 Repeat steps 1-4 for as many segments as necessary. If the beam just created is being opposed, 
you may use the Copy & Oppose option. Because you copied a beam with a zero weight, the 
weight for the copied beam is zero.

6 Recalculate the dose distribution.
7 Adjust the beam weights to produce the optimal dose distribution. See Optimize beam weights.

Optimize beam weights

Beam weights are set by specifying percentages of the total prescription for each beam. The 
relative weights for all beams assigned to a prescription always add up to 100%. Beam weights can 
be adjusted manually or automatically. Because the beam weights are relative, making a change to 
the weight of one beam changes the weight of all other beams. If you want to prevent a beam 
weight from being changed, you can lock the weight.

The beam weight optimizer function allows you to specify POI-based dose objectives and have the 
system determine the optimum weights for each beam required to achieve these objectives.

Standard margin Blocking critical structures
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Beam weight optimization can be used to optimize weights for segmental fields, beam orientations, 
and wedge angles to deliver uniform dose distributions.

�CAUTION
Verify that the dose distribution is correct and does not contain unexpected hot or cold spots. 
After you have optimized the beam weights, use the dose volume histogram and the maximum 
dose display to evaluate the dose distribution.

Optimize beam segment weights

Because the software displays dose distribution changes in real time as beam weights are adjusted, 
it is often easier to optimize segment weights manually. We recommend that you set equal weights 
for beams before beginning the optimization process to assure that no beams have weights set to 
zero. 

Most of the prescribed dose is delivered by the original beams with the remaining dose given by 
the subfields. As a result, setting the total weight for all original beams to 90% of the prescription 
dose gives you a reasonable starting point for optimization. 

For example, if there are two original beams, set the initial weight for each beam to 45%. If you lock 
the first beam after setting the weight to 45%, then set the second beam weight to 45% (without 
locking it), to keep the beam weight equal to 100%, the software changes the weights of the 
additional beams. Then you can produce the desired dose distribution by manually fine-tuning the 
beam weights. Alternatively, you can adjust the weights for the original beams until the high dose 
region receives the prescribed dose. For the additional beams, adjust the beam weights to deliver 
the prescribed dose.

There are two ways you can use the beam weight optimizer to determine the segment weights:

• Distribute POIs throughout the target volume and critical structures, specify dose objectives 
and constraints, and let the system optimize the weights. If necessary, you can manually fine-
tune the beam weights after computer optimization is complete. 

• Place POIs within the dose regions used to define the segments, specify a uniform dose 
objective to each of these points, and let the system optimize the weights.

�CAUTION
Always evaluate each beam after optimization. Blocking to cover isodose lines may result in fields 
that are normalized under a block or MLC. For the best accuracy, the prescription point of interest 
should be exposed by all fields.

NOTE
For additional information on adjusting beam weights and using the beam weight 
optimizer, please refer to the Calculate Dose chapter.

Optimize beam orientations

The beam weight optimizer can be used to optimize beam orientations (beam selection). This 
technique is useful for designing site-specific class solutions or optimal initial beam arrangements 
for 3D conformal planning. 
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For example, you may routinely use a standard technique consisting of four, five, or six beams at 
specified angles to treat a particular site. The beam optimizer may be able to find a better beam 
arrangement that can be used as a new standard plan.

1 Place a large number of coplanar beams around the patient contour at equi-angular 
increments. An increment of 15° is reasonable.

NOTE
You can record a HotScript to use the new plan as a standard plan to treat similar sites in 
the future.

2 Compute the dose distribution.
3 Set the weights equal for all beams.
4 Place POIs throughout the target volume and critical structures.
5 Open the beam weight optimizer and specify dose objectives and constraints for each POI.
6 Optimize the weights.
7 Lock all beams that have weights below a given value (for example, below 5% or below 10%).
8 Delete the locked beams.
9 Optimize the weights for the remaining beams.
10 Repeat steps 6-9 until a reasonable number of beams remain.
11 Fine-tune the weights to produce the optimal dose distribution.

NOTE
This technique can be extended to optimize non-coplanar beam orientations as well.

Optimize wedge angles

The beam weight optimizer can be used to optimize wedge angles. 

1 Place an open beam and a 60° wedge beam at each orientation.
2 Compute the dose distribution.

24 beams at equi-angular 15° increments
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3 Set the weights equally for all beams.
4 Place POIs throughout the target volume and critical structures. 

5 Open the beam weight optimizer and specify dose objectives and constraints for each POI.
6 Optimize the weights.
7 Review the relative weights of the open and 60° wedge beams at each orientation. You can 

either accept these beams or select an equivalent virtual/dynamic or physical wedge angle to 
replace both beams and then compute the final dose distribution.

Click the Dose button. On the Dose panel click the Beam Weighting button. The Beam 
Weighting and Prescription window appears.

NOTE
Optimization can also be performed by manually adjusting the beam weights. You can 
also optimize wedge orientation by placing an open beam and a 60° wedge beam at 
each allowable wedge orientation.

POIs distributed throughout target area

Optimized dose distribution
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Forward planning using control points
Instead of creating multiple beams with different blocking shapes, you can modulate beam 
intensity by adding control points to a beam. A control point holds the state of the treatment as it 
progresses. The present state includes gantry, collimator, and couch angles, MLC leaf positions, the 
dose grid, and modifier descriptions. As any of these aspects of the treatment changes, a new 
control point is introduced for the beam.

For static beams, there is only one control point. For arc beams, there are two control points 
(beginning and ending points) and the blocking shape remains the same for both. For step-and-
shoot MLC beams, you can set the blocking and store the dose for each control point. Storing the 
dose allows you to re-weight the individual control points in the beam and see the dose update in 
real time. If you store dose for each control point, you can optimize the control point weights.

The software invalidates dose for both a control point and the beam if you change a parameter that 
changes the control point, unless the weight of the control point is zero.

If a parameter affects all control points for a beam, and that parameter is changed, the software 
invalidates the dose for all control points. For example, changing the isocenter, the dose grid, or the 
machine, or adding or removing wedges, changes the dose for the beam and all control points.

Define MLC control points

Use the options in the Beams panel to add control points to a beam. This procedure assumes that 
you have already completed, displayed, and evaluated a conventional treatment plan. (An example 
of a 3D dose distribution is shown in Design beam segments.)

1 Select the beam to which you want to add MLC control points.
2 Set the beam type to Step & Shoot MLC.
3 Click the OK button to confirm that the software should turn on MLC.
4 Select Options > Control Points.The Control Points window appears.

�CAUTION
For VMAT plans: The Control Points window contains several additional fields that are specific to 
dynamic arc beams. If the gantry rate or leaf speed value at a control point exceeds the limitation 
of the machine, the violated values are highlighted in red to indicate that the beam is not 
deliverable. When this occurs, reset the monitor units in the prescription and specify the beam 
weights that are proportional to the monitor units.

For more information about resetting the prescription, see the Compute Final Dose chapter in the 
P3IMRT Instructions for Use.

�CAUTION
When you store dose for MLC control points, the software calculates dose for each MLC control 
point when you compute dose for the beam, so calculating dose will take more time than usual. 
In order to preserve disk space, the software does not save dose for the individual MLC control 
points when you exit the plan, but does save dose for the entire beam.
4598 006 81251 A  Pinnacle3 16.4  Planning Instructions for Use



236 Forward planning using control points
If you need to change the MLC control points after you have exited the plan, you have to store 
dose for the MLC control points and recompute dose for the beams again in order to see the dose 
update in real time when you make your changes.
5 Do you want to store the dose for the MLC control points?

• If yes, select Yes in the Store Control Point Dose field.
• If no, select No in the Store Control Point Dose field.

If you store the dose, you can re-weight the individual MLC control points in the beam and see 
the dose update in real time. If you do not store the dose, the software invalidates dose when 
you add or re-weight MLC control points.

6 Click the Close button.
7 Compute dose for the beam.
8 Display a DRR for the beam.
9 Display the 3D dose cloud corresponding to the dose level to be blocked or boosted.
10 Select Options > Control Points. The Control Points window appears.
11 Do you want to add an MLC control point to the “end” of the beam or insert one after the 

selected MLC control point?
• Add to the end—click the Add Control Point button. A new MLC control point appears at the 

end of the list. The new MLC control point is a copy of the one that was previously at the end 
of the list, except its weight is 0.0.

• Insert after the selected point—click the Insert Control Point button. A new MLC control 
point appears after the selected point. The new MLC control point is a copy of the previous 
one, except its weight is 0.0.

12 Add a block to the new MLC control point.
13 Manually draw a block matching the 3D dose cloud displayed on the DRR. (An example is shown 

in Draw segments on 3D DRR displays.) If necessary, delete the existing block before you draw 
the new block.

14 Repeat steps 9-13 until you have added all the necessary MLC control points to the beam. 
(Examples are shown in Draw segments on 3D DRR displays.)

15 Add the necessary MLC control points to the other beams. You can either copy the current 
beam, copy and oppose the current beam, or repeat steps 1-14 to manually add MLC control 
points to the other beams.

16 When you are finished adding MLC control points to the beams, recalculate dose for all the 
beams.

�CAUTION
If you did not store the dose for the MLC control points, the software invalidates dose for a beam 
when you adjust the relative weights of the MLC control points. You will need to recalculate dose 
for the beam after you re-weight the MLC control points.
17 Adjust the relative weight of each beam and MLC control point, as necessary, to obtain the dose 

distribution you want. As you change the relative weight, the dose changes in any dose displays 
you have open for the trial.
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NOTE
If you are licensed for P3IMRT, you can use that program to perform segment weight 
optimization. See the P3IMRT Instructions for Use for information.

18 If you want to lock the weight of a beam or MLC control point so the software will not change it, 
set the Weight Locked column to Yes.

19 When you are satisfied with the plan, you can print a hard copy of the plan and export the plan 
via DICOM RT or Varian Shaper, version G.

NOTE
You can only use DICOM RT or Varian Shaper, version G, to export control points. For 
more information, see the Export chapter.
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13 Plan Evaluation Tools

Overview
The software provides a variety of tools for evaluating and comparing treatment plans. This chapter 
describes how to use the following plan evaluation tools:

• Display dose distribution information
• Obtain point dose information
• Evaluate trials with a scorecard
• Evaluate plans with dose volume histograms
• Obtain ROI dose statistics
• Compare dose
• ROI trending
• Generate dose profiles
• Accumulate dose
• Compare multiple trials
• Compute dose to a plane
• Use the Record Viewer and the Treatment Navigator
• Evaluate plans with QA phantoms
• Evaluate plans with DRRs
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Display dose distribution information
Once dose is computed, you can display the dose distribution with the patient data. In 2D displays, 
you can display isodose levels as a colorwash and as isodose lines. In 3D displays, you can display 
isodose levels as solid or transparent surfaces.

1 Click the Isodose button to display the Isodose Lines panel.
2 Do you have default isodose lines set up from a previous planning session?

• Yes—Click All Lines On to display the isodose line. Go to step 4.
• No—Click Add Line(s).

3 In the Isodose Line Addition Window, click a button to select the isodose lines to display.

Click the Close button when you are finished.

NOTE
When normalizing to maximum dose, the 100% line is actually a point, not a line. 
Therefore, the highest isodose line value is initially set to 98%.

NOTE
If isodose lines are not displayed, check to see that all beams with a weight greater than 
zero are computed. If all the beams are computed and you still cannot see the isodose 
lines on the currently displayed 2D slices, scroll through the images. The current slice 
may not be receiving dose, or it may be outside the dose grid.

4 To change the value for an isodose line, type a new value in the Value field for that line.
5 To change the isodose line display color, select the color from the Color list.
6 To turn the 2D display of a single isodose line on or off, click the 2D Display button for the 

isodose line.

NOTE
If you want the system to display the same isodose values using the same display colors 
each time a plan is created, you can save those lines and display colors. Click Line 
Details to display the Isodose Line Window. Set the isodose line display options that 
you want to use as the defaults, then click Save As Default.

NOTE
If you want to apply the same setting to all isodose lines, change the setting for the top 
isodose line in the table and then click the Redo spreadsheet button.

7 To display the isodose surface in 3D, select Surface or Transparent from the 3D Display option 
list. Then render the image.

8 Click the Isodose Lines Are option list at the top of the Isodose Lines panel and select the 
isodose line display normalization.
• Absolute—the isodose lines show absolute dose values in cGy rather than percentage dose 

values, and the maximum dose is listed.
• Percent of Max Dose—the isodose lines are displayed as a percentage of maximum dose, 

and the maximum dose is listed.
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• Percent of POI Dose—the isodose lines are displayed as a percentage of the dose at a 
selected point of interest (POI). When you select the POI, the dose at that normalization 
point is displayed.

9 If desired, turn on the colorwash display for the dose distribution in 2D and 3D.

Click the On/Off buttons next to 2D Colorwash Display and 3D Colorwash Display in the 
Evaluation panel. 

If you have specified isodose lines, the colors used for the colorwash display correspond to the 
isodose line colors. If you have not specified isodose lines, the colorwash display uses a 
spectrum from red to purple, with red at the “hot” end of the spectrum.

Create an ROI from an isodose line

You can create an ROI from an isodose line. The software resamples the dose volume at the 
resolution of the image set, then automatically contours the resampled volume.

1 Click the Isodose button to display the Isodose Lines panel.
2 Click Line Details. The Isodose Line Window appears.
3 Click Create ROI for a given isodose line.

The new ROI is named value (trial name)_y. For example, the ROI for the 110% isodose line for 
the second trial is named “110% (Trial_2)_1.”

Remove an isodose line
1 In the Isodose Lines panel, click Remove Line.

The Isodose Line Removal Window appears.

2 Select the isodose line to delete and then click Delete line. Repeat as needed.
3 Click Close.

Set up 3D isodose surface displays

When evaluating plans, it is often useful to set up a 3D isodose surface display that shows the 
target volume and a particular isodose surface.

1 To display the target volume and an isodose surface in 3D without patient images, first create a 
3D viewing window or enter 3D mode from one of the existing 2D windows.

2 Right-click in the viewing window and select BEV > None.
3 Click the Contours button to display the Regions of Interest panel.
4 Select Surface or Poly Surf as the 3D Display mode for all ROIs that you want to see as solid 

surfaces in 3D.
5 Select Utilities > Data Sets.
6 In the Data Set Specifications window, set the Render option to No.
7 Click Close to close the Data Set Specifications window.
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NOTE
To see the isodose surface through the patient data, set the Render option to Yes and 
select Transparent Dataset On from the 3D menu of the 3D viewing window in which 
you want to view the image.

8 In the Isodose Lines panel, turn on the 3D display for the isodose value you want to view as an 
isodose surface.
• To see through the isodose surface to the target volume, select Transparent as the 3D 

Display mode.
• To see only the portions of the target volume that are not covered by the isodose surface, 

select Surface as the 3D Display mode.

9 Right-click in the viewing window you set up in step 1 and select 3D > Render.

NOTE
To have the image update automatically after rotating or zooming the image, right click 
in the viewing window and from the 3D menu, select Render New Image > After 
motion complete. To have the image update continuously, select Render New 
Image > After any view change.

Isodose surface

3D ROI

Transparent Display

Isodose surface

3D ROI

Surface Display
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Obtain point dose information
Once dose has been computed, you can obtain dose information for any point in the patient 
volume.

�CAUTION
Because isodose lines can be smoothed and interpolated, it is possible that a prescription point 
will not comply with the isodose lines. Under such conditions, the point should be taken as the 
sole indicator of dose.
1 Click the Isodose button.
2 Click the Max dose point display button.

The Maximum Dose Point Display window appears.

3 To display the maximum dose point within the dose calculation grid in the viewing window, 
select On as the Display option.

If you set up multiple trials, use the Coordinates of max dose point for trial option list to select 
the trial you want to use to view the maximum dose point coordinates. To view a different trial, 
place the cursor in the viewing window, and then press T.

The maximum dose point displays on the appropriate slice, and the name of the trial or record 
appears in parentheses after it. Record names are indicated with an asterisk (*).

4 Click Close.
5 Select the button next to Maximum dose point display to display the slice containing the 

maximum dose point for the trial in all 2D views of the viewing window.

�CAUTION
Different trials may have different doses. So that you are aware of which trial’s dose you are 
viewing, check the trial name in the upper corner of the POI dose report.
6 To display the dose to any point of interest, click Point of Interest Dose Table.

The POI Dose report appears and displays the total dose to each point of interest as well as the 
dose contribution from each beam to the total dose. Dose is displayed for all POIs in the plan, 
even for those added after dose is computed. When prior dose is included (the Dose Display 
Mode is either Prior Dose Only or Current Dose and Prior Dose), the prior dose to each point 
of interest is also displayed. Click the Close button when you finish reviewing the POI Dose 
report.

NOTE
The dose at each point is linearly interpolated from the dose grid.

When dose is computed, right-click in a 2D viewing window and then click the Show image 
value 2D tool to display the dose at the point in the CT image that corresponds to the current 
cursor position. The CT value and density for the point are also displayed at the bottom of the 
viewing window.
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Evaluate trials with a scorecard
On the Scorecard tab, you can define clinical goals and then evaluate how well the trials in the plan 
meet those goals. When you save your plan, the scorecard is saved along with it, although the 
computed results are not saved.

You can define goals for a plan, and then save those goals to a library to use with other plans.

To create and modify scorecards or access sample scorecards, click the Inverse Planning button and 
then the Scorecard tab in the Planning window. 

About sample scorecards

There are sample scorecards in the scorecard library to provide you with a starting point as you 
develop your scorecards. These sample scorecards were developed based on RTOG protocols. We 
recommend that you create copies of the sample scorecards (by saving the sample scorecards with 
new names that are appropriate for your clinical practices) and then change the copied scorecards 
as needed.

NOTE
If you reinstall Pinnacle3 or install a new version of Pinnacle3, any changes you have 
made to the sample scorecards are overwritten and the original samples are restored. 
To retain your changes to the sample scorecards, save the sample scorecards with new 
names before you change them.

Create a new scorecard

This procedure provides steps to create a new card from scratch. If you want to create a copy from 
sample scorecard in the library, see Create a copy of an existing scorecard.

1 In the Planning window, click the Inverse Planning button.
2 Click the Scorecard tab, and then click Editor. 
3 In the Scorecard window, type a description for the scorecard in the Description field. 
4 Click Add Goal.
5 Select an ROI from the ROI list, and then set the values for the goal.

Field Description

ROI ROI for which you set a goal (see About ROIs and POIs in treatment techniques and 
scorecards in the P3IMRT Instructions for Use)
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6 As needed, continue to add more goals and set the values.
7 Do you want to use this scorecard for other plans?

• No—Continue to Compute a scorecard.
• Yes—Go to step 8.

8 On the File menu, click Save Scorecard to Library. 
9 Type a name for the scorecard and click OK. 

The scorecard name displays in the Name field at the top of the Scorecard window. 

10 Continue to Compute a scorecard.

Create a copy of an existing scorecard
1 In the Planning window, click the Inverse Planning button.
2 Click the Scorecard tab, and then click Library. The Scorecard Library window opens. 
3 Select a sample scorecard (or any existing scorecard) from the list and click Load. 

The goals for the scorecard are loaded to the Scorecard tab in the Planning window, and the 
Scorecard window opens.

4 On the File menu, click Save Scorecard to Library. 
5 Type a new name for the scorecard and click OK. 

The scorecard name displays in the Name field at the top of the Scorecard window. 

Type Type of goal. The goal is met under the following conditions:
• Min DVH (%)—At the volume (%) that you specify in the goal, the dose that is 

delivered to the ROI is greater than or equal to the dose value that you specify in 
the goal.

• Max DVH (%)—At the volume (%) that you specify in the goal, the dose that is 
delivered to the ROI is less than or equal to the dose value that you specify in the 
goal.

• Min DVH (cm3)—At the volume (cm3) that you specify in the goal, the dose that is 
delivered to the ROI is greater than or equal to the dose value that you specify in 
the goal.

• Max DVH (cm3)—At the volume (cm3) that you specify in the goal, the dose that 
is delivered to the ROI is less than or equal to the dose value that you specify in 
the goal.

• Min Dose—The minimum dose that is delivered to the ROI is greater than or 
equal to the dose value that you specify in the goal.

• Max Dose—The maximum dose that is delivered to the ROI is less than or equal 
to the dose value that you specify in the goal.

• Mean Dose—The mean dose that is delivered to the ROI is less than or equal to 
the dose value that you specify in the goal. This goal is intended for use with OARs 
(organs at risk) rather than targets.

Primary Goal Dose cGy (RBE)
Primary Goal Volume

Dose goal that the trial must meet. For dose goals that require a volume, set the 
volume for the dose goal.

Secondary Goal Dose cGy (RBE)
Secondary Goal Volume

Dose goal that the trial should meet if the primary goal dose cannot be met. (The 
secondary goal dose is the goal that is less stringent but still acceptable.) For dose 
goals that require a volume, set the volume for the dose goal.

Field Description
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6 On the File menu, click Close Window to close the Scorecard window. Click Close to close the 
Scorecard Library window.

7 You may now modify the new scorecard on the Scorecard tab.

Compute a scorecard

Before you compute a scorecard, compute dose for the trial that you want to evaluate. If you have 
already created a scorecard for this plan, you can click the Scorecard tab and go to step 3.

When prior dose is included, the Dose Display Mode (either Prior Dose Only or Current Dose and 
Prior Dose) displays to the left of the trial name. See Assess the impact of prior dose.  

�CAUTION
Scorecard results are intended to be used in conjunction with other plan evaluation tools. We 
recommend that you follow the established clinical procedures for plan review and approval.
1 In the Planning window, click the Inverse Planning button, then click the Scorecard tab.
2 Create a scorecard (see Create a new scorecard) or load a scorecard from the library. To load a 

scorecard, click Library, select a scorecard from the list, and click Load.

If you have a large number of scorecards, you can filter the list using search terms. For example:

• To display only those scorecards with the word “breast” anywhere in the name, type 
“breast” in the Scorecard Name field and click Filter.

• To display only those scorecards with the words “head and neck” anywhere in the name and 
the words “IMRT trial” anywhere in the description, type “head and neck” in the Scorecard 
Name field, type “IMRT trial” in the Description field, and then click Filter. 

Click Show All to clear the filter and show the full list again.

3 In the upper-right corner of the Planning window, select the trial that you want to evaluate.
4 On the Scorecard tab, click Compute.

The software analyzes the trial and determines how well the trial meets the clinical goals. The 
results of the analysis display in the scorecard.

Field Description

Dose Dose statistic for the dose to the ROI that is used in the goal. The type of dose statistic 
that displays varies based on the type of goal:
• Min DVH or Min Dose—Minimum dose from the trial to the ROI
• Max DVH or Max Dose—Maximum dose from the trial to the ROI
• Mean Dose—Mean dose from the trial to the ROI

Volume at Primary Goal 
Dose

For DVH goals, the actual volume receiving the amount of dose that is specified in the 
Primary Goal Dose

Result Result of the goal:
• Met—Primary Goal Dose is met
• OK—Primary Goal Dose is not met, but Secondary Goal Dose is met
• Not Met—Neither Primary Goal Dose nor Secondary Goal Dose is met
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5 In the upper-right corner of the Planning window, select a different trial and click Compute to 
display the scorecard results for that trial.

6 Continue to select different trials and click Compute to see the results of the analysis for each 
trial and to compare the results of the different trials. You can also click ROI Statistics to view 
the statistics for the ROIs, if needed.

NOTE
When you compute a scorecard, the result may be unclear when the goal and the 
computed result are very close. For dose values, this is more likely to occur when the 
Dose Display Decimal places field in the Preferences window has a low value. For 
example, a goal may display as Not Met even when the values for the Primary Goal 
Dose and Dose appear to be the same. When this occurs, the two values differ, but the 
difference is so small that the difference is not evident because there are insufficient 
decimal places displayed to show the difference. To avoid this issue with regard to dose 
values, set the Dose Display Decimal places field to a higher value.

Delete a scorecard
1 In the Planning window, click the Inverse Planning button, then click the Scorecard tab.
2 Click Library. The Scorecard Library window opens.
3 Select a scorecard from the list and click Delete.
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Evaluate plans with dose volume histograms

�CAUTION
The DVH default is normalized to the percent of maximum dose. The maximum dose is the 
maximum anywhere in the dose grid and may cause the DVH to be misinterpreted. We 
recommend that you select absolute dose or specify the maximum dose rather than using the 
default. For detailed information about how maximum dose is calculated, see the Pinnacle3 
Planning Reference Guide.

You can summarize the dose distribution for selected regions of interest (ROIs) across multiple trials 
with dose volume histograms (DVHs). You can also summarize dose distribution for ROI groups 
across both trials and records. DVHs provide plots of normalized or absolute dose versus 
normalized or absolute volume. From the DVHs you can determine the distribution of dose within 
given volumes. However, the DVHs do not provide any spatial information about the dose 
distribution.

If any of the trials selected in the DVH include prior dose (the Dose Display Mode is either Prior 
Dose Only or Current Dose and Prior Dose), then those trials are indicated in orange in the Trials 
list, and the text “Includes Prior Dose” displays on the DVH. See Assess the impact of prior dose.

NOTE
When you copy a plan to a new image set with or without deformation, prior dose 
values for the new plan will be slightly different than those of the original plan. Small 
differences in prior dose values are expected because the resolution, size, and   
alignment of the dose grid for each plan are inherently different. 

1 To generate a dose volume histogram for an ROI, click the Plan Evaluation button. 

The Plan Evaluation panel appears in the Planning window with the Dose Volume Histogram 
tab selected.

NOTE
To return to the Dose Volume Histogram from another panel, click the Plan evaluation 
button at the top of the Planning window.

2 In the Trials list on the ROI tab or the Trials and Records list on the ROI Group tab, select the 
check boxes next to the trials or records that you want to evaluate. If you want to display 
multiple items, use the Line Type lists to distinguish among DVH line types.

3 In the ROIs list on the ROI tab or the ROI Groups list on the ROI Group tab, select the check 
boxes next to the ROIs or ROI groups that you want to evaluate. The DVHs appear for the ROIs 
in the selected trials and records using the current DVH calculation and display options.

NOTE
The DVHs are automatically recalculated in the following situations:
• If beams are re-weighted.
• If beams are recalculated.
• If ROI volumes change.
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NOTE
The color of the DVH line cannot be changed because it is linked to the ROI or ROI group 
color.

NOTE
You can obtain NTCP and TCP response values for an ROI using the Lyman-Kutcher 
model. While in Plan Evaluation, select Options > Edit NTCP/TCP. For more information, 
see the Plan Evaluation Tools chapter in the Pinnacle3 Planning Reference Guide.

4 In the ROIs list, enter a value for the ‘a’ parameter for each ROI. The generalized EUD (gEUD) 
equation requires a single parameter ‘a’. The ‘a’ parameter controls the sensitivity of the gEUD 
computation to hot or cold dose areas within the specified ROI. (This parameter is not available 
on the ROI Group tab.)

Click the Compute button above the gEUD column to compute gEUD values. If you change dose 
or edit an ROI, the software invalidates gEUD values. If you change the ‘a’ parameter for an ROI 
after you compute gEUD values, the software automatically recomputes the gEUD value for 
that ROI:

• a < 1—appropriate for ROIs representing targets. As the ‘a’ value becomes smaller (or more 
negative), the gEUD computation becomes more sensitive to cold spots.

• a = 1—corresponds to the mean dose to the target.
• a > 1—appropriate for ROIs representing critical structures. As the ‘a’ value becomes larger, 

the gEUD computation becomes more sensitive to hot spots.
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5 Select a DVH calculation and axis display options. The DVH is automatically recalculated and 
displayed using the new settings.

NOTE
The software calculates the % > Max value by dividing the volume of all voxels whose 
values exceed the range of the last histogram bin by the total volume of the ROI. 
Therefore, the value that the software uses to calculate the % > Max value may not be 
the same as the value that you enter in the Specify Max Dose field. 

6 To view the DVH for an ROI in tabular format, select the ROI in the ROI Statistics spreadsheet 
and click Tabular DVH in DVH Tools.

The tabular DVH display is controlled by the following parameters in the top section of the 
window. These controls also affect the graphical DVH display:

• DVH—Select the DVH for tabular display.
• Include in plan report—Choose whether the currently displayed tabular DVH prints with the 

plan report. 
• Set Number of Bins/Set Bin Size—Choose how the DVH table is generated. Changes to these 

parameters also affect the DVH plots. 
– Use the Set Number of Bins option to specify the number of bins in the histogram. Bin size 

is calculated by dividing the maximum dose by the number of bins.
– If you choose Set Bin Size, you can specify the size of the bins in the histogram in cGy. The 

number of bins are calculated by dividing the maximum dose by the bin size.
• Columns—Specify the number of columns used to display and print the tabular DVH.

Group Option Description

DVH Calculation Cumulative DVH displays the total volume that has received a given dose or 
more.

Differential DVH displays the distribution of dose received by each volume unit 
of the specified structure.

Dose Axis Display Normalized Dose The dose to the ROI is normalized to 1.0 (100%), and the dose axis 
of the DVH shows the percent of maximum dose to the specified 
ROI.

Absolute Dose The dose axis of the DVH shows absolute dose to the ROI (in cGy or 
Gy).

Auto-Compute Max Select this option to compute the maximum dose value in the ROI. 
This option is selected by default.

Specify Max Dose Select this option to specify the maximum dose yourself. This 
option is commonly used with brachytherapy plans, which 
sometimes have high doses that fall outside the maximum range of 
the histogram. The percentage of the structure volume with a dose 
greater than the maximum histogram dose is shown in the % > Max 
column of the ROI Statistics spreadsheet.

Volume Axis Display Normalized Volume The volume is normalized to 1.0 (100%), and the volume axis of the 
DVH shows the percent of the ROI volume receiving a given dose.

Absolute Volume The volume axis of the DVH shows the actual volume (in cm3) 
receiving a given dose.
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7 Use DVH Tools to get dose and volume values for a point on a curve and to zoom into the graph:
• Mouse over a point on a curve. The selected curve is highlighted. The dose and volume 

values appear, along with the curve’s trial and record information, in a box superimposed 
over the graph near the mouse pointer. Moving the mouse along the curve allows you to see 
the changes in values. To switch to a different curve, mouse over another curve in the graph. 

• You can also zoom in on a part of a curve and view dose and volume values. Click the Box 
Zoom 2D tool, and then click and drag to create a rectangle, defining a subset of the graph to 
display. You can zoom further by clicking and dragging again. To reset the zoom level to the 
original default setting, click the Reset button in DVH Tools.
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Dose-based objectives and constraints
The table below shows the objectives and constraints and their associated markers are displayed on 
the DVH on the Dose Volume Histogram tab of the Conventional Planning panel in the Planning 
window. The table also explains how the software determines when a constraint or objective has 
been met.

Objectives Markers Constrained Description

Min Dose Applies to the whole ROI volume. The constraint or objective 
is met when the region of interest has a minimum dose that 
is greater than or equal to the target dose. The marker 
appears at the 100% volume level of the DVH.

Max Dose Applies to the whole ROI volume. The constraint or objective 
is met when the region of interest has a maximum dose that 
is less than or equal to the target dose. The marker appears 
at the 0% volume level of the DVH.

Uniform Dose NA Applies to the whole ROI volume. Can only be used as an 
objective. The objective comes closer to being satisfied as 
the dose throughout the ROI’s volume becomes more 
uniform.

Min DVH Applies only to a percent volume of the ROI. The constraint 
or objective is satisfied if the % volume of the ROI which 
exceeds the specified target dose is greater than the 
specified % volume.

Max DVH Applies only to a percent volume of the ROI. The constraint 
or objective is satisfied if the % volume of the ROI which 
exceeds the specified target dose is less than the specified % 
volume.

Target EUD (No marker) (No marker) Applies to the whole ROI volume. The constraint or objective 
is met when the gEUD value is equal to the target cGy value. 
The gEUD computation uses the value entered in the a field.

Min EUD (No marker) (No marker) Applies to the whole ROI volume. The constraint or objective 
is met when the gEUD value is greater than or equal to the 
target cGy value. The gEUD computation uses the value 
entered in the a field.

Max EUD (No marker) (No marker) Applies to the whole ROI volume. The constraint or objective 
is met when the gEUD value is less than or equal to the 
target cGy value. The gEUD computation uses the value 
entered in the a field.

Uniformity NA (No marker) Applies to the whole ROI volume. Can only be used to set a 
constraint. The constraint is met when the variation of dose 
within the ROI is less than the specified % variation.
The objective value for uniformity constraints is the percent 
uniformity that the software achieves. The objective value 
for uniformity constraints will be less than or equal to the 
specified % variation.
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Obtain ROI dose statistics

�CAUTION
To obtain accurate statistical information on the dose in an ROI, the entire ROI must be included 
in the dose grid. Any portion of the ROI that is outside the dose grid is reported in the % Outside 
Grid column of the ROI Statistics spreadsheet.

The ROI Statistics spreadsheet displays statistical information for the dose in a region of interest. 
Do one of the following to access the ROI Statistics spreadsheet:

• In the Planning window, click the Plan Evaluation button. The ROI Statistics spreadsheet 
appears below the Dose Volume Histogram.

• Click the Contours button, and then from the Options menu, select Statistics to open the 
Region of Interest window.

The Line Type column shows the line color and style for the corresponding line in the DVH.

NOTE
You can include dose statistics for all ROIs in printed plan reports. 
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Compare dose
The Dose Comparison panel in the Planning window allows you to compare dose between a trial 
and another trial, a trial and a record, or a record and another record. The two items to be 
compared appear side by side in 2D viewing windows.

The windows in the Dose Comparison panel work like other viewing windows. For example, you 
can compare the dose on multiple slices by scrolling through the anatomy.

Note that the two viewing windows do not operate independently. If you pan and zoom in one 
window, for example, the other window pans and zooms, too.

1 Click the Plan Evaluation button. 

The Plan Evaluation panel appears in the Planning window, with the Dose Volume Histogram 
and Viewing Window as tabs.

2 Click the Compare button on the Plan Evaluation panel. The Dose Comparison panel appears in 
the Planning window.

3 From the Trial or Record list above each 2D window, select the trial or record that you want to 
display. Records are indicated with an asterisk in the Trial or Record list.

About records in the Dose Comparison panel

A viewing window that displays a record will display the primary image set for that record, even 
when this image set is not the same as the primary image set for the current plan. The trial viewing 
window and record viewing window are synchronized, though, so that when you scroll through 
either image set, both windows scroll together. 

For a record, you set up your display of isodose lines, POIs, and ROIs in the Record Viewer window. 
See Use the Record Viewer and the Treatment Navigator. 

You can access directly the Dose Comparison panel from the Record Viewer window. On the File 
menu, click Records, then click the Trial/Record Comparison button. 



254 ROI trending

 Pinnacle3 16.4  Planning Instructions for Use 4598 006 81251 A

ROI trending
You can use Trends & Analysis to track the motion and view the volume of an ROI group.

NOTE
Trends & Analysis is available only if you are licensed for Dynamic Planning.

1 From the Planning window, click either the Plan Evaluation button or the Inverse Planning 
button.

2 From the Options menu, click Trends.

The Trends & Analysis window appears.

3 From the ROI Group list, select an ROI group to view.

NOTE
ROI groups are managed automatically when you use Dynamic Planning. However, an 
ROI Group Manager is provided to allow you to make changes when a manual ROI group 
is preferred over an automatic one, for example, or when ROI groups are not working as 
you wish. For more information, see Manage ROI groups.

Information about the motion and volume of the ROI group appears in numerical form in the 
table, and in graphical form at the bottom of the window. In the table, a record is indicated by 
an initial asterisk in the Volume Description.

The first ROI in the group has an Index value of 0 and is used as the reference, and the motion 
of the other ROIs in the group is calculated relative to this first ROI.

The Relative Centroid Position graph displays the motion in each dimension (Delta X, Delta Y, 
and Delta Z) and also displays the magnitude of change (Delta Mag) in all three dimensions. 
The Total Volume graph represents the total volume of the ROIs. The graphs refer to the ROIs 
by their index values in the table.

NOTE
If you modify any ROIs in the ROI group while the Plan Evaluation window is open, click 
the Recompute button to recompute the data in the window.
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Generate dose profiles

�CAUTION
Dose profiles cannot be generated until the dose has been computed for the plan.

You can generate dose profiles between any two points of interest.

1 Select Utilities - Profile.

The Profile window appears.

2 In the Title field, type a title that identifies the profile.
3 Select the points of interest to use as the profile’s start and end points from the First POI and 

Second POI option lists.
4 Select the type of data you want to profile by selecting one of the data sets from the Data set 

option list. For a profile of dose values, choose the Dose data set.
5 Select the interpolation method to use for the dose profile. Nearest Neighbor interpolation is 

more blocky than Trilinear interpolation.
6 Do you want to view the Water Equivalent Thickness (WET) profile?

• If yes, select the Yes button and specify the beam that you want to use from the Use Beam 
option list.

• If no, select the No button.

NOTE
The WET profile? option only appears in the Profile window if you are licensed for 
proton treatment planning.

7 Click the Options button. The Profile Options window appears. 
8 How do you want to display the bins?

• To divide the bins of the profile into increments of centimeters, click Specify Bin Width (cm). 
Then enter the width increment in the Bin Width field.

• To display the bin in terms of the number of profile sampling points, click Specify Bin Count. 
Then use the Bin Count field to specify the number of sample points to display in the profile.

9 Click the Close button.
10 Click the Create Profile button in the Profile window to generate a dose profile.
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Accumulate dose
You can calculate the dose accumulated in multiple trials or records associated with the primary 
image set.

Trials and records are only available for dose accumulation if the following requirements are met:

• The dose grids of the trials or records must overlap. Dose is accumulated only in the 
overlapping regions of the dose grids.

• The trials must be selected for treatment.
• The dose must be valid. In other words, you cannot accumulate dose from a trial that has 

approximate monitor units (MUs).
• The dose units must be the same. For example, you cannot accumulate dose from a record in 

which dose was computed in Gy and a trial in which dose was computed in cGy.
• Prior dose is not displayed. See Assess the impact of prior dose.

�CAUTION
Accumulating dose creates a record, which contains copies of the ROIs (including boluses) and 
POIs in the plan. The copies are locked when the record is created. This means that if you edit the 
planning ROIs and POIs after accumulating dose, the changes will not be reflected in the record 
ROIs and POIs. If you use the edited ROIs or POIs in planning in conjunction with the unchanged 
versions in the record, the point doses, dose volume histograms, and inverse planning results 
may be misleading, as they rely on the accuracy of the objects. For this reason, if you edit ROIs or 
POIs after accumulating dose be sure to delete the dose accumulation record and create a new 
one.
1 Select Utilities > Dose Accumulation.
2 Select the trials or records to accumulate. Records are indicated with an asterisk.
3 If you want to weight the dose of a trial or record for accumulation, enter a Scale value. The 

default Scale value is 1, which will accumulate the dose from that trial or record at 100%. To 
weight the dose, enter a Scale value either less than or greater than 1. For example, a Scale 
value of .5 would accumulate 50% of the dose, or a Scale value of 1.2 would accumulate 120% 
of the dose.

4 Click Accumulate.

The software creates a new record, which includes the ROIs, POIs, and dose for the 
accumulated trials and records. POIs that were locked are unlocked. Any boluses in the 
accumulated trials are converted to ROIs. The new record displays in the Record Viewer 
window with a standard set of isodose lines for the accumulated dose.

To add comment text to the record that describes the trials or records for which you 
accumulated dose, select File > Records, and in the Records window, click the Details button. 
See Manage records.
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Use multiple trials
Using the multiple trials option, you can first prepare aspects of a treatment plan as described 
elsewhere in this guide. You can then copy the plan, change aspects of it to set up slightly different 
scenarios, and then compare the plans to see which is more effective. For example, you can 
compare two beam configurations. For breast treatment planning, you could contrast a trial 
containing a 15-degree wedge versus a trial with a 30-degree wedge.

You can create as many comparative trials as you want, and the trials you compare can be as similar 
or dissimilar as you want. The following steps explain a common way to use multiple trials.

1 Develop your plan in the software.
2 Open the Trials window in any of the following ways:

• Select File > Trials.
• Right-click the Trial list that appears at the top of the Planning window.

If you have not developed a plan yet, click Add New Trial, and then enter a name for the plan in 
the Trial Name field.

3 To create a copy of the existing trial, select the trial (plan) you developed and then click Copy 
Current Trial.

A generic name for the copied trial appears in the list. Select this name and enter a more 
descriptive one in the Trial Name field.

4 Click Close.

�CAUTION
Any changes you make to a plan are applied to the current trial. Verify that you are using the 
desired trial.
5 Click the Trial list and select the copied trial you just created.

The trial you select becomes the current trial throughout the software. Any changes you make 
to a plan are applied to the current trial. If you print a plan, the information for the selected 
trial prints.

�CAUTION
Viewing windows are not linked to the current trial. You must explicitly select the trial to display 
in a viewing window. Verify that you are using the correct trial in the viewing windows when 
planning.

NOTE
If you select a different trial, any beam’s eye views (BEVs), room’s eye views, or beam-
relative views will revert to normal viewing windows, since the software does not know 
which beam should be referenced in the new trial. The only exceptions to this rule are 
BEVs and REVs set to display the Current beam.
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You can view any trial in a 2D viewing window. The name of the current trial is displayed in the 
upper-left corner of the viewing window. To view a different trial: 

• Right-click in a 2D viewing window and select 2D > Next Trial until you see the trial you want.
• Position the cursor within a viewing window and then press the t key.
• Select a trial from the Trial list in the upper-right corner of the window.

6 Change variables of the new trial to create two similar but competing plans.

For example, if your original trial was a 4-field prostate trial, you could change the copied trial 
to be a 6-field prostate trial.

7 To compare the two trials, return to the Trials window and click the Trial/Record Comparison 
button. The two trials appear side-by-side for comparison in the Dose Comparison panel of the 
Planning window. See Compare dose.

8 To evaluate and compare dose distribution in multiple trials, click the Isodose button at the top 
of the Planning window.
• Isodose Lines—The Isodose Lines panel  attributes (line color, 2D and 3D display settings) are 

common to all trials.
• Maximum dose point display—Click this button to display the Maximum Dose Point Display 

window. This window works in conjunction with the Dose Comparison panel of the Planning 
window. To see the maximum dose point for one of the multiple trials in the Dose 
Comparison panel, select the trial you want from the Coordinates of max dose point for trial 
option list.

• Point of Interest Dose Table—Click this button to display the POI Dose table. This table 
displays dose information for all the trials.

9 Use dose volume histograms (DVHs) to see which trial is delivering the best dose to the target 
volume.

Click the Plan Evaluation button and then click the Show individual windows button to access 
the Dose Volume Histogram tab. 

The dose distribution of any ROI can be summarized by a DVH. You can set up the DVH to show 
each of the multiple trials so you can compare them as overlays in the graph. 

�WARNING
Selecting the wrong trial for treatment could cause injury to the patient. Verify that the trial you 
select for treatment is the one you want to use.
10 Return to the Trials window, select the trial to be used for treatment, and select Yes next to Use 

selected trial for treatment? You can select more than one trial for treatment.

�CAUTION
Do not delete the trial you will use for treatment. If you have not saved the treatment plan and 
you delete the trial, you cannot recover the most recent version of the trial. Verify that you are 
deleting the correct trial.
11 If a trial is no longer useful for comparison, you can select its name in the list and click the 

Delete Trial button. You must keep at least one trial in the plan.
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12 To exit the Trials window, click the Close button.
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Compute dose to a plane
The Planar Dose option lets you generate a two-dimensional dose array (planar dose) for a beam at 
a given depth in a phantom or the current image set. The dose map is displayed by default in 
inverse greyscale. Planar dose maps may be printed or exported to files for comparison with 
measurements.

NOTE
In the sample dose plane shown above, the negative y-axis points upward in the beam’s 
eye view because the machine was commissioned with the tray opening toward the 
bottom of the image. Pinnacle3 ignores collimator rotations for planar dose 
reconstruction, and the negative y-axis is always opposite the tray opening.

NOTE
The planar dose algorithm only computes dose within the volume of the patient or 
water phantom, including any extension you defined when you set up the dose grid.

See the Pinnacle3 Planning Reference Guide for more information on the planar dose settings.

Use a treatment beam to compute planar dose

You can compute planar dose for treatment beams that are static and, if you are using a phantom 
that rotates with the gantry, you can use the Collapse VMAT option to compute planar dose for 
dynamic arc treatment beams. When you select the Collapse VMAT option to compute planar dose 
for dynamic arc treatment beams, the software converts the dynamic arc beams to step-and-shoot 
beams, collapses the gantry angle of each control point to a neutralized point, and then 
redistributes the MUs of each beam.

Add a dose plane for a treatment beam
1 From the Dose panel, compute dose for all of the beams in the plan.
2 Select Utilities > Planar Dose.

The Planar Dose Computation window opens.
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3 Select the appropriate trial from the Trial list.
4 Add one or more planes to the current trial:

• Click Add Plane to add one dose plane to the trial. Add as many planes to the trial as needed.
• Click Add Plane Per Beam to add dose planes to all beams in the trial.

Each dose plane is listed on the Planes tab.

NOTE
To delete the selected dose plane, click Delete Plane. To delete all dose planes, click 
Delete All.

5 If you did not add dose planes for all of the beams in the plan, select a beam for each dose 
plane from the Beam list.

6 If you want to change the name for a dose plane, type a new name in the Name field.
7 Continue to Compute planar dose for a treatment beam.

Compute planar dose for a treatment beam
1 From the Beam list on the Planes tab, select the treatment beam that you want to use to 

compute planar dose.
2 If necessary, change the couch angle for a static beam by typing a new value in the Couch field.

�CAUTION
If you change the Gantry Start or Gantry Stop angle for a beam, the geometry for the beam 
changes.
3 If necessary, you can change the Gantry Start or Gantry Stop angle for the treatment beam:

• Arc beams are invalidated and you cannot compute planar dose. 
• The dose for static and step-and-shoot beams must be recomputed.

4 Do you want dose calculated as if the beam is being delivered to a phantom or the current 
patient image set?
• Phantom—Select Phantom on the Planes tab. The software computes planar dose based on 

the SPD and SSD that you select for the beam. 
• Patient image set—Select Primary data on the Planes tab.

5 Type the source to plane distance of the beam in the SPD field.
6 Did you select Phantom or Primary data?

• Phantom—Type the distance from the source to the surface of the phantom in the SSD field. 
• Primary data—Select one of the following:

– Compute beam—The software computes planar dose based on the gantry and couch 
angles that you enter in the fields available and the geometry of the beam selected. If you 
want to compute planar dose that is delivered to a QA phantom that rotates with the 
gantry, then you must select Compute beam.

– Sample trial—The software interpolates planar dose from the trial dose grid. Using the 
Sample trial option is equivalent to a composite dose. When prior dose is included, the 
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Dose Display Mode (either Prior Dose Only or Current Dose and Prior Dose) displays on 
the planar dose image. See Assess the impact of prior dose.

7 On the Dose tab, use the Resolution field to set the resolution of the dose distribution. The 
smaller the resolution, the finer the dose display, and the longer the calculation time.

The TERMA grid resolution is determined by either the trial dose grid or the user-specified 
resolution. Therefore, you should set the planar dose grid resolution to match the TERMA grid 
resolution to avoid a loss of resolution in the planar dose image.

8 Set the dimensions of the dose map in the Dimension fields. By default, the dose map 
dimensions are set to include a 1.5 cm margin around the exposed field.

9 If necessary, change the display color of the dose map in the Color option list.
10 Do you want to compute planar dose for a dynamic arc treatment beam?

• If yes, select Yes for Collapse VMAT to compute planar dose that is delivered to a QA 
phantom that rotates with the gantry.

• If no, go to step 11.
11 Click the Compute button. When the planar dose computation is complete, the dose 

distribution appears in the viewing window.

The planar dose is computed in cGy/MU for the selected beam. If you chose to sample the trial 
dose grid, the dose values in the plane are in cGy or Gy, depending on the Dose Display setting 
in the Preferences window.

NOTE
If you are licensed for proton treatment planning and the trial contains a proton beam, 
dose values in the plane are computed in cGy(RBE) or Gy(RBE).

To compute multiple dose planes, click the Compute button for the first plane, and then click 
the Redo spreadsheet button to compute the remaining planes.

Add a static beam to compute planar dose

To compute planar dose for arc beams, conformal arc beams, dynamic arc beams, and beams with 
motorized wedges, add a static beam with zero weight to the plan. The use of a static beam is 
appropriate for these beam types if the phantom that is used to compute planar dose is fixed to the 
room’s coordinate system and does not rotate with the gantry. The software uses the geometry of 
the static beam to compute planar dose.

Add a static beam to the plan
1 Open a plan and then click Add beam on the Beams panel. 

A new static beam with a weight of zero is added to the plan. 

2 If necessary, click the Setup tab and type a Name for the static beam to differentiate it from the 
treatment beams in the original plan.

3 Click the Geometry tab to define a plane within the dose grid. Set the couch, collimator, and 
gantry angle for the static beam to reflect the desired plane orientation.
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4 Continue to Add a dose plane for the static beam.

Add a dose plane for the static beam
1 From the Dose panel, compute dose for all of the beams in the original plan, and for the static 

beam you added to the plan. Make sure the weight of the static beam is zero before you 
compute dose.

2 Select Utilities > Planar Dose.

The Planar Dose Computation window opens.

3 Select the appropriate trial from the Trial list.
4 Add one or more planes to the current trial:

• Click Add Plane to add one dose plan to the trial. Add as many beams to the trial as needed.
• Click Add Plane Per Beam to add dose planes to all beams in the trial.

Each dose plane is listed on the Planes tab.

NOTE
To delete the selected dose plane, click Delete Plane. To delete all dose planes, click 
Delete All.

5 If you did not add dose planes for all of the beams in the plan, select a beam for each dose 
plane from the Beam list.

6 If you want to change the name for a dose plane, type a new name in the Name field.
7 Continue to Compute planar dose for the static beam.

Compute planar dose for the static beam
1 From the Beam list on the Planes tab, select the static beam that you added to the plan. This is 

the beam with zero weight that is used by the software to compute planar dose.
2 If necessary, change the couch angle by typing a new value in the Couch field.

�CAUTION
If you select Primary data and Sample trial for an arc beam, conformal arc beam, or dynamic arc 
beam, the software uses the gantry start angle for the arc to define the plane. 
3 Select Primary data on the Planes tab.

The dose grid settings option list appears.

4 Select Sample trial.

For Sample trial, the software interpolates planar dose from the trial dose grid. Using the 
Sample trial option is equivalent to a composite dose. When prior dose is included, the Dose 
Display Mode (either Prior Dose Only or Current Dose and Prior Dose) displays on the planar 
dose image. See Assess the impact of prior dose.

5 Type the source to plane distance of the beam in the SPD field.
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�CAUTION
If you select Primary data and Sample trial for an arc beam, conformal arc beam, or dynamic arc 
beam, the software uses the gantry start angle for the arc to define the plane. 
6 On the Dose tab, use the Resolution field to set the resolution of the dose distribution. The 

smaller the resolution, the finer the dose display.
7 Set the dimensions of the dose map in the Dimension fields. As a default, the dose map 

dimensions are set to include a 1.5 cm margin around the exposed field.
8 If necessary, change the display color of the dose map in the Color option list.
9 Click the Compute button. When the planar dose computation is complete, the dose 

distribution appears in the viewing window.

The planar dose is computed in cGy or Gy, depending on the Dose Display setting in the 
Preferences window.

To compute multiple dose planes, click the Compute button for the first plane, and then click 
the Redo spreadsheet button to compute the remaining planes.

Troubleshoot planar dose results
• The planar dose algorithm only computes dose within the volume of the patient or water 

phantom, including any extension you defined when you set up the dose grid.
• The trial dose grid must be large enough to encompass all of the high dose region. Otherwise 

planar dose may be incorrect.
• If the planar dose image appears to be cut off, go to the Dose Grid panel in the Planning 

window and extend the top or bottom slice of the CT image. This should make the rest of the 
planar dose image visible.

• If necessary, you can use the 2D tools to modify the display and obtain information about the 
data. Right-click the planar dose viewing window to display the 2D menu and tools. See the 
View Patient Data chapter for details about the 2D tools. 

Use arbitrary point files for defining points on film

You can use a point file that defines the x,y,z locations of the planar dose pixels in world 
coordinates. This allows you to specify a spiral (or any other shape) phantom and compute dose to 
each point on the “plane.”

The point file is a space-delimited ASCII text file in the following format:

x_dim y_dim resolution
point1.x point1.y point1.z
point2.x point2.y point2.z
...

The following is a sample point file:

84 13 0.500
15.110 30.680 11.700
14.919 30.189 11.700
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15.034 29.658 11.700
15.351 29.215 11.700
15.818 28.980 11.700
...

where 84 is the x dimension, 13 is the y dimension and 0.500 is the resolution. In this example 
there are 84*13 sets of x,y,z coordinates representing the world location of each pixel in the 84x13 
pixel array.

NOTE
You can only use point files for dose planes that use the patient image set. You cannot 
use point files with water phantoms.

1 If a dose plane does not exist, create one before proceeding.
2 In the Planar Dose Computation window on the Dose tab, click the File Input button. The 

Select Point File For Planar Dose window opens.
3 Select the Yes radio button to use the point file for plane definition.
4 Use the directory tools to locate and select the point file.
5 Click the OK button.

Print planar dose

After you compute planar dose, you can print the dose plane.

1 In the Planar Dose Computation window, change the Scale value, if necessary, to print a dose 
display that is smaller or larger than the value currently shown.

A value of “1” creates a life-sized print of the dose distribution.

2 Click the Print Using X:1 Scale button. The Print window opens. Adjust the print settings as 
needed. For information about the settings, see the Print chapter. 

3 Click the Proceed button.
4 From the confirmation dialog box that opens, choose Yes to print the image. Choose No to 

cancel printing.

Print planar dose to a DICOM printer

After you compute planar dose, you can preview and print the dose plane to a DICOM printer. You 
can also print the dose plane as a secondary capture or computed radiography image. For more 
information about how to print DICOM images, see the Print chapter. 

1 In the Planar Dose Computation window, click the DICOM Print Preview button to preview the 
dose plane. Click the button again to return to the normal view.

When you print a dose plane using DICOM, the annotations are “burned” onto the image. 
Before printing, verify that the annotations do not overlap something important. If necessary, 
you can use the Pinnacle3 2D tools to modify the display before printing.
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You can choose which annotations are included when the dose plane is printed by selecting film 
annotation options in Preferences.

2 Click the DICOM Print button. The Print window opens. Adjust the print settings as needed. For 
information about the settings, see the Print chapter. 

3 Click the Proceed button.
4 From the confirmation dialog box that opens, choose Yes to print the image. Choose No to 

cancel printing.

Export planar dose

After you compute planar dose, you can export the information to a file.

1 In the Planar Dose Computation window, type the name of the directory to which you want to 
export the file. If necessary, click the Browse button to locate a directory.

2 Select either ASCII or binary as the export format.
3 Do you want to export the selected dose plane or all dose planes?

• Selected dose plane—go to step 4.
• All dose planes—go to step 6.

4 Type a name for the file.
5 Click the Export Plane To File button. A message confirms that the dose plane was exported 

successfully. This procedure is complete.
6 Click the Export All Planes To File button. The software exports a file for each dose plane to the 

selected directory. File names are based on the dose plane names. A message confirms that the 
dose planes were exported successfully.
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Use the Record Viewer and the Treatment Navigator

About records

A record is a view of data that cannot be changed. It includes information that is either historical in 
nature, or data that has been imported or generated. Pinnacle3 creates a record after you perform 
one of these tasks:

The primary tool for viewing a record is the Record Viewer window. However, you can work with 
records in other tools, too, such as the Plan Evaluation window. Record names are indicated with 
an asterisk (*), and records display with their dose image set by default.

About the Record Viewer 

The Record Viewer window is similar to the Planning window; it includes a subset of the features in 
the Regions of Interest, Points of Interest, and Evaluation panels.

Use the View menu to change the viewing window setup in the Record Viewer. You cannot change 
individual windows between 2D and 3D mode in this tool.

View a record
1 From the Utilities menu, click Record Viewer. The Record Viewer window opens.

You can also open the Record Viewer window from the Treatment Navigator window. See 
Navigate to a trial or record. 

2 Select the record that you want to view from the list in the upper-right corner of the window. 
You can also type a t in a viewing window to see the next record.

The Record Viewer displays the dose image set associated with the selected record. This dose 
image set is identified in the Dose Information section of the Evaluation panel. However, you 
can display dose data on another image set. Type a v in a 2D viewing window or use the left and 
right arrow keys to see dose data on a different image set.

All ROIs and POIs that are associated with records display with dotted lines. 

Task Records created Items in the records Where to find more information

Copy a plan to a new 
image set

One record for each trial 
selected to be copied

ROIs, POIs, prescriptions, 
and dose

See Create plans with Dynamic 
Planning in the Launch Pad 
Instructions for Use.

Accumulate dose One record ROIs, POIs, and dose See Accumulate dose.

Import DICOM RT dose One record Dose See Import plan information.
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Compare records and trials

In the Record Viewer window, you can compare trials in the current plan and records using the 
following tools:

• ROI display in Planning—In the Regions of Interest panel, select Yes next to Display record ROIs 
on all data sets in order to display ROIs from this record on all data sets associated with the 
plan. For each record ROI that you want to display in the Planning window, set the 2D display 
mode in the Record Viewer window to either Both or Poly. ROIs from records display with 
dotted lines.

• POI display in Planning—In the Points of Interest panel, select Yes next to Display record POIs 
on all data sets in order to display POIs from this record on all data sets associated with the 
plan. POIs from records display with dotted lines in 2D viewing windows.

• ROI or POI display for all records—On the Utilities menu, click either All ROI Display or All POI 
Display to control the display of all ROIs or POIs in 2D and 3D viewing windows.

• Dose comparison—From the File menu of the Record Viewer window, click Records, then click 
the Trial/Record Comparison button. Records are indicated with an asterisk in the Trial or 
Record list. See Compare dose.

• DVH—In the Plan Evaluation panel of the Record Viewer window, click the Dose Volume 
Histogram tab. Use the options in the ROI Group tab to compare ROI groups across trials and 
records. See Evaluate plans with dose volume histograms.

• Isodose lines—In the Dose Information panel of the Record Viewer window, display isodose 
lines on the viewing windows. Click the Line Details button to manage the isodose lines and 
create ROIs from isodose lines. See Display dose distribution information.

• Maximum dose point display—In the Dose Information panel of the Record Viewer window, 
click the Max dose point display button to display the maximum dose point for any record 
associated with the plan. See Obtain point dose information.

NOTE
DVH may also be viewed from the Plan Evaluation panel of the Planning window. 
Isodose lines and maximum dose point display information may also be viewed in the 
Isodose Lines panel of the Planning window.

View record prescriptions

If a record contains prescription information, you can view it by clicking Prescriptions at the bottom 
of the Eval panel. The Record Prescriptions window opens and shows prescription information for 
the current record. To view prescription information for a different record, select the record from 
the Prescriptions for Record list at the top of the window. 

If you choose, you can add comments to the prescription information at the bottom of the Record 
Prescriptions window.

Manage records
1 From the File menu in the Record Viewer window, click Records. The Records window opens.
2 Select a record from the Record List.
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3 Perform any of the following tasks:
• Delete the record—Click the Delete Record button.
• Change the name of the record—Select the text in the Record Name field and type a new 

name.
• View record details—Click the Details button to view additional information about the 

record, including the date that the record was created and the dose image set associated 
with the record. For records that you create by accumulating dose, you can add comment 
text to describe each trial or record that was accumulated.

About the Treatment Navigator

The Treatment Navigator window allows you to navigate between the current plan and the records 
associated with the plan. The Treatment Navigator window opens when a plan has at least one 
record associated with it. 

The Treatment Navigator window displays one icon for each image set. The icons are ordered from 
oldest image set to newest image set, left to right. The right-most icon represents the primary 
image set of the current plan. Each icon provides access to all records associated with that image 
set. The right-most icon also provides access to the trials in the current plan. A sample icon appears 
in the following illustration.

NOTE
The Treatment Navigator is only available if you have the Dynamic Planning license.

Navigate to a trial or record
1 In the Treatment Navigator window, select an icon by clicking it or by using the left and right 

arrow keys on the keyboard to navigate to it.

1

2

3

4

1 Image set name

2 Center slice of the image set

3 Image set date

4 Scanner name and modality
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2 Click the selected icon or press the Enter key to open the Record Viewer window. For the right-
most icon (the primary image set for the current plan), click the icon or press the Enter key to 
toggle between two windows:
• the Record Viewer window for records associated with the image set 
• the Planning window for trials in the current plan
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Evaluate plans with QA phantoms
The Copy to Phantom option lets you copy the beams from a plan to one of your stored quality 
assurance (QA) phantoms to verify the dose distribution or the dose at given points of interest.

Define a QA phantom

�CAUTION
Define a QA phantom for each patient orientation you expect to treat. When you evaluate a plan, 
we recommend that the orientation of the QA phantom match the patient orientation in the 
plan. If the orientations do not match, the plan will be incorrectly oriented with respect to the 
phantom and you will not be able to accurately verify the dose distribution.

�CAUTION
Do not select the Water Phantom option in the Edit Plan Data window when you add a plan to 
the phantom patient. If you select Water Phantom, you will not be able to save the plan as a 
phantom.
1 In the Patient Select window, add a patient in which to store phantoms.
2 Import the phantom images.
3 Add a plan that uses the images you just imported.
4 Click the Planning button to enter the treatment planning software.
5 In the Confirm Plan Setup window, verify that the patient orientation is correct.
6 Add POIs and ROIs to the phantom as necessary.

Choose names for the POIs that are different from names used in patient plans. During plan 
evaluation, it will be easier to differentiate between phantom and patient POIs if they have 
different names.

7 End the planning session and save the data files.
8 In the Patient Select window, click the QA Tools button. The QA Tools window appears.
9 Click the Save as Phantom button. The Save Phantom window appears.
10 Enter a name for the phantom.
11 Click the Save button.

Copy a plan to a QA phantom

NOTE
You cannot copy a plan that was created in Pinnacle3 version 8.0 or earlier to a phantom 
that was created in Pinnacle3 9 or later.

If you have saved a data set as a QA phantom, you can copy a plan to the phantom for quality 
assurance and plan verification.

1 In the Patient Select window, select a patient and the plan you want to copy.
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2 Click the QA Tools button. The QA Tools window appears.
3 Click the Copy to Phantom button. The CT Patient/Directory List window appears.
4 Select the phantom data set you want to use. We recommend that you use a phantom data set 

that has the same patient orientation as the patient plan you selected.
5 Click the Import button.

A new plan is added to the Plans list. This new plan is the result of copying the patient plan to 
the phantom plan. This is the plan you will use to validate your patient plan.

NOTE
When you copy a plan to a QA phantom, the following actions occur:
• The dose is invalidated.
• All boluses are removed from the plan.
• Each prescription in the new plan is set to the Set Monitor Units option.
• The MUs for each beam are retained.
• The dose grid is adjusted so that it covers the entire image set in the new plan.

Evaluate the plan

�CAUTION
You cannot return to the Phantom POI Adjust window once you click the Close button. Be sure 
you are finished aligning the patient and phantom plans before you click the Close button.

�CAUTION
The software does not prevent you from moving beams or POIs once you close the Phantom POI 
Adjust window. DO NOT change any beam or POI locations. If you change these settings, this plan 
will no longer match your patient plan, and the dose calculations you make will not be valid for 
your patient plan.
1 In the Patient Select window, select the plan that was created when you copied the patient’s 

data to a phantom.
2 Click the Planning button.

The Phantom POI Adjust window appears. Use this window to align the coordinate systems of 
the patient and phantom plans.

3 In the Target POI option list, select the phantom POI you want to use as the target POI.
4 In the Target Beam option list, select the beam you want to align to the coordinates of the 

target POI.
5 Click the Move beams to new position button. The software aligns the POI of the target beam 

to the coordinates of the target POI. The spatial relationship between all beams and their 
associated POIs is maintained.

6 Click the Close button.
7 Adjust the size and location of the dose grid, if necessary.
8 Calculate dose for the beams.
9 Evaluate the results against film dosimetry, planar dose, or other measurements.
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NOTE
When you back up patients that contain QA phantom plans, Pinnacle3 also backs up the 
phantoms. See the Launch Pad Instructions for Use for information on backing up 
patient data.

Delete a QA phantom

You can delete QA phantoms that do not have patient plans copied to them. If a patient plan is 
associated with a QA phantom, you must delete the plan before you can delete the QA phantom.

1 In the Patient Select window, click the QA Tools button. The QA Tools window appears.
2 Click the Delete Phantom button. The CT Patient/Directory List window appears.
3 Select the phantom to be deleted from the list and click the Delete button.
4 Click the Close buttons in the CT Patient/Directory List window and the QA Tools window.
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Evaluate plans with DRRs
Use the Plan Evaluation DRRs window to view and print beam’s eye views (BEVs) that help you 
verify the isocenter of a completed plan.

1 Select Utilities - Plan Eval DRRs.

If virtual setup beams are not configured, the Select Setup Beam POI window appears. In this 
window, you must select the isocenter and machine that the software uses to create the 
evaluation DRRs. Then, click the Plan Eval DRRs button to access the Plan Evaluation DRRs 
window.

If virtual setup beams are already configured, the Plan Evaluation DRRs window appears.

• To create DRRs for non-proton beams, see Create non-proton beam DRRs.
• To create DRRs for proton beams, see Create proton beam DRRs.

Create non-proton beam DRRs

For non-proton beams, you can display or print AP or PA, Left or Right, and Superior or Inferior 
DRRs to verify your plan.

1 In the Plan Evaluation DRRs window, select an orientation for viewing the DRRs.

NOTE
The software calculates the source to surface distance (SSD) using the CT to density 
table that you selected in the Beam’s Eye View Options window. If you use a different 
CT to Density table in the Plan Evaluation DRRs window than you do in Planning, the 
SSD in the Plan Evaluation DRRs window may be slightly different than the SSD in your 
plan.

2 Specify the jaw positions for each beam. The default jaw names and positions are set in Physics 
during commissioning.

NOTE
If the machine is commissioned with stereotactic or electron energies and with no 
photon energies, you are not allowed to change the jaw positions. If the machine is a 
fixed jaw machine, you cannot change the jaw positions even though the software 
allows you to enter new values. The jaw position values are set as they were 
commissioned with the machine and you cannot change them.

3 If necessary, adjust the DRR display parameters in the Plan Evaluation DRRs window. Right-click 
in a viewing window and then click the BEV Options button. For more information on the 
display parameters, see the View Patient Data chapter.

NOTE
The window and level settings are percentages of the maximum DRR volume value.

4 To display all multi-leaf collimator (MLC) leaves for all beams in the trial, deselect the Clip Setup 
MLCs check box.
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5 To change the isocenter or machine, select a different option from the Isocenter or Machine 
option list.

6 To print the DRRs, click the Print Window button. The Print window appears. For more 
information about how to print viewing windows, see the Print chapter.

7 Click the Close button.

NOTE
To delete all setup beams, click the Delete Setup Beams button. When you click the 
Delete Setup Beams button, the Plan Evaluation DRRs window and the DICOM Export 
window are both closed.

Create proton beam DRRs

For proton beams, you can display or print AP or PA, Left or Right, and Superior or Inferior DRRs to 
verify your plan, or you can specify an angle from which to create the DRR.

1 In the Plan Evaluation DRRs window, select an imaging device from the option list.
• If you selected a continuous imaging device, go to step 2.
• If you selected a fixed imaging device, go to step 4.

NOTE
The Angle and SAD values displayed in the window are the values that were 
commissioned for the imaging device.

2 Select an orientation for viewing the DRRs.
3 If you selected Other as the orientation, specify the angle that should be used to create the 

DRR.
4 If necessary, adjust the DRR display parameters in the Plan Evaluation DRRs window. Right-click 

in a viewing window and then click the BEV Options button. For more information on the 
display parameters, see the View Patient Data chapter.

NOTE
The window and level settings are percentages of the maximum DRR volume value.

5 To change the isocenter or machine, select a different option from the Isocenter or Machine 
option list.

6 To print the DRRs, click the Print Window button. The Print window appears. For more 
information about how to print viewing windows, see the Print chapter.

7 Click the Close button.

NOTE
To delete all setup beams, click the Delete Setup Beams button. When you click the 
Delete Setup Beams button, the Plan Evaluation DRRs window and the DICOM Export 
window are both closed.
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Perform robustness analysis

NOTE
The robustness analysis option is only available if you are licensed for proton treatment 
planning.

Robustness analysis is a plan evaluation tool that lets you define different scenarios to evaluate 
how different setup or range errors will affect dose distribution. Robustness analysis can only be 
performed for proton beams. If a trial also contains beams that are not proton beams, the dose 
from those beams is considered as background dose to create scenarios.

1 Click the Plan evaluation button.

The Plan Evaluation panel opens in the Planning window, displaying a Dose Volume Histogram 
tab.

2 Click Options > Trends. The Trends & Analysis window appears.
3 Click the Robust analysis button. The Robustness Analysis panel opens, displaying the 2D Dose 

Comparison tab.

On the 2D Dose Comparison tab, you can view and compare the nominal dose and dose due to 
error side-by-side for each slice of the image set. The window on the left shows the dose 
distribution from the trial that is selected in the Trial option list. The window on the right shows 
the dose distribution from the scenario that is selected in the Scenario option list.

The 2D viewing window tools function the same in these viewing windows as they do in other 
2D viewing windows in the software. For example, you can compare the dose on multiple slices 
by scrolling through the anatomy. 

NOTE
The two viewing windows do not operate independently. If you pan and zoom in one 
window, for example, the other window also pans and zooms.

Use the fields at the top of the panel to specify errors for the scenario.

• Range Error—Specify the percent by which the range should be shifted. Dose for each beam 
is recomputed assuming changes to the Water Equivalent Thickness (WET) based on the 
percentage that you enter.

• Setup errors—Specify errors (in cm) in the setup by entering values in the X Error, Y Error, 
and Z Error fields. Dose is recomputed for each beam based on the error values.

NOTE
The X Error, Y Error, and Z Error values use the room coordinate system, not the patient 
coordinate system. The isocenters do not move with the patient.

Create a scenario

NOTE
To create a scenario, the trial must contain at least one proton beam and dose must be 
computed for all of the beams in the trial.
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1 From the Trial list, select the trial that you want to evaluate.
2 In the fields at the top of the Robustness Analysis panel, enter the error parameters for the 

scenario.
3 Click Compute Scenarios. The software recomputes dose for the beams in the trial and displays 

the dose distribution for the scenario in the viewing window on the right. The scenario is saved 
to the trial that is selected in the Trial list.

NOTE
To cancel the creation of a scenario, click Cancel in the Robustness Analysis Progress 
window. The errors that have been computed are retained, but those that are in 
progress or not yet started are canceled.

NOTE
If a beam has a locked isocenter, that beam will not be shifted when dose is computed 
for the setup error scenarios. This can be useful when you have junction fields where 
each beam has a separate isocenter and you want to evaluate the robustness of the 
trials with individual beams that are shifted independently of the other beams.

NOTE
In some instances, the setup errors that you specified may result in a scenario in which 
dose needs to be computed in a Z plane that lies outside of the minimum and maximum 
Z-plane values that were defined for the machine during commissioning. If this occurs, a 
warning message appears indicating that dose could not be computed. To correct the 
problem, change the setup error for the scenario that could not be created and then 
create the scenarios again. Alternatively, you can change the dimensions of the dose 
grid in the trial so that the entire dose grid including the scenario error lies within the 
range of the Z-plane values. Dose for the trial is invalidated if you change the 
dimensions of the dose grid, and you will need to recompute dose for the trial.

Evaluate scenario dose with dose volume histograms

�CAUTION
The DVH default is normalized to the percent of maximum dose. The maximum dose is the 
maximum anywhere in the dose grid and may cause the DVH to be misinterpreted. We 
recommend that you select absolute dose or specify the maximum dose rather than using the 
default. For detailed information about how maximum dose is calculated, see the Pinnacle3 
Planning Reference Guide.

On the DVH tab in the Robustness Analysis panel, you can summarize the dose distribution for 
selected regions of interest (ROIs) across multiple trials with dose volume histograms (DVHs). DVHs 
provide plots of normalized or absolute dose versus normalized or absolute volume. From the DVHs 
you can determine the distribution of dose within given volumes. However, the DVHs do not 
provide any spatial information about the dose distribution.

1 Click the DVH tab. The dose volume histogram information appears.
2 In the Scenario list, select the scenario for which you want to view the DVH.
3 In the Trials or Scenarios list, select the Display check box for the trial or scenarios that you 

want to evaluate. If you want to display multiple choices, use the Line Type lists to set different 
styles for the DVH lines for each trial or scenario.
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NOTE
The trial that is shown in the Trials or Scenarios list is the trial that is selected in the Trial 
list at the top of the Robustness Analysis panel.

4 In the ROIs list, select the Display check box for the ROIs that you want to evaluate. The DVHs 
for the ROIs appear in the selected trials and scenarios using the current DVH calculation and 
display options.

NOTE
If beams are re-weighted or recalculated or if ROI volumes change, the DVHs are 
automatically recalculated.

NOTE
The color of the DVH line is linked to the ROI color, so the line color cannot be changed.

5 Select the desired DVH calculation and axis display options. The DVH is automatically 
recalculated and displayed using the new settings.

NOTE
The software calculates the % > Max value by dividing the volume of all voxels whose 
values exceed the range of the last histogram bin by the total volume of the ROI. 
Therefore, the value that the software uses to calculate the % > Max value may not be 
the same as the value that you enter in the Specify Max Dose field. 

NOTE
The DVH for a scenario is not saved when the plan is saved.

Group Option Description

DVH Calculation Cumulative DVH displays the total volume that has received a given dose or
more.

Differential DVH displays the distribution of dose received by each volume unit
of the specified structure.

Dose Axis Display Normalized Dose The dose to the ROI is normalized to 1.0 (100%), and the dose axis
of the DVH shows the percent of maximum dose to the specified
ROI.

Absolute Dose The dose axis of the DVH shows absolute dose to the ROI (in cGy or
Gy).

Auto-Compute Max Select this option to let the software compute the maximum dose
value in the ROI. This option is selected by default.

Specify Max Dose Select this option to specify the maximum dose yourself. This
option is commonly used with brachytherapy plans, which
sometimes have high doses that fall outside the maximum range of
the histogram. The percentage of the structure volume with a dose
greater than the maximum histogram dose is shown in the % > Max
column of the ROI Statistics spreadsheet.

Volume Axis Display Normalized Volume The volume is normalized to 1.0 (100%), and the volume axis of the
DVH shows the percent of the ROI volume receiving a given dose.

Absolute Volume The volume axis of the DVH shows the actual volume (in cm3)
receiving a given dose.
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6 Use the DVH Tools to obtain dose and volume values for a point on a curve and to zoom into 
the graph.
• Mouse over a point on a curve. The selected curve is highlighted. The dose and volume 

values appear, along with the curve’s trial and record information, in a box superimposed 
over the graph near the mouse pointer. Moving the mouse allows you to see the changes in 
values. 
Changes in the values depend on the resolution of the binning. No interpolation is 
performed, and thus some of the value changes may appear “jumpy” if the Tabular DVH 
settings are too small.
To switch to a different curve, mouse over another curve in the graph. You can use this tool in 
a zoomed window.

• Click the Box Zoom 2D tool and draw a rectangle to define a subset of the graph to display. 
You can zoom further by drawing a rectangle again. To return the DVH to its original state 
before any zooming, click Reset.
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14 Import

Overview
If you are licensed for DICOM RT, you can import the following DICOM RT data:

• Plans.
• Structure sets.
• Dose (where Dose Summation Type = PLAN).
• Spatial registration.

Before you attempt to import plan information into Pinnacle3, you must set up the patient, import 
the image sets, and create a plan in Launch Pad. For more information, see the Launch Pad 
Instructions for Use. For information about Pinnacle3 DICOM conformance, see DICOM 
conformance in the Getting Started chapter.

When you import image sets in Launch Pad with the intent to import plan data from that image set 
later via DICOM RT, the image set must conform to the following standards:

• To properly match the image data with the plan data, you must enter the correct Medical 
Record Number (MRN) in Launch Pad for the imported image set. If you do not, you cannot 
import the plan. 

If you do not know the MRN, enter the other information in Launch Pad, open the Select 
Images For Import window and note the MRN that appears in the window. You can then return 
to Launch Pad and enter the correct MRN. Alternatively, you can choose to import the image 
set with patient demographics. For more information, see the Launch Pad Instructions for Use.

• When you import the image sets in Launch Pad, select the DICOM3File scanner type in the 
Image Select window.

• The Select Images For Import window displays the DICOM image sets that you can import. The 
names in the Image Name column will become the patient names for the images in Pinnacle3. 
Punctuation such as carets (^) indicate breaks in the name. For example, an image name of 
FFS^Head^  will be considered a patient with the last name of FFS and the first name of Head in 
Pinnacle3. You can reduce error messages by entering the first and last names as the patient 
names in Launch Pad. However, these errors do not prevent you from importing plans via 
DICOM RT.

Transfer limitations
• In Launch Pad, if you make any of the following changes to an image set, you cannot import 

dose, structure sets, or spatial registration to that image set:
– Change the patient position.
– Change the patient orientation.
– Change the treatment position.
 Pinnacle3 16.4  Planning Instructions for Use 4598 006 81251 A



Import plan information 281 
– Change the X/Y pixel size.
– Change the Z coordinate for a slice.
– Delete a slice.

• You cannot import structure sets or spatial registration if the original plan was created on a 
decubitus image set.

• You cannot import structure sets, dose, or spatial registration if the original plan was created on 
an image set that is not found in the current plan.

• You cannot import structure sets if ROIs have contours that are not on a slice.
• You cannot import plans that contain segmented beams, dynamic wedges, or motorized 

wedges.
• You can import plans and structure sets only if you used DICOM Image 4.2d or later to import 

the images in the plan.
• You can import spatial registration only if you used DICOM Image 9 or later to import the 

images in the plan.

Import plan information

�CAUTION
When the import is complete, verify all information before continuing the planning process in 
Pinnacle3.

You can import plans (RT Plan), structure sets (RT Structure Set), dose (RT Dose), and spatial 
registration to any plan. 

1 On the File menu, click Import and then click DICOM.

The Import window appears.

NOTE
If you know that new patients or messages have been transmitted to or deleted from 
the Pinnacle3 DICOM server since you last opened the window, click the Refresh Lists 
button.

2 In the Patients eligible for import list, select the patient that contains the information that you 
want to import. 

To delete a patient from the list, select the patient and click the Delete Patient button. When 
you delete a patient, you remove the messages that are associated with the patient but retain 
any image files.

3 The Available messages list displays a list of messages that are associated with the selected 
patient.
• Import all messages—Click Import. The software imports all messages that are associated 

with the patient.
• Import one message—Select the message that you want to import and then click Import. 

The software imports only the message that you selected.
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• Import multiple messages—Press Ctrl and select the messages that you want to import. Click  
Import. The software imports only the messages that you selected.

To delete messages, select the messages that you want to delete and click the Delete Messages 
button. Press Ctrl as you click to select multiple messages.

4 Click Close when the import is complete. 

Import beams from RadCalc

NOTE
The instructions in this section require the use of RadCalc. To purchase RadCalc, contact 
your Philips sales representative or local distributor.

If you want to import beams from an RT plan into Pinnacle3 but the beams contain multiple control 
points, use RadCalc to export a script file that contains the beam data. You can then run the script 
file to import the beams into Pinnacle3 for use in planning. 

�CAUTION
When the import is complete, verify all information before continuing the planning process in 
Pinnacle3.

NOTE
Specific directories are required to transfer files between Pinnacle3 and other software 
applications such as PlanIQ and RadCalc. For more information about these directories 
and instructions to change them, see the System Administration chapter in the Pinnacle3 
Launch Pad Instructions for Use.

1 After you have exported the script file from RadCalc to the RadCalc to Pinnacle directory, click 
Import from the File menu, and then click RadCalc. The RadCalc Import window opens.

The RadCalc Import window lists the file name and date for each RadCalc script that matches 
the patient’s MRN. If necessary, click Refresh to update the list of script files.

2 Select the script file that contains the beams you want to import.

Imported Message Type Result

RT Plan The software creates a new trial and imports the plan data to that trial. The 
new trial becomes the current trial for that plan.

RT Structure Set The ROIs and POIs in the structure set are added to the plan. If your plan 
already contains ROIs and POIs, the ROIs and POIs in the structure set are 
added to the plan in addition to the existing ROIs and POIs.

RT Dose The software creates a new record and imports the dose data to that record. 
See Use the Record Viewer and the Treatment Navigator. 

Spatial registration The software registers the image sets in the plan.
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NOTE 
When Delete upon import is selected, the script file you selected is deleted from the 
RadCalc to Pinnacle directory after the beams are imported into Pinnacle3. This option 
is selected by default.

3 Click OK to run the script. The beams are imported into a new trial.
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15 Export

Overview

�WARNING
Plans may include the statement NOT FOR CLINICAL USE. Based on the machine or isotope data 
and the plan, the software determined that the plan cannot be delivered clinically. Do not treat 
patients with plans that are not for clinical use.

DICOM RT is the most common method of export. You can also export some plan information 
without using DICOM RT.

This chapter describes how to export the following:

• Export DICOM plan information
• Export laser localization coordinates
• Export blocks
• Export compensators
• Export MLCs
• Export to Calypso
• Export for record and verify systems
• Export for Mitsubishi DME record and verify systems
• Export files for RTOG submission
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Export DICOM plan information

�CAUTION
We recommend that you test the output from the software to your receiving DICOM system to 
confirm that parameters are being transferred correctly. Confirm that the plan information at the 
receiving system console is the same as the plan information you set up in the software.

For information about Pinnacle3 DICOM conformance, see DICOM conformance in the Getting 
Started chapter.

NOTE
You can export DICOM information only if you are licensed for DICOM RT.

NOTE
When you export a plan, DICOM RT samples the dose grid at the reference point 
specified in the Monitor Units window in order to determine the dose per beam to 
export. If you prescribe to something other than a POI, we recommend that you create a 
new POI in a region of the patient with the desired prescription dose. Specify this new 
POI as the dose reference point for each beam.

NOTE
If you are licensed for protons, all dose that you export is assumed to be cobalt-
equivalent effective dose, not physical dose. For information, see the Calculate Dose 
chapter. For information about how the software exports dose, see the Pinnacle3 
DICOM Conformance Statement, which is available on the Philips Healthcare website 
(www.healthcare.philips.com).

Transfer limitations
• In Launch Pad, make sure that the patient and plan information does not contain any of the 

following characters. If the patient or plan information contains these characters, you cannot 
export the plan.

. ‘ ~ & ( ) | < > + * \ / ; : @ ! [ ] #

• In Launch Pad, you must enter a last name, first name, and medical record number. If any of 
these fields are blank, you cannot export the plan.

• In Launch Pad, if you make any of the following changes to an image set, you cannot export 
structure sets, dose, or spatial registration for the modified image set. You can still export a 
plan, but the software does not include the isocenter in the plan.
– change the patient position
– change the patient orientation
– change the treatment position
– change the X/Y pixel size
– change the Z coordinate for a slice
– delete a slice

• You cannot export a trial that is not selected for treatment or that cannot be delivered clinically.
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• You cannot export a locked plan that has been changed.
• You cannot export structure sets, dose, or spatial registration from a decubitus image set.
• You can export structure sets only if you used DICOM Image 4.2d or later to import the images 

in the plan.
• You can export spatial registration only if you used DICOM Image 9 or later to import the 

images in the plan.
• You cannot export an entire trial in one export if the trial contains both proton and non-proton 

beams. You must export the trial prescription-by-prescription in order to export all beams for 
that trial.

• You cannot export a proton plan for which dose is not computed.

Export plan information

DICOM RT Export must be configured properly before you can export DICOM information. For 
assistance with configuring DICOM RT Export, contact Customer Support at 1-800-722-9377 (US 
and Canada) or your local distributor. Contact the appropriate target system representative for 
details regarding your target system.

1  On the File menu, click Export, and then click DICOM.

The DICOM Export window opens.

2 Select the trial that contains the information that you want to export from the Trial to export 
list.

3 Select the destination to which you want to export plan information from the Destination AE 
Title list.

The Destination AE Title list identifies the possible DICOM target systems. If no choice is 
available, obtain the appropriate AE (Application Entity) title from your IT department, and 
then contact Customer Support or your local distributor for assistance in entering it.

4 Select the information that you want to export. See Fields and buttons.
5 Click Transmit Data to export the information to the AE destination.

If the export cannot be completed within the number of seconds you specify in the DICOM 
Timeout field, the export may fail.

�CAUTION
For a RT plan, If there is any unrecoverable error in the plan, the software does not allow you to 
export the DICOM information. The software displays a recoverable beam violation error 
message if the beam parameters such as Gantry Rate, Leaf Speed, or MU/Degree exceed the 
limitations of the machine. For such beam violation error, you can view the violated parameters 
and export the DICOM information if you want. If you get a combination of a beam violation 
error and unrecoverable errors, the software does not allow you to export the DICOM, but you 
still can view the violated beam parameters. For beam violation errors, if the error is too high, we 
recommend that you adjust the parameters in the Edit Prescription window to bring the violated 
parameters within the machine limitations before you export the DICOM.
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NOTE
The Pinnacle3 software does not include a mechanism for the electronic approval of 
plans prior to export. For this reason, the software always exports the approval status of 
plans as UNAPPROVED. This information is explicitly stated in the following message 
that is displayed in the DICOM Export window:

“The Approval Status DICOM tag (300E, 0002) is always sent as UNAPPROVED.”

Fields and buttons

Title Description

Trial to export The trial that contains the information that you want to export.

Use trial for treatment Select Yes if you want to use the selected trial for the treatment. Select No if you 
do not want to include the selected trial.
The Use trial for treatment option only appears if you have added multiple trials in 
your plan.

Local AE Title The local site from which you want to export the information.

Series Number
Series Description

Enter a series number and series description to associate with the current export 
(optional).

Destination AE Title The remote site to which you want to export the information.

DICOM Timeout The amount of time (in seconds) before the software cancels the DICOM export.

DRR Resolution If you will export RT Image or Setup Beams, set the resolution of the DRRs to be 
exported. The default value is 512, and you can set the value within the range 256–
4096.

Plan Intent Select the purpose for this export. Select None if you do not want to include this 
information in the DICOM export.

Transmit Data Transmit (export) the selected information.

RT Plan Export the prescriptions that you select. Only the prescriptions that have non-
proton beams assigned to them will appear in the Prescription list.
You can also choose which tolerance table the machine uses for the prescription. If 
a prescription uses multiple machines, you cannot export a tolerance table for that 
prescription.
Relative couch shifts between the patient setup and the treatment positions are 
exported if the lasers have been set for the plan and the plan contains only one 
isocenter. If the plan contains multiple isocenters, then the shifts are not exported.

RT Ion Plan Export the prescription that you select. Only the prescriptions that have proton 
beams assigned to them will appear in the Prescription list.
The RT Ion Plan check box only appears if you are licensed for proton treatment 
planning.

Send SSDs in all arc control 
points

Include the Source to Surface Distance (SSD) for each control point in each arc 
beam that is in the prescriptions that you select for export.
This option applies only to plans that use arc, conformal arc, and dynamic arc 
beams.
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Export beam dose as: Choose how to calculate the beam dose tag (300A,0084) for RT Plan or RT Ion Plan:
• Weighted Prescription Dose—Prescription dose per fraction multiplied by the 

beam weight.
• Dose at Ref Point/Fraction—The dose per fraction at the given reference point 

for a beam.

RT Structures Export the ROIs and POIs that are associated with the image sets that you select.
Only valid DICOM image sets appear under RT Structures. A DICOM image set is 
invalid if you changed any of the following for the image set: patient position, 
patient orientation, treatment position, X/Y pixel size, or the Z coordinate for a 
slice.

Select ROI Click Select ROI to view the list of ROIs that are associated with the selected image 
sets. The Select ROIs to Export window opens. Select the ROIs that you want to 
export and then click Close.
ROIs that are created by the Personalized Planning tool during optimization appear 
dimmed in the window if you set the Include Personalized Planning ROIs in plan 
output preference to No in the IMRT category of the Preferences window. See the 
Utilities chapter in the Pinnacle3 Planning Reference Guide for more information.
Available only if you select the RT Structures and the related image set check 
boxes.

RT Image Export a DRR for each treatment beam that is associated with the trial. Available 
only if you select RT Plan or RT Ion Plan. You can set the resolution of the DRRs to 
be exported in the DRR Resolution field.

Annotate Images Annotate the treatment beam DRRs that you export. Available only if you select 
RT Image.

RT Dose Export dose grids for the plan. The software allows you to export the following:
• Dose per control point—Export a dose grid for each control point in each beam 

that is associated with the prescriptions that you select for export. (This option 
is not available if you select RT Ion Plan.)

• Dose per beam—Export a dose grid for each beam that is associated with the 
prescriptions that you select for export.

• Dose per prescription—Export a dose grid for each prescription that you select 
for export. Each dose grid is the sum of the dose grids for all beams in the 
prescription.

• Sum of selected prescriptions—Export one dose grid that is the sum of the 
dose grids in the prescriptions that you select for export.

• Current dose and prior dose—Export both the computed dose and prior dose. 
This option is available only when the Dose Display Mode in the Prescriptions 
window is set to Current Dose and Prior Dose. All other DICOM export options 
except DICOM Image are unavailable when prior dose is included. See Assess 
the impact of prior dose.

The check boxes listed above are available only if you have computed dose and you 
select RT Plan or RT Ion Plan.

Spatial Registration Export the spatial registration for each secondary image set.

DICOM Image Export the DICOM image sets that you select.
The software exports the original DICOM image set. Any changes that you made to 
the image set do not export.

Title Description
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Setup Beams Export two setup beams for the isocenter that you select. If no setup beams are 
configured, the Select Setup Beam POI window opens and you must select the 
isocenter and machine for the setup beams.
For proton DRRs, you can select imaging devices and orientations for the setup 
beams.
Available only if you select RT Plan or RT Ion Plan.

Annotate Setup Beams Annotate the setup beam DRRs that you export. Annotations include a crosshair, an 
orientation cube, and information about the plan, machine, energy, prescription, 
patient setup, and beam modifiers.
Available only if you select the Setup Beams check box. You can set the resolution 
of the DRRs to be exported in the DRR Resolution field.

Setup Beam Viewer Use the Isocenter and Machine lists to define the setup beam DRR that you want 
to export. 
For non-proton DRRs, use the orientation lists to view the DRR. However, the 
software always exports one left and one anterior setup beam DRR for the selected 
POI, regardless of the settings that you select in the orientation lists.
For proton DRRs, use the Imaging Device lists to select imaging devices for the 
DRRs. If you select a Continuous imaging device, use the orientation list to view the 
DRR. For an orientation of Other, type an angle for the DRR.
Available only if you select the Setup Beams check box.

Title Description
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Export laser localization coordinates
After you localize the patient and set up beams (beams must exist before you can export) or when 
the plan is completed, you can create files that contain a description of the plan’s isocenter 
geometry using the specific coordinate systems of laser localization systems. These files can be 
used by the laser localization system to align laser marking devices to correspond to the plan. 

�CAUTION
Verify that you are using the correct trial when you export laser coordinates. And, export the 
laser coordinates using an appropriate file name so you can identify the patient and plan.

NOTE
You cannot export laser coordinates for a trial that is not selected for treatment or that 
cannot be delivered clinically.

1 Select File - Export - Other. The Export window appears.
2 Use the fields at the top of the Export window to select the trial you want to export and specify 

the directory where you want to store the files.
3 In the Category list, select Laser.
4 In the Laser alignment system option list, select the laser localization system.

You can select a system for a single moveable (sagittal) laser or for three (one sagittal and two 
coronal) lasers.

5 In the Isocenters to export field, select the isocenters. Hold down the Control key to select 
more than one.

6 In the Output file name field, assign a name to the laser localization file.
7 Click the Export Isocenters button to create the files.
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Export blocks
If you have an automatic block cutter, you can generate a file to transfer to the block cutter for 
block generation.

�CAUTION
Verify that the block shape is correct for your treatment plan prior to exporting the block to a file.

�CAUTION
Using an old block cutter output file may result in the incorrect blocks being cut for the plan. If 
you change the plan or use a different trial for your treatment, generate a new block cutter 
output file.

NOTE
You cannot export block cutter information for a trial that is not selected for treatment 
or that cannot be delivered clinically.

1 Click the Beams icon at the top of the window, and in the Modifiers tab of the Beam panel, click 
the Output button. 

The Export window appears.

2 Use the fields at the top of the Export window to select the trial you want to export and specify 
the directory where you want to store the exported file.

You can enter the directory path manually or click the Browse button and select the directory 
path you want.

3 Select the export format for the block cutter file.
4 Select the beam you want to export.
5 In the Block file name field, enter a name for the block file.

A default name appears according to the export format you selected.

6 In the Block/Field edge overlap field, enter the margin of overlap between the block and the 
edge of the field (if necessary).

7 Click the Export Block button to save the file to the specified directory.
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Export compensators
After you complete your compensator design, you can export it to a file that can be taken to a 
milling machine.

�WARNING
If you modify a compensator parameter without re-optimizing the compensator, the output 
compensator design will not take into account that change. Make sure the compensator is 
optimized with the current settings prior to generating an output file.

NOTE
You cannot export compensator information for a trial that is not selected for treatment 
or that cannot be delivered clinically.

1 In the Compensator Editor window, click the Compensator Output button. The Export window 
appears.

2 Use the fields at the top of the Export window to select the trial you want to export and specify 
the directory where you want to store the exported file.

3 Select the export format for the compensator file.
4 Select the beam you want to export.
5 In the Compensator file name field, enter a name for the compensator design you are 

exporting.
6 Click the Export Compensator button to save the file to the specified directory.
7 After exporting the file, copy it to a disk for transfer to the milling machine.
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Export MLCs
You can export MLC leaf positions to an ASCII text file in a number of formats.

�WARNING
After exporting the MLC leaf positions, verify their accuracy by examining them in your MLC 
software. Incorrect leaf positions can result in incorrect dose.

�WARNING
If you commissioned a machine using Pinnacle3 version 4.2f and enabled swapping of MLC leaf 
pairs and leaf order on export, you must recommission the machine before exporting will be 
allowed for any native format.

�CAUTION
Using incorrect MLC leaf positions can expose or block the incorrect area on a patient. Verify the 
positions of the MLC leaves before exporting the positions to a file.

NOTE
You cannot export MLC leaf positions for a trial that is not selected for treatment or that 
cannot be delivered clinically.

1 Click the Export MLC Leaf Positions button in the Beam MLC Leaf Position Editor window. The 
Export window appears.

2 Use the fields at the top of the Export window to select the trial you want to export and specify 
the directory where you want to store the exported file.

For Philips/Elekta export, the directory specified for export should be NFS-mounted to the 
Philips/Elekta MLC. By default, /home/p3rtp is NFS-exported. Therefore, you can create an 
Exports directory in /home/p3rtp, then specify /home/p3rtp/Exports in the Specify Export 
Directory field. The directory is then NFS-mounted to your Philips/Elekta MLC computer, so you 
can perform a direct import on the Philips/Elekta side. No disk copying is necessary.

3 Select the MLC export format.
4 Which format did you select?

• Varian—enter an Output ID number. This ID number is the actual name of the file that is 
exported. Continue to Export using the Varian format.

• Philips/Elekta—enter an Output ID number. This ID number is the Patient ID to be imported 
to the MLC and the name of the default directory. Continue to Export using the Philips/Elekta 
format.

• Toshiba—enter an Output ID number. This ID number is the Patient ID to be imported by the 
MLC. Continue to Export using the Toshiba format.
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Export using the Varian format

�CAUTION
The Varian Shaper software limits block shapes to 100 points. If necessary, the software reduces 
the number of points during export to meet this requirement, but when blocking to an ROI, you 
might want to use the ROI point reduction tool to reduce the number of points yourself. You are 
thus assured that ROIs maintain the shape you want.
1 Specify the File version as F or G (F is not available for arc beams). If you select version G, enter 

a value in the Leaf Position Tolerance field. This value specifies the position tolerance (in cm) of 
the leaves during dynamic treatment.

2 Select the beams you want to export. Hold down the Control key as you click to select multiple 
beams.

3 Click the Export All button to export all beams, or click the Export Selected button to export 
only the beams that you selected.

Export using the Philips/Elekta format
1 Specify the MLC name in the MLC Name field.
2 Specify whether you are using an accessory in the beam path. If you select Yes, the software 

prompts you to enter the fitment code assigned to the accessory.
3 Select the beams you want to export.

Use the Treatment and Beam Number menus to specify treatment numbers and beam 
numbers for each beam you want to export. If you select No Export for either the treatment or 
beam number, the beam will not be exported. You cannot assign two beams to the same 
treatment/beam number pair.

4 Click the Export button to save the files to the specified directory.

Export using the Toshiba format

NOTE 
You must calculate dose before MLC data can be exported in Toshiba format.

1 Select the beams you want to export.

Use the Plan Number menu to specify a plan number for each beam you want to export. If you 
select No Export for the plan number, the beam will not be exported. You cannot specify beam 
numbers; they increment automatically each time you select a plan number. You cannot have 
more than eight beams per plan, and you cannot assign two beams to the same plan/beam 
number pair.

2 Click the Export button to save the files to the specified directory. Toshiba will connect to your 
system via FTP and retrieve the files.
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Export to Calypso

NOTE
When you scan the patient, use slices that are between 1 and 1.5 mm thick. If slices are 
thicker than 1.5 mm, the transponders may not be visible in the image set.

Contour the transponders

To export the location of each transponder, you must place a POI to mark each transponder’s 
location. To accurately position each POI, we recommend that you contour each transponder and 
use the Autoplace POI feature to place the POIs.

1 Create an ROI for each transponder.
2 Contour each transponder on the primary image set.
3 Create one POI for each transponder that you contour. You must assign the POIs to the primary 

image set in order to export to Calypso.
4 Use the Autoplace POI feature to place each POI in the center of a transponder ROI. Select 

Centroid as the placement method. For more information, see Place a point of interest in the 
Points of Interest chapter.

5 If you want to define the treatment isocenter as the center of all transponders, create another 
POI and use the Set Inside Multiple Regions feature to place the POI in the middle of the 
transponder contours. Select Centroid as the placement method.

Export the transponder locations
1 Select File - Export - Other.

The Export window appears.

2 In the Category list, select Calypso.
3 In the Trial to export option list at the top of the Export window, select the trial that you want 

to export. The trial that you select must be the trial that is selected for treatment.
4 In the Apex, Left Base, and Right Base option lists, select the POI that corresponds to the 

appropriate transponder. You must select at least two transponders to export to Calypso.
5 In the Isocenter option list, select the treatment isocenter. You can only select a POI that is the 

isocenter for a beam. Therefore, you must add at least one beam to the plan.

NOTE
Only POIs that are assigned to the primary image set appear in the option lists.

6 Click the Export button.
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Export for record and verify systems
After you calculate dose, you can export to a Record and Verify system. To see a list of the data 
exported by Record and Verify, see the Pinnacle3 Planning Reference Guide.

�CAUTION
We recommend that you test the output from the software to your record and verify system to 
confirm that parameters are being transferred correctly. Confirm that the plan information at the 
record and verify system console is the same as the plan information you set up in the software.
Note that when exporting data using Record and Verify, the exported dose is the reference point 
dose (the isocenter, by default). If you prescribe a percentage of the reference point dose, the 
export data will still report 100% of the dose prescribed to the reference point.

NOTE
You cannot export using Record and Verify for a trial that is not selected for treatment or 
that cannot be delivered clinically.

NOTE
Before you can export with the Record and Verify feature, machines must first be 
commissioned for Record and Verify in Physics mode and the patient must have a 
medical record number assigned in Pinnacle3.

You may want to assign a field identifier to each beam before you export. Open the Beams panel 
and enter the field identifiers in the Field ID field.

If you are sending the file to a remote site, the file is first saved to a local drive and then transferred 
via FTP to the remote site. To make FTP transfers, the Record and Verify computer must be 
configured as an FTP server with a known login and password.

To use the Mitsubishi DME export format, please see Export for Mitsubishi DME record and verify 
systems.

1 Select File - Export - Other. 

The Export window appears.

2 Use the fields at the top of the Export window to select the trial you want to export and specify 
the directory where you want to store the exported file. 

3 In the Category list, select R & V.
4 Select the Record and Verify format.
5 In the File name field, enter a name for the file you are exporting.

�CAUTION
If you use any of the following characters when you enter a file name, the export may fail. Check 
the Export data fields for these characters before attempting to export:
. “ ‘ ` ~ & ( ) | < > + * \ / ; : @ ! [ ] #
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6 If you do not want to export MLC leaf positions, click the No button next to Transmit MLC 
leaves. 

If the leaves of an Elekta/Philips accelerator MLC were set closer than the minimum tip 
distance, the software prompts you to set the leaves to zero before exporting.

7 Enter the Course ID you want the Record and Verify system to use.
8 In the Tolerance table field, enter the tolerance table value (1-9), which identifies a specific 

tolerance table on your Record & Verify system.
9 In the Destination field, select one of the following options:

• Local—your file is exported to the specified local directory. Go to step 11.
• Remote—several new fields appear. Go to step 10.

10 Fill in the fields so that the file can be exported via FTP to the remote site. 

If you want to export the file to the top-level FTP directory, specify the directory as a period (.) 
in the Directory field. To export the file to any other existing directory, specify the directory by 
name.

If you want to save these settings as the default settings for future exports, click the Save FTP 
Preferences button. The password is not saved.

11 Click the Export R & V button.

If you try to export with a file name you have already used, you are asked if you want to 
continue. Click Yes to continue or No to cancel the export. If you cancel, rename the file and 
perform the export. An .rtp extension is added to the file name, and all plan information is sent 
to an intermediate interface for recording and verification.
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Export for Mitsubishi DME record and verify systems
To see a list of the data exported by Mitsubishi DME Record and Verify, see the Pinnacle3 Planning 
Reference Guide.

Export guidelines
• The Mitsubishi Record and Verify software does not support the export of physical modifiers. If 

you export a trial that includes physical modifiers, a warning appears and the trial is exported 
without the physical modifier information.

• The Machine Type in the Machine Editor window of the physics tool must have “Mitsubishi” as 
the first word of the Machine Type. Also, if more than one machine type is used in the plan, 
then no data will be exported.

• The Mitsubishi Record and Verify software does not accept dynamic wedges. Therefore, in the 
Wedge Editor of the physics tool, the Wedge Angle (for RTOG) must be filled in with the wedge 
angle for the FIXED wedge being edited. If one or more beams contain a dynamic wedge, then 
no data will be exported.

• The Mitsubishi Record and Verify software only allows export of conformal arc beams if all the 
jaw positions are the same for all of the control points in a beam. 

Export procedure

Before you can export plans using the Record and Verify feature, machines must first be 
commissioned for Record and Verify in the physics tool.

�CAUTION
We recommend that you confirm that the plan information at the Record and Verify system 
console is the same as the Pinnacle3 plan information.
When you export data using Record and Verify, the exported dose is the reference point dose 
(the isocenter, by default). If you prescribe a percentage of the reference point dose, the export 
data still reports 100% of the dose prescribed to the reference point.
1 After calculating dose for your plan, in Launch Pad click the Planning button. The Patient Select 

window appears.
2 Select the patient, image set, and plan as you normally do in Launch Pad. Make sure the patient 

has a Medical Record Number, or no data will be exported.

3 In the Patient Select window click the Planning button to start Pinnacle3.
4 If you want to assign a field identifier to each beam, display the Machine tab in the External 

Beam Treatment Planning window. Enter the identifiers in the Field ID fields.
5 In the Pinnacle Main Menu click the Plan button. The Plan Information window appears.
6 Click the Export Other button. The Export window appears. 
7 Select the R & V Category.
8 At the top of the Export window select the trial to export, and enter the directory path or click 

the Browse button and select the path in which to store the exported file.
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9 Select the Mitsubishi record and verify format.
10 Click the Export R & V button.

If you try to export using an existing file name, you are asked if you want to continue. If you 
cancel the export, rename the file and perform the export again. Two files are created: TEMP1 
(the export file) and TEMPID.dat (the export management file). For remote exports, the file is 
first saved to a local drive and then transferred via FTP. To make FTP transfers, the Record and 
Verify computer must be configured as an FTP server with a known login and password.
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Export files for RTOG submission
Files can be created for electronic RTOG submission using a special exporting option. All plan 
information is saved in these files.

NOTE
You cannot export a file for RTOG submission for a trial that is not selected for treatment 
or that cannot be delivered clinically.

1 Select File > Export > Other.

The Export window appears.

2 Use the fields at the top of the Export window to select the trial you want to export and specify 
the directory where you want to store the files. 

3 In the Category list, select RTOG.
4 In the RTOG output file name prefix field, enter the name to be used for the RTOG output files 

(for example, MSmith).

For compatibility with older PCs, restrict the name to eight characters.

5 Click the Export RTOG Files button.

Files are created with the prefix (for example, MSmith.001, MSmith.002, MSmith.003) in the 
specified directory.
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16 Print

Overview

�WARNING
Plans may include the statement NOT FOR CLINICAL USE. Based on the machine or isotope data 
and the plan, the software determined that the plan cannot be delivered clinically. Do not treat 
patients with plans that are not for clinical use.

You can generate reports that describe treatment plan setup and prescription, and graphically 
depict plan setup and isodose distributions.

This chapter describes how to:

• Print plan setup information
• Print viewing windows
• Print DICOM images
• Print blocks
• Print to PDF with P3PDF
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Print plan setup information
Using the printer, you can generate reports that describe treatment plan setup and prescription, 
and graphically depict plan setup and the isodose distributions. Include this information in the 
patient’s chart.

�CAUTION
Make sure you verify all setup parameters, dose information, and MLC positions in the report 
against the same information as it appears on the screen. 

�CAUTION
On MLC reports, the leaf coordinates are Pinnacle3 coordinates, not the coordinates of the 
machine you are using. Make sure you review the Pinnacle3 coordinates on the report and how 
they relate to your machine before setting up your MLCs.

�CAUTION
On reports that contain control points, note that jaw-related parameters such as OFc and 
unblocked equivalent squares are specific to the last control point. Dose-related parameters such 
as dose, MU, dose/MU, and normalized dose are for the overall beam.
1 Select File > Print Plan.

The Trial Print Confirmation window appears.

2 Select the type of report you want to print.
• Summary and Text Report—Select this option to print the entire plan report.
• Summary Report Only—The summary report includes information about beam setup, 

prescriptions, and isocenters. Go to step 4.
• MLC Report—This report includes information about the multi-leaf collimator (MLC) 

included with the plan. Go to step 4.
3 Choose the plan information to include, such as ROI dose information, MLC information, a 

summary of an IMRT plan, a summary of the registration information, or a summary of the 
prior dose information.

4 For the beam’s page option, select if you want beams grouped by modality or isocenter.

If you select Modality, beams of the same modality and using the same machine (and version) 
are printed on together. If you select Isocenter, beams of the same modality and assigned to 
the same isocenter, prescription, machine (and version), and localization are printed together. 
Up to three beams are printed per page.

5 In the Comment field, add any comments you want to include with the report.
6 If the plan contains more than one trial, select the trial for which you want to print a report.
7 Click the Print button.

NOTE
Note the Revision field in the report heading. The plan revision numbers show whether 
the ROIs, POIs, and dose have been modified since the last report was printed. For 
example, R03.P03.D03 would represent the third revision to ROIs, POIs, and dose.
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NOTE
If you are licensed for Dynamic Planning and you chose to include a summary of the 
registration information in the plan report, information will only be included for those 
secondary images for which you approved the registration.

Select different printers and paper sizes

From the Printer Selection window, you can add and delete printers, edit printer information, and 
direct reports to a file or a different printer. For details, see the Pinnacle3 Planning Reference Guide.
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Print viewing windows
The Color Print function provides three methods of printing windows on the color printer:

• Click on window to be printed—When the cursor changes to a diamond shape, click on the 
window you want to print. The window you select is scaled to fit the page.

• Define rectangular area using cursor—When the cursor changes to a corner ( ), click and 
drag a box to encompass the area of the screen to be printed. The area within the box is scaled 
to fit the page.

• Specify a window by the ID number—You can choose a window to be printed by specifying its 
ID number, which is in the title bar of the viewing window/window set in Classic Pinnacle3. 

NOTE
If any area of the window you want to print is not displayed on the screen, that area will 
not print. Drag the entire window into view before printing it.

You can resize the image to fill the page or specify a zoom factor for the printed image. You can 
print a life-size image by specifying a zoom factor of 1. If the image you are printing will be used 
for cutting blocks, you can calculate the appropriate zoom factor by dividing the source to film 
distance by the SAD.

If the image does not fit on a page, it prints on multiple pages with registration marks so that 
the pages can be properly aligned.

Print a viewing window

NOTE
You cannot print DICOM images to film from this window. Use a BEV viewing window, as 
explained in Print the DICOM image to film from a BEV window.

1 Select File - Print Window.

The Print window appears.

2 Select a printing method.
3 Which print method do you want to use?

• Click on window to be printed—go to step 7.
• Define rectangular area using cursor—go to step 7.
• Specify a window by the ID number—go to step 4.

4 Enter the ID number of the window to print. The ID numbers are in the title bar of the viewing 
window/window set in Classic Pinnacle3. By default, the software enters the ID number of the 
current window for you.

5 Select the window sizing option for the printed image.
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�CAUTION
Specifying a large zoom factor may result in a large number of pages being printed. The 
confirmation window displays the number of pages. You can decrease the number of pages 
printed by using the zoom tool to focus on a smaller area before specifying the print zoom factor.
6 In the Zoom Factor field change the zoom factor to the desired setting.
7 Use the Report Comment field to add any comments you want to include on the printout.
8 If necessary, click the Select Printer button and switch to a different color printer or paper size. 

The Color Printer Selection window appears.

For details on this window, see the Pinnacle3 Planning Reference Guide.

9 Click the Proceed button.
10 Did you choose to print an image using the window ID?

• If yes, go to step 11.
• If no, select the window or area you want to print. Then go to step 11.

11 From the confirmation dialog box that appears, choose Yes to print the image on the color 
printer. (Choosing No cancels the print job.)

Print a beam’s eye view image to scale

You can specify a magnification factor for printing beam’s eye view images that are similar to 
simulator films. This procedure assumes that you have set up a beam’s eye view in a viewing 
window.

1 Set up the beam’s eye view display for the beam you want to print.
2 Select File - Print Window. The Print window appears.
3 Select Specify a window by the ID number. The software enters the ID number of the current 

window for you.
4 Select Resize Image by Zoom Factor as the output image size.

�CAUTION
Specifying a large zoom factor may result in a large number of pages being printed. The 
confirmation window displays the number of pages. You can decrease the number of pages 
printed by using the zoom tool to focus on a smaller area before specifying the print zoom factor.
5 In the Zoom Factor field enter the magnification factor. You can use the following equation to 

determine the zoom factor.

6 Use the Report Comment field to add comments to the printout.
7 From the confirmation dialog box that appears, choose Yes to print the image on the color 

printer. Choose No to cancel printing.

Zoom factor Source to film distance
Source to axis distance
-------------------------------------------------------=
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Print DICOM images
You can print DICOM images to film from a beam’s eye view (BEV) window. In addition, you can 
print planar dose maps to a DICOM printer. See Print planar dose to a DICOM printer in the Plan 
Evaluation Tools chapter. For information about Pinnacle3 DICOM conformance, see DICOM 
conformance in the Getting Started chapter.

You also can capture DRR images or planar dose maps to send to an R & V system. See DICOM print 
setup for delivery to an R & V system.

NOTE
If you want to add or remove a DICOM printer, call Customer Support.

DICOM BEV print setup
1 Select File - Print Window.

The Print window appears.

2 Click the Select Printer button. The Color Printer Selection window appears.
3 Click the Add Printer button. The Edit Color Printer window appears.
4 Click the Printer Type option list and select DICOM Printer.
5 Make the following settings.

NOTE
This information is available in the conformance statement published by the printer 
manufacturer.

• Select an available DICOM printer from the Printer AE Title option list.
• Select whether the printer output is color or grayscale.
• Select the print medium, such as clear film or blue film.
• Select the size of the film.
• Select the destination bin to which the film will print on the selected printer.
• Select whether the printer supports collation.
• Select the magnification type, which specifies the interpolation algorithm used to fill in 

missing pixel values when magnifying the image. 
– Cubic—A polynomial surface algorithm creates a weighted average of the neighboring 

pixels. This is the slowest method, but produces the highest image quality. If you select 
Cubic magnification, you can specify the smoothing type. The greater the value you enter, 
the sharper the image appears. The range of values you can enter varies by printer; see 
your printer conformance statement for more information.

– Bilinear—A bilinear algorithm creates a weighted average of a small neighborhood of four 
pixels.

– Replicate—A nearest-neighbor algorithm duplicates the closest pixel value. This is the 
fastest method, but produces the lowest image quality.
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• Set the print margin for your printer. The print margin should be documented in your 
printer’s instructions. The software uses this margin to determine the maximum allowable 
magnification.

• Specify the maximum density value of the printout. This value varies by printer; see your 
printer conformance statement for more information.

• Specify the polarity of the printout, either Normal (x-ray) or Reverse (negative). When you 
select Normal, pixels with intensities of zero are black; when you select Reverse, pixels with 
intensities of zero are white.

• Specify whether a trim should be added to the printout.
• Specify whether empty areas of the image should appear in black or white.
• If you selected a trim for the printout, specify whether the trim color should be black or 

white.
• If any component of a print request is not completed within the number of seconds you 

specify in the Timeout field, the print job is cancelled.
• If desired, you can enter a configuration string of non-standard options that further optimize 

printing quality. These strings are specific to the selected printer and manufacturer.
6 If you want to test the printer connection, click the Test Connection button.

�CAUTION
We recommend that you measure the feature on the test print to ensure that the scaling is 
correct.
7 If you want to see an example printout, click the Print Test Image button.
8 When you finish editing the printer settings, click the Close button.
9 In the Color Printer Selection window, click the Save Printers button. If you do not click the 

Save Printers button, the printer setup information is lost when you exit the software.
10 Click the Close button.
11 Click the Cancel button in the Print window.
12 Determine which annotations you want to print with DICOM images. Select 

Utilities - Preferences. The Preferences window appears.
13 Select Film Annotation from the Category list and specify which annotations you want to 

include or exclude from the printout:
• The comment entered with the patient demographic data in Launch Pad.
• Machine information, including machine name, energy, and modality.
• Beam geometry, including SSD, gantry start and stop positions, couch angle, collimator angle, 

and positions and names of each jaw.
• Beam modifiers, including wedge name and angle, and presence of bolus and compensators.
• Isocenter information, including isocenter name, explanation of coordinate system, 

coordinate labels and values, and body board angle. (This text is modified if the plan uses a 
stereo beam.)

• Institution information, including the institution name, physician name, and planner’s name.
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• Prescription information, including prescription name, MU/fraction, number of fractions, 
and beam weight. 

14 When you finish, click the Close button to use the settings for this session. To save the 
annotation settings, click the Save Planning Preferences button in the Preferences window, and 
then click the Close button. 

Print the DICOM image to film from a BEV window
1 Right-click a 3D viewing window, select the BEV menu, and select the beam you want to view.
2 Right-click the BEV viewing window and click the Preview button.

Annotations appear on the BEV image as they will appear on the printout. If you want to turn 
some annotations off, open the Preferences window. Select Film Annotation from the 
Category list and specify which annotations you want to exclude.

Some required annotations appear at the top of the viewing window, including the patient 
name, patient medical record number, magnification factor, beam name, plan name, trial 
name, plan revision, Pinnacle3 version, timestamp, and notifications whether the printout may 
be used clinically and whether the localization system is valid.

Annotations may look small on the viewing window, but they are readable when printed on the 
film.

3 If you are satisfied with the print preview and the annotations, right-click the BEV window again 
and click the Print button. The Print window appears.

4 Adjust the print settings as needed and click the Proceed button.
5 Enter the life-size scale factor you want for the printed image. The window shows the maximum 

scale that will fit the image on a single film.
6 Click the Print button.
7 From the confirmation dialog box that appears, choose Yes to print the image. Choose No to 

cancel printing.

If you want to print another film, wait until the print confirmation message appears for the first 
printout.

DICOM print setup for delivery to an R & V system

You can capture DRR images or dose planes to send to an R & V system. 

Contact Customer Support to configure the DICOM Remote AE Title. The representative will need to 
know the AE Title, host name, and DICOM port of your R & V system.

1 Select File - Print Window. 

The Print window appears.

2 Click the Select Printer button. The Color Printer Selection window appears.
3 Click the Add Printer button. The Edit Color Printer window appears.
4 Enter the printer name.
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5 From the Printer Type list select DICOM Network.
6 In the Remote AE Title list, select the AE Title of the location to which you are sending images.
7 Click the Send Test Image button to test the connection and output.
8 Click the Close button when you finish editing the printer settings.
9 In the Color Printer Selection window, click the Save Printers button. If you do not click the 

Save Printers button, the printer setup information is lost when you exit the software.
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Print blocks
You can print the beam’s eye view to scale and use the scaled output to cut the block. A scale factor 
of 1 generates a life-size image. To generate an image with a source-to-film distance (SFD) of 
140 cm (assuming the SAD is 100 cm), enter a scale factor of 1.4. To determine a scale factor, divide 
the SFD by the SAD.

�CAUTION
Specifying a large scale factor may result in a large number of pages being printed. Review the 
confirmation window to determine how many pages will print. You can decrease the number of 
pages printed by using the zoom tool to zoom in on a smaller area before specifying the print 
zoom factor.

If the scaled image is too large to fit on a page, the software splits up the image to print on multiple 
pages. When the image is printed on multiple pages, registration marks are printed on the images 
so the pages can be properly aligned.

�CAUTION
Verify that the block shape is correct for your treatment plan prior to printing the block.

Print the block
1 Set up a beam’s eye view with the block displayed in it.
2 Select File - Print Window. The Print window appears.
3 Select Specify a window by the ID number. The software enters the ID number of the current 

window for you.
4 Select Resize Image by Zoom Factor as the output image size.
5 In the Zoom Factor field enter the magnification factor.
6 Use the Report Comment field to add comments to the printout.
7 Click the Proceed button.
8 In the confirmation dialog box that appears, choose Yes to print the image on the color printer. 

Choose No to cancel printing.
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Print to PDF with P3PDF

About P3PDF

P3PDF is a set of Pinnacle3 scripts (see The Scripting utility) that prints reports and windows to 
PostScript files and converts the PostScript files to a single PDF file. The reports and windows are 
grouped by patient so that each PDF file is for a specific patient and trial. P3PDF does not require a 
separate license.

Using P3PDF

All the settings for the PostScript files and generated PDF files come from the Trial Print 
Confirmation and Print Window Confirmation windows. For example, to include a comment, add 
it in the Trial Print Confirmation window and then use P3PDF.

1 Select Utilities > Scripting. 

The HotScripts window appears. 

2 In the HotScripts window click Browse.
3 Browse to /usr/local/adacnew/p3pdf.
4 Select P3PDFReportManager.Script and click OK. The HotScripts window changes to show a list 

of buttons that you can use to generate PostScript files and convert them to PDF files.
5 Use the list of buttons to create PostScript files and convert them to a PDF file. See the 

following table for information about each button.
6 Click the Go to HotScript Main Window button.

NOTE
We recommend that you add to your HotScript buttons a button to run 
P3PDFReportManager.Script.

NOTE
Every time that you run the P3PDF HotScript, the script removes PostScript and PDF files 
that are over a week old. 

Field Description

Create a Trial PS File Print the report for the current trial to a PostScript file that can be converted to a 
PDF file. 

Create a Window PS File Select a window and print it to a PostScript file that can be converted to a PDF 
file. (You can print multiple windows.)

Create a Concatenated PDF File Convert the PostScript files of the trial report and windows to a single PDF file. 
The PDF file is saved in the /home/p3reports folder. Each file is named 
pinnaclePatient_MRN-TrialName.pdf:
• MRN is the patient ID (Medical Record Number).
• TrialName is the name of the current trial.

Display the PDF File Open a PDF viewer and display the PDF file that you created for the current 
patient and trial. You also can use this button to display an existing PDF file. 
4598 006 81251 A  Pinnacle3 16.4  Planning Instructions for Use



312 Print to PDF with P3PDF
Delete All Temporary Files Use this when you do not want the current PostScript files to be part of a PDF file.

Go to HotScript Main Window Display your list of HotScript buttons again in the HotScript window.

Field Description
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17 Save Plans

Overview
You should save the plan frequently while planning, and before exiting the software. You can save 
your plan information at any time, set up an automatic save, and recover plans after a system error.

Save the plan

�CAUTION
If you lose power to your system while you are saving a plan, it is possible that not all of the plan 
data was saved, causing anomalies in your plan. For example, when you re-open a plan the 
beams may not appear in the data set where you had placed them. Review any plan that you had 
open during a power loss to verify and correct the plan data.

The software provides three methods for saving your plans.

• Save—To save your plan while you are still working on it, select File - Save Plan.
• Save on exit—When you exit the planning software, it prompts you to save your plan. If you do 

not save the plan while exiting, the plan reverts to the last saved plan. If you do not save your 
plan at all, the plan reverts to its original, “un-planned” state.

Two additional save options are also available upon exiting the software:

– Delete auto-saved computed files—Delete any computed files that were created during the 
planning session. Plan elements that will be deleted include (but are not limited to) the 
following items: dose grid, control point dose, brachytherapy dose, DRRs, and compensators.

– Delete stored control point dose for dynamic arc beams—Remove dose from all control 
points in the plan. This option appears only if your plan contains a dynamic arc beam.

• Save automatically—In the Preferences window, you can set how often the software 
automatically saves your current plan. The time is set in minutes. The automatically saved plan 
is used only when there is an abnormal termination and recovery of the plan. You still must 
save the plan normally when you quit the planning software. See Preferences in the Utilities 
chapter.

�CAUTION
If you exit normally without saving the plan, you cannot recover what you have done from the 
automatically saved plan.
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Recover the plan
If a power failure or fatal error occurs in the software, the Plan Recovery window appears when 
you reopen the plan. Use the window to attempt to recover the last normally saved plan or the last 
automatically saved plan. You can review both plans before selecting the plan to accept and save.

The software initially loads the normally saved plan. At this point, you can review the plan. For 
instance, if you had been adding beams, you can click the Beams button to see what beams were 
saved for the plan. You can open all planning windows for review. If you cover up the Plan Recovery 
window while reviewing the plan, you can bring it forward by selecting File - Save Plan.

After you review the normally saved plan, choose one of the options in the Plan Recovery window.

• Exit with No Changes—Both plans are left intact and you exit the software.
• Accept and Save Plan—The currently loaded plan is saved and the other plan (in this case, the 

last automatically saved plan) is lost.
• Review Last Auto-Saved Plan—The software loads the last automatically saved plan, which you 

can review. The Plan Recovery window now lets you choose whether to accept and save this 
plan or review the last normally saved plan.

NOTE
You can switch between the two plans as many times as you like. You will not lose either 
plan until you accept and save one of them. 
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Plan locking
Plans can be locked to preserve the state of the plan. A locked plan is a read-only plan and changes 
cannot be saved. We recommend you lock a plan after it is approved for treatment. 

When a plan is locked, a padlock icon is displayed next to the patient information above the viewing 
windows. 

When you print a treatment plan and window for a locked plan, the printout indicates the locked 
status. You can print and export an unlocked plan. Prior to printing or exporting, the software may 
warn you that the plan is unlocked, depending on how you set the Warn about unlocked plan 
preference (see the Utilities chapter in the Pinnacle3 Planning Reference Guide).

�CAUTION
In a locked plan you can make changes that modify the RPD (ROI, POI, and Dose) revision levels, 
but you cannot print or export plan information. Any changes you make will not be saved (the 
revision levels will increment while you are in the plan but will return to the locked revision 
levels when you close the plan).

You can delete, backup, and restore locked plans. During backup and restore, the software 
maintains the lock status. 

Lock the plan
1 In Planning: Select File > Lock Plan. After you click Yes, the Lock Plan window appears.

OR

1 In Irregular Planning: Click the Lock Plan button. The Lock Plan window appears.
2 Enter your name or initials in the field. (You can use only numbers, letters, and underscores.)
3 Click the Lock Plan button. The plan is locked. You can still change the plan but you cannot save 

the changes. If you need to make changes that must be saved, you must copy the plan and 
modify the copy.

In Launch Pad an asterisk (*) appears next to the plan name to show it is locked. When you 
select the plan in Launch Pad, the user name, text entered when the plan was locked, and the 
date and time it was locked appear to the right of the plan list.

Unlock the plan

If you need to unlock a plan, you must copy the plan and modify the copy. The copied plan keeps 
the same RPD (ROI, POI, Dose) revision levels as the original plan. 
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Overview
The table below contains a comprehensive list of the utilities available in Pinnacle3. The utilities 
that appear in the Utilities menu depend on the application that you are using (Planning, AcQSim3, 
or Image Fusion).

Utility Description

Cutplanes Open the Cutplanes spreadsheet. See the View Patient Data chapter.

Profile Open the Profile window to generate dose profiles between two points of 
interest. See the Plan Evaluation Tools chapter. 

Scripting Open the scripting window to play or record scripts. This feature is explained in 
this chapter.

Preferences Open the Preferences window to change global settings for the software. This 
feature is explained in this chapter.

Data Sets Open a window that contains basic parameters for each data set in the plan. See 
the View Patient Data chapter.

Image Set Slice List Open a window to see the Z position and SUV (standardized uptake value) scale 
factor of each slice in a selected image set.

Image Fusion Open a window that lets you fuse images. See the Image Fusion chapter.

Transform Display the tools needed to transform/fuse data sets. See the View Patient Data 
chapter.

Planar Dose Open the Planar Dose Computation window. See the Plan Evaluation Tools 
chapter. 

Plan Eval DRRs Open the Plan Evaluation DRRs window.See the Plan Evaluation Tools chapter. 

Planning Open the Planning window. See the Pinnacle3 Planning Instructions for Use.

AcQSim Open the AcQSim window. See the AcQSim3 Instructions for Use.

Record Viewer Open the Record Viewer window. See the Plan Evaluation Tools chapter. 

Dose Accumulation Open the Dose Accumulation window, which allows you to select trials or records 
for dose accumulation. See the Plan Evaluation Tools chapter. 

About Open the information window that displays the software version number and 
other information.

All ROI Display Display or hide ROIs in all 2D or 3D windows. This utility allows you to override the 
display settings for individual ROIs. 

All POI Display Display or hide POIs in all 2D or 3D windows. This utility allows you to override the 
display settings for individual POIs. 

All Beam Display Display or hide all the beams in 2D or 3D viewing windows. This utility allows you 
to override the display settings for individual beams. 
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Clip MLC Leaves Override the Clip leaves settings in the Beam MLC Leaf Position Editor window for 
the individual beams. Display or clip the MLC leaves for all beams in the plan. See 
the Beam Modifiers chapter.

Fill MLC Leaves Override the Fill in leaves settings in the Beam MLC Leaf Position Editor window 
for the individual beams. Display the MLC leaves as outlines or as filled for all 
beams in the plan. See the Beam Modifiers chapter.

Max MLC Leaf Motion Override the Maximum leaf motion settings in the Beam MLC Leaf Position Editor 
window for the individual beams. Display or hide the maximum leaf motion 
indicators for all beams in the plan. See the Beam Modifiers chapter.

Utility Description
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Preferences
In the Preferences window you can specify separate preferences for either Classic Pinnacle3 and 
Planning (Planning Preferences) or AcQSim3 (AcQSim Preferences).

NOTE
You can only set preferences for the current tool. To set both Planning Preferences and 
AcQSim Preferences within the same window, see the System Administration chapter of 
the Launch Pad Instructions for Use.

If all users log in using the same name, one set of preferences is used for all system users. If you 
have separate login names (available with Solaris 8 or later), each user has their own preferences.

NOTE
Preferences are specific for each user irrespective of the software version is used. When 
the software is installed for the first time, the default settings are used unless you 
change the Planning and AcQSim3 preferences. But, when you upgrade the software to a 
higher version, the settings in the Preferences window are copied automatically from 
the previous version of Pinnacle3 to the current version.

1 Select Utilities - Preferences. The Preferences window appears.
2 Set the preference options as desired. For more information about Auto-Segmentation 

preferences, see Set up Auto-Segmentation Preferences. The other options are described in 
detail in the Pinnacle3 Planning Reference Guide. 

3 Click the Save Planning Preferences button.

If you do not save the preference settings, they are active for your current session only. If you 
do not save the preference settings for Auto-Segmentation, they are not active for any session.
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The Scripting utility
The Scripting utility allows you to record and play back “scripts” of software operations. These 
scripts allow you to automate repetitive operations and store protocol plans for easy retrieval. 

Scripts are similar to macros in other software products. A script executes a series of software 
operations when it is run. To create the script, you “record” the software operations you want to 
include in it. Scripts can be used for everything from repeating simple operations, such as setting 
the window and level for prostate CT data, to complex beam setup operations.

For details on advanced scripting options, see the Pinnacle3 Planning Reference Guide.

�CAUTION
We recommend that you save your scripts to the PinnacleSiteData/Scripts directory. (This is the 
default directory when recording scripts.) Scripts you save in system areas such as /PinnacleStatic 
will be inaccessible when a new version of Pinnacle3 is installed.
All scripts that you create must be validated again if you install a new version of Pinnacle3.

Run HotScripts

The HotScripts window lets you play back scripts that have been recorded.

�CAUTION
Using the incorrect script may add elements to your plan that change the treatment you are 
trying to achieve. Make sure you select the proper script and verify your plan after running the 
script.
1 Select Utilities > Scripting.

The HotScripts window appears. 

NOTE
In the Preferences window, you can set up Pinnacle3 to always display the HotScripts 
window when the system starts.

2 Click the button for the HotScript you want to run. The operations specified in the script are 
performed.

NOTE
See the Pinnacle3 Planning Reference Guide for information on using the Browse button 
to play back script files that are not set up in the Hotscripts window. 

Record HotScripts

To record a script, turn on the recording option, use the software as you normally would to perform 
the operations you want to record, and turn the recording option off when you are done. Once a 
script has been recorded, you can replay the script by clicking the appropriate button in the 
HotScripts window. 
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To make sure you record exactly what you want to record, see the Pinnacle3 Planning Reference 
Guide.

1 Select Utilities > Scripting.

The HotScripts window appears.

2 Click the Edit button in the HotScripts window to display the Edit HotScript List window. 
3 Do you want to record a new script, record over an existing script, or add a script to the list 

(expand the list with another script)?
• New script, in one of the fields that says “unassigned” delete the label and type an 

appropriate name for your script.
• Record over a script, in the field that you want to record over, delete the label and type an 

appropriate name for your script.
• Add a script, click the Add button. Replace the “unassigned” text with the appropriate name 

for your script.

NOTE
Script names cannot contain spaces or the following characters:
+ ? * < > [ ] | \ ` " ' & , / ! { } ( )

�CAUTION
Once you start recording, you cannot pause the recorder. You also cannot append one script onto 
another, so you must record all the steps you want to perform or run multiple scripts separately.
4 Click the Record button to the right of the HotScript name to begin recording, then perform the 

operations that you want to include in your script.
5 When you finish, click the End Record button to stop recording.
6 Click the Done button to return to the HotScript window where you can run the script.

Remove HotScripts from the HotScripts window

You can remove HotScripts from the HotScripts window or replace them with new HotScripts. 

1 Click the Edit button in the HotScripts window to display the Edit HotScript List window.
2 Select the HotScript you want to remove and press the Backspace or Delete key to delete the 

name.

When you exit the Edit HotScript List window, the HotScript is unassigned and the unassigned 
button is moved to the bottom of the HotScripts window. 
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19 Tools

Data sets
These tools appear in the Data Set Editor window.

Image Fusion and Syntegra
These tools appear in the Image Fusion and Syntegra windows.

Tool Name Function

Display one MPR 
layout

Examine a specific slice. To examine a slice, click on the slice and then click this 
tool.

Display multiple 
MPR layout

Return to a view of multiple images after examining a specific slice.

Display three 
MPR, one 3D 
layout

View a compound layout to help you select the patient orientation. The layout 
consists of transverse, sagittal, and coronal views in 2D, a 3D window, and a set of 
basic 3D tools. For details on using the 3D tools, see 3D images.

Tool Name Function

Move secondary Align the secondary image set over the primary image set. When moving an 
image set in one viewing window, the movement appears in all viewing windows. 

2D fine-tune shift Shift the secondary image set in small increments by clicking at the top, bottom, 
left, or right part of the image. To change the increment, select Options > 2D Tool 
Parameters. The default incremental move is 1 mm.

Rotate secondary Correct rotational errors between the images in any of the planes. This tool allows 
for free rotation of the image set.

2D fine-tune 
rotation

Rotate the secondary image set in small increments by clicking the right half of 
the image for clockwise rotation and the left half for counterclockwise rotation. 
You can rotate the secondary image with respect to the primary image in any 
plane.
The default rotational increment is 1 degree. To change the increment, select 
Options > 2D Tool Parameters.

Undo previous 
transformation

Undo previous transformations that you have made to the secondary image set. 
You can undo all actions until you make the image set unmovable. Once it is 
unmovable, the transformation history is removed from the software’s memory.

Redo Redo a transformation that you have just “undone.”
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2D images
You can access 2D tools in several locations. See Access 2D and 3D tools in the View Patient Data 
chapter for information. Use these tools to modify the display of 2D images and obtain information 
on the patient data.

Place fiducial 
markers

Place fiducial marker pairs (points of interest) on the primary and secondary 
image sets. To move the primary point, click on the point in the primary image set 
or the fusion image. To move the secondary point, click on the point in the 
secondary image set.
This tool is only available when you display the Points registration tab.

Correlated 
pointer

Change the orthogonal slices that are displayed in the viewing windows. Position 
the cursor on a viewing window and click, then drag the lines until the desired 
slices are displayed in the other windows. When the slice position lines are 
displayed in all three orientations, you can use this tool to quickly display the 
transverse, sagittal, and coronal planes which cut through structures of interest.
If used in a window that is not a transverse, sagittal, or coronal view, the tool 
displays orthogonal lines intersecting at the selected point, and it does not cause 
the other viewing windows to change slices.

Zoom correlated 
pointer 2D

Change the orthogonal slices that are displayed in the viewing windows while 
zooming in on a region of an image. Drag diagonally until the region to be zoomed 
is within the box. The region of the image that is inside the box is magnified in the 
transverse, sagittal, and coronal viewing windows, and the orthogonal slices that 
are displayed are adjusted accordingly.

Show secondary 
image cutout

In a 2D fusion viewing window, create a rectangular cutout on the primary image 
set that shows the overlay of the secondary image set just in that cutout. You can 
resize it by clicking and dragging its edges or corners. Its maximum size is 1/4 of 
the size of the viewing window.
The cutout does not move if you move the image sets within that viewing 
window. You can move it if you click in the center of it and then drag it. It remains 
displayed until you click outside of it (with this tool still selected).
This tool is available only in Syntegra.

Adjust bounding 
box

Place a rectangle on the image set to define a sub-volume for use in automated 
registration. This is available if Limit Primary data, Limit Secondary data, or Limit 
both data sets is set to Bounding Box.
This tool is available only in Syntegra.

Tool Name Function

Tool Name Function

Scroll through 
slices

Scroll through the “stack” of transverse, sagittal, or coronal images in a viewing 
window. To scroll through a stack of images, drag the cursor to the left and right 
within the 2D viewing window. Clicking on the far left places you at the beginning 
of the series of slices. Clicking on the far right places you at the end of the series. 
When the cursor is in a viewing window, you can also press n to display the next 
image in the series and press p to display the previous image.

2D pan Use this tool to reposition the 2D image within the viewing window. Drag the 
cursor within the window until the image is positioned as desired.
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2D zoom Increase and decrease the magnification of the image by dragging the cursor 
across the viewing window. Dragging to the left shrinks the image. Dragging to 
the right magnifies the image. The image remains centered in the viewing 
window, so you may need to use the 2D Pan tool to change the region of the 
image that is displayed.

Box zoom Draw a box around a region of the image that you want to zoom by dragging the 
cursor diagonally until the region to be zoomed is within the box.

Show image 
value 2D

Display the image value for the point in the image that corresponds to the cursor 
position. The image values appear when you click and hold the left mouse button. 
If the dose has been computed, the computed dose and density at that cursor 
position also appear. If you are licensed for proton treatment planning, the 
stopping power and the Water Equivalent Thickness (WET) are also shown.Values 
are computed using the nearest-neighbor method.

Distance display Measure distances on an image. As you drag across the image, a line is drawn 
showing the distance being measured. The distance (in centimeters) is listed at 
the bottom of the image. If you are licensed for proton treatment planning, the 
Water Equivalent Thickness (WET) is also shown.

Distance 
annotation

Use the tool to measure distances on an image and draw a distance indicator and 
label on the image. As you drag to draw a line, the line that you drew remains on 
the image and the distance (in centimeters) is listed on the image. If you are 
licensed for proton treatment planning, the Water Equivalent Thickness (WET) is 
also shown.
Use the Delete annotation tool to remove the label from the image.

Profile Generate a profile of the numbers across any portion of the image. You can use 
the Profile tool to determine threshold values for autocontouring regions of 
interest or to compute maximum gradients when defining organ models. To 
generate a profile of image values, drag the cursor across the image. A window 
appears and shows a plot of the image values along the line that you drew.

Window/level 
bar

Set the window and level for displaying 2D images. When you use this tool, the 
Window/Level color bar appears along the right edge of the viewing window in 
which you are adjusting the window and level.
The green bar in the upper portion of the color bar sets the level. The red bar in 
the lower portion of the color bar sets the window. To change the level, click the 
green bar and drag the cursor up and down until the level is set as desired. The 
green bar does not appear if the level is negative, but clicking near the top of the 
color bar will make the green bar reappear (and make the level positive). To 
change the window setting, click the red bar and drag the cursor up and down 
until the window is set as desired.

Window/level 
point

With the Window/level point tool, you can use the current window to set the 
level by specifying the center point of the window. The level is set so that the 
current window frames the image value at the cursor position. Position the cursor 
on the desired point and then drag the cursor to adjust the image.

Window/level Use the Window/level tool to specify the window and level by dragging the 
cursor within the viewing window. To change the level, drag the cursor up and 
down in the viewing window. To change the window setting, drag the cursor left 
and right. The window and level values appear at the bottom of the viewing 
window.

Tool Name Function
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3D images
You can access 3D tools in several locations. See Access 2D and 3D tools in the View Patient Data 
chapter for information. Use these tools to modify the display of 3D images.

Zoom correlated 
pointer 2D

Drag the cursor to draw a box around a region of the image that you want to 
zoom. When you release the mouse, transverse, sagittal, and coronal views all 
zoom to the same selected region. Slice position display is automatically turned 
on and centered in the selected region, and the Correlated pointer tool is 
automatically selected. You can use this tool to set up viewing windows before 
loading an organ model. See the Model-Based Segmentation chapter.
Change the orthogonal slices that are displayed in the viewing windows while 
zooming in on a region of an image. Drag diagonally until the region to be zoomed 
is within the box. The region of the image that is inside the box is magnified in the 
transverse, sagittal, and coronal viewing windows, and the orthogonal slices that 
are displayed are adjusted accordingly.

Correlated 
pointer

Change the orthogonal slices that are displayed in the viewing windows. Turn on 
slice position display, then drag the lines until the desired slices are displayed in 
the other windows. You can use this tool to quickly display the transverse, 
sagittal, and coronal planes that cut through structures of interest. You cannot use 
this tool in BRV windows. For information on slice position display, see Display the 
slice position in other windows in the View Patient Data chapter.

2D annotation 
with label

Use the 2D annotation with label tool to add labels to 2D images.

Delete 2D 
annotation

Use the Delete 2D annotation tool to remove annotations from 2D images. Click 
this tool and then click the annotation that you want to delete.

2D cursor select Click the tool with the middle mouse button to return the middle mouse button 
to its default state. The default state of the middle mouse button is to toggle 
between the Scroll through slices, 2D zoom, and 2D pan tools. The tool you 
activate with the middle mouse button is then selected by default when you click 
the left mouse button in a viewing window.

Water equivalent 
thickness (WET) 
profile

Generates a Water Equivalent Thickness (WET) profile (gm/cm2) between two 
points. To generate a WET profile, drag the cursor across the image. A window 
appears and shows a plot of the WET values for the current beam along the line 
that you drew.

Tool Name Function

Tool Name Function

3D rotate Rotate the image as if you were holding it in your hand and turning it to look at it 
from a different angle. With this tool selected, click on an edge of the volume 
limits to grab the volume and drag the cursor to rotate the volume.

3D pan Move the volume up, down, left, or right in the window. The volume’s zoom 
factor and viewpoint do not change.

3D zoom Change the field of view for the volume. When you “zoom in” on the volume, the 
field of view is decreased, and the image appears larger. When you “zoom out” on 
the volume, the field of view is increased, and the image appears smaller.
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Localization
Use these tools for patient localization tasks.

Meshes
Use these tools to edit meshes in 2D windows.

Rotate XY Rotate the volume about the viewing coordinate system axes that extend out 
from the focus point in the middle of the viewing window. To rotate the volume 
about the y-axis, drag the cursor left or right within the viewing window. To rotate 
the volume about the x-axis, drag the cursor up and down.

3D annotation Label an ROI with its defined name after clicking on the ROI in a 3D viewing 
window. Annotations are not “linked” to the items you are labelling. For example, 
if you delete or rename an ROI, you must delete or rename the annotation 
separately.

3D cursor select Click the tool with the middle mouse button to return the middle mouse button 
to its default state. The default state of the middle mouse button is to toggle 
between the 3D rotate, 3D zoom, and 3D pan tools. The tool you activate with 
the middle mouse button is then selected by default when you click the left 
mouse button in a viewing window.

Tool Name Function

Tool Name Function

Manually 
position rod

Position the stereotactic frame rods on individual slices. After selecting the tool, 
click on the rods in a 2D viewing window.

Move couch 
removal plane

Position the couch plane in a 2D window. This marks where the couch begins so it 
can be taken out of dose calculations.

Tool Name Function

Move mesh Move the selected mesh to a new location. Select the mesh that you want to 
move, then drag it to the new location.

Scale mesh Scale the selected mesh. Select the mesh that you want to scale, then drag left 
and right to scale it horizontally or drag up and down to scale it vertically.

Rotate mesh Rotate the selected mesh. Select the mesh that you want to rotate, then drag 
clockwise or counterclockwise to rotate the mesh around its center.

Undo mesh edit Undo the last action that you performed on the mesh. Click the Undo mesh edit 
button again to redo the action.
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Regions of interest
Use these tools to create and edit regions of interest (ROIs).

Pull mesh Pull the surface of the mesh. Set the radius of the tool, then drag the cursor to 
pull the mesh. As you drag the cursor, vertices farther away from the original 
cursor location move in the direction you drag, but with a distance weighted by a 
Gaussian function and the radius of the tool. A dashed-line circle indicates the 
range of vertices affected as you drag the cursor.
The Mesh Modeling Options section on the Edit Options tab of the Regions of 
Interest panel contains a Lock edited vertices option. To prevent edited vertices 
from moving during adaptation, set the Lock edited vertices option to Yes before 
using this tool. Setting the Lock edited vertices option to Yes can be useful if the 
mesh is shifting toward neighboring organs during adaptation. Please note that 
the lock is not absolute; the edited vertices may still move slightly during 
adaptation.
Locked edited vertices display in a different color from other vertices. Click the 
Reset button to unlock all vertices in the mesh.

Tool Name Function

Tool Name Function

Create contour 
paintbrush

“Paint” an ROI on a 2D transverse slice. The tool provides contour drawing, 
editing, and deleting functions, depending on where you use it. Before clicking 
the tool, use the Diam field to enter the diameter (in millimeters) of the brush. If 
you want painted contours to be closed and filled automatically, leave the Auto-
close painted contours option set to Yes. Sometimes, such as when contouring 
organ walls, you may want to set this option to No.
Next, click the Create contour paintbrush tool and position the cursor at the 
point where you want to start, edit, or delete a contour. The tool works differently 
depending on where you click.
• If you click on an image where there is no contour, a new, circular contour 

appears. Drag the cursor to create a thick line; wherever you move the cursor, 
the circle is filled in for the ROI.

• By clicking inside an existing contour, you can push out the edges of the 
contour.

• If you click outside, but near, an existing contour, the tool functions as an 
eraser, and the ROI is erased wherever you move the tool. You can use this 
method to push in the edges of the contour.

Go to the next slice on which you want to draw a contour for this ROI and repeat 
the process.

Create contour 
point by point

Define contours by “dropping” a series of points. Select the tool and click where 
you want to start the contour. A small box appears and indicates the point that 
you defined. Then click where you want to add the next point to the contour. You 
can also drag the point to the position that you want. A line is drawn between the 
two points. Continue to define the remaining points in the same way. To close the 
contour, drop the last point of the contour inside the box of the first point.

Create contour 
freehand

Define contours by drawing a continuous line. Position the cursor at the point on 
the slice where you want to start the contour. Then drag the cursor to draw a 
contour around the limits of the region. Release the mouse button when you have 
closed the contour. Go to the next slice on which you want to draw a contour for 
this ROI and repeat the steps.
 Pinnacle3 16.4  Planning Instructions for Use 4598 006 81251 A



Regions of interest 327 
Autocontour 
structure on 
current slice

Generate a single contour on a single slice automatically. The software searches 
to the right from where you click on the image until the first structure with values 
within the minimum and maximum threshold values that you specify is found. 
The software then automatically draws a contour around the structure.
After entering the upper and lower thresholds in the Autocontour thresholds 
fields, select the tool and click at an appropriate seed point in the image. If the 
seed point has a value within the specified range, the first structure to the right of 
the seed point with values outside the range is autocontoured. If the seed point 
has a value outside the range, the first structure to the right of the seed point 
with values inside the range is autocontoured.

Autocontour all 
on current slice

Generate contours automatically for all structures on a given slice that have 
values within the specified range. After entering the upper and lower thresholds 
in the Autocontour thresholds fields, select the tool and click within the image. 
All structures on the slice within the threshold are contoured. If the 2D image is 
zoomed, this may include contours that are not visible in the window.

Autocontour 
structure on all 
slices

Autocontour a single structure on all slices on which the structure appears. The 
tool uses the specified autocontouring thresholds to generate a contour on the 
current slice automatically and then generates a contour on adjoining slices for 
any structure that is connected to the contour on the previous slice and has a 
value within the specified range.
After entering the upper and lower thresholds in the Autocontour thresholds 
fields, select the tool and click at an appropriate seed point in the image. If the 
seed point has a value within the specified range, the first structure to the right of 
the seed point with values outside the range is autocontoured. If the seed point 
has a value outside the range, the first structure to the right of the seed point 
with values inside the range is autocontoured. The software then searches for the 
structure in adjacent slices and automatically contours the structure on those 
slices.

Autocontour all 
on all slices

Autocontour all structures on all slices. The tool uses the specified autocontouring 
thresholds to generate contours automatically on the current slice and then 
generates contours on adjoining slices for any structures that are connected to 
the contours on the previous slice and have values within the specified range.
After entering the upper and lower thresholds in the Autocontour thresholds 
fields, select the tool and click at an appropriate seed point in the image. If the 
seed point has a value within the specified range, the first structures to the right 
of the seed point with values outside the range are autocontoured. If the seed 
point has a value outside the range, the first structures to the right of the seed 
point with values inside the range are autocontoured. The software then searches 
for the structures in adjacent slices and automatically contours the structures on 
those slices.

Delete contour Remove one or more contours from a slice associated with the current ROI. To 
delete the contours, drag the cursor diagonally over any contours associated with 
the current ROI you want to delete.

Split contour Divide a single contour into two contours on the current ROI. To divide a contour, 
position the cursor outside the current ROI and drag the cursor to another 
position outside the ROI.

Select contour Select a contour for editing by clicking it.

Add contour 
point

Add a point after the last point that was added. 

Tool Name Function
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Points of interest
Use these tools to position points of interest (POIs).

Edit contour Move a point in the selected contour using a “rubber band” effect. Click the point 
you want to reposition and then drag it to the new location.

Insert contour 
point

Place a point between two previously defined points in the selected contour. To 
insert a point, position the cursor between the two points and click. After the 
point is inserted it can be dragged until it is positioned as desired.

Delete contour 
point

Remove a point from the selected contour. Position the cursor on the point you 
want to remove and click to remove the point.

Move contour Move the selected contour to a new location on the same slice. Click the contour 
you want to move and then drag it to the new location. (If you do not select the 
contour first but just click on this tool, the points disappear to allow you to place 
the contour accurately.)

Scale contour Scale the selected contour. Select the contour you want to scale, then drag left 
and right to scale it horizontally or drag up and down to scale it vertically. (If you 
do not select the contour first but just click on this tool, the points disappear to 
allow you to scale the contour accurately.) 

Tool Name Function

Tool Name Function

Move POI Place a POI directly on a transverse, sagittal or coronal slice. Display the 2D slice 
where you want to place the center of the POI. Next, select the Move POI tool, 
position the cursor where you want to add the POI, and click to place the POI on 
the slice. You can also position the POI by dragging it to the new position.

Translate POI Move a POI within the current plane without moving it to the slice where you 
click. Use this tool when a POI is positioned between CT slices and you want to 
reposition it without changing the slice.

Move POI 3D Position POIs on 3D images. First, open a 3D viewing window and render the 3D 
image you want to use to position the POI. Next, select the Move POI 3D tool, 
position the cursor where you want to add the POI, and click to place the POI in 
the volume. You can also position the POI by dragging it to the new position.

Nudge POI 
toward you

Move a POI 1/10 of the voxel height toward you in the volume. Click the Nudge 
POI toward you tool, then click in the viewing window that shows the images that 
you want to use for positioning. Continue to click in the window until the POI is 
positioned properly.

Nudge POI away 
from you

Move a POI 1/10 of the voxel height away from you in the volume. Click the 
Nudge POI away from you tool, then click in the viewing window that shows the 
images that you want to use for positioning. Continue to click in the window until 
the POI is positioned properly.
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Beams
Use these tools to position beams and isocenters.

Collimators
Use these tools to adjust isocenters, collimator jaws, and MLC leaves.

Tool Name Function

Move POI Position the isocenter for the current beam. The isocenter is moved to the plane 
of the CT slice on which it is placed.

2D aim beam Position the beam on 2D images. The couch and gantry angles are modified so 
that the central axis of the current beam intersects the point selected using this 
tool.

3D aim beam Position the beam on 3D images. The couch and gantry angles are modified so 
that the central axis of the current beam intersects the selected point on the 
patient’s surface.

Tool Name Function

Reposition 
isocenter

Reposition the isocenter of the beam displayed in the BEV window by dragging 
the isocenter to a new position.

Place Field Reposition the isocenter of the beam displayed in the BEV window. Click in the 
BEV window to move the isocenter to a new location.

Adjust collimator 
3D

Adjust collimator jaw positions in BEV windows by dragging a jaw to change its 
position. To rotate the collimator, drag the axis.

Move MLC 
manually

Move multi-leaf collimator leaves in a BEV window. Click this tool in the Beam 
MLC Leaf Position Editor window, then click the leaf you want to move and drag 
it, or click the location where you want the leaf to have the software move it.
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Blocks
Use these tools to create, edit, and delete blocks when the Structure field is set to Manual.

Tool Name Function

Create block 
paintbrush

“Paint” a block. The tool provides block drawing, editing, and deleting functions, 
depending on where you use it. Before clicking the tool, use the Diam field to 
enter the diameter (in millimeters) of the brush. The drawn block is closed and 
filled automatically.
Next, click the Create block paintbrush tool and position the cursor at the point 
where you want to start, edit, or delete a block. The tool works differently 
depending on where you click.
• If you click on an image where there is no block, a new, circular contour 

appears. Drag the cursor to create a thick line; wherever you move the cursor, 
the circle is filled in for the block.

• By clicking inside an existing block, you can push out the edges.
• If you click outside, but near, an existing block, the tool functions as an eraser, 

and the block is erased wherever you move the tool. You can use this method 
to push in the edges of the block.

Create block 
point by point

Draw a beam block by defining a series of points. Any number of contours can be 
drawn for a single block. 

Delete block Remove a manually drawn block. Drag the cursor over the block to remove it.

Select block Select the block outline to be edited by clicking on the outline. If the block has a 
margin, you must select the original block outline instead of the margin.

Edit block point Move points in the selected block.

Insert block point Place a point between two previously defined points in the selected block. To 
insert a point, position the cursor on the outline between the two points and 
click. After the point is inserted it can be dragged until it is positioned as desired.

Delete block 
point

Remove points from the selected block. Position the cursor on the point that you 
want to remove and click to remove the point.

Move block Move the selected block to a new location within the collimator jaws.

Scale block Scale the selected block. Click on the block that you want to scale, then drag left 
and right to scale it horizontally or drag up and down to scale it vertically.

Copy block Copy the selected block. Once you have copied the block, you can flip it over 
either axis to mirror the original block.

Flip block over X 
axis

Flip the selected block over the X axis. Use this tool in conjunction with the Copy 
block tool to create a mirror image of a block.

Flip block over Y 
axis

Flip the selected block over the Y axis. Use this tool in conjunction with the Copy 
block tool to create a mirror image of a block.
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Bolus
Use the bolus tools to define the skin boundary and bolus.

Tool Name Function

Skin boundary For a constant thickness bolus, define the skin boundary in which the bolus will 
be created. To define the boundary, drag the cursor in a 2D transverse image to 
draw a rectangle that will be the skin boundary. If you need to adjust the location 
of the rectangle, draw a new rectangle in the correct location. The old rectangle 
disappears.

Add bolus edge For a constant thickness bolus, define the left and right edges of a bolus on a 2D 
image. To define the edges, drag the cursor to draw a line where the left edge of 
the bolus should be. Then drag the cursor to draw a line where the right edge of 
the bolus should be. The edges must be drawn in a clockwise direction, and the 
lines must intersect the patient air threshold.

Delete bolus 
edge

For a constant thickness bolus, remove a line drawn to define a bolus edge on a 
2D image by dragging the cursor to draw a rectangle around the line.

Create bolus 
point by point

For a variable thickness bolus, define the contours of the bolus on a 2D image or 
3D BEV image by “dropping” a series of points. Select the tool and click where you 
want to start the contour. A small box appears and indicates the point that you 
defined. Then click where you want to add the next point to the contour. You can 
also drag the point to the position that you want. A line is drawn between the two 
points. Continue to define the remaining points in the same way. To close the 
contour, drop the last point of the bolus inside the box of the first point.

Select the center 
slice

For a constant thickness bolus with Encompass data set to Yes, select the image 
slice from which the bolus extends in the superior and inferior directions.

Create bolus 
paintbrush

Edit the shape of a variable thickness bolus on a slice-by-slice basis.
Before clicking the tool, use the Diam field to enter the diameter (in millimeters) 
of the brush. Next, click the Create bolus paintbrush tool and position the cursor 
at the point where you want to start, edit, or delete a contour. The tool works 
differently depending on where you click.
• If you click on a section of the image where there is no bolus, a new, circular 

bolus appears. Drag the cursor to create a thick line; wherever you move the 
cursor, the circle is filled in for the bolus.

• By clicking inside an existing bolus you can push out the edges of the bolus.
• If you click outside, but near, an existing edge of the bolus, the tool functions 

as an eraser, and the bolus is erased wherever you move the cursor. You can 
use this method to push in the edges of the bolus.

Go to the next slice on which you want to edit the shape of the bolus and repeat 
the process.
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Proton compensator
Use these tools to edit and view the thickness of a proton compensator.

Tool Name Function

Edit pixel Displays the thickness (cm) of a proton compensator at a specific point. With this 
tool selected, click on the compensator. The thickness at the point on which you 
clicked appears in the Value at cursor field, and that pixel is highlighted in the 
Thickness Array.

Create contour 
freehand

Define contours by drawing a continuous line. Drawing a contour allows you to 
edit multiple pixels at one time. You can change the thickness values of all of the 
pixels within the contour to a single value, update the thickness values of all of 
the pixels to the average of the thickness values, or modify the thickness values 
by adding or subtracting a specific value or percentage.
After you click the tool, position the cursor at the point on the slice where you 
want to start the contour. Then drag the cursor to draw a contour around the 
limits of the region. Release the mouse button when you have closed the contour. 

Create contour 
point by point

Define contours by “dropping” a series of points. Drawing a contour allows you to 
edit multiple pixels at one time. You can change the thickness values of all the 
pixels within the contour to a single value, update the thickness values of all the 
pixels to the average of the thickness values, or modify the thickness values by 
adding or subtracting a specific value or percentage.
Select the tool and click where you want to start the contour. A small box appears 
and indicates the point that you defined. Then click where you want to add the 
next point to the contour. You can also drag the point to the position that you 
want. A line is drawn between the two points. Continue to define the remaining 
points in the same way. To close the contour, drop the last point of the contour 
inside the box of the first point.

Create contour 
paintbrush

“Paint” a contour on a slice. Drawing a contour allows you to edit multiple pixels 
at one time. You can change the thickness values of all the pixels within the 
contour to a single value, update the thickness values of all the pixels to the 
average of the thickness values, or modify the thickness values by adding or 
subtracting a specific value or percentage.
The tool provides contour drawing, editing, and deleting functions, depending on 
where you use it. Before clicking the tool, use the Diam field to enter the 
diameter (in millimeters) of the brush. Next, click the Create contour paintbrush 
tool and position the cursor at the point where you want to start, edit, or delete a 
contour. The tool works differently depending on where you click.
• To draw a contour, drag the cursor to create a thick line; wherever you move 

the cursor, the circle is filled in for the contour.
• By clicking inside an existing contour, you can push out the edges of the 

contour.
• If you click outside, but near, an existing contour, the tool functions as an 

eraser, and the contour is erased wherever you move the tool. You can use this 
method to push in the edges of the contour.

Delete contour Remove one or more contours from the compensator. To delete the contours, 
drag the cursor diagonally over any contours that you want to delete.
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Dose

Use these tools to position and resize the dose grid.

Dose point
Use these tools to display the slice containing maximum and minimum dose points, and to hide the 
dose point annotations.

Dose volume histogram (DVH)
Use these tools for navigating the DVH graph.

Tool Name Function

Draw dose grid Position and resize the dose grid in a 2D image.

Move dose grid Reposition the dose grid in a 2D image.

Display 
maximum dose 
point of trial

Click to display the slice that contains the maximum dose point of the trial.

Display 
maximum dose 
point of ROI

Click to display the list of ROIs available for the current trial, and then select a ROI 
to display the slice that contains the maximum dose point of the ROI.

Display minimum 
dose point of ROI

Click to display the list of ROIs available for the current trial, and then select a ROI 
to display the slice that contains the minimum dose point of the ROI.

Hide dose point 
annotations

Click to hide the dose point annotations in a slice.

Tool Name Function

Tracking Mouse over a point on a curve. The selected curve is highlighted. The dose and 
volume values appear, along with the curve’s trial and record information, in a 
box superimposed over the graph near the mouse pointer. Moving the mouse 
allows you to see the changes in values. 
Changes in the values depend on the resolution of the binning. No interpolation is 
performed, and thus some of the value changes may appear “jumpy” if the 
Tabular DVH settings are too small.
To switch to a different curve, mouse over another curve in the graph. You can use 
this tool in a zoomed window.
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Brachytherapy
Use the brachytherapy tools to place sources and position catheters.

Cutplanes
Use these tools for creating cutplanes.

Box Zoom 2D Click the Box Zoom 2D tool and drag to create a rectangle to define a subset of 
the graph to display. You can zoom further by dragging again. To reset the zoom 
level to the default setting, click the tool again. To return the DVH to its original 
state before any zooming, click Reset.

Tool Name Function

Tool Name Function

Place source Place the currently selected source in the patient by clicking on the desired source 
position.

Rotate source Specify the angle of a linear source. When this tool is selected, drag the cursor in 
a viewing window to change the source orientation.

Select source Use this tool if you have difficulty selecting the proper source. When you click this 
tool, the source that you select becomes the active source in the Brachytherapy 
windows and the viewing windows.

Add/delete 
source

Add or delete sources. If you click this tool and then click an area that is more 
than 0.25 cm from an existing source, a new source is added. If you click the tool 
and then click on a source, the source is deleted.

Place catheter tip To position the tip of the catheter, select the tool and click in the image at the 
position of the tip of the catheter.

Place catheter 
base

To position the base of the catheter, select the tool and click in the image at the 
position of the base of the catheter.

Add segment If the catheter is not straight, use the tool to create segments that follow the 
changes in the catheter positions in the CT. To interactively position the segment 
tip and base, select the segment from the list of segments and use the tip and 
base tools to position the tip and base. 

Move all 
catheters

To reposition the catheter template, select the tool and move the catheter 
template in any axis. You can use the Catheter Transform tools to rotate and 
translate the catheter template positions.

Tool Name Function

Move cutplane 
2D

Click the tool to turn on the 2D display of marked cutplanes. Click in a 2D window 
to move the displayed cutplanes along their tangent.

Move cutplane 
3D

Move a marked cutplane in the direction perpendicular to the plane.
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Additional
The following are additional tools in the software. 

Keyboard shortcuts
Use these keyboard shortcuts to perform various functions in Pinnacle3.

Rotate cutplane 
about X-axis

Rotate a marked cutplane about the X-axis to create an oblique cutplane.

Rotate cutplane 
about Y-axis

Rotate a marked cutplane about the Y-axis to create an oblique cutplane.

Rotate cutplane 
about Z-axis

Rotate a marked cutplane about the Z-axis to create an oblique cutplane.

Tool Name Function

Tool Name Function

Redo 
spreadsheet

Apply the last change to a parameter in a spreadsheet to all entries in that 
spreadsheet. The Redo spreadsheet tool appears in several of the windows in the 
software.

Keys Function

t View next trial.

n View next image slice.

p View previous image slice.

v View next image set.

a View transverse (axial) orientation.

s View sagittal orientation.

c View coronal orientation.

r Render BEV or 3D skin.

x In a 2D viewing window, toggle between the Scroll through slices, 2D zoom, and 2D pan tools. In a 3D 
viewing window, toggle between the 3D rotate, 3D zoom, and 3D pan tools. 

o Select a slice by number.

z Set a 2D window back to the default magnification.

u Increase magnification of the 2D window.

d Decrease magnification of the 2D window.

m Expand a viewing window so that it fills the entire viewing layout.

Ctrl + c Open the ROI Spreadsheet.

Ctrl + d Compute dose for all beams.
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Ctrl + o Select 2D images by the starting slice and increment.

Ctrl + p Open the Prescriptions window.

Ctrl + r Redo spreadsheet.

Ctrl + s Save plan.

Ctrl + w Create a 3D viewing window.

Ctrl + x Exit the software.

Ctrl + y Redo previous change to conventional objectives or personalized goals.

Ctrl + z Undo previous change to conventional objectives or personalized goals.

Keys Function
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